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Contact Us!

Oracle8 Enterprise Edition for Windows NT
Part No. A55928-01

How to Contact Oracle Technical Publications
Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this 
publication. We also welcome your comments regarding our documentation delivery format. Your 
input is an important part of the information used for revision.

■ Did you find any errors?
■ Is the information clearly presented?
■ Do you need more information? If so, where?
■ Are the examples correct? Do you need more examples?
■ What features did you like most about this manual?
■ Do you have suggestions for improvement? Please indicate the topic, chapter, and page 

number (if available) in your e-mail.

Send your comments to ntdoc@us.oracle.com

How to Contact Oracle Worldwide Customer Support
Depending on your need for information, one or more of these sources may be valuable to you:  

Information Source Description

Oracle Worldwide Customer 
Support Web Page

http://www.oracle.com/support/

This site is the starting point for all support information. From this Web 
site, you can access information such as free installation support, support 
service descriptions, sales office phone numbers, documentation sales, as 
well as current interest items. Also, from this site, you can link to the major 
areas outlined below:

OracleMetaLink

http://support.oracle.com/

This site provides BRONZE, SILVER, and GOLD customers the with the 
ability to resolve technical issues by accessing repositories of technical 
support solutions. This service has recently been enhanced to enable 
United States customers to track the progress of Technical Assistance 
Requests (TARs) being resolved by Oracle. You can register for 
MetaLink by navigating to http://support.oracle.com/ and choosing the 
Registration Page link.
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Oracle Client Relations

http://support.oracle.com/
client_relations/

This is Oracle’s customer service department, which handles issues 
ranging from locating Customer Support Identifier (CSI) numbers, and 
issuing product upgrades and returns, to providing product release 
information and conducting proactive customer visits. If you visit this 
site, you can receive answers to frequently asked questions and can 
register for the SupportNotes CD-ROM. 

Oracle SupportInSite 

http://support.oracle.com/insite/

Visit this area when you want a better understanding of Oracle 
Worldwide Customer Support’s resources, or when you want to find out 
how to enhance your experience with the support organization. You can 
find out how to locate information such as support bulletins, bug 
queries, solutions articles, and white papers. 

You can also find out about accessing TAR management reports and Fax 
on Demand services. In addition, SupportInSite is also available on CD-
ROM and can be ordered through the Oracle Client Relations Web site.

US Customer Visit Program 
(CVP)

This program was established to help Oracle customers understand and 
obtain maximum benefits from the support services they have 
purchased. The visit program includes presentations, demonstrations, 
helpful tips on working more effectively with Oracle Worldwide 
Customer Support, and a comprehensive overview of Oracle’s electronic 
support services. 

Interested customers should contact their Oracle account manager or 
license sales representative and instruct them to complete the “customer 
visit nomination” template in Oracle’s internal e-mail system. 

SupportNews

http://www.oracle.com/support/
supportnews/html/index.html

You can find out all the latest news and information about Oracle 
Worldwide Customer Support’s vast array of products, programs and 
customer-oriented accomplishments by reading SupportNews. 
SupportNews is not a technical journal. This publication is a practical 
newsletter packed with informative articles written by expert Oracle 
staff and specialists. SupportNews is published quarterly and mailed to 
more than 41,000 customers across the United States. You can view the 
electronic version of SupportNews on the Web.

Information Source Description
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Virtual Support Analyst (VSA) This is an automated e-mail response system which allows access to 
Oracle Worldwide Customer Support Services’ databases through any e-
mail server connected to the Internet. VSA is available to all United 
States Oraclemetals customers and is available 24 hours a day, 7 days a 
week, 365 days a year. Once registered with your supported CSI 
Number, VSA enables you to do the following: 

Create, update, query and close TARs 

Query bugs 

Query bulletins 

Request TAR Management Reports 

Request software updates 

For more information on VSA and instructions on how to register, send 
an e-mail to vsa@us.oracle.com. In the e-mail, enter: 

help 

topic: subscribe 

stop 

Oracle Worldwide Customer 
Support for the United States of 
America (by telephone)

(1) (650) 506-1500 for customers with support contracts

(1) (650) 506-5577 to obtain a support contract

Oracle Worldwide Customer 
Support for Europe (by telephone)

(1) (44) (1344) 860-160

Oracle Worldwide Customer 
Support International

Your local Oracle Sales Office in your country. Oracle Sales Offices are 
listed in the Desktop Customer Support Guide booklet in your kit.

Information Source Description
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Other Ways to Contact Oracle Corporation
Depending on your need for information, one or more of these sources may be valuable to you: 

Information Source Contact Description

Oracle Corporation Home Page

http://www.oracle.com

This Web site is the starting point for general information on Oracle 
Corporation.

Oracle Education

http://education.oracle.com/

Customers come to Oracle Education with a variety of needs. You may 
require a complete curriculum based on your job role to enable you to 
implement new technology. Or you may seek an understanding of 
technology related to your key area of responsibility to help you meet 
technical challenges. You may be looking for self-paced training that can be 
used as an ongoing resource for reference and hands-on practice. Or, you 
may be interested in an overview of a new product upgrade. Whatever 
your training need, Oracle Education has the solution. 

Product Availability

infowin@us.oracle.com

Send an e-mail to request information on future product releases on Oracle 
for Windows NT.
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Before You Begin

This guide is your primary source of introductory, post-installation, configuration, 
and administration information for Oracle8 Enterprise Edition. 

Specific topics discussed are:

■ Prerequisites

■ Intended Audience

■ How This Manual Is Organized

■ Conventions
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Prerequisites
This guide assumes that you are familiar with:

■ Windows NT and have installed and tested it on your personal computer (PC) 
and network hardware

■ Object relational database management concepts

Intended Audience
This guide is necessary for anyone configuring or administering Oracle8 Enterprise 
Edition. 

How This Manual Is Organized
This manual is organized as follows:

Chapter 1, “Getting Started with Your Documentation”
Introduces you to the Oracle documentation set. Read this chapter before 
installing or using Oracle8 Enterprise Edition.

Chapter 2, “Introducing Oracle8 Enterprise Edition”
Describes the basic components of Oracle8 Enterprise Edition.

Chapter 3, “Database Tools Overview”
Provides a list of preferred and optional tools you can use to perform common 
database administration tasks.

Chapter 4, “Oracle Enterprise Manager Overview”
Provides an overview of Oracle Enterprise Manager, Oracle’s suite of products 
for managing Oracle databases over a distributed network.

Note: This guide describes only the features of the Oracle8 
Enterprise Edition software that apply to the Windows NT and 
Windows 95 operating systems. For information about Oracle8 
Enterprise Edition that is applicable to all operating systems, see 
the other documentation included in your package listed in 
Chapter 1, “Getting Started with Your Documentation”.
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Chapter 5, “Starter Database Contents”
Describes the contents of the preconfigured starter database.

Chapter 6, “Using Multiple Oracle Homes”
Describes how to use single and multiple Oracle homes.

Chapter 7, “Migrating and Upgrading”
Describes what to do if you have existing databases on your system and want 
to install Oracle8 Enterprise Edition.   

Chapter 8, “Post-Installation Configuration Tasks”
Describes the configuration tasks you must perform before using products, 
such as Oracle Enterprise Manager, Net8, and Cartridges.

Chapter 9, “Creating a Database”
Describes how to create a database automatically using Oracle Database 
Assistant, or manually using command line tools and the BUILD_DB.SQL 
script.

Chapter 10, “Administering a Database”
Describes how to administer a database.

Chapter 11, “Authenticating Database Users with Windows NT”
Describes how to authenticate Oracle8 database users with Windows NT.

Chapter 12, “Monitoring a Database”
Describes how to monitor Oracle8 Enterprise Edition.

Chapter 13, “Backing Up and Recovering Database Files”
Provides recommendations and procedures for backing up and recovering 
database files.

Chapter 14, “Distributing and Managing Oracle Software”
Describes how to install Oracle8 Enterprise Edition products using Microsoft 
Systems Management Server (SMS).

Chapter 15, “Developing Applications”
Describes Windows NT-specific issues for application developers.
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Chapter 16, “Using Oracle8 ConText Cartridge”
Describes Oracle8 ConText Filters, Demos, and Oracle8 ConText Cartridge 
Workbench components.

Appendix A, “Directory Structures”
Lists default directory structures for Oracle8 Enterprise Edition components 
installed on the Windows NT and Windows 95 operating systems.

Appendix B, “Initialization Parameters”
Describes Oracle8 Enterprise Edition initialization parameters, how to edit 
them, and Windows NT-specific values (and ranges) for them.

Appendix C, “Configuration Parameters and the Registry”
Describes the use of the registry for various Oracle8 Enterprise Edition 
components. Additionally, it lists the recommended values and ranges for 
configuration parameters.

Appendix D, “Messages and Codes”
Lists the error messages, causes, and corrective actions specific to installing and 
using Oracle8 Enterprise Edition.

Appendix E, “National Language Support”
Explains the NLS_LANG configuration parameter and its components, and 
lists available options.

Appendix F, “Troubleshooting”
Describes how to diagnose and troubleshoot common error messages. It also 
describes how to contact Oracle Worldwide Customer Support if you cannot 
resolve these problems.

Glossary
Provides brief descriptions of terms used throughout this manual.
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Conventions
The following conventions are used in this guide:

Convention Example Meaning

All uppercase plain C:\ORANT\DATABASE Indicates command names, SQL 
reserved words, and keywords, as in 
ALTER DATABASE. All uppercase 
plain is also used for directory names 
and file names.

Italic Italic is used to indicate a variable:

filename

Italic is used for emphasis:

The WHERE clause may be used to join 
rows in different tables.

Indicates a value that you must provide. 
For example, if a command asks you to 
type filename, you must type the actual 
name of the file.

Italic is also used for emphasis in the 
text and to indicate the titles of other 
manuals.

Square brackets [ ] Start > Programs > Oracle for Windows 
NT - [HOME_NAME] > Oracle Database 
Assistant

Encloses optional items. For example, 
you can start Oracle Installer from the 
default Oracle home or from another 
Oracle home indicated by 
[HOME_NAME] if you use multiple 
Oracle homes. 

Square brackets also indicate a function 
key, for example [Enter].

Choose Start > Choose Start > Programs > Oracle for 
Windows NT > Oracle Installer

How to start a program. For example, to 
start Oracle Installer, you must click the 
Start button on the taskbar and then 
choose Programs, Oracle for Windows 
NT, Oracle Installer. 

C:\> C:\ORANT\DATABASE Represents the Windows NT command 
prompt of the current hard disk drive. 
Your prompt reflects the subdirectory in 
which you are working. Referred to as 
the MS-DOS command prompt in this 
guide.

Backslash (\) before 
a directory name

\DATABASE Indicates that the directory is a 
subdirectory of the root directory.
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ORACLE_HOME Go to the ORACLE_HOME\DATABASE 
directory

SVRMGR> 
@%ORACLE_HOME%\RDBMS80\ADMIN\CATALOG.SQL

ORACLE_HOME is represented as the 
hard drive letter and the top level 
directory where your Oracle software is 
installed, which may be:

■ C:\ORANT for Windows NT

■ C:\ORAWIN95 for Windows 95

■ C:\ORAWIN for Windows 3.1

or whatever you may have called your 
Oracle home.

In Server Manager commands, you may 
see %ORACLE_HOME%. Server 
Manager is able to locate your Oracle 
Home directory using the 
%ORACLE_HOME% variable. This 
convention can be used in Server 
Manager, SQL*Plus, Export Utility, and 
Import Utility.

HOME_NAME OracleHOME_NAMETNSListener80 Represents the Oracle home name if you 
use multiple Oracle homes. This 
convention is not applicable for a single 
Oracle home.

The home name can be up to sixteen 
alphanumeric characters. The only 
special character allowed in the home 
name is the underscore. 

HOMEID HOME0, HOME1, HOME2 Represents a unique registry subkey for 
each Oracle home directory in which 
you install products. A new HOMEID is 
created and incremented each time you 
install products to a different Oracle 
home directory on one computer. Each 
HOMEID contains its own configuration 
parameter settings for installed Oracle 
products.

Convention Example Meaning
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Symbols period  .

comma  ,

hyphen  -

semicolon  ;

colon  :

equal sign  =

backslash  \

single quote  ‘

double quote  “

parentheses ()

Symbols other than brackets and vertical 
bars must be entered in commands 
exactly as shown.

Convention Example Meaning
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Getting Started with Your Documentation

This chapter introduces you to the Oracle8 Enterprise Edition for Windows NT 
documentation set. Read this chapter before installing or using Oracle8 Enterprise 
Edition.

Specific topics discussed are:

■ Documentation Formats

■ What Documentation Did I Receive?

■ What Documentation Do I Read First?

■ Starting Oracle Information Navigator

■ Starting Adobe Acrobat Reader
tation 1-1



Documentation Formats
Documentation Formats
This table describes the format and availability of documents in your Oracle8 
Enterprise Edition kit and the tools required to view them: 

Document Format Document Availability Document Tools

HyperText Markup 
Language (HTML)

All Oracle documentation is 
available in HTML.

Use Oracle Information Navigator to view your 
HTML documentation set. For information on how 
to start Oracle Information Navigator, see “Starting 
Oracle Information Navigator” in this chapter.

Portable Document 
Format (PDF)

All Oracle documentation is 
available in PDF.

Use Adobe Acrobat Reader to view your PDF 
documentation set. For information on how to start 
Adobe Acrobat Reader, see “Starting Adobe Acrobat 
Reader” in this chapter.

Printed Oracle8 Enterprise Edition 
Getting Started for Windows 
NT

Oracle8 Enterprise Edition 
Release Notes for Windows NT

Oracle8 Enterprise Edition 
Installation for Windows NT

Net8 Getting Started for 
Windows NT and Windows 95

Certain printed manuals are also included in your 
kit. To order printed manuals, contact Oracle 
Documentation Sales at the following locations:

■ Telephone (1) (800) 252-0303 in the United 
States of America.

■ Visit: http://www.oracle.com/documentation/sales/
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What Documentation Did I Receive?
What Documentation Did I Receive?
Your documentation set consists of two types of documentation:    

Online Documentation Set
Your online Oracle documentation set is divided into the following categories:

■ Installation

■ Oracle8 Database

■ Oracle8 Cartridges

■ SQL*Plus

■ Network

■ Oracle Enterprise Manager

■ Application Development

■ Parallel Server

■ Oracle Web Publisher

■ Legato Storage Manager

Documentation Type Describes...

Operating System-specific Installation, configuration, and use of Oracle8 Enterprise Edition products in a 
Windows NT or Windows 95 environment. Operating system-specific documents 
are occasionally referred to in the generic documentation set. These documents 
are easy to identify because they always mention their specific operating system 
in their title.

Generic Oracle8 Enterprise Edition, Net8 networking information, and Application 
Programming Interfaces information that is uniform across all operating system 
platforms. The vast majority of documents in your documentation set belong to 
this category. While reading through the generic documentation set, you are 
occasionally asked to refer to your platform (or operating system) documentation 
for procedures specific to the Windows NT or Windows 95 operating systems.

IMPORTANT: Documentation may be included in your package 
detailing products that you did not buy or license, or whose 
functionality is not included in the current release. The presence 
of such documentation does not mean that these products are 
included in your package or that you are licensed to use them.
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What Documentation Did I Receive?
Installation
Oracle8 Enterprise Edition Installation for Windows NT

Oracle8 Database
Oracle8 Enterprise Edition Getting Started for Windows NT

Getting to Know Oracle8 and the Oracle8 Enterprise Edition 

Oracle8 Concepts

Oracle8 Administrator’s Guide 

Oracle8 Backup and Recovery 

Oracle8 Distributed Database Systems 

Oracle8 Migration

Oracle8 Replication 

Oracle Server Manager User’s Guide

Oracle8 Tuning

Oracle8 Utilities

Oracle8 Error Messages

Oracle8 Reference

Oracle8 SQL Reference

PL/SQL User’s Guide and Reference

Oracle8 Cartridges
Oracle8 ConText Cartridge QuickStart

Oracle8 ConText Cartridge Administrator's Guide

Oracle8 ConText Cartridge Application Developer's Guide

Oracle8 ConText Cartridge Workbench User’s Guide

Oracle8 Image Cartridge User's Guide

Oracle8 Spatial Cartridge User’s Guide and Reference

Oracle8 Time Series Cartridge User’s Guide

Oracle8 Visual Information Retrieval Cartridge User’s Guide
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What Documentation Did I Receive?
SQL*Plus
SQL*Plus Getting Started for Windows NT and Windows 95

 SQL*Plus Quick Reference

SQL*Plus User’s Guide and Reference

Network

Net8  

Net8 Getting Started for Windows NT and Windows 95

Net8 Administrator’s Guide 

Oracle Cryptographic Toolkit Programmer's Guide

Oracle Security Server Guide 

Oracle7 Networking  

Oracle Network Products Getting Started Release 2.3.4 for Windows Platforms

Oracle Names Administrator’s Guide

Oracle Network Manager Administrator’s Guide

Oracle Network Products Troubleshooting Guide

Understanding SQL*Net

Oracle Advanced Networking Option Administrator’s Guide 

Oracle Enterprise Manager
Oracle Enterprise Manager Readme

Oracle Enterprise Manager Administrator's Guide 

Oracle Enterprise Manager Application Developer’s Guide 

Oracle Enterprise Manager Concepts Guide 

Oracle Enterprise Manager Configuration Guide 

Oracle Enterprise Manager Messages Manual 

Oracle Enterprise Manager Oracle Expert User's Guide 

Oracle Enterprise Manager Oracle Trace Developer's Guide 

Oracle Enterprise Manager Oracle Trace User's Guide 

Oracle Enterprise Manager Performance Monitoring User's Guide 
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What Documentation Did I Receive?
Oracle Parallel Server Management User’s Guide

Oracle SNMP Support Reference Guide

Application Development
Oracle Call Interface Getting Started for Windows NT and Windows 95

Oracle Pro*C/C++ Getting Started for Windows NT and Windows 95

Oracle Pro*COBOL Getting Started for Windows NT and Windows 95

Oracle Call Interface Programmer’s Guide

Oracle8 Application Developer’s Guide

Oracle8 JDBC Drivers

Pro*C/C++ Precompiler Programmer’s Guide

Pro*COBOL Precompiler Programmer’s Guide

Parallel Server
Oracle Parallel Server Getting Started for Windows NT

Oracle8 Parallel Server Concepts and Administration

Oracle Web Publisher
Oracle Web Publishing Assistant Getting Started for Windows NT

Legato Storage Manager
Legato Storage Manager Administrator’s Guide
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What Documentation Do I Read First?
What Documentation Do I Read First?
This table lists the recommended order in which to start reading through your 
documentation set in order to quickly install and configure Oracle8 Enterprise 
Edition.          

Read Documents in This Order... For Information On...

1. Customer Support Information Booklet How to obtain Customer Support information. 
This document is also available online at http://
support.oracle.com/support_guide/.

2. Oracle8 Enterprise Edition Release Notes for Windows NT Important last minute installation and 
configuration information.

3. Oracle8 Enterprise Edition Installation for Windows NT Installation instructions included in the CD-
ROM insert.

4. Oracle8 Enterprise Edition Getting Started for Windows NT Post-installation, database migration, database 
upgrade, and configuration information for 
Oracle products.

5. Net8 Getting Started for Windows NT and Windows 95 Oracle8 Enterprise Edition client/server 
networking environment, basic database 
network concepts, network protocols, and 
Oracle Protocol Adapters.

6. Oracle8 Concepts Basic database concepts.

7. Oracle8 Administrator’s Guide Basic database administration.

8. Oracle Enterprise Manager Concepts Guide Instructions on using Oracle Enterprise 
Manager.

9. The remaining documentation in an order appropriate 
to your needs.
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Starting Oracle Information Navigator
Starting Oracle Information Navigator
Use Oracle Information Navigator to view your HTML documentation set. Oracle 
Information Navigator enables you to search your entire documentation set for 
information on specific topics.

To start Oracle Information Navigator:

1. Install Oracle Documentation from the CD-ROM. If you select Oracle8 
Enterprise Edition or Oracle8 Client from the Oracle Installation Settings dialog 
box, Oracle documentation is automatically installed. You can selectively 
install Oracle documentation from the Custom Installation option.

Oracle Information Navigator is automatically installed along with your Oracle 
Documentation.

2. Use one of the following Java-enabled browsers: 

■ Netscape Navigator Version 3.0 or later

Visit http://www.netscape.com

■ Microsoft Internet Explorer Version 3.0 or later

Visit http://www.microsoft.com

Oracle Information Navigator can only work with a Java-enabled browser. If 
you do not have a Java-enabled browser, you can still read the Oracle online 
documentation. However, you will not be able to use the Oracle Information 
Navigator.

3. Choose Start > Programs > Oracle for Windows NT - [HOME_NAME] > Oracle 
Documentation.

Your web browser is automatically started, and a welcome page appears.

Oracle Information Navigator appears.

4. Click the icon to access help for instructions on using Oracle Information 
Navigator.
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Starting Adobe Acrobat Reader
Starting Adobe Acrobat Reader
Use Adobe Acrobat Reader to view and print your PDF documentation set. 

To start Adobe Acrobat Reader:

1. Insert the Oracle8 Enterprise Edition CD-ROM into the mapped CD-ROM 
drive.

The operating system automatically detects the CD-ROM. The Oracle8 
Enterprise Edition Autorun dialog box appears and prompts you to make a 
selection:

■ Begin Installation

■ Browse Information

■ Explore CD

2. Click Explore CD.

3. Go to the \ACROREAD directory. 

4. Double-click on Ar32e30 to install the free Adobe Acrobat Reader.

A wizard helps you quickly install Adobe Acrobat Reader.

5. Choose Start > Programs > Adobe Acrobat Reader 3.0 after installation is 
complete to start Adobe Acrobat Reader.

6. Choose Open from the File Menu and navigate to the \PDFDOC directory on 
the CD-ROM to read the PDF documents.

Notes: Some notes on using Oracle Information Navigator:

■ The Java components of Oracle Information Navigator do not 
work on Windows 3.1. You can still access the Oracle online 
documentation, however, you will not be able to use the 
Oracle Information Navigator. To use the Oracle Information 
Navigator, use a 32-bit Microsoft operating system such as 
Windows NT or Windows 95.

■ Recent changes to Microsoft’s Internet Explorer release 3.02 to 
address security issues may prevent Oracle Information 
Navigator from starting and displaying properly. This does 
not affect your access to the Oracle online documentation.
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Starting Adobe Acrobat Reader
7. Read PDF directly from the CD-ROM, or copy the files to your hard disk. 

Notes: Some notes on using Adobe Acrobat Reader:

■ After several documents are opened in Adobe Acrobat Reader, 
you may receive an error message when trying to open an 
additional document, stating that the document does not exist. 
This error occurs because memory is low. To solve the 
problem, close open documents that you are not using, and 
continue.

■ You must use Adobe Acrobat Reader Version 3.0 to view the 
PDF documentation set.
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Introducing Oracle8 Enterprise Edition

This chapter introduces you to Oracle8 Enterprise Edition.

Specific topics discussed are:

■ Oracle8 Enterprise Edition Overview

■ New Products and Features in This Release

■ What Products are on the CD-ROM?
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Oracle8 Enterprise Edition Overview
Oracle8 Enterprise Edition Overview
Oracle8 Enterprise Edition for Windows NT is an Object Relational Database 
Management System (ORDBMS). Oracle8 Enterprise Edition client and server 
software operates on a personal computer (PC), running on the following operating 
systems:        

Key Features
Operating within the framework of Network Computing Architecture (NCA), 
Oracle8 Enterprise Edition provides:

■ Maximum performance and scalability through its unique design with the 
Windows NT multi-threaded architecture. In addition, Oracle8 Enterprise 
Edition for Windows NT has been optimized to take full advantage of 
Windows NT’s multi-tasking and input/output (I/O) capabilities.

■ Integration with the Performance Monitor, Event Viewer, Registry, and 
Security Login.

■ Automatic authentication of users by the Windows NT operating system.

■ Central, easy-to-use Graphical User Interface (GUI) distributed database 
management using Oracle Enterprise Manager.

Operating System Client software? Server software?

Windows NT Workstation Version 4.0 Yes Yes

Windows NT Server Version 4.0 Yes Yes

Windows 95 Yes No
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New Products and Features in This Release
New Products and Features in This Release
These tables describe the new products and features of Oracle8 Enterprise Edition 
release 8.0.4 specific to Windows NT. See Getting to Know Oracle8 and the Oracle8 
Enterprise Edition for the list of new Oracle8 Enterprise Edition products and 
features common to all operating systems.          

New Products Description For More Information, See...

Oracle Data Gatherer Part of the Oracle Enterprise Manager 
framework and is used for collecting 
performance data.

Oracle Enterprise Manager 
Performance Monitoring User’s 
Guide 

Oracle Parallel Server 
Option

Enables you to run multiple Oracle instances on 
a single Oracle database. This option requires a 
separate license.

■ Oracle8 Enterprise Edition 
Installation for Windows NT

■ Oracle Parallel Server Getting 
Started for Windows NT

Oracle Patch Assistant Enables you to quickly and easily download 
and install patches for your Oracle products on 
Windows NT and Windows 95.

Chapter 10, “Administering a 
Database”

Oracle8 Time Series 
Cartridge

Stores and retrieves timestamped data through 
object data types (ODTs). This cartridge is a 
building block for applications, rather than 
being an end-user application. For example, 
applications can use this cartridge to process 
historical data derived from financial market 
transactions, such as trades of stocks, bonds, 
and mutual fund shares. This option requires a 
separate license.

Oracle8 Time Series Cartridge 
User’s Guide

Oracle8 Visual 
Information Retrieval 
Cartridge

Stores, retrieves, and manipulates image data 
managed by an Oracle8 database. Oracle8 
Visual Information Retrieval Cartridge supports 
image storage using Binary Large Objects 
(BLOBS) and references to image data residing 
in external files (BFILEs). This cartridge is a 
building block for various imaging applications, 
rather than being an end-user application. This 
option requires a separate license and the Oracle8 
Image Cartridge.

Oracle8 Visual Information 
Retrieval Cartridge User’s Guide

Oracle Home Selector Allows you to prioritize your Oracle Home 
directory when using multiple Oracle home 
functionality.

Chapter 6, “Using Multiple 
Oracle Homes”
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What Products are on the CD-ROM?
What Products are on the CD-ROM?
Although the Oracle8 Enterprise Edition for Windows NT CD-ROM in your kit 
contains many Oracle products, you may install and use only those products for 
which you have purchased licenses. For additional licensing information, refer to 
the Global License Terms booklet in your kit. Oracle Worldwide Customer Support 
does not provide support for products where licenses have not been purchased.   

When you run Oracle Installer, a dialog box displays several product installation 
options. If you choose Oracle8 Enterprise Edition or Oracle8 Client, a group of 
products are automatically installed. If you choose Custom Installation, you can 
selectively install products. Available options depend upon the operating system 
you are using:      

New Features Description For More Information, See...

Multiple Oracle homes You can have multiple, active Oracle homes 
usable concurrently on a single computer.

Chapter 6, “Using Multiple 
Oracle Homes”

Integration of Legato 
Storage Manager

Provides both 4 mm and 8 mm tape backup 
software that works with Backup Manager and 
Recovery Manager (RMAN80.EXE).

■ Legato Storage Manager 
Administrator’s Guide

■ Chapter 13, “Backing Up 
and Recovering Database 
Files”

Multi-Threaded 
External Callouts

You can increase the speed of external 
procedure invocations when making calls to the 
database from PL/SQL programs by taking 
advantage of multiple, light-weight threads.

Chapter 15, “Developing 
Applications”

IMPORTANT: If you purchased Oracle Web Application Server, 
install the Oracle Web Application Server CD-ROM first. 

If you attempt to install the Oracle Web Application Server CD-
ROM after installing Oracle8 Enterprise Edition, dialog boxes 
appear requesting if you want to downgrade the software 
components. Select No to those messages. Also, Oracle Web 
Application Server must be installed and running prior to 
installing Oracle8 ConText Cartridge Viewer Cartridge and/or 
Oracle8 ConText Configuration Manager.
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What Products are on the CD-ROM?
Oracle Products for Windows NT and Windows 95
The products in this table are listed according to the installation option, of which 
they are a part, for each operating system. Note that the products are listed in 
alphabetical order.       

Operating System Installation Option

Windows NT Oracle8 Enterprise Edition

Oracle8 Client

Database Administrator

Application User

Custom Installation

Windows 95 Oracle8 Client

Database Administrator

Application User

Custom Installation

Oracle8 Enterprise Edition Products Installation Options Available on Each Operating System...

Oracle8 
Enterprise 
Edition on 
Windows NT

Oracle8 Client on Windows NT 
and Windows 95

Custom 
Installation 
on Windows 
NT and 
Windows 95

Application 
User

Database 
Administrator

Assistant Common Files 1.0

When you install this product, these 
components are installed:

BALI

A set of re-usable components that are built in 
Java including toolbars, tab panels, scrolling 
areas, spin boxes, status bars, table/grid 
controls, and so on. 

JHELP

Java-based online help included with Oracle 
Assistants.

JNLS

Java native interface to Oracle National 
Language Support (NLS) runtime library.

Yes Yes Yes Yes
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What Products are on the CD-ROM?
Legato Storage Manager (LSM) 4.4

Using Oracle8 Recovery Manager (RMAN80) 
for Oracle database backups requires the 
installation of a media management product in 
order to back up and restore from tape storage. 
You can choose to install the media 
management product supplied with Oracle8 
Enterprise Edition, which is LSM, or use a third-
party media management product which also 
complies with Oracle’s Backup Solutions 
Program (BSP). LSM also includes a scaled-
down version of Legato NetWorker. LSM has its 
own installer; it is not installed by Oracle 
Installer. You are given the option of installing 
LSM during installation. For more information 
on this product, call toll free (1) 888-8-LEGATO 
in the United States of America, or visit Legato’s 
Oracle backup and recovery web site:

http://www.backup-oracle.com/

Yes No No No

Java Runtime Environment 1.1

A set of files distributed by Sun Microsystems 
that allows Java applications to run. It is 
required by many of the Oracle Assistants.

Yes Yes Yes Yes

JDK 1.0 JDBC Thin Driver 8.0

JDK 1.1 JDBC Thin Driver 8.0

Appropriate for use by Java applets that can be 
downloaded in a web browser. The JDBC Thin 
Client Driver provides a direct connection from 
a web browser to the database by emulating 
Net8 and TTC (the wire protocol used by Oracle 
Call Interface [OCI]) on top of Java sockets. This 
driver works for Oracle7 version 7.2 and later.

No No No Yes

Oracle8 Enterprise Edition Products Installation Options Available on Each Operating System...

Oracle8 
Enterprise 
Edition on 
Windows NT

Oracle8 Client on Windows NT 
and Windows 95

Custom 
Installation 
on Windows 
NT and 
Windows 95

Application 
User

Database 
Administrator
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What Products are on the CD-ROM?
JDK 1.0 JDBC OCI Driver 8.0

JDK 1.1 JDBC OCI Driver 8.0

The OCI-based drivers are used by Java 
applications, which include the Oracle 
WebServer Java Cartridge, or any other Java 
middle tier. The OCI JDBC Drivers call OCI 
directly from Java to connect to the database.

No No No Yes

Open Database Connectivity Driver (ODBC) 
Driver 8.0

Provides support for ODBC connections from 
Windows NT and Windows 95 client systems to 
Oracle8 databases.

Yes Yes Yes Yes

Oracle Administrator Toolbar 1.5

Enables you to execute commands and run 
applications in Oracle Enterprise Manager.

Yes No Yes Yes

Oracle Biometrics Manager 8.0

Administers the Oracle Fingerprint Security 
Service for the Advanced Networking Option.

No No No Yes

NT Only

Oracle Call Interface (OCI) 8.0

An application programming interface (API) for 
accessing an Oracle database from a C or C++ 
program. You make calls directly to the OCI 
functions from within your C or C++ program 
to direct the execution of your SQL statements.

Yes No Yes Yes

Oracle Connection Manager 8.0

Allows you to multiplex multiple logical client 
sessions through a single transport connection 
to an Oracle server destination. 

Yes No No Yes

NT Only

Oracle8 Enterprise Edition Products Installation Options Available on Each Operating System...

Oracle8 
Enterprise 
Edition on 
Windows NT

Oracle8 Client on Windows NT 
and Windows 95

Custom 
Installation 
on Windows 
NT and 
Windows 95

Application 
User

Database 
Administrator
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What Products are on the CD-ROM?
Oracle Data Gatherer

Part of the Oracle Enterprise Manager 
framework and is used for collecting 
performance data. This performance data is 
used by Oracle Capacity Planner and the Java-
based Oracle Performance Manager. If you are 
not using either of these two products, then you 
do not need to install Oracle Data Gatherer. 
Oracle Capacity Planner and Oracle 
Performance Manager are not included on this 
CD-ROM. They are included on a separately 
purchasable Oracle Enterprise Manager CD-
ROM.

No No No Yes

NT Only

Oracle Data Migration Assistant 8.0

Migrates your existing Oracle7 database (release 
7.1.3.3.6 or later) or upgrades previous releases 
of Oracle8 to an Oracle8 database.

Yes No No Yes

NT only

Oracle Database Assistant 2.0

Creates and deletes custom databases.

Yes No Yes

NT only

Yes

NT only

Oracle Documentation 8.0

Available in HTML, viewable using a web 
browser. PDF is also available but is not 
automatically installed. You can find the PDF 
documentation on the CD-ROM in the PDFDOC 
directory. The Adobe Acrobat Reader is located 
in the ACROREAD directory.

Yes Yes Yes Yes

Oracle Enterprise Manager 1.5

Combines a graphical console, agent processes, 
and common services to provide an integrated, 
comprehensive systems management platform 
for managing databases and networks.

Yes No Yes Yes

Oracle8 Enterprise Edition Products Installation Options Available on Each Operating System...

Oracle8 
Enterprise 
Edition on 
Windows NT

Oracle8 Client on Windows NT 
and Windows 95

Custom 
Installation 
on Windows 
NT and 
Windows 95

Application 
User

Database 
Administrator
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Oracle Enterprise Manager Software 
Development Kit (SDK) 1.5

Provides sample source files, libraries, and 
header files for integrating new applications 
into the Oracle Enterprise Manager Console.

Yes No Yes Yes

Oracle File Packager 1.0

Installed as part of Oracle Software Manager 
(OSM), which is part of Oracle Enterprise 
Manager. Only appears in Software Asset 
Manager once installed. This product cannot be 
separately installed.

Yes No Yes Yes

Oracle Installer 3.3

A GUI application that lets you quickly install, 
update, and remove Oracle products. Oracle 
Home Selector is automatically installed with 
Oracle Installer. This product allows you to 
prioritize your Oracle home directories when 
using multiple Oracle home functionality.

Yes Yes Yes Yes

Oracle Intelligent Agent 8.0

Responds to, schedules, and executes database 
administration job requests initiated by the 
Oracle Enterprise Manger Console.

Yes No No Yes

NT Only

Oracle Migration Assistant for Microsoft 
Access 8.0

Complete and easy migration of schema and/or 
data from your Microsoft Access database to an 
Oracle8 database.

Yes No Yes Yes

Oracle Net8 Assistant 8.0

Advanced configuration and administration of 
Net8 products.

Yes Yes Yes Yes

Oracle Net8 Easy Config 8.0

Fast and simple configuration of Net8 products.

Yes Yes Yes No

Oracle8 Enterprise Edition Products Installation Options Available on Each Operating System...

Oracle8 
Enterprise 
Edition on 
Windows NT

Oracle8 Client on Windows NT 
and Windows 95

Custom 
Installation 
on Windows 
NT and 
Windows 95

Application 
User

Database 
Administrator
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Oracle Net8 Products 8.0

Net8 establishes and maintains a connection 
between the client application and the server 
and exchanges messages between them. Net8 is 
a software layer that is required to communicate 
between Oracle clients and servers. It provides 
both client/server and server-server 
communications across any network. It enables 
client tools to access, modify, share, and store 
data on Oracle8 Enterprise Edition servers over 
a network. See Net8 Getting Started for Windows 
NT and Windows 95 for detailed information on 
each Net8 product.

Yes Yes Yes Yes

Oracle Names Server 8.0

A transparent naming service used to 
centrally manage name and address 
resolution in a heterogeneous network. It 
stores network names and addresses so that 
network components can contact one another 
easily without regard to their physical 
locations or specific configurations on the 
network.

Yes No No Yes

NT Only

Oracle Net8 Client 8.0

Provides products that allow client 
connection to databases across a network. A 
client-side application sends a request to Net8 
to be transported across the network to the 
server. 

Yes Yes Yes Yes

Oracle Net8 Server 8.0

Provides products that allow the network 
listener, through an Oracle Protocol Adapter, 
to accept connections from client applications 
on the network. 

Yes No No Yes

NT Only

Oracle8 Enterprise Edition Products Installation Options Available on Each Operating System...

Oracle8 
Enterprise 
Edition on 
Windows NT

Oracle8 Client on Windows NT 
and Windows 95

Custom 
Installation 
on Windows 
NT and 
Windows 95

Application 
User

Database 
Administrator
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Oracle Protocol Adapters 8.0

Oracle Protocol Adapters map Transparent 
Network Substrate (TNS) functionality to 
industry-standard protocols used in client/
server connections. Each protocol adapter maps 
the equivalent functions between TNS and a 
specific protocol. Net8 Client and not oracle 
Installer force installs Oracle Named Pipes 
Protocol Adapter, and auto-detects TCP/IP and 
SPX. TP/IP and SPX are only installed in the 
installation packages if the appropriate software 
is detected on your system. If you explicitly 
select these Oracle Protocol Adapters in the 
Custom Installation option, they will be 
installed even if you do not have the 
appropriate software on your system. See Net8 
Getting Started for Windows NT and Windows 95 
for detailed information on each protocol 
adapter.

Yes Yes Yes Yes

Oracle LU6.2 Protocol Adapter 8.0

See Net8 Getting Started for Windows NT and 
Windows 95.

Yes Yes

NT Only

Yes

NT Only

Yes

NT Only

Oracle Named Pipes Protocol Adapter 8.0

See Net8 Getting Started for Windows NT and 
Windows 95.

Yes Yes Yes Yes

Oracle SPX Protocol Adapter 8.0

See Net8 Getting Started for Windows NT and 
Windows 95.

Yes Yes Yes Yes

Oracle TCP/IP Protocol Adapter 8.0

See Net8 Getting Started for Windows NT and 
Windows 95.

Yes Yes Yes Yes

Oracle8 Enterprise Edition Products Installation Options Available on Each Operating System...

Oracle8 
Enterprise 
Edition on 
Windows NT

Oracle8 Client on Windows NT 
and Windows 95

Custom 
Installation 
on Windows 
NT and 
Windows 95

Application 
User

Database 
Administrator
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What Products are on the CD-ROM?
Oracle Object Type Translator (OTT) 8.0

OTT (executable name OTT80.EXE) is used to 
create C-struct representations of Abstract Data 
Types that have been created and stored in an 
Oracle8 database. To take advantage of objects, 
run OTT against the database, and a header file 
is generated which includes the C structs.

Yes No Yes Yes

Oracle INTYPE File Assistant 8.0

Only installed if OTT is installed. This 
assistant is used in conjunction with Oracle 
development environments to build rapid 
object-oriented applications.

Yes No Yes Yes

Oracle Objects for Object Linking and 
Embedding (OLE) 2.2

A custom control (OCX or ActiveX) combined 
with an OLE in-process server that lets you plug 
native Oracle8 Enterprise Edition functionality 
into your Windows applications.

Yes Yes Yes Yes

Oracle Parallel Server Option 8.0

Provides the ability for multiple Oracle 
instances to share a single Oracle database. This 
product requires a separate license.

Yes No No Yes

NT Only

Oracle Parallel Server Manager Server 8.0

Allows Oracle Parallel Server nodes to manage 
multiple parallel server instances.

Yes No No Yes

NT Only

Oracle Patch Assistant 1.0

Enables you to quickly and easily download 
and install patches for Oracle products.

Yes No Yes Yes

Oracle8 Enterprise Edition Products Installation Options Available on Each Operating System...

Oracle8 
Enterprise 
Edition on 
Windows NT

Oracle8 Client on Windows NT 
and Windows 95

Custom 
Installation 
on Windows 
NT and 
Windows 95

Application 
User

Database 
Administrator
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Oracle Replication Manager 1.4

Simplifies the complex tasks of managing and 
maintaining multiple copies of data in a 
distributed environment. The application 
provides immediate local access to data and 
allows local systems to function automatically, 
even when networks or other systems in the 
environment fail.

Yes No Yes Yes

Oracle Security Server Manager 2.0

Controls database security through the 
management of users, roles, and profiles.

No No No Yes

Oracle Trace Collection Services 7.3 and 8.0

Release 7.3 is installed as part of SQL*Net Client 
release 2.3 and release 8.0 is installed as part of 
Required Support Files 8.0. Oracle Trace 
Collection Services is a general-purpose data 
collection product that captures data for specific 
software events. This product cannot be 
separately installed. 

No No No No

Oracle Web Publishing Assistant 2.0

Enables you to query a database and publish the 
data retrieved on a web page.

Yes No Yes

NT only

Yes

NT only

Oracle Web Server Manager 1.0

Performs the most common web administrative 
tasks through web pages. Web administrative 
tasks include creating, modifying, and deleting 
Database Connection Descriptors (DCDs).

No No No Yes

Oracle8 Enterprise Edition Products Installation Options Available on Each Operating System...

Oracle8 
Enterprise 
Edition on 
Windows NT

Oracle8 Client on Windows NT 
and Windows 95

Custom 
Installation 
on Windows 
NT and 
Windows 95

Application 
User

Database 
Administrator
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What Products are on the CD-ROM?
Oracle7 Utilities 7.3

A suite of products used for Oracle7 database 
administration. Oracle7 Utilities include NT 
Instance Manager, ORADIM73, Server 
Manager, Export Utility, Import Utility, 
SQL*Loader, DBVERIFY, NT Backup Manager, 
NT Recovery Manager, TKPROF, and Password 
Utility. 

No No No Yes

Oracle8 ConText Cartridge 2.3

Enables text queries to be performed through 
SQL and PL/SQL from most Oracle interfaces. 
By installing Oracle8 ConText Cartridge with 
Oracle8 Enterprise Edition, client tools such as 
SQL*Plus, Oracle Forms, and Pro*C are able to 
retrieve and manipulate text in an Oracle 
database. This product requires a separate license. 

Yes No No Yes

NT only

Oracle8 ConText Cartridge Workbench 2.3

A suite of products used in conjunction with 
Oracle8 ConText Cartridge to enhance viewing, 
storage, and manipulation of text data. If you 
select Oracle8 ConText Cartridge Workbench, 
the following components are installed:

Yes No No Yes

Oracle8 ConText Cartridge Configuration 
Manager 2.3

A web application for administering Oracle8 
ConText Cartridge and managing the text 
objects in the Oracle8 ConText Cartridge data 
dictionary on non-Windows platforms, 
including network computers (NCs).

No No No Yes

Oracle8 ConText Cartridge Demos 2.3

A sample application illustrating the text 
querying and retrieval capabilities of Oracle8 
ConText Cartridge and Oracle8 Enterprise 
Edition. 

Yes No No Yes

Oracle8 Enterprise Edition Products Installation Options Available on Each Operating System...

Oracle8 
Enterprise 
Edition on 
Windows NT

Oracle8 Client on Windows NT 
and Windows 95

Custom 
Installation 
on Windows 
NT and 
Windows 95

Application 
User

Database 
Administrator
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Oracle8 ConText Cartridge I/O Utility 2.3

A stand-alone executable that can be used to 
load text to a database column, load text from 
a column into a file, execute SQL and PL/SQL 
code, and call other executables from the MS-
DOS command prompt.

Yes No No Yes

Oracle8 ConText Cartridge System 
Administration 2.3

A GUI application that can be used to 
perform system and text administration tasks.

Yes No No Yes

Oracle8 ConText Cartridge Viewer 2.3

A document viewer supplied as a custom 
control (OCX), which can be embedded in 
any application developed in an environment 
(such as Visual Basic and Visual C++) that 
supports custom controls.

Yes No No Yes

Oracle8 ConText Cartridge Viewer Cartridge 
2.3

A Java web server cartridge that packages 
data for viewing using the web browser 
plugin, and provides generic facilities for 
downloading large data types from the 
database to a web browser.

Yes No No Yes

Oracle8 Enterprise Edition Products Installation Options Available on Each Operating System...

Oracle8 
Enterprise 
Edition on 
Windows NT

Oracle8 Client on Windows NT 
and Windows 95

Custom 
Installation 
on Windows 
NT and 
Windows 95

Application 
User

Database 
Administrator
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TextServer3 Dictionary Migration Tool

Assists users migrating from TextServer3 to 
Oracle8 ConText. This tool is not installed by 
Oracle Installer. The tool is delivered as a PL/
SQL package called CTXWMG_MIGRATE. 
The package generates SQL scripts that you 
can customize to meet your requirements 
before running them. This package must be 
created in the ConText database on the server 
after the ConText Workbench is installed on a 
client machine. 

See Oracle8 ConText Cartridge Workbench 
User’s Guide for details on how to install and 
use the TextServer3 Dictionary Migration 
Tool. 

Yes No No Yes

Oracle8 Enterprise Edition 8.0

The database component of Oracle8 Enterprise 
Edition software.

Yes No No Yes

NT Only

Oracle8 Image Cartridge 8.0

Provides for the storage, retrieval, and 
processing of two dimensional, static 
bitmapped images. Images are stored efficiently 
using popular compression schemes in industry 
standard desktop publishing image interchange 
formats. This product requires a separate license.

Yes No No Yes

NT Only

Oracle8 Objects Option 8.0

Creates and manipulates objects, as well as 
integrating objects with standard relational 
functionality. This product requires a separate 
license.

Yes No No Yes

NT only

Oracle8 Enterprise Edition Products Installation Options Available on Each Operating System...

Oracle8 
Enterprise 
Edition on 
Windows NT

Oracle8 Client on Windows NT 
and Windows 95

Custom 
Installation 
on Windows 
NT and 
Windows 95

Application 
User

Database 
Administrator
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Oracle8 Partitioning Option 8.0

Provides more control in managing tables and 
indexes by directing all maintenance operations 
to individual partitions rather than to tables and 
index names. This product requires a separate 
license.

Yes No No Yes

NT only

Oracle8 Performance Utility 8.0

Enables database administrators to monitor 
local and remote database performance through 
the Windows NT Performance Monitor.

Yes No No Yes

NT Only

Oracle8 Spatial Cartridge 8.0

Makes the storage, retrieval, and manipulation 
of spatial data easier for users. This product 
requires a separate license.

Yes No No Yes

NT Only

Oracle8 Spatial Data Cartridge Utilities 8.0

A suite of tools that manage spatial data in an 
Oracle database.

Yes No No Yes

NT Only

Oracle8 Time Series Cartridge 8.0

Provides the ability to store and retrieve 
timestamped data through object data types 
(ODTs). This product requires a separate license.

Yes No No Yes

NT Only

Oracle8 Utilities 8.0

A suite of products used for database 
administration. Oracle8 Utilities include 
ORADIM80, Server Manager, Export Utility, 
Import Utility, SQL*Loader, DBVERIFY, NT 
Backup Manager, NT Recovery Manager, 
TKPROF, Migration Utility, Recovery Manager, 
OCOPY, and Password Utility. 

Yes No Yes Yes

Oracle8 Enterprise Edition Products Installation Options Available on Each Operating System...

Oracle8 
Enterprise 
Edition on 
Windows NT

Oracle8 Client on Windows NT 
and Windows 95

Custom 
Installation 
on Windows 
NT and 
Windows 95

Application 
User

Database 
Administrator
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Oracle8 Visual Information Retrieval 
Cartridge 8.0

Provides the ability to store, retrieve, and 
manipulate image data managed by an Oracle8 
database. This product requires a separate license.

Yes No No Yes

NT Only

Required Support Files 8.0

A collection of files and libraries required by 
Oracle applications.

Yes Yes Yes Yes

Required Support Files 7.3.4

A collection of files and libraries required by 
Oracle applications. Required Support Files 
release 7.3.4 are supplied for third party 
applications linked with them.

No No No Yes

SQL*Net Products 2.3

A software layer required to communicate 
between Oracle clients and servers. It provides 
both client/server and server/server 
communications across any network. It enables 
client tools to access, modify, share, and store 
data on Oracle8 Enterprise Edition servers over 
a network. See Net8 Getting Started for Windows 
NT and Windows 95 for detailed information on 
each SQL*Net product.

No No No Yes

Oracle Names Server 2.3

A transparent naming service used to 
centrally manage name and address 
resolution. 

No No No Yes

SQL*Net Server 2.3

Provides products that allow the network 
listener, through an Oracle Protocol Adapter, 
to accept connections from client applications 
on the network. 

No No No Yes

Oracle8 Enterprise Edition Products Installation Options Available on Each Operating System...

Oracle8 
Enterprise 
Edition on 
Windows NT

Oracle8 Client on Windows NT 
and Windows 95

Custom 
Installation 
on Windows 
NT and 
Windows 95

Application 
User

Database 
Administrator
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What Products are on the CD-ROM?
Oracle Products for Windows 3.1x
Oracle products for Windows 3.1x are provided for backward compatibility with 
Oracle7. Note that there are no Oracle8 components available on Windows 3.1x. 
When you run Oracle Installer, a dialog box displays several product installation 
options. If you choose Oracle7 Application User or Oracle7 Network Manager, a group 
of products is automatically installed. If you choose Custom Installation, you can 
selectively install products.    

The products in this table are listed according to the installation option of which 
they are a part. Note that the products are listed in alphabetical order. See your 
Oracle7 Client documentation for more information on these products.       

SQL*Plus 8.0

Enables you to use the SQL and PL/SQL 
database languages in the Windows NT or 
Windows 95 environments. SQL*Plus has both 
command line and GUI versions.

Yes Yes Yes Yes

Operating System Installation Option

Windows 3.1x Oracle7 Application User

Oracle7 Network Manager

Custom Installation

Oracle7 Client Products Oracle7 
Application User

Oracle7 Network 
Manager

Custom 
Installation

GUI Common Files 2.5 No Yes Yes

Open Database Connectivity Driver (ODBC) 
Driver 2.5

No No Yes

Oracle Call Interface (OCI) 7.3 Yes No Yes

Oracle Documentation 8.0 Yes Yes Yes

Oracle Installer 3.1 Yes Yes Yes

Oracle8 Enterprise Edition Products Installation Options Available on Each Operating System...

Oracle8 
Enterprise 
Edition on 
Windows NT

Oracle8 Client on Windows NT 
and Windows 95

Custom 
Installation 
on Windows 
NT and 
Windows 95

Application 
User

Database 
Administrator
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Oracle Objects for Object Linking and 
Embedding (OLE) 2.1

No No Yes

Oracle Network Manager 3.1 No Yes Yes

Oracle Protocol Adapters 2.3 Yes Yes Yes

Oracle DECnet Protocol Adapter 2.3 Yes Yes Yes

Oracle LU6.2 Protocol Adapter 2.3 Yes Yes Yes

Oracle Named Pipes Protocol Adapter 2.3 Yes Yes Yes

Oracle NetBIOS Protocol Adapter 2.3 Yes Yes Yes

Oracle SPX Protocol Adapter 2.3 Yes Yes Yes

Oracle TCP/IP Protocol Adapter 2.3 Yes Yes Yes

SQL*Net Client 2.3 Yes Yes Yes

SQL*Plus 3.3 Yes Yes Yes

Oracle7 Client Products Oracle7 
Application User

Oracle7 Network 
Manager

Custom 
Installation
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Database Tools Overview

Oracle8 Enterprise Edition includes various tools to perform database functions. 
This chapter describes the preferred tools to perform common database 
administration tasks.

Specific topics discussed are:

■ Choosing a Database Tool

■ Starting Database Tools

■ Using ORADIM80

■ Using SQL*Loader

■ Using Windows NT Tools
rview 3-1



Choosing a Database Tool
Choosing a Database Tool
Database tools is a collective term for tools, utilities, and assistants that you can use 
to perform database administration tasks. Some database tools perform similar 
tasks, though no one database tool performs all database administration tasks. The 
following sections indicate which database tools can be used on particular 
operating systems and the preferred tools to use for common database 
administration tasks.

Database Tools and Operating System Compatibility
This table lists database tools and the operating system(s) on which each can be 
used:       

Database Tools Oracle8 
Enterprise 
Edition for 
Windows NT

Oracle8 Client 
for Windows NT

Oracle8 Client 
for Windows 95

Oracle8 Utilities

DBVERIFY (DBVERF80) Yes Yes Yes

Export Utility (EXP80) Yes Yes Yes

Import Utility (IMP80) Yes Yes Yes

Migration Utility (MIG80) Yes No No

NT Backup Manager1
Yes No No

NT Recovery Manager Yes No No

OCOPY80 Yes Yes Yes

ORADIM802
Yes No No

Password Utility (ORAPWD80)3
Yes No No

Recovery Manager (RMAN80) Yes Yes Yes

Server Manager (SVRMGR30)4
Yes Yes Yes

SQL*Loader (SQLLDR80) Yes Yes Yes

TKPROF (TKPROF80) Yes Yes Yes
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Choosing a Database Tool
1 NT Backup Manager and NT Recovery Manager are Oracle Corporation products, distinct from the NT Backup Tool 
available with your Windows NT operating system.

2 ORADIM80 only operates on local databases.
3 ORAPWD80 does not work on password files for remote databases.
4 The ORADEBUG utility can be used through Server Manager to send debug commands to Oracle processes. See “Using the 

ORADEBUG Utility” in Chapter 10, “Administering a Database”.

Windows NT Tools

Control Panel Yes Yes No

Event Viewer Yes Yes No

Performance Monitor Yes Yes No

Registry Yes Yes Yes

User Manager Yes Yes No

Oracle Enterprise Manager

Backup Manager Yes Yes Yes

Data Manager Yes Yes Yes

Instance Manager Yes Yes Yes

Schema Manager Yes Yes Yes

Security Manager Yes Yes Yes

SQL Worksheet Yes Yes Yes

Storage Manager Yes Yes Yes

Oracle Assistants

Oracle Data Migration Assistant Yes No No

Oracle Database Assistant Yes No No

Oracle INTYPE File Assistant Yes Yes Yes

Oracle Migration Assistant for Microsoft Access Yes Yes Yes

Oracle Net8 Assistant Yes Yes Yes

Oracle Net8 Easy Config Yes Yes Yes

Oracle Patch Assistant Yes Yes Yes

SQL*Plus Yes Yes Yes

Database Tools Oracle8 
Enterprise 
Edition for 
Windows NT

Oracle8 Client 
for Windows NT

Oracle8 Client 
for Windows 95
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Choosing a Database Tool
Preferred Database Tools
This table lists common database administration tasks and the various database 
tools you can use to perform them. Oracle Corporation recommends you use the 
tools listed in the “Preferred Database Tool” column of the table. After choosing a 
tool to perform a task, go to “Starting Database Tools” in this chapter for 
instructions on how to start the tool.   

Database Administration Task Preferred Database Tool Other Database Tools

Create a database Oracle Database Assistant ■ ORADIM80 and Server Manager 
(SVRMGR30) together

■ SQL Worksheet

Delete a database Oracle Database Assistant ORADIM80 and Server Manager 
(SVRMGR30) together

Delete a database service Oracle Database Assistant ORADIM80

Start a database Instance Manager1
■ ORADIM80 and Server Manager 

(SVRMGR30) together

■ SQL Worksheet

Shut down a database Instance Manager ■ ORADIM80 and Server Manager 
(SVRMGR30) together

■ Control Panel

■ SQL Worksheet

Change internal database passwords ORAPWD80 ORADIM802

Migrate a database

From release 7.x to release 8.0.4

Oracle Data Migration Assistant Migration Utility (MIG80)

Upgrade a database

From release 8.0.3 to release 8.0.4

Oracle Data Migration 
Assistant3

Run provided scripts in Server Manager

Export data Data Manager Export Utility (EXP80)

Import data Data Manager Import Utility (IMP80)

Load data Data Manager SQL*Loader (SQLLDR80)

Back up a database Backup Manager ■ Recovery Manager (RMAN80)

■ NT Backup Manager

■ OCOPY804

Recover a database Backup Manager ■ Recovery Manager (RMAN80)

■ NT Recovery Manager

■ OCOPY80
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Starting Database Tools
This section describes how to start each of the database tools in the following 
categories:

■ Starting Database Tools in Multiple Oracle Homes

■ Starting Oracle8 Utilities

■ Starting Windows NT Tools

■ Starting Oracle Enterprise Manager

■ Starting Oracle Assistants

■ Starting SQL*Plus

You will be referred back to this section for database tool startup procedures as you 
use this manual.

1 Instance Manager can start up and shut down a database and perform other limited functions. This tool cannot be used to 
create database services, or create and delete databases. Instance Manager is an Oracle Enterprise Manager tool.

2 ORADIM80 can only set a password when none was previously set. Also, ORADIM80 can change a password by deleting 
and recreating the Oracle8 services.

3 Oracle Data Migration Assistant can only be used to upgrade release 8.0.3 databases to release 8.0.4. It cannot be used to 
upgrade an earlier Oracle7 database release to a later Oracle7 database release. See your Oracle7 for Windows NT 
documentation for information on how to upgrade from an earlier Oracle7 release to a later Oracle7 release.

4 Do not back up files while you are shutting down the database, otherwise your backup will be invalid. You cannot use an 
invalid backup to restore files at a later date.

5 See Oracle8 Administrator’s Guide for guidelines on creating databases objects. In particular, see Appendix A, “Space 
Estimations for Schema Objects” which provides equations for estimating the space requirements for clusters, non-clustered 
tables, and indexes. Windows NT uses the same fixed header, transaction header, and row header constants described in 
that guide. 

Authenticate database administrators 
and users

Security Manager ■ Server Manager (SVRMGR30)

■ SQL*Plus

■ Windows NT operating system

■ SQL Worksheet

Grant database roles Security Manager User Manager

Create database objects5 Schema Manager ■ Server Manager

■ SQL*Plus

Database Administration Task Preferred Database Tool Other Database Tools
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Starting Database Tools in Multiple Oracle Homes
If you are using multiple Oracle homes functionality, the command to start a tool 
includes [HOME_NAME] where [HOME_NAME] indicates the name of a different 
Oracle home. For example:

Start > Programs > Oracle for Windows NT - [HOME_NAME] > Oracle Database 
Assistant

If you want to start Oracle Database Assistant from an Oracle home called PROD, 
choose Start > Programs > Oracle for Windows NT - PROD > Oracle Database 
Assistant.

Taskbar pathname for first 
Oracle8 database installation. 
No home name is required and 
none appears in the pathname.  

Taskbar pathname for second 
Oracle8 database installation. 
The home name of PROD 
appears in the pathname. 
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Starting Oracle8 Utilities
This table describes how to start each Oracle8 Utility, and where to go for further 
information on using these products:     

Oracle8 Utilities To Start... For More Information, See...

DBVERIFY 
(DBVERF80)

Enter the following at the MS-DOS command 
prompt:

C:\> DBVERF80

DBVERIFY starts and prompts you for a file name 
parameter. To obtain a list of parameters, enter the 
following at the MS-DOS command prompt:

C:\> DBVERF80 HELP=Y

Oracle8 Utilities

Export Utility 
(EXP80)

Enter the following at the MS-DOS command 
prompt followed by your user name and password:

C:\> EXP80

EXP80 starts and prompts you for parameters. To 
obtain a list of these parameters, enter the following 
at the MS-DOS command prompt:

C:\> EXP80 HELP=Y

Note:  When running the Export utility, the default 
values for the following parameters under Windows 
NT are:

BUFFER 4 KB

RECORDLENGTH 2 KB

Note:  To export an entire database, you must use 
the user name SYSTEM. Do not use INTERNAL or 
SYS.

■ Oracle8 Utilities, which 
describes how to use the 
Export utility

■ Oracle8 Error Messages for 
information on error messages
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Import Utility 
(IMP80)

Enter the following at the MS-DOS command 
prompt followed by your user name and password:

C:\> IMP80

IMP80 starts and prompts you for parameters. To 
obtain a list of these parameters, enter the following 
at the MS-DOS command prompt:

C:\> IMP80 HELP=Y

Note:  When running the Import utility, the default 
values for the following parameters under Windows 
NT are:

BUFFER 4 KB

RECORDLENGTH 2 KB

■ Oracle8 Utilities, which 
describes how to use the 
Import utility

■ Oracle8 Error Messages for 
information on error messages

Migration 
Utility (MIG80)

Enter the following at the MS-DOS command 
prompt:

C:\> MIG80

Chapter 7, “Migrating and 
Upgrading”

NT Backup 
Manager

Choose Start > Programs > Oracle for Windows NT - 
[HOME_NAME] > NT Backup Manager

Online help included with this tool

NT Recovery 
Manager

Choose Start > Programs > Oracle for Windows NT - 
[HOME_NAME] > NT Recovery Manager

Online help included with this tool

OCOPY80 Enter the following at the MS-DOS command 
prompt:

C:\> OCOPY80

Chapter 13, “Backing Up and 
Recovering Database Files”

ORADIM80 Enter the following with parameters at the MS-DOS 
command prompt:

C:\> ORADIM80 PARAMETERS

To get a complete listing of ORADIM80 parameters, 
enter a question mark preceded by a dash after the 
executable name:

C:\> ORADIM80 -?

Note:  If you enter ORADIM80 without parameters 
at the MS-DOS command prompt, a GUI Instance 
Manager screen appears. This tool is no longer 
supported for use on Oracle8 Enterprise Edition.

“Using ORADIM80” in this chapter

Oracle8 Utilities To Start... For More Information, See...
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Password Utility 
(ORAPWD80)

Enter the following at the MS-DOS command 
prompt:

C:\> ORAPWD80 FILE=FILENAME PASSWORD=PASSWORD 
ENTRIES=USERS

where:

■ FILENAME is the instance’s password file name

■ PASSWORD is the logon password for the 
instance

■ USERS is the maximum number of users

Oracle8 Administrator’s Guide, 
which describes how to use the 
Password utility

Recovery 
Manager 
(RMAN80)

Enter the following at the MS-DOS command 
prompt:

C:\> RMAN80 PARAMETERS

Chapter 13, “Backing Up and 
Recovering Database Files”

Server Manager 
(SVRMGR30)

Enter the following at the MS-DOS command 
prompt:

C:\> SVRMGR30

■ Oracle Server Manager User’s 
Guide

■ Chapter 10, “Administering a 
Database”, for examples of 
starting and stopping the 
database with Server Manager

SQL*Loader 
(SQLLDR80)

Invoke SQL*Loader at the MS-DOS command 
prompt followed by certain keywords. Enter the 
following and SQL*Loader displays a Help screen 
with the available keywords and default values:

C:\> SQLLDR80

■ Oracle8 Utilities, which 
describes how to use the 
SQL*Loader utility

■ Oracle8 Error Messages for 
information on error messages

■ “Using SQL*Loader” in this 
chapter

TKPROF 
(TKPROF80)

Enter the following at the MS-DOS command 
prompt:

C:\> TKPROF80

Oracle8 Tuning

Oracle8 Utilities To Start... For More Information, See...
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Starting Windows NT Tools
This table describes how to start each Windows NT tool, and where to go for more 
information on using these products:    

Windows NT 
Tools

To Start... For More Information, See...

Control Panel Choose Start > Settings > Control Panel ■ “Control Panel” in this 
chapter

■ Chapter 10, 
“Administering a 
Database”

■ Your Microsoft Windows 
NT documentation

Event Viewer Choose Start > Programs > Administrative Tools > 
Event Viewer

■ “Event Viewer” in this 
chapter

■ Chapter 12, “Monitoring a 
Database”

■ Your Microsoft Windows 
NT documentation

Performance 
Monitor

Choose Start > Programs > Oracle for Windows NT - 
[HOME_NAME] > Performance Monitor

■ “Performance Monitor” in 
this chapter

■ Chapter 12, “Monitoring a 
Database”

■ Your Microsoft Windows 
NT documentation

Registry Enter the following at the MS-DOS command prompt:

C:\> REGEDT32

The registry editor window appears.

■ “Registry” in this chapter

■ Appendix C, 
“Configuration Parameters 
and the Registry”

■ Your Microsoft Windows 
NT documentation

User Manager Choose Start > Programs > Administrative Tools > User 
Manager

■ “User Manager” in this 
chapter.

■ Chapter 11, 
“Authenticating Database 
Users with Windows NT”

■ Your Microsoft Windows 
NT documentation
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Starting Oracle Enterprise Manager
You can start Oracle Enterprise Manager tools:

■ as separate applications

■ from the Oracle Enterprise Manager Console

To start an Oracle Enterprise Manager tool separately:

1. Choose Start > Programs > Oracle Enterprise Manager > tool. 

For example Start > Programs > Oracle Enterprise Manager > Instance 
Manager.

The Login Information dialog box appears.

2. Enter the connect information in the Login Information dialog box.      

To start an Oracle Enterprise Manager tool from the Console:

1. Choose Start > Programs > Oracle Enterprise Manager > Oracle Enterprise 
Manager.

The Login Information dialog box appears.

2. Log on when prompted.

3. You can now either:

■ Select the database you want to administer in the Navigator tree or in the 
Map window, then choose the tool from the Console Tools menu or in the 
Launch Palette.

■ Select the database you want to administer in the Navigator tree, then 
choose the tool from the Related Tools menu of the context-sensitive menu.

■ Choose the application from the Console Tools menu or from the Launch 
Palette, then enter the connect information in the Login Information dialog 
box.

Additional Information: See “Oracle Enterprise Manager” in 
Chapter 8, “Post-Installation Configuration Tasks” for information 
on configuration tasks you must perform before using Oracle 
Enterprise Manager and information on how to connect to an 
Oracle8 database.
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This table describes how to start each Oracle Enterprise Manager tool through the 
Console, and where to go for further information on using these tools. 

Note: When you select a database before starting a tool, you are 
connected to the database according to the preferred credentials 
that have been set up for the database or the credentials you used 
to log on to the Console. If connection to the database fails for any 
reason, the Login Information dialog box appears.

Oracle Enterprise 
Manager Tool

Choose Tools > Applications > For More Information, See...

Backup Manager Backup Manager  Oracle Enterprise Manager 
Administrator’s Guide

Data Manager Data Manager Oracle Enterprise Manager 
Administrator’s Guide

Instance Manager Instance Manager  Oracle Enterprise Manager 
Administrator’s Guide

Schema Manager Schema Manager  Oracle Enterprise Manager 
Administrator’s Guide

Security Manager Security Manager Oracle Enterprise Manager 
Administrator’s Guide

SQL Worksheet SQL Worksheet

The new worksheet is connected to the database you 
have selected in the Navigator tree list or in the map 
window.

Oracle Enterprise Manager 
Administrator’s Guide
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Starting Oracle Assistants
This table describes how to start each assistant, and where to go for further 
information on using these products:   

Assistant Choose Start > Programs > Oracle for Windows NT -  
[HOME_NAME] >

For More Information, See...

Oracle Data 
Migration 
Assistant

Oracle Data Migration Assistant ■ Chapter 7, “Migrating and 
Upgrading”

■ Oracle8 Enterprise Edition 
Installation for Windows NT

Oracle Database 
Assistant

Oracle Database Assistant ■ Chapter 9, “Creating a 
Database”

■ Oracle8 Enterprise Edition 
Installation for Windows NT

Oracle 
Migration 
Assistant for 
Microsoft Access

Oracle Migration Assistant for Microsoft Access Chapter 7, “Migrating and 
Upgrading”

Oracle Net8 
Assistant

Oracle Net8 Assistant ■ Net8 Getting Started for 
Windows NT and Windows 95

■ Net8 Administrator’s Guide

Oracle Net8 
Easy Config

Oracle Net8 Easy Config ■ Net8 Getting Started for 
Windows NT and Windows 95

■ Net8 Administrator’s Guide

Oracle Patch 
Assistant

Oracle Patch Assistant “Downloading Patches from 
Oracle Worldwide Customer 
Support” in Chapter 10, 
“Administering a Database”
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Starting SQL*Plus
This table describes how to start SQL*Plus, and where to go for further information 
on using this product:      

Using ORADIM80
This table describes the ORADIM80 commands and parameters. Note that each 
command is preceded by a dash (-).   

SQL*Plus To Start... For More Information, See...

Enter the following at the MS-DOS 
command prompt:

C:\> SQLPLUS

or

Choose Start > Programs > Oracle for 
Windows NT - [HOME_NAME] > SQL*Plus 
8.0

Starts the GUI version of SQL*Plus

■ SQL*Plus Getting Started for Windows 
NT and Windows 95

■ SQL*Plus User’s Guide and Reference

■ SQL*Plus Quick Reference

Task Use This Parameter...

Create an 
instance 

ORADIM80 -NEW -SID SID [-INTPWD INTERNAL_PWD] [-SRVC SRVCNAME] 

[-MAXUSERS NUMBER][-STARTMODE AUTO, MANUAL][-PFILE FILENAME]

where:

■ SID is the value of the instance.

■ INTERNAL_PWD is the password for the INTERNAL account. 

■ SRVCNAME is the service name.

■ NUMBER is the number of users defined in the password file. The default 
is 5.

■ AUTO or 
MANUAL

indicates whether to start the database automatically or 
manually at startup. The default setting is MANUAL.

■ FILENAME is the INITSID.ORA file to be used with this instance. Ensure 
you specify the complete pathname of this file, including drive 
letter.

Note:  -NEW and -SID are mandatory parameters. The 
remaining parameters are optional.

Note:  Creating an instance using ORADIM80 only creates the 
password file and related service. The database (that is, the 
database files) is not created.
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Task Use This Parameter...

Start an instance ORADIM80 -STARTUP -SID SID [-USRPWD USER_PWD] -STARTTYPE SRVC,INST [-PFILE 
FILENAME] 

where:

■ SID is the value of the instance to start.

■ USER_PWD is the password for the INTERNAL account. This is a 
mandatory parameter.

■ SRVC is for starting the services and INST is for starting an instance 
(both can be specified).

■ FILENAME is the INITSID.ORA file to be used with this instance. Ensure 
you specify the complete pathname of this file, including drive 
letter.

Note:  -STARTUP, -SID, and -STARTTYPE are mandatory 
parameters. The remaining parameters are optional.

Stop an instance ORADIM80 -SHUTDOWN -SID SID [-USRPWD USER_PWD] -SHUTTYPE SRVC, INST -SHUTMODE 
[A, I, N]

where:

■ SID is the value of the SID to stop.

■ USER_PWD is the password for the INTERNAL account.

■ SRVC is for stopping the services.

■ INST is for shutting down a database (both SVRC and INST can be 
specified).

■ A, I, or N Specifications on how to stop an instance; A indicates abort 
mode, I indicates immediate mode, and N indicates normal 
mode.

Note:  -SHUTDOWN, -SID, and -SHUTTYPE are mandatory 
parameters. The remaining parameters are optional.
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Task Use This Parameter...

Edit an instance ORADIM80 -EDIT -SID SID [-NEWSID NEWSID][-INTPWD INTERNAL_PWD]
[-STARTMODE AUTO, MANUAL][-PFILE FILENAME]

where:

■ SID is the value of the SID to edit.

■ NEWSID is the new SID for the instance (enter only if changing an 
existing instance name).

■ INTERNAL_PWD is the password for the INTERNAL account. This is necessary 
only if the password file was not created earlier.

■ AUTO or 
MANUAL

indicates whether to start the database automatically or 
manually at startup.

■ FILENAME is the INITSID.ORA file to be used with this instance. Ensure 
you specify the complete pathname of this file

Note:  -EDIT and -SID are mandatory parameters. The 
remaining parameters are optional.

Note:  This command cannot be used to change the password, 
as it does not overwrite the existing password file. It can only 
create a new password file when none already exists. To create 
a new password file, use ORAPWD80, or delete the Oracle8 
services (this action implicitly deletes the associated password 
file) and then recreate the Oracle8 services (this action 
implicitly creates the associated password file).

Delete an 
instance

ORADIM80 -DELETE -SID SIDA, SIDB, SIDC,... 
ORADIM80 -DELETE -SRVC SRVCA, SRVCB, SRVCC,... 

where:

■ SIDA, SIDB, SIDC are the values of the SIDs to delete.

■ SRVCA, SRVCB, 
SRVCC

are the services to delete.

Display a 
complete list of 
ORADIM80 
commands

ORADIM80 -? | /? | /H | /HELP

Note: When you use ORADIM80, a log file called 
ORADIM80.LOG is opened in ORACLE_HOME\RDBMS80. All 
operations (both successful and failed) are logged in this file. You 
must check this file to verify the success of an operation.
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Using SQL*Loader
This section describes Windows NT specific information for using SQL*Loader 
(SQLLDR80).

Windows NT Processing Options
These are the possible values for the Operating System Dependent (OSD) file 
processing specifications string option, referred to in the “SQL*Loader Control File 
Reference” chapter of Oracle8 Utilities.   

Direct Path Option
SQL*Loader includes a direct path option that bypasses Oracle8 Enterprise Edition 
redo log and data verification features, thereby decreasing loading time. Use the 
direct path option with data files known to be error free.

1 Two double quote characters with no space in between.

Processing Option Description

""1 Stream record format in which each record is terminated by a newline character. 
The maximum record size is 48 KB.

"FIX  n" Fixed record format in which each record is exactly n bytes long. If the record is 
terminated by a newline character, the newline character must be the nth byte.

"VAR xxxx" Load variable length records. Specify the OSD "VAR recsizehint" in the control file 
for this option to take effect. The xxxx gives an estimate of the average record size 
to SQL*Loader so that it can approximate buffer sizes accurately and not waste 
memory. The default length is eighty characters. The xxxx does not specify how 
many leading bytes of length are included in each record. It only acts as a hint to 
SQL*Loader. Each record must always be preceded by five ASCII bytes containing 
the length of the remainder of the record. For example, a record must look like the 
following: 

00024This is a 24 byte string 

Any whitespace, carriage returns, or linefeeds at the end of the record are ignored 
unless specifically included in the byte count in the length field. 
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Control File Conventions
When preparing a SQL*Loader control file (.CTL), you must follow certain syntax 
and notational conventions. When specifying datatypes in the SQL*Loader control 
file, note that the default size of native datatypes are specific to Windows NT. You 
cannot override these defaults in the control file.     

Using Windows NT Tools
The following Windows NT tools can be used to administer an Oracle8 database:

■ Control Panel

■ Event Viewer

■ Performance Monitor

■ Registry

■ User Manager

Native Datatypes Default Field Length

DOUBLE 8

FLOAT 4

INTEGER 4

SMALLINT 2

Additional Information: For a complete list of options and 
instructions on using SQL*Loader, see Oracle8 Utilities. The 
directory ORACLE_HOME\RDBMS80\LOADER contains a 
number of examples on the use of SQL*Loader.
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Control Panel
The Control Panel enables you to modify system options such as computer 
services. A service is an executable process registered in the registry and 
administered by Windows NT. The registry automatically tracks and records 
security information for each service you create. 

What Oracle8 Services Appear in the Control Panel?
When you install the Oracle8 database and other products, Oracle services are 
created and displayed in the Services dialog box: 

Use the Services dialog box to start, stop, pause, or continue each of the Oracle 
services available on the computer, and to pass startup parameters to the service.

Oracle services are the same as Windows NT services. In order to connect to and 
use an Oracle instance, an Oracle service is created during the database creation 
process and associated with the Oracle8 database 

Once a service is created with your Oracle8 database, the service can run even 
while no user is logged on. This is because your Oracle8 database starts each 
instance as a service. This feature enables you to maintain workstation security 
while running your Oracle8 database.

You can now have multiple, active Oracle home directories on a single computer. 
This affects the naming conventions for Oracle services. See “Managing Oracle 
Services” in Chapter 10, “Administering a Database” and Chapter 6, “Using 
Multiple Oracle Homes” for additional information.  
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Event Viewer
Event Viewer enables you to monitor events in your system. An event is an 
important occurrence in the system or application (such as your Oracle8 database) 
that requires user notification. While messages for major events can display on-
screen as you work at your computer, events not requiring your immediate 
attention are recorded by Windows NT in the Event Viewer log file. You can then 
view this information at your convenience.

What Oracle8 Database Events Are Monitored?
The Event Viewer can be used to monitor Oracle8 database events, such as:

■ initialization of the System Global Area (SGA) for the active instance

■ initialization of the Program Global Area (PGA) for the background processes 
of the active instance

■ connection to the Oracle8 database with the CONNECT INTERNAL command

Additional Information: See Chapter 10, “Administering a 
Database”, for specific instructions on using the Control Panel to 
start and stop Oracle8 database services. See also “Step 1: Start 
Oracle Services on Managed Oracle8 Database” in Chapter 8, “Post-
Installation Configuration Tasks”, for specific instructions on using 
the Control Panel to start the Oracle Intelligent Agent service.
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In addition, the operating system audit trail is logged to the Event Viewer. The 
figure below shows the Event Viewer displaying Oracle8 database events. Double-
click an entry to find out specific information about an event.    

Additional Information: See Chapter 12, “Monitoring a 
Database”, for specific instructions on accessing and using Event 
Viewer to monitor Oracle8 database events.
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Performance Monitor
Performance Monitor measures computer performance. This tool enables you to 
view the performance of processors, memory, cache, threads, and processes. 
Performance information provided includes device usage, queue lengths, delays, 
throughput measurements, and internal congestion measurements. This 
information is provided in the form of charts, alerts, and reports.

What Oracle8 Database Information is Monitored?
If you install the Oracle8 Performance Utility from your Oracle8 Enterprise Edition 
CD-ROM, you can use the Performance Monitor to monitor key Oracle8 database 
information, such as:

■ Library Cache

■ Buffer Cache

■ Data Dictionary Cache

■ Redo Log Buffer Cache

■ Thread Activity
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You can use your findings to improve database performance. The figure below 
shows the Performance Monitor monitoring Oracle8 database objects listed at the 
bottom of the screen:

  

Additional Information: See Chapter 12, “Monitoring a 
Database”, for specific instructions on accessing and using the 
Performance Monitor to monitor Oracle8 database performance.

Counters Objects
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Registry
The Oracle8 database stores its configuration information in a structure known as 
the registry. You can view and modify this configuration information through the 
registry editor. The registry contains configuration information for your computer, 
and must not be accessible for editing by inexperienced users. Only experienced 
administrators should view and change this information.

The registry editor displays configuration information in a tree-like format 
consisting of four keys (or folders). These keys are shown in the tree view in the 
left-hand window. In the right-hand window, the parameters and values assigned 
to that key are displayed. 

What Database Parameters Are Configured?
When you install products from your Oracle8 Enterprise Edition CD-ROM, 
configuration parameters are automatically entered in the registry. These 
parameters are read each time your Windows NT computer is restarted. These 
parameters include settings for:

■ Oracle home directory

■ Language

■ Company name

■ Oracle home subdirectories for individual products

■ Individual products such as SQL*Plus

■ services
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The figure below shows some of the Oracle8 database configuration parameters in 
the registry:    

Additional Information: See Appendix C, “Configuration 
Parameters and the Registry” for definitions of Oracle8 database 
configuration parameters and specific instructions on using the 
registry to modify Oracle8 database configuration parameters.
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User Manager
User Manager enables you to manage Windows NT computer security and create 
user accounts. 

What Oracle8 Database Tasks Can the User Manager Perform?
With User Manager, you can:

■ Grant Oracle8 database roles

■ Use operating system authentication for user accounts

■ Create an NT user account that enables you to make secure client connections 
to Oracle8 Enterprise Edition without a password

The figure below shows the User Manager:

Additional Information: See Chapter 11, “Authenticating 
Database Users with Windows NT” for specific instructions on 
using User Manager to perform Oracle8 database administration.
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4
Oracle Enterprise Manager Overview

This chapter provides an overview of Oracle Enterprise Manager, Oracle’s suite of 
products for managing Oracle8 databases over a distributed network.

 Specific topics discussed are:

■ Oracle Enterprise Manager Overview

■ Oracle Enterprise Manager Components
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Oracle Enterprise Manager Overview
Oracle Enterprise Manager enables database administrators (DBAs) to manage 
databases distributed across a network from a centralized Console. Database 
management is performed through an easy-to-use graphical user interface (GUI). 
From the Console, you can:

■ Administer, diagnose, and tune multiple databases distributed across a 
network. 

■ Distribute software to multiple servers and clients.

■ Accommodate growing distributed environments by easily scaling upwards to 
maintain performance and automate routine tasks.

■ Automate remote task execution by scheduling jobs on multiple databases 
simultaneously or at varying time intervals.

■ Schedule and run tasks such as remote database backups or report execution at 
off hours, providing the kind of "lights out" management vital in a large, 
distributed environment.

■ Remotely monitor critical database and system events that you define, have 
detected events represented graphically on the Console (or be notified through 
e-mail or paging), and specify for corrective actions to be performed in 
response to an event.

■ Run integrated third-party applications and tools.

■ Accommodate both large database configurations and environments with 
numerous databases.

■ Administer multiple databases simultaneously in separate windows.

■ Localize task execution, so that tasks are completed even during network 
downtime. Messages are queued locally and saved until they can be delivered, 
even if a network connection is down.

■ Allow DBAs single logon access to particular databases by storing their 
privileges in a credentials file used to manage connections. When connecting to 
a database from the Console, credentials are transparently passed, so you do 
not have to log in repeatedly.
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Oracle Enterprise Manager Components
This section describes the components that enable Oracle Enterprise Manager to 
manage your distributed database network:

■ Oracle Enterprise Manager Console Features

■ Common Services for Managing Databases

■ Integrated Applications

Oracle Enterprise Manager Console Features
The Oracle Enterprise Manager Console provides a central point of control through 
a GUI that provides drag and drop systems management. The Oracle Enterprise 
Manager Console consists of:

■ Menus that primarily manipulate objects in the Console windows

■ Toolbars that provide graphic icons that represent most menu items

■ Tools palette for executing applications and utilities

■ Four windows that provide a general view of the system being managed and 
an interface to the Oracle Enterprise Manager common services (described later 
in this chapter) 

The menus, toolbars, and tools palette are context-sensitive. Integrated applications 
can also be launched from the Console. The menu options that display depend on 
which Console window is active. The tools available in a palette depend upon the 
type of service selected in the Navigator or Map windows. Press F1 to view the 
options.
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This figure shows the four Console windows:

See the Oracle Enterprise Manager Administer’s Guide for information on using the 
Console menus, toolbars, tools palette, and windows. Brief descriptions of the four 
windows are provided in the following table.

Navigator Window Map Window

Job Scheduling Window Event Management Window
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Window Description

Navigator The Navigator Window provides a hierarchical tree view of the network’s nodes and 
services, and any objects they contain. This enables easy object manipulation of all 
objects in the system. (Objects include nodes, databases, listeners, users, roles, and 
profiles. A node contains databases and listeners. A database contains users, roles, and 
profiles.)

Each type of object in the Navigator tree list is identified by an icon and a name. An 
object in the tree can also be copied by dragging and dropping it. For example, you can 
drag and drop users from one database to another.

Map The Map Window provides a customized, graphical representation of key objects (such 
as databases) created by an administrator to manage and monitor a subset or group of 
objects in the system. Objects can be grouped based on any criteria, simplifying all 
operations performed on the group members. 

The map is useful for environments with many databases and for visually representing 
problems detected by the Event Management System.

Job Scheduling The Job Scheduling Window enables you to automate repetitive tasks and provide the 
kind of “lights out” management vital in a large, distributed environment. 

You can schedule or cancel a job and view its status, or review historical information 
about jobs. You can also create and manage job scripts. See “Job Scheduling System” for 
additional information.

Event Management The Event Management Window enables you to create and register event sets, modify 
or cancel registrations, view the status of services being monitored, view summary 
information about events that have occurred, and further manage event information. 

You can choose to have the events of interest represented graphically on the Console 
when they are detected. The system can also notify you through e-mail or numeric and 
alphanumeric paging. The Oracle Enterprise Manager Console provides support for 
paging and e-mail when a preregistered event is encountered. The Console currently 
supports alphanumeric paging systems that use the Telocator Alphanumeric Paging 
(TAP) protocol for automatic paging and both the Simple Mail Transfer Protocol 
(SMTP) and Mail Application Programming Interface (MAPI) for e-mail notification.
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Common Services for Managing Databases
Oracle Enterprise Manager has the following set of common services that help you 
manage Oracle8 databases throughout the network:

■ Oracle Intelligent Agent and Communication Daemon

■ Service Discovery

■ Job Scheduling System

■ Event Management System

■ Repository

■ Security

The figure below shows how these common services work together to perform 
distributed database management across a network. Each common service is then 
described.

Oracle
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Applications
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Integrated
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Applications
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Oracle Intelligent Agent and Communication Daemon
The Oracle Enterprise Manager uses Oracle Intelligent Agent and the 
communication daemon to manage Console tasks such as scheduling and running 
remote jobs, and monitoring events on remote sites. The Oracle Enterprise Manager 
is installed on a Windows NT or Windows 95 Console workstation. Oracle 
Intelligent Agent is installed on each node with an Oracle8 Enterprise Edition for 
Windows NT database to be managed.

The communication daemon runs on the Console and communicates with Oracle 
Intelligent Agent to manage jobs and events. 

Oracle Intelligent Agent is effective, nonintrusive, and functions as the executor of 
jobs and events sent by the Console through the communication daemon. High 
availability is ensured since Oracle Intelligent Agent can function regardless of the 
status of the Console or network connections. Oracle Intelligent Agent is 
responsible for managing and completing tasks requested from the Console 
workstation by the Oracle Enterprise Manager. Once installed, Oracle Intelligent 
Agent:

■ listens for and responds to job requests initiated from the Oracle Enterprise 
Manager Console workstation 

■ schedules job requests (requests can include detecting and correcting abnormal 
conditions, performing standard database administration procedures, and 
monitoring events)

■ executes the job request
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Service Discovery 
The communication daemon uses the dynamic discovery feature to identify nodes 
and services on the network. The figure below illustrates this process:

Job Scheduling System
The Job Scheduling System enables you to schedule and manage job tasks on 
remote sites. The Job Scheduling System, communication daemon, and Oracle 
Intelligent Agents work together to schedule and execute jobs. Use the Job 
Scheduling System to perform asynchronous tasks on multiple sites without 
having to maintain connections to all those sites. In addition, jobs can run 
simultaneously on different nodes in the system. See the Oracle Enterprise Manager 
Administrator’s Guide for information on scheduling and managing jobs. 

The process for scheduling a job is:

1. From the Console Job system, submit a job that you have set up.

2. The communication daemon sends the job information to the appropriate 
intelligent agent(s). 

3. If a site or its agent is down, the communication daemon queues the job. Once 
the site can be contacted, the daemon submits the queued job to the agent.

4. The agent executes the job on schedule.

5. The agent returns any related job messages back to the daemon for display in 
the Console.

Communication Daemon

Network

Intelligent
Agent

Network

Console

Topology

Manager
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The Job Scheduling System, communication daemon, and Oracle Intelligent Agents 
work together to schedule and execute the job. You can use the Job Scheduling 
System to perform asynchronous tasks on multiple sites without having to 
maintain connections to all those sites. In addition, jobs can run simultaneously on 
different nodes in the system.

The features of the Job Scheduling System are described in the table below:

Feature Description

Variety of predefined job 
tasks

Schedule and run jobs on remote sites throughout the 
network, including: 

■ Backing up a database

■ Starting up or shutting down databases or listeners

■ Running SQL scripts or operating system programs

You can also submit your own custom jobs to the Job 
Scheduling System.

Stored and forwarding 
job scheduling

Submit a job once, regardless of the number of nodes on 
which the job runs or how often it must be executed. Oracle 
Enterprise Manager ensures that the job is run on schedule on 
all specified databases, and keeps a history of the job and 
record of the job’s status. You can view information about the 
job in the Job Scheduling Window. (This is because the task of 
submitting and managing jobs is centralized in the Console.)

To schedule a job, you do not need to connect to the node on 
which the job runs. Instead, submit the job from the Console 
and specify the nodes or services on which it runs.

When you submit a job to one or more destinations, it is 
possible that any one of those sites may be down. If a site or 
its Oracle Intelligent Agent is down, the communication 
daemon queues job requests not delivered to the sites. Once 
the site can be contacted, the daemon submits the queued job 
to the agent.
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"Lights out" management Automate repetitive and periodic tasks and problem 
correction. If the job has to be executed periodically, the 
agents reschedule the job without your intervention. 
Messages about a job’s status are reported back to the 
Console.

When you register an event to be monitored by Oracle 
Enterprise Manager, you can specify a fixit job, which is 
executed to correct the problem if the event occurs.

Cross-operating system 
job scripts

Jobs are implemented as Tool Command Language (Tcl) 
scripts. Tcl is a scripting language used to write both job and 
event scripts. Oracle has also extended Tcl (OraTcl) to include 
database-specific commands. With OraTcl, you can:

■ Invoke operating system facilities, such as programs or 
shell scripts

■ Execute SQL and PL/SQL scripts

■ Start up and shut down Oracle databases

■ Communicate with Oracle Intelligent Agent

Although you submit a job from the Console, the job scripts 
reside on the agent nodes. Because the manner in which a job 
is implemented can depend on the operating system, each 
agent keeps its own set of job scripts.

This enables you to submit a job, such as backing up a 
database, without worrying about the specifics of the 
operating system. For example, you can select a group of 
databases residing on Windows NT computers, and send one 
backup job request to back up the databases. The agents on 
those nodes run backup job scripts that are specific to their 
operating systems.

Composite jobs Combine two or more predefined jobs (such as backing up a 
database and then running a script) into one composite job. 
Each of the predefined jobs contained in the composite job is 
called a task.

Composite jobs can contain test conditions based on the 
success of a task. For example, if a composite job consists of 
two tasks, starting up a database and then running a SQL 
script, you can specify that the script be run only if the 
database was successfully started.

Feature Description
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Scalability Run jobs efficiently on multiple remote nodes. When you 
submit a job to run on a remote node, all the information 
needed to run the job is transferred to the agent servicing the 
node. When the job is executed, it is run by the agent on that 
node, minimizing network traffic between the remote node 
and the Console and daemon. The only communication 
between the agents and the Console and daemon are the 
initial transmission of job information and any subsequent 
messages about job status changes.

Because jobs are run independently by agents, you can 
submit any number of jobs on multiple nodes without 
affecting the Console. For example, you can submit several 
jobs and then immediately start another task without waiting 
for the agents to schedule the jobs.

In addition, because there is an Oracle Intelligent Agent 
residing on each managed node, jobs can be run on multiple 
nodes simultaneously. For example, you can submit a job to 
run a report on multiple databases worldwide. The job is 
scheduled and run independently by the agent that services 
each database. Therefore, the jobs can be executed by their 
respective agents at the same time.

Security Jobs are normally run with your preferred credentials; 
therefore, you cannot run jobs to perform functions that you 
could not perform if you were logged into the computer 
directly.

Because jobs are categorized by service types, such as 
database or node, the Job Scheduling System knows which 
credentials to pass to the agent. If the job runs on a node, the 
Job Scheduling System passes either your preferred 
credentials for the node or, if none are specified, the user 
name and password used when logging into the Console. If 
the job runs on a service, such as a database, the Job 
Scheduling System also passes your preferred credentials to 
the service.

A job can also be run with the agent’s credentials. This 
flexibility enables a site to easily incorporate the Job 
Scheduling System’s authentication methods with existing 
security policies.

Feature Description
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Event Management System
The Event Management System enables you to monitor specific events at remote 
sites throughout the network, such as problems on a node or database. The process 
to register an event set is:

1. From the Console, register a predefined event set or a set that you created.

2. The communication daemon sends the event information to the appropriate 
intelligent agent(s). 

3. The agent does the monitoring and alerts you if the event occurs.

4. Optionally, you can specify a fixit job to execute if the event occurs.

When an event occurs, you can be notified in various ways, such as e-mail or 
paging. Also, events are logged in the repository and can be viewed in the Console.

The features of the Event Management System are described in the table below:

Feature Description

Proactive Events 
Management

Automate problem detection and correction in response to an 
event. This ensures that a problem is corrected before it 
noticeably impacts end-users. You can also specify a fixit job 
to be run in response to a particular event. For example, you 
can have the Event Management System monitor the 
tablespace TEMP in the database HR_DB and generate an 
alert if TEMP runs out of free space. You can also have a data 
file automatically added to TEMP if this event occurs.

Unsolicited Error 
Detection

Detect events with tools and applications independent of 
Oracle Intelligent Agents. These tools and applications can be 
integrated into the Event Management System and 
communicate directly with Oracle Intelligent Agents. For 
example, a third-party application can detect an event on a 
node and report that event to Oracle Intelligent Agent on that 
node. Oracle Intelligent Agent then sends the message back to 
the Console.
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Scalability The Event Management System allows one person to monitor 
a large system. If you are responsible for 100 databases, you 
cannot connect to each database every day to check on 
performance. Using the Event Management System, you can 
effectively monitor all databases 24 hours a day, and be 
alerted if a problem is detected.

The Event Management System also enables you to focus on 
select systems and events. This control is vital in a large 
system. Rather than monitor all sites or a large number of 
sites, you can pinpoint only those services you want to 
monitor.

An administrator can monitor a large number of sites with 
minimal performance impact on the Console. Because Oracle 
Intelligent Agents perform the monitoring independent of the 
Console, an administrator can monitor many sites without 
slowing other tasks.

Predefined Event Sets Standard pre-defined event sets are provided. Advanced 
event sets are included with the optional Performance Pack. 

The standard pre-defined events are the fault management 
events:

■ Database up/down

■ Listener up/down

■ Node up/down

Pre-defined event sets included with the Performance Pack 
are:

■ Space and resource management events, such as a disk 
becoming too full or a tablespace running out of extents

■ Performance management events, such as a CPU load 
being abnormal or a database system statistic being too 
high

See the Oracle Enterprise Manager Performance Monitoring 
User’s Guide and Chapter 12, “Monitoring a Database”.

Optimized Intelligent 
Agents

The optimized intelligent agent has been optimized to 
monitor large numbers of systems and events efficiently. 
Event tests are generally executed by the agent process 
directly and can be run quickly.

Feature Description
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Repository
The Oracle Enterprise Manager Repository is a database accessible from the 
Console. The repository:

■ consists of database tables

■ holds information used by the Oracle Enterprise Manager

■ can be installed in any accessible Oracle database in the system

You can have more than one repository in your system. A user is associated with 
one repository.

The repository provides a centralized location for storing information about the 
state of the environment managed by Oracle Enterprise Manager from the 
perspective of each Console user. It contains information on: 

■ configurations 

■ jobs and events 

■ historical collections 

■ tuning recommendations 

■ preferred credentials for each user 

■ other information associated with each Oracle Enterprise Manager Console 
login. 

See the Oracle Enterprise Manager Administrator’s Guide for information on creating 
your own repository.

Event Scripts As with jobs, events are OraTcl scripts stored on the Oracle 
Intelligent Agent node. Event scripts can save state 
information. Saving a state between executions of an event 
script enables Oracle Intelligent Agent to remember if it has 
already detected a certain event and eliminate redundant 
event messages to the Console. This also enables event scripts 
to maintain a history of a database and adjust to typical 
behavior.

Note: Unlike job scripts, event scripts are run with the 
permissions of Oracle Intelligent Agent.

Feature Description
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Security
Access to Oracle Services on the network is controlled by a set of user-defined, 
preferred credentials for the available nodes and services. Oracle Enterprise 
Manager caches the user authentication information in encrypted form in the 
repository and provides it as part of the connection request from the Oracle 
Enterprise Manager Console or Console-launched applications. 

To access services, you must log in to the Console by using an authorized user 
name and password. Oracle Enterprise Manager manages the connections made on 
your behalf and ensures that others cannot perform operations they are not 
privileged to perform.

Integrated Applications
Oracle Enterprise Manager has an open architecture that enables software to be 
integrated with the Console. The design of these integrated applications:

■ executes tasks quickly

■ performs multiple tasks concurrently

■ administers multiple databases simultaneously in separate windows

■ centralizes DBA tasks in a single locale

This section describes the following integrated application features:

■ Database Administration Applications

■ Common Features

■ Integrating Additional Applications

Database Administration Applications
Oracle Enterprise Manager includes a standard set of integrated database 
administration (DBA) applications that automate and simplify DBA tasks. These 
applications can be launched directly from the Console or the Administration 
Toolbar. In addition, third-parties can write applications that integrate into the 
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Console, use the available common services, and launch from the Console. The 
applications available are described in the following table:

DBA Application Description

SQL Worksheet Enables you to enter SQL statements, PL/SQL code, and DBA commands 
dynamically, and run scripts that are stored as files. SQL Worksheet maintains a 
history of the commands entered, enabling you to edit and re-execute an earlier 
command without retyping it. You can drag a SQL file and drop it into a worksheet 
to load it. You can have multiple SQL Worksheets open at a time, each separate from 
others. Therefore, you can commit or roll back work in each worksheet 
independently.

Instance Manager Enables you to start up and shut down databases, examine and edit initialization 
parameters, manage in-doubt transactions, and manage user sessions. 

Storage Manager Enables you to perform DBA tasks associated with managing database storage. 
These tasks include managing tablespaces and rollback segments, and adding and 
renaming data files. You can also launch database tools and utilities from Storage 
Manager.

Backup Manager Enables you to perform tablespace backups, create backup scripts guided by a 
backup wizard, and administer redo logs. The Backup Manager manages the 
following groups:

■ database

■ tablespace

■ data files

The Backup Manager simplifies backups through the use of a backup wizard. The 
Backup Wizard enables you to specify the:

■ status of the database required to complete the backup 

■ particular tablespaces of the database to be backed up

■ backup method to be used

■ name of the file that contains the backup job script you are creating using the 
Tablespace Backup Wizard

Security Manager Enables you to create, alter, and drop users, roles, and profiles, and add multiple 
privileges and roles for database users. Security Manager controls the security of 
Oracle databases. Profiles and roles assigned to a set of users are in constant change; 
Security Manager simplifies making changes by providing security lists that an 
administrator uses to determine which profiles and roles have been assigned to a set 
of users. Use property sheets to determine the security parameters for each database. 
Required changes can be made quickly.
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Schema Manager Enables you to create, edit, and examine status, owner, creation date, and last date 
modified information for the following schema objects:

■ clusters

■ database links

■ functions and procedures

■ indexes

■ packages and package bodies

■ refresh groups

■ sequences

■ snapshots and snapshot logs

■ synonyms

■ tables

■ triggers

■ views

Data Manager Enables you to automate (through wizards) the transfer of data to and from an 
Oracle database. Data Manager also provides job tasks that can be submitted with 
the Job Scheduling System. The Data menu of Data Manager includes Export, 
Import, and Load wizard options for:

■ Exporting data to a file. This option transfers data from an Oracle database to an 
Oracle binary operating system file. The file can then be used with the import 
operation. 

■ Importing data from a file. This option transfers data to an Oracle database that 
has been exported from another Oracle database.

■ Loading data from an external file. This option loads data from operating 
system files, such as text files, to an Oracle database.

DBA Application Description
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See the Oracle Enterprise Manager Administrator’s Guide for information on using 
these tools.

Common Features
The integrated database administrator applications share some common features:

Oracle Software 
Manager

Enables you to manage software from a central location across the enterprise with: 

■ An integrated toolset for managing software in a distributed fashion 

■ A next generation architecture that offers network scalability through an 
advanced client-agent-server paradigm 

■ An easy-to-use GUI that allows administrators to easily run software 
configuration jobs and track assets across the entire network 

The Oracle Enterprise Manager/Oracle Software Manager (OSM) network 
comprises one or more Oracle Enterprise Manager/OSM installations, each 
administering host servers that contain Oracle Intelligent Agents. Oracle Intelligent 
Agent can have clients that are administered as part of the network.

OSM uses a lightweight store-and-forward messaging system that keeps network 
traffic to a minimum. In the event of network problems, any message that is waiting 
to be sent, either from the Console or Oracle Intelligent Agent, is held until the 
network is back online. Communications between the Console and agents are not 
resource intensive; they require only one connection per agent. If a host becomes 
unavailable, the connection is freed.

Feature Description

Tree Lists All tools have a tree list of managed objects similar to the Navigator tree list in the 
Console. For example, in the Security Manager, the tree list has containers for 
users, roles, and profiles. These containers can be expanded or collapsed by 
clicking the + or - icons to the left of the container.

Multi-column Lists A multi-column list is displayed when you select a group container. Each row in 
the list provides a quick view of summary information about objects in the selected 
container. Additionally, you can select and alter items through their respective 
property sheets.

Property Sheets A property sheet is a dialog box used to specify options when you are creating or 
altering a composite instance, such as a user or tablespace. A property sheet 
consists of one or more pages that are labeled with page tabs. By default, one page 
is open when the sheet is entered, but all pages show page tabs. To access another 
page, select its page tab.

DBA Application Description



Oracle Enterprise Manager Components

                                                       Oracle Enterprise Manager Overview 4-19

Integrating Additional Applications
Additional systems management applications are available for Oracle Enterprise 
Manager. These applications are available from Oracle Corporation and third-party 
software developers.

Examples of Oracle applications integration into Enterprise Manager are:

■ Oracle Replication Manager

■ Oracle Media Server

■ Oracle Parallel Server

■ Oracle Web Application Server

■ Oracle Advanced Networking Option-Network Security and Single Sign-On 
Biometric Manager

Record and Play Back The integrated applications also provide a "record and play back" mechanism that 
makes it easy to record a task and perform it at multiple locations. For example, if 
you want to assign several privileges to a set of users who exist on ten databases, 
use the Security Manager and the logging mechanism to record the granting of the 
privileges, then use the Job Control System to perform the assignment at the ten 
databases.

Basic/Advanced User 
Modes

Advanced Mode displays additional property sheets that enable you to access an 
application’s advanced database administration features.

Feature Description
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5
Starter Database Contents

This chapter describes the contents of the Oracle8 Enterprise Edition starter 
database.

Specific topics discussed are:

■ Starter Database Guide

■ Starter Database Contents
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Starter Database Guide
During the installation process, you are prompted to install either of two types of 
database configurations:

■ Typical Configuration (installs the starter database)

■ Custom Configuration, which starts Oracle Database Assistant at the end of 
installation and enables you to create a custom database.

 This table describes some of the features available with each configuration:

Database Feature Typical Configuration Custom Configuration

Type of Database Created Automatically creates a fully 
preconfigured and ready-to-use 
starter database with default 
INITSID.ORA file parameter settings.

Enables you to create your own 
database with customized 
INITSID.ORA parameter settings. 
This option is only for Oracle 
database administrators (DBAs) 
experienced with advanced database 
creation procedures.

Database Name Automatically named ORCx1. Your choice.

System Identifier (SID) 
Name

Automatically named ORCx1. Your choice.

Cartridges and Options Both configuration types allow you to select the following cartridges and 
options for installation:

■ Oracle8 ConText Cartridge

■ Oracle8 Spatial Cartridge

■ Oracle8 Image Cartridge

■ Oracle8 Time Series Cartridge

■ Oracle8 Visual Image Retrieval Cartridge

■ Oracle Parallel Server Option

■ Oracle8 Partitioning Option

■ Oracle8 Objects Option

Advanced replication 
(updatable snapshots)

Automatically installed. Your choice.
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1 When you install the Oracle8 database for the first time on a computer, your SID and database name are typically named 
ORCL. For each additional Oracle8 database installation on the same computer, the last letter of ORCL is replaced by a 
number and automatically incremented (that is, for a second Oracle8 database installation, the SID and database name are 
ORC1, for a third Oracle8 database installation, the SID and database name are ORC2, etc.).

User names, database files, 
and tablespaces

Automatically creates the user names, 
database files, and tablespaces 
described in “Starter Database 
Contents”.

Automatically creates the SYS, 
SYSTEM, SCOTT, DEMO, and 
DBSNMP user names and 
INTERNAL alias described in 
“Starter Database Contents”, but 
enables you to customize tablespace 
and database file settings and create 
an extra control file and extra 
tablespace named INDEX. An 
Oracle8 Cartridge user name is only 
created if you select that specific 
cartridge for installation when 
running Oracle Database Assistant.

Additional Information: You can still create a custom database 
manually. See Chapter 9, “Creating a Database” for additional 
information.

Database Feature Typical Configuration Custom Configuration
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Starter Database Contents
The starter database you receive if you select the Typical Configuration database 
option contains the following features: 

■ User Names

■ System Identifier

■ Tablespaces

■ Data Files

■ Initialization Parameter File

■ Redo Log Files

■ Control File

■ Data Dictionary 

User Names
Your starter database contains these user names:           

User Name Passwords Description

INTERNAL ORACLE is 
automatically the 
password if you installed 
your Oracle8 database 
using the Oracle8 
Enterprise Edition 
option. If you installed 
your Oracle8 database 
using the Custom option, 
the password is 
whatever you entered 
when prompted during 
installation.

DBA user name with which to perform 
database administration tasks, including 
starting up and shutting down a database.

Note: INTERNAL is not a true user name; 
it is an alias for the SYS user name and 
SYSDBA privilege.

Note: INTERNAL uses the SYS schema, 
listed below, with additional SYSDBA 
privileges. See the chapter “The Oracle 
Database Administrator” of the Oracle8 
Administrator’s Guide for more 
information.



Starter Database Contents

                                                                    Starter Database Contents 5-5

1 MDSYS and ORDSYS are automatically created with the starter database even if you do not select their 
Oracle8 Cartridges for installation.

SYS CHANGE_ON_INSTALL DBA user name with the following 
database roles:

■ AQ_ADMINISTRATOR_ROLE 

■ AQ_USER_ROLE 

■ CONNECT

■ DBA 

■ DELETE_CATALOG_ROLE

■ EXECUTE_CATALOG_ROLE

■ EXP_FULL_DATABASE

■ HS_ADMIN_ROLE

■ IMP_FULL_DATABASE

■ RECOVERY_CATALOG_OWNER

■ RESOURCE

■ SELECT_CATALOG_ROLE

■ SNMPAGENT

SYSTEM MANAGER DBA user name with DBA database role.

SCOTT TIGER User name with CONNECT and 
RESOURCE database roles. 

DEMO DEMO User name with CONNECT and 
RESOURCE database roles. Oracle 
Corporation recommends that you drop 
this account if it is not needed.

DBSNMP DBSNMP User name with CONNECT, RESOURCE, 
and SNMPAGENT database roles. If you 
want to drop this role and user, run 
CATNSNMP.SQL.

MDSYS1 MDSYS Oracle8 Spatial Cartridge administrator 
user name.

ORDSYS1 ORDSYS Oracle8 Image, Time Series, and Visual 
Information Retrieval Cartridges 
administrator user name with CONNECT 
and RESOURCE database roles.

User Name Passwords Description
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System Identifier
Each Oracle8 database has a SID. A SID is a unique name for an Oracle database 
instance that can be up to four alphanumeric characters in length. 

For example, if the SID for an Oracle8 database is ORCL, each database file in the 
ORACLE_HOME\DATABASE directory has ORCL as part of its name (for 
example, CTL1ORCL.ORA, LOG1ORCL.ORA, and INITORCL.ORA). The new 
multiple Oracle homes feature enables you to have multiple, active Oracle8 
databases installed on a single computer. Each database requires a unique SID. To 
ensure that each SID is unique, the last letter of ORCL is automatically replaced by 
a number and incremented each time you install Oracle products into a different 
home (that is, for a second Oracle8 database installation, the SID is ORC1, for a 
third Oracle8 database installation, the SID is ORC2, etc.). See Chapter 6, “Using 
Multiple Oracle Homes” for further information. Because of this, the data files, 
initialization files, redo log files, and control files described below use a variable of 
SID in their names. When you see SID, substitute it with the SID for your Oracle8 
database.

Note: Change the passwords for the SYS, SYSTEM, MDSYS, and 
ORDSYS user names immediately after installation with the 
following SQL statement at the Server Manager prompt:

SVRMGR> ALTER USER USERNAME IDENTIFIED BY PASSWORD;

See Chapter 3, “Database Tools Overview” for information on 
starting Server Manager.

Note: If you create an Oracle8 database through the Custom 
Configuration option, the Oracle8 Cartridge user names described 
in the previous table are only created if you select the cartridges for 
installation with which each are used.
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Tablespaces
An Oracle8 database is subdivided into smaller logical areas of space known as 
tablespaces. Each tablespace corresponds to one or more physical data files. The 
four tablespaces in the Oracle8 database contain the following types of data:  

Tablespace Consists of This Type of Data...

SYSTEM The data dictionary, including definitions of tables, views, 
and stored procedures needed by the Oracle8 database. 
Information in this area is maintained automatically. The 
SYSTEM tablespace is present in all Oracle8 databases.

USER_DATA Your application data. As you create and enter data into 
tables, you fill this space with your data.

TEMPORARY_DATA Temporary tables and/or indexes created during the 
processing of your SQL statement. You may need to expand 
this tablespace if you are executing a SQL statement that 
involves a lot of sorting, such as ANALYZE COMPUTE 
STATISTICS on a very large table, or the constructs GROUP 
BY, ORDER BY, or DISTINCT.

ROLLBACK_DATA Rolling back transactions that fail to complete normally. You 
may need to expand this tablespace if you have long-running 
or high-data-volume transactions.

Additional Information:  See the chapter “Tablespaces and 
Datafiles” of Oracle8 Server Concepts and the chapter “Managing 
Tablespaces” of the Oracle8 Administrator’s Guide.
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Data Files
Data files contain the contents of logical database structures such as tables and 
indexes. One or more data files form a logical unit of storage called a tablespace. A 
data file can be associated with only one tablespace, and only one database. The 
starter database contains the following four data files located in the 
ORACLE_HOME\DATABASE directory:   

Initialization Parameter File
The starter database contains one initialization parameter file located in the 
ORACLE_HOME\DATABASE directory:   

This Data File... Is Contained in the Tablespace...

SYS1SID.ORA SYSTEM

USR1SID.ORA USER_DATA

TMP1SID.ORA TEMPORARY_DATA

RBS1SID.ORA ROLLBACK_DATA

Additional Information: See the chapter “Tablespaces and 
Datafiles” of Oracle8 Server Concepts and the chapter “Managing 
Datafiles” of the Oracle8 Administrator’s Guide.

Initialization Parameter File Description

INITSID.ORA The parameter file INITSID.ORA must exist for an 
instance to start. A parameter file is a text file 
containing a list of instance configuration 
parameters. The starter database includes a file called 
INITSID.ORA that has preconfigured parameters. No 
edits are required to this file in order to use the 
starter database.

Additional Information: See Appendix B, “Initialization 
Parameters” of this guide. This appendix lists the Oracle8 database-
specific initialization parameters for Windows NT and their default 
values. See Oracle8 Reference for further information on 
initialization parameters.
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Redo Log Files
The starter database contains four redo log files located in the 
ORACLE_HOME\DATABASE directory, each 1 MB in size. In previous Oracle8 
releases, the starter database only contained two redo log files, each 200 KB in 
size:                

Control File
The starter database contains one control file located in the ORACLE_HOME\ 
DATABASE directory:     

Database Files Disk Size Description

LOG1SID.ORA

LOG2SID.ORA

LOG3SID.ORA

LOG4SID.ORA

1 MB

1 MB

1 MB

1 MB

Redo log files hold a record of all changes made to data 
in the database buffer cache. If an instance failure occurs, 
the redo log files are used to recover the modified data 
that was in memory. Redo log files are used in a cyclical 
fashion. For example, if four files constitute the online 
redo log, the first two files are filled, the second two files 
are filled, the first two files are re-used and filled, the 
second two files are re-used and filled, and so on. 

Additional Information: See the chapters “Managing the Online 
Redo Log” of the Oracle8 Administrator’s Guide and “Recovering a 
Database” of Oracle8 Backup and Recovery.

Control Files Description

CTL1SID.ORA A control file is an administrative file required to start 
and run the database. The control file records the 
physical structure of the database. For example, a control 
file contains the database name, and the names and 
locations of the database’s data files and redo log files. 
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Data Dictionary
The data dictionary is a protected collection of tables and views containing 
reference information about the database, its structures, and its users. The data 
stored in the dictionary includes:

■ Names of the Oracle8 database users

■ Privileges and roles granted to each user

■ Names and definitions of schema objects (including tables, views, snapshots, 
indexes, clusters, synonyms, sequences, procedures, functions, and packages) 

■ Integrity constraints

■ Space allocation for database objects

■ Auditing information, such as who accessed or updated various objects 

Note: Oracle Corporation recommends that you keep at least two 
control files (on separate physical drives) for each database and set 
the CONTROL_FILES initialization parameter to list each control 
file. See the chapter “Managing Control Files” of the Oracle8 
Administrator’s Guide for information on setting this initialization 
parameter value.

Additional Information: See the chapter “The Data Dictionary” of 
Oracle8 Server Concepts and “Static Data Dictionary Views” of 
Oracle8 Reference.
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6
Using Multiple Oracle Homes

This chapter describes how you work with multiple Oracle homes.

Specific topics discussed are:

■ Multiple Oracle Homes Overview

■ What Is Different About a Multiple Oracle Home Environment?

■ Which Products Are Multiple Oracle Home Enabled?

■ Working with Multiple Oracle Homes
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Multiple Oracle Homes Overview 

An Oracle home corresponds to the environment in which Oracle products run. 
This environment includes:

■ location of installed product files

■ PATH variable pointing to the products’ binary files

■ registry entries 

■ service names

■ program groups

Oracle homes also have a name, and a language associated with them. You specify 
the name, location, and language of an Oracle home at installation.

Releases of Oracle for Windows NT and Windows 95 prior to release 8.0.4 
supported single Oracle homes, allowing you to install and run Oracle products in 
a single Oracle home. Different versions of Oracle products could be installed in 

WARNING: If you quit Oracle installer after you have entered 
the name and location for an Oracle home (for example, you 
need to quit the installer because you have insufficient disk 
space in the location specified) you will not be able to specify a 
different location for that home until you identify and delete the 
HOMEID key and the IDx key that corresponds to that Oracle 
home from the registry. To do this:

1. Read the value of the ORACLE_HOME_NAME parameter 
for each HOMEID subkey in the 
HKEY_LOCAL_MACHINE\
SOFTWARE\ORACLE key until you find the value that 
matches the name of the Oracle home you want to delete. 

2. Delete the HOMEID subkey you have just identified. 

3. Delete the appropriate IDx subkey located in the 
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ALL_H
OMES key where x has the same value as the ID in 
HOMEID. For example, if the HOMEID subkey for the home 
name you want to delete is HOME1, then the appropriate 
IDx subkey is ID1.

For more information on the registry keys and subkeys, see 
Appendix C, “Configuration Parameters and the Registry”. 
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the same Oracle home provided they had different second-digit release numbers. 
For example, you could install version 7.2 products and version 7.3 products in the 
same Oracle home. However, you could not install multiple third-digit releases of 
the same products. For example, you could not install release 7.3.2 and release 7.3.3 
versions of the same Oracle products on the same machine; one installation would 
overwrite the other.

This release includes the new multiple Oracle homes feature, which enables you to 
install one or more releases of Oracle products on the same machine in multiple 
Oracle homes. For example, with multiple Oracle homes, you can install version 
8.0.3 products and 8.0.4 products in different Oracle homes on the same machine. 
You can still install different versions of Oracle products in the same Oracle home 
provided they have different second-digit release numbers.

Why Use Multiple Oracle Homes?
The main benefit of using multiple Oracle homes is that you can run multiple third-
digit versions of the same products concurrently. For example, you can test an 8.x.x 
database patch, before you run your production database 8.x.x against it.

When using third-party tools on your machine, if one tool is certified against 
release 8.x.1.x while another tool is certified against release 8.x.2.x, you may want 
to use the multiple Oracle homes feature so that you can install each third-party 
tool in a separate home.

When Should I Not Use Multiple Oracle Homes?
If you have previously installed release 8.0.x software and have no reason to keep 
the old version, overwrite the existing version by installing the 8.0.4 products in the 
home used for the previous release.

WARNING: Multiple Oracle homes functionality only works 
with release 8.0.4. If you have, for example, release 7.3.3 products 
already installed on your machine, you cannot install release 
7.3.4 products in a separate Oracle Home. However, you can 
install release 8.0.4 on a machine on which release 7.3.3 or 7.3.4 is 
installed and the version 7 release will be left intact.
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What Is Different About a Multiple Oracle Home Environment?
 If you decide to use multiple (versus single) Oracle homes, note these differences:

Which Products Are Multiple Oracle Home Enabled?
The products included on your CD-ROM are either:

■ Multiple Oracle Home Enabled

You can install products multiple times in multiple Oracle homes. Products are 
multiple Oracle home enabled unless they are listed in the “Multiple Oracle 
Home Compliant Products” or “Non-Multiple Oracle Home Products” sections 
below.

■ Multiple Oracle Home Compliant

You can install products into any Oracle home, but only once per machine. 
When installing any of these products, if other versions are detected on your 
machine, you are prompted to:

Element First Oracle Home Each Additional Oracle Home

Service Names OracleTNSListener80 Includes the Oracle home name in 
service names, for example:
OracleHOME_NAMETNSListener80

Program 
Groups

Oracle for Windows NT Appends the Oracle home name to the 
program group, for example: Oracle for 
Windows NT - HOME_NAME

Registry 
Entries

Located in 
HKEY_LOCAL_MACHINE\
SOFTWARE\ORACLE

Subkeys for each Oracle home added 
below the HKEY_LOCAL_MACHINE\
SOFTWARE\ORACLE subkey (HOME0, 
HOME1, HOME2, and so on). For more 
information on the registry keys and 
subkeys, see Appendix C, 
“Configuration Parameters and the 
Registry”.

SID for starter 
database

ORCL Only the first starter database on your 
machine is called ORCL. Additional 
starter databases use the naming 
convention ORCx or ORxx where x is a 
number appended to ensure the SID is 
unique



Which Products Are Multiple Oracle Home Enabled?

                                                                   Using Multiple Oracle Homes 6-5

■ continue installation without installing the product

■ quit the installation so that you can delete the existing version before 
proceeding to install the new version.

■ Non-Multiple Oracle Home

You can only install these products into an old-style Oracle home (pre-8.0.4 
Oracle home).

Multiple Oracle Home Compliant Products
■ Oracle Enterprise Manager

■ Oracle Enterprise Manager SDK

■ Oracle Enterprise Manager DB Admin Applications

■ Oracle Administrator Toolbar

■ Oracle Replication Manager

■ Oracle Web Server Manager

■ Oracle Biometrics Manager

■ Oracle Security Server Manager

■ Oracle File Packager

■ Oracle Intelligent Agent

■ Open Database Connectivity Driver (ODBC)

■ Oracle Objects for OLE

■ Oracle Migration Assistant for Microsoft Access

■ Oracle8 ConText Cartridge Workbench

■ Oracle Parallel Server

■ All products that are dependent on any of the products listed above

When installing groups of products, if any of the products listed above are 
included in the group and already exist on the machine, they will not be installed. 
You must first deinstall pre-existing copies of these products (which may break 
other applications) before you can install them in a different home.
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Non-Multiple Oracle Home Products
All Oracle release 8.0.3 products and all Oracle7 Products are non-multiple Oracle 
home products.

Working with Multiple Oracle Homes
Unless you specify otherwise at installation time, the Oracle home in which you 
installed products most recently is the first directory listed in your PATH (primary 
home). As such, it has priority over the other Oracle Home entries in your PATH. If 
you invoke a product, the version of the product invoked will be that stored in the 
Oracle Home listed first in your path, unless you specifically invoke a different 
version of the product by:

■ specifying the full pathname to the version of the product you want to use at 
the command line

■ navigating to the program group that contains the version you require

■ changing your PATH so that the first entry points to the binary files for the 
product version you want to use

Changing the Value of PATH
You can change the value of PATH:

■ using Oracle Home Selector.

■ at the system level. The new value you assign to PATH exists until you change 
the value of PATH again.

■ at the command line. The value of PATH reverts to its previous value when 
you quit the session.

To change the value of PATH using Oracle Home Selector:

Oracle Home Selector is a graphical user interface (GUI) that enables you to edit 
your environment path to make an appropriate Oracle home directory your 
primary home. This tool can only be used when you have multiple, active Oracle 
home directories on a single computer. 

1. Choose Start > Programs > Oracle for Windows NT - [HOME_NAME] > Oracle 
Home Selector.

The Oracle Home Selector window appears.

2. Select the Oracle home that you want to be the primary Oracle home from the 
drop-down list.
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To change the value of PATH at the system level:

On Windows NT:

1. Choose Start > Settings > Control Panel.

The Control Panel window appears.

2. Double-click the System icon.

The System Properties window appears.

3. Click the Environment tab.

The System Variables appear.

4. Edit the value of the PATH in the Systems Variables window and click OK to 
exit.

On Windows 95:

1. Open the AUTOEXEC.BAT file.

2. Edit the value of the PATH statement.

3. Reboot your machine

To change the value of PATH at the command line:

At the command prompt enter:

C:\> PATH PATHNAME;%PATH%

where PATHNAME is the full path to the binary files for the products you want to 
use. This change is valid for the current session only. If you want to change the 
value of your PATH more permanently, you should use the Oracle Home Selector 
or change the value of PATH at the system level. Both methods are described 
above.
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Migrating and Upgrading

This chapter describes the installation types you can choose when you have existing 
databases on your system. In particular, it describes how to migrate an Oracle7 
database or upgrade an earlier Oracle8 database release to the current release of 
Oracle8 Enterprise Edition. This chapter also includes information on migrating a 
Microsoft Access database to an Oracle8 database.

Specific topics discussed are:

■ Intended Audience

■ Installation Types When You Have Existing Databases

■ Database Coexistence and Multiple Oracle Homes Overview

■ Migrating and Upgrading Overview

■ Choosing an Installation Type

■ Oracle7 Client and Oracle8 Client/Server Configurations

■ Installing Two or More Databases Into the Same Oracle Home

■ Installing Databases Into Multiple Oracle Homes

■ Migrating an Oracle7 Database

■ Upgrading an Oracle8 Database

■ Migrating a Microsoft Access Database
ading 7-1



Database Coexistence and Multiple Oracle Homes Overview
Intended Audience
This chapter is necessary for anyone who has existing Oracle7 and Oracle8 
databases on their system and wants to install Oracle8 Enterprise Edition release 
8.0.4.

Installation Types When You Have Existing Databases
Consider the following installation types if you have existing Oracle7 database(s) 
and Oracle8 database(s) on your system and want to install Oracle8 Enterprise 
Edition(s) release 8.0.4.

■ Install release 8.0.4 in an Oracle home where an Oracle release 7.x database 
already exists (this procedure is known as database coexistence). Note that you 
cannot coexist Oracle release 8.0.4 and release 8.0.3 in the same Oracle home; 
the 8.0.4 installation overwrites the 8.0.3 installation.

■ Install release 8.0.4 in a different Oracle home on the same server (this 
procedure is known as using multiple Oracle homes).

■ Migrate release 7.x to release 8.0.4

■ Upgrade release 8.0.3 to release 8.0.4

All of these installation types are described in detail in this chapter.   

Database Coexistence and Multiple Oracle Homes Overview
Releases of Oracle for Windows NT and Windows 95 prior to release 8.0.4 
supported single Oracle homes, allowing you to install and run Oracle products in 
a single Oracle home. Different versions of Oracle products could be installed in 
the same Oracle home provided they had different second-digit release numbers. 
For example, you could install version 7.2 products and version 7.3 products in the 
same Oracle home (database coexistence). However, you could not install multiple 
third-digit releases of the same products. For example, you could not install release 
7.3.2 and release 7.3.3 versions of the same Oracle products on the same computer; 
one installation would over-write the other.

Additional Information: See Oracle8 Enterprise Edition Installation 
for Windows NT if you want to install Oracle8 Enterprise Edition on 
a system containing no existing databases.
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This release includes the new multiple Oracle homes feature, which enables you to 
install one or more releases of Oracle products on the same computer in multiple 
Oracle homes. For example, with multiple Oracle homes, you can install version 
8.0.3 products and 8.0.4 products in different Oracle homes on the same computer. 
You can still install different versions of Oracle products in the same Oracle home 
provided they have different second-digit release numbers. See Chapter 6, “Using 
Multiple Oracle Homes” for more information.

Migrating and Upgrading Overview
This section explains the difference between migrating and upgrading.

What is Migrating?
Migrating is the process of transforming one database version to a later database 
version. For example, transforming an Oracle7 database to an Oracle8 database is 
migrating the database system. The term migrating is also used in this manual to 
refer to the transformation of a Microsoft Access database to an Oracle8 database.

What is Upgrading?
Upgrading is the process of transforming one database release to another database 
release of the same database version. For example, transforming an Oracle8 database 
release 8.0.3 to an Oracle8 database release 8.0.4 is upgrading the database system.

Migrating and Upgrading Using Multiple Oracle Homes
You can easily migrate or upgrade databases across multiple Oracle homes. If you 
use the graphical user interface (GUI) Oracle Data Migration Assistant, all database 
instances on your system are displayed in a drop-down list. You select the Oracle 
database instance you want to migrate or upgrade and the assistant takes care of 
any multiple Oracle homes issues. 

If you use the command line tools, the Migration Utility (MIG80) to migrate, or the 
CAT8004.SQL script to upgrade, you need to copy files from one Oracle home 
directory to another. You also must ensure the PATH variable is set correctly so 
that any Oracle database tools you run are started from the correct Oracle home 
directory.
                                                                   Migrating and Upgrading 7-3



Choosing an Installation Type
Choosing an Installation Type
If you have an existing Oracle7 database(s) and Oracle8 database(s) on your system 
and want to install Oracle8 Enterprise Edition(s) release 8.0.4, you must decide to:

■ Install release 8.0.4 in an Oracle home where an Oracle release 7.x database 
already exists

■ Install release 8.0.4 in a different Oracle home on the same server

■ Migrate release 7.x to release 8.0.4

■ Upgrade release 8.0.3 to release 8.0.4

Consider the following database coexistence issues before you decide which of the 
above installation types is most suitable for your requirements:

■ Oracle7 Applications

■ Oracle7 Client Connections to Oracle8 Databases

■ Oracle8 Client Connections to Oracle7 Databases

Oracle7 Applications
Can all my Oracle7 applications run on an Oracle8 database?

Most Oracle7 applications can run on an Oracle8 database. Some applications 
cannot run on an Oracle8 database unless you upgrade them to versions which 
support Oracle8 databases. If you have a combination of Oracle7 and Oracle8 
applications, you may want to have an Oracle7 database and Oracle8 database 
coexist on the same system, until you have time to upgrade all your Oracle7 
applications to version 8. Contact your application vendor to check if your third-
party applications are supported with Oracle8 Enterprise Edition. 
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Choosing an Installation Type
Oracle7 Client Connections to Oracle8 Databases
As this figure illustrates, an Oracle7 client requires SQL*Net Client, and an Oracle 
server requires Net8 Server. When the client and server are on the same computer, 
both SQL*Net Client and Net8 Server are required. 

Consider the following questions for your own environment:

■ Can my third-party Oracle7 applications take advantage of Net8 features?

No. You must rebuild or upgrade applications to work with Net8 libraries.

■ Do my Oracle7 clients require Net8 Client to connect to a local Oracle8 database?

Yes. If the Oracle7 client needs to connect to a local Oracle8 database, you must 
have SQL*Net Client version 2.x, Net8 Client, and Net8 Server in the Oracle7 
client Oracle home. Note that Net8 Client and Net8 Server are already installed 
during the installation of Oracle8 Enterprise Edition. 

If you are using Oracle7 release 7.3.4 and SQL*Net release 2.3.4, you can 
connect to the Oracle8 database without specifying a service name. Oracle7 
client automatically uses the Bequeath Protocol Adapter when connecting to a 
local Oracle8 database.

If you are using Oracle7 release 7.3.3 (or lower) and SQL*Net release 2.3.3 (or 
lower), you need to create a service name using SQL*Net Easy Configuration 
or Oracle Network Manager in the SQL*Net Client version 2.x 
TNSNAMES.ORA file. Ensure you specify this service name in the connect 
string when connecting to the Oracle8 database. The Bequeath Protocol 
Adapter is not supported when connecting from an Oracle7 client (release 7.3.3 
or lower) to an Oracle8 database.

■ Do my Oracle7 clients require Net8 Client to connect to a remote Oracle8 database?

No. If an Oracle7 client needs to connect to a remote Oracle8 database, only 
SQL*Net Client version 2.x has to be configured on the Oracle7 client. Net8 is 
backward compatible with SQL*Net version 2.x. The only limitation is that the 
new network features available with Net8 are unavailable with this connection 
type.

Oracle8
Database

Oracle7 Client Application

   SQL*Net Client Net8 Server 

The Oracle7 Client and
Oracle8 database are on
the same (local) computer
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Choosing an Installation Type
Oracle8 Client Connections to Oracle7 Databases
An Oracle8 client requires Net8 Client, and an Oracle7 server requires SQL*Net 
Server. When the client and server are on the same computer, both Net8 Client and 
SQL*Net Server are required.

Consider the following questions for your own environment:

■ Do my Oracle8 clients require SQL*Net Client version 2.x to connect to a local 
Oracle7 database?

Yes. If the Oracle8 client needs to connect to a local Oracle7 database, you need 
to have both SQL*Net Server version 2.x and Net8 Client in the Oracle8 client 
Oracle home. Note that the Oracle8 client uses the Bequeath protocol adapter 
by default to connect to an Oracle7 database. 

■ Do my Oracle8 clients require SQL*Net Client version 2.x to connect to a remote 
Oracle7 database?

No. If an Oracle8 client needs to connect to a remote Oracle7 database, only Net8 
Client needs to be configured on the Oracle8 client. SQL*Net version 2.x is 
upward compatible with Net8. The only limitation is that the new network 
features available with Net8 are unavailable with this connection type.  

Oracle7
Database

Oracle8 Client Application

   Net8 Client SQL*Net Server 

The Net8 Client and
Oracle7 database are on
the same (local) computer
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Oracle7 Client and Oracle8 Client/Server Configurations
Oracle7 and Oracle8 clients can communicate either with Oracle7 or Oracle8 
databases. This functionality gives you maximum flexibility when designing 
your network and deciding when to:

■ Install Oracle7 and Oracle8 Databases in the Same Oracle Home

■ Install Oracle7 and Oracle8 Databases in Multiple Oracle Homes

■ Install Oracle7 and Oracle8 Databases on Separate Computers

■ Migrate an Oracle7 Database to an Oracle8 Database

■ Upgrade an Oracle8 Database to the Current Oracle8 Database Release

■ Migrate Oracle7 Clients to Oracle8

Install Oracle7 and Oracle8 Databases in the Same Oracle Home
Install Oracle7 and Oracle8 databases in the same Oracle home directory and have 
both Oracle7 and Net8 clients connecting to Oracle7 and Oracle8 databases. The 
figure below gives an example of this network configuration:

 

You can install different versions of Oracle databases in the same Oracle home 
provided they have different first or second-digit versions. For example, you can 
have release 7.2.x, 7.3.x, and 8.0.x databases in the same Oracle home. You cannot 
install multiple third-digit releases of the same products. For example, you cannot 
install release 7.3.2 and release 7.3.3, or release 8.0.3 and release 8.0.4 versions of the 
same Oracle databases in the same Oracle home; one installation overwrites the 
other.

Oracle8 clientOracle8 clientOracle7 client Oracle8 client

Oracle7
Database

Oracle8
Database

Three databases are in the
same Oracle home directory

on the same computer

Oracle7 client

Oracle7
Database

7.2.2 7.3.3 8.0.4
(Database Coexistence)
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Oracle7 Client and Oracle8 Client/Server Configurations
Ensure that each database instance has a unique SID. In particular, be careful that 
you do not use the default SID ORCL for subsequent installations if you already 
have a starter database with the SID ORCL installed. If you do so, the services of 
the later installation overwrite the services of the earlier installation. 

Install Oracle7 and Oracle8 Databases in Multiple Oracle Homes
Install Oracle7 and Oracle8 databases in multiple (different) Oracle homes and 
have both Oracle7 and Net8 clients connecting to Oracle7 and Oracle8 databases. 
Multiple Oracle homes functionality currently only works with release 8.0.4. If you have, 
for example, release 7.3.3 products already installed, you cannot install any other 
release 7.x products in a different Oracle home. Also, if you have release 8.0.3 
products already installed, you cannot install any other 8.0.3 products in a different 
Oracle home. The figure below gives an example of this network configuration:

  

Oracle8 clientOracle8 clientOracle7 client Oracle8 clientOracle7 client

Oracle7
Database

Oracle8
Database

8.0.47.3.3

Oracle8
Database

8.0.4

Three databases are in
three Oracle home directories

on the same computer

Old style
Oracle7 home directory

New style
Oracle8 home directories

(Multiple Oracle Homes)
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Oracle7 Client and Oracle8 Client/Server Configurations
Install Oracle7 and Oracle8 Databases on Separate Computers
Install Oracle7 and Oracle8 databases on separate computers and have both 
Oracle7 and Oracle8 clients connecting to both databases. The figure below shows 
two computers and a number of Oracle7 and Oracle8 clients. On each computer 
you can have a mix of databases and products in both single and multiple Oracle 
homes. 

   

Oracle8 clientOracle8 client Oracle8 clientOracle7 client Oracle7 client

Oracle7
Database

Oracle8
Database

Oracle7
Database

7.2.2 7.3.3 8.0.3

Oracle8
Database

Oracle8
Database

8.0.48.0.4

Oracle8
Database

8.0.4

Oracle7
Database

Oracle8
Database

Oracle7
Database

7.2.2 7.3.3 8.0.4

Oracle8
Database

Oracle8
Database

8.0.48.0.4

Oracle8
Database

8.0.4
Six databases are in

four Oracle home directories
on the same computer

New style Oracle8
home directories

Old style
Oracle7 home directory

New style Oracle8
home directories

Old style
Oracle7 home directory

Six databases are in
four Oracle home directories

on the same computer

(Database Coexistence)

(Database Coexistence)

(Multiple Oracle Homes) 

(Multiple Oracle Homes) 
                                                                   Migrating and Upgrading 7-9



Oracle7 Client and Oracle8 Client/Server Configurations
Migrate an Oracle7 Database to an Oracle8 Database
Migrate your Oracle7 database to an Oracle8 database and have both Oracle7 and 
Oracle8 clients connecting to the Oracle8 database. You can migrate your Oracle7 
database to an Oracle8 database either in the same Oracle home or in a different 
Oracle home. See “Migrating an Oracle7 Database” for instructions. The figure 
below illustrates this network configuration:

Oracle8 client Oracle8 client

Oracle7
Database

Migrate Oracle7 database
to an Oracle8 database

Oracle7 client Oracle7 client

Oracle8
Database

8.0.47.3.3

in a different Oracle home

Oracle7
Database

Migrate Oracle7 database
to an Oracle8 database

Oracle8
Database

8.0.47.3.3

in the same Oracle home
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Oracle7 Client and Oracle8 Client/Server Configurations
Upgrade an Oracle8 Database to the Current Oracle8 Database Release
Upgrade your Oracle8 database, for example, release 8.0.3, to release 8.0.4 and have 
both Oracle7 and Oracle8 clients connecting to the release 8.0.4 Oracle8 database. 
You can upgrade databases either in the same Oracle home or across different 
Oracle homes. See “Upgrading an Oracle8 Database” for instructions. The figure 
below illustrates this network configuration:

Oracle8 client Oracle8 client

Oracle8
Database

Upgrade Oracle8 database
to current Oracle8 database

Oracle7 client Oracle7 client

Oracle8
Database

8.0.48.0.3

release across different Oracle homes

Oracle8
Database

Upgrade Oracle8 database
to current Oracle8 database

Oracle8
Database

8.0.48.0.3

release in the same Oracle home
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Oracle7 Client and Oracle8 Client/Server Configurations
Migrate Oracle7 Clients to Oracle8
Migrate some or all of your Oracle7 clients to Oracle8 release 8.0.4 and migrate 
your Oracle7 database to an Oracle8 database or upgrade your Oracle8 database to 
the current Oracle8 release at a later date. See Net8 Getting Started for Windows NT 
and Windows 95 for instructions. The figure below illustrates this network 
configuration. 

    

Oracle8 client Oracle8 client

Migrate

Oracle7 client release 7.x Oracle7 client
to Oracle8 client

Oracle7 client

configured with

Oracle8
Database

8.0.3

Oracle7
Database

7.3.3

Net8 Client

release 8.0.4
SQL*Net Client version 2.x
configured with
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Installing Two or More Databases Into the Same Oracle Home
In the following example, an Oracle7 release 7.3.3 starter database named ORACLE 
with a SID of ORCL is already installed in C:\ORANT. Now, create an Oracle 
release 8.0.4 database named PROD with a SID of PROD in C:\ORANT.  

To install an Oracle8 database and Oracle7 database into the same Oracle home:

1. Ensure you have enough hard disk space and RAM for both databases. You 
need to add the system requirements for Oracle8 Enterprise Edition and 
Oracle7 Server to determine the total system requirements. See Oracle8 
Enterprise Edition Installation for Windows NT for system requirements.

2. Ensure all Oracle7 services are stopped. See “Managing Oracle Services” in 
Chapter 10, “Administering a Database” for information on how to stop 
services.

3. Install Oracle8 Enterprise Edition for Windows NT from the CD-ROM. See 
Oracle8 Enterprise Edition Installation for Windows NT for complete installation 
instructions.

The Oracle Installation Settings dialog box appears.

a. Do not enter a value in the Name: field of the Oracle Installation Settings 
dialog box.

b. Set the Oracle home directory location to the same directory where release 
7.3.3 is already installed. In this example, enter C:\ORANT in the Location: 
field of the Oracle Installation Settings dialog box. Click OK.

The Select Installation Settings dialog box appears.

4. Select Oracle8 Enterprise Edition from the Select Installation Options dialog box, 
then click OK. 

The Select Cartridges and Options dialog box appears.

5. Select the cartridges and options you are licensed to install, then click OK.

The Previous Version of Oracle Database Detected dialog box appears indicating 
that Oracle Installer has detected an earlier version of the database. You are 
asked if you want to migrate your Oracle7 database to release 8.0.4 using 
Oracle Data Migration Assistant.

6. Click No. If you click Yes, Oracle Data Migration Assistant is launched at the 
end of installation. Do not click Yes to run Oracle Data Migration Assistant while 
you are installing another database into the same Oracle home as an existing database.

The Select a Starter Database Configuration dialog box appears.

7. Select Custom Configuration (allows you to create a customized database).

8. Complete Oracle8 Enterprise Edition Installation. At the end of installation the 
Oracle Database Assistant is launched. 



Installing Two or More Databases Into the Same Oracle Home
The following Oracle Database Assistant window appears:

9. Respond to instructions in each Oracle Database Assistant window, and click 
Next when you are ready to continue to the next window. 

10. When the following Oracle Database Assistant window appears, you will 
notice that the Database Name and SID fields are automatically set to ORC1. 
Substitute PROD in both of these fields. Do not set the SID to ORCL as you will 
overwrite the Oracle7 release 7.3.3 starter database.

When you get to the last window, click Finish to start the creation of the PROD 
database. More documentation on this assistant is included with the Help. 
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Installing Databases Into Multiple Oracle Homes
In the following example, an Oracle7 release 7.3.3 starter database called ORACLE 
with a SID of ORCL is already installed in C:\ORANT. Now, install the Oracle 
release 8.0.4 starter database ORCL in a different Oracle home directory called 
C:\ORANTv8 with an Oracle home name of TESTv8.  

To install an Oracle8 database and Oracle7 database in multiple (different) 
Oracle homes:

1. Ensure you have enough hard disk space and RAM for both databases. You 
need to add the system requirements for Oracle8 Enterprise Edition and 
Oracle7 Server to determine the total system requirements. See Oracle8 
Enterprise Edition Installation for Windows NT for system requirements.

2. Ensure all Oracle7 services are stopped. See “Managing Oracle Services” in 
Chapter 10, “Administering a Database” for information on how to stop 
services.

3. Install Oracle8 Enterprise Edition for Windows NT from the CD-ROM. See 
Oracle8 Enterprise Edition Installation for Windows NT for complete installation 
instructions.

The Oracle Installation Settings dialog box appears.

a. Enter the name of the new Oracle home in the Name: field of the Oracle 
Installation Settings dialog box.In this example, enter TESTv8. 

b. Enter the location of the Oracle home directory where you want to install 
release 8.0.4. In this example, enter C:\ORANTv8 in the Location: field of 
the Oracle Installation Settings dialog box. Click OK.

The Select Installation Settings dialog box appears.

4. Select Oracle8 Enterprise Edition from the Select Installation Options dialog box, 
then click OK. 

The Select Cartridges and Options dialog box appears.

5. Select the cartridges and options you are licensed to install, then click OK.

The Select a Starter Database Configuration dialog box appears.

6. Select Typical Configuration (allows you to create a preconfigured starter database).

7. Complete Oracle8 Enterprise Edition installation.

During installation of the release 8.0.4 database, Oracle Installer detected the 
listener of the previously installed release 7.3.3 database. To avoid conflicts of 
listening addresses (for example, the Port number for TCP/IP), the new release 
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Migrating an Oracle7 Database
8.0.4 listener is not started and is set to Manual Startup mode. After installation 
is complete, modify the release 8.0.4 LISTENER.ORA file to resolve possible 
conflicts in listening addresses, and then start the listener. This is required to 
enable the release 8.0.4 database to accept connections from clients. See Net8 
Getting Started for Windows NT and Windows 95 for information on how to 
modify the LISTENER.ORA file.  

Migrating an Oracle7 Database
This section describes how to migrate an Oracle7 database to the current Oracle8 
database release. You can choose either of the following database tools to perform a 
migration:

■ Oracle Data Migration Assistant

■ Migration Utility (MIG80)

Oracle Corporation recommends that new users use Oracle Data Migration 
Assistant to migrate databases because it is the easiest method to perform a 
migration. If you want to perform a migration manually using command line tools, 
use the Migration Utility (MIG80).

Migration Networking Issues
If you perform a migration, the following networking issues may need to be 
resolved:

■ Migrating Oracle7 Clients

■ Using the Net8 Listener

■ Installing Appropriate Versions of SQL*Net

■ Editing the LISTENER.ORA File for Multiple Oracle Homes

Migrating Oracle7 Clients
Although Oracle7 clients using SQL*Net Client version 2.x can connect to Oracle8 
databases, they should be migrated to Oracle8 clients configured with Net8 when 
their applications are upgraded to version 8. Note that SQL*Net version 2.x can 
coexist with Net8 in the same Oracle home directory.
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Using the Net8 Listener
To use the Net8 listener, you may need to change your network configuration on 
either the SQL*Net version 2.x or Net8 configurations to prevent a conflict. For 
example, you may need to change:

■ Port numbers on a TCP/IP network so that they are unique

■ Service name on an SPX/IPX network

■ Pipe name on a Named Pipes network

You may also need to start the Net8 listener and change the status of the service to 
Automatic Startup, depending upon your network needs. If you make changes to 
the listener, you must make changes to client configuration files to reflect those 
listener changes.

SQL*Net version 2.x uses configuration files from 
ORACLE_HOME\NETWORK\ADMIN, while Net8 uses files from 
ORACLE_HOME\NET80\ADMIN by default. If you want SQL*Net version 2.x 
and Net8 to use configuration files from the same directory, you can set the registry 
variable TNS_ADMIN.

Installing Appropriate Versions of SQL*Net
When migrating from Oracle7 Server release 7.3.x to Oracle8 release 8.0.4, install 
the appropriate version of SQL*Net for the server before using Oracle Data 
Migration Assistant or the Migration Utility (MIG80). Migration will be 
unsuccessful if you do not install the appropriate versions of SQL*Net.
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Migrating an Oracle7 Database
Migrating from... Install...

Oracle7 release 7.3.2.x to Oracle8 SQL*Net version 2.3.2.1.4

SQL*Net version 2.3.2.1.12

Note:  If you do not have SQL*Net version 2.3.2.1.4 on your system, you 
must install it before installing SQL*Net version 2.3.2.1.12. SQL*Net 
version 2.3.2.1.4 is not available on the CD-ROM. To obtain it, you must 
contact Oracle Worldwide Customer Support. See “How to Contact Oracle 
Worldwide Customer Support” in the chapter “Contact Us!”.

Oracle7 release 7.3.3.x to Oracle8 SQL*Net version 2.3.3.0.3

To install SQL*Net version 2.3.2.1.12 or 2.3.3.0.3

1. Start Oracle Installer from the CD-ROM. See Oracle8 Enterprise Edition 
Installation for Windows NT for complete installation instructions.

2. Answer questions about language and Oracle home directory location.

3. Select Custom Installation. The Software Asset Manager window 
appears.

4. Click From...

5. Navigate to \PATCHES\SQLNET\232112 on the CD-ROM if you 
want to install SQL*Net version 2.3.2.1.12. Navigate to 
\PATCHES\SQLNET\23303 if you want to install SQL*Net version 
2.3.3.0.3.

6. Select SQL*Net Server 2.3.2.1.12 and SQL*Net Client 2.3.2.1.12 if you 
want to install SQL*Net version 2.3.2.1.12. Select SQL*Net Server 
2.3.3.0.3 and SQL*Net Client 2.3.3.0.3 if you want to install SQL*Net 
version 2.3.3.0.3.

7. Click Install.

A window appears showing the progress of the installation. After 
installation is complete, a message appears confirming the installation.

8. Click Exit to exit Oracle Installer.
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Editing the LISTENER.ORA File for Multiple Oracle Homes

Using Migration Utility (MIG80)  When you migrate from an Oracle7 database in one 
Oracle home to a release 8.0.4 Oracle8 database in a different Oracle home, the SID 
needs to be removed from the Oracle7 Oracle home’s LISTENER.ORA file and 
added to the release 8.0.4 Oracle home’s LISTENER.ORA file.

Using Oracle Data Migration Assistant  When you migrate from an Oracle7 database in 
one Oracle home to a release 8.0.4 Oracle8 database in a different Oracle home, 
Oracle Data Migration Assistant adds the appropriate SID value to the release 8.0.4 
Oracle home’s LISTENER.ORA file. However, the assistant does not remove the 
SID from the Oracle7 Oracle home’s LISTENER.ORA file. To prevent a conflict 
when you start the Oracle7 listener, remove the SID entry from the Oracle7 Oracle 
home’s LISTENER.ORA file.

Migrating Using Oracle Data Migration Assistant
Oracle Data Migration Assistant helps you migrate data from an Oracle7 database 
to an Oracle8 database. During installation of Oracle8 Enterprise Edition, you are 
prompted to migrate a database with this assistant if Oracle Installer detects that an 
earlier database release exists on your system. If you do not want to migrate a 
database during the installation process, you can choose install this assistant and 
use it later.     

Before you use this assistant, ensure the Oracle7 database to be migrated meets 
these requirements:

■ the database you want to migrate is at least release 7.1.3.3.6

■ the service for the database instance is present in the Services window of the 
Control Panel

■ SQL*Net Server version 2.x or later is installed
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To migrate a database using Oracle Data Migration Assistant:

1. Choose Start > Programs > Oracle for Windows NT - [HOME_NAME] > Oracle 
Data Migration Assistant.

The Oracle Data Migration Assistant welcome window appears: 

 

2. Respond to instructions in each Oracle Data Migration Assistant window, and 
click Next when you are ready to continue to the next window. When you get 
to the last window, click Finish to start the migration of the database. More 
documentation on this product is included with the Help.

Migrating Using Migration Utility (MIG80)
This section describes how to use the Migration Utility (MIG80) to migrate your 
Oracle7 database to an Oracle8 database. 

Before Using the Migration Utility (MIG80)
Complete the following steps before you use the Migration Utility (MIG80):

■ Read Chapter 1, “Migration Overview” and Chapter 2, “Preparing to Migrate” 
in Oracle8 Migration for background information.

■ Read “Prepare the Version7 Source Database for Migration” in Chapter 3 
“Migrating Using the Migration Utility” of Oracle8 Migration for information on 
other tasks you may need to perform before using the Migration Utility 
(MIG80).
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■ Check that your Oracle7 Server release can be directly migrated to Oracle8 
Enterprise Edition. MIG80 only migrates databases that are Oracle7, release 7.1 
or later (at least patch release 7.1.3.3.6). If the database is an earlier version (for 
example, version 6), migrate it to at least Oracle7 release 7.1.3.3.6 before 
migrating it to an Oracle8 database.

■ Log on to your Windows NT server as a member of the Administrators group.

■ Check the character set of your Oracle7 database, and compare it with the 
character set in the NLS_LANG environment variable, or in the registry (if the 
character set does not exist as an environment variable). If the character sets are 
identical, then you can proceed to run MIG80.

If the character sets are different, before you run MIG80, you must set the 
NLS_LANG environment variable as follows:

AMERICAN_AMERICA.database character set

where database character set should be substituted with the character set of your 
Oracle7 database. For example, if the character set of your Oracle7 database is 
JA16EUC, set the NLS_LANG environment variable as follows: 

C:\> SET NLS_LANG=AMERICAN_AMERICA.JA16EUC 

Messages output from MIG80 will now be in English. After MIG80 finishes, 
reset the NLS_LANG environment variable to its original value.

■ Determine the appropriate version of SQL*DBA or Server Manager for the 
release of Oracle7 Server you are migrating: 

To migrate an Oracle7 database using MIG80:

Step 1: Shut Down the Oracle7 Database

Step 2: Back Up the Oracle7 Database

Step 3: Prepare the Oracle7 Database for Migration

Step 4: Install Oracle8 Enterprise Edition

Step 5: Run the Migration Utility (MIG80)

Step 6: Create Oracle8 Services and Database Files

Step 7: Remove Oracle7 Software (Optional)

Use... When Migrating From...

SQLDBA71 Oracle7 release 7.1.x

SQLDBA72 Oracle7 release 7.2.x

SVRMGR23 Oracle7 release 7.3.x
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Step 1: Shut Down the Oracle7 Database
1. Start SQL*DBA or Server Manager:    

2. Connect to the Oracle7 database as INTERNAL, where PASSWORD is the 
password of the database you want to migrate. Note that ORACLE is the 
default password for INTERNAL.    

The message Connected. appears if you successfully connected to the database.

3. Shut down the database. Do not use SHUTDOWN IMMEDIATE or 
SHUTDOWN ABORT. If the database is not shut down before you start the 
migration, MIG80 stops and issues an error message. Also, if the database was 
not cleanly shutdown, any backup you make may be useless as it was taken 
while data was being written to the data files.    

1 For Oracle7 release 7.1 only, edit the INITSID.ORA file and set the 
REMOTE_LOGIN_PASSWORDFILE parameter to EXCLUSIVE or SHARED.

Using... Enter at the MS-DOS Command Prompt...

Oracle7 release 7.1.x C:\> SQLDBA71 MODE=LINE

Oracle7 release 7.2.x C:\> SQLDBA72 MODE=LINE

Oracle7 release 7.3.x C:\> SVRMGR23

Using... Enter at the SQLDBA or SVRMGR Command Prompt...

Oracle7 release 7.1.x1 SQLDBA> CONNECT INTERNAL/PASSWORD

SQLDBA> ALTER USER SYS DEFAULT TABLESPACE SYSTEM 
TEMPORARY TABLESPACE SYSTEM;

SQLDBA> ALTER TABLESPACE SYSTEM ADD DATAFILE 
‘ ORACLE_HOME\RDBMS71\SYS2SID.ORA’ SIZE 50 M;

Oracle7 release 7.2.x SQLDBA> CONNECT INTERNAL/PASSWORD

Oracle7 release 7.3.x SVRMGR> CONNECT INTERNAL/PASSWORD

Using... Enter at the SQLDBA or SVRMGR Command Prompt...

Oracle7 release 7.1.x SQLDBA> SHUTDOWN

Oracle7 release 7.2.x SQLDBA> SHUTDOWN

Oracle7 release 7.3.x SVRMGR> SHUTDOWN
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Step 2: Back Up the Oracle7 Database
1. Back up the entire Oracle home directory and all its subdirectories.      

Ensure the database was cleanly shutdown before you back up. Ensure you 
back up the database files in the following list (and any other database files you 
may have created). Also, back up any scripts you may have created.   

To obtain the list of database files you must back up:

a. Create a spool file called V7DBFILES.LOG:   

b. Enter the following commands at the SQL*DBA or Server Manager prompt 
where the WHERE clause equals control_files, DB_FILES, or LOG_FILES. 
Note that control_files must be lowercase. The list of database files is 
output to V7DBFILES.LOG.     

WARNING: If anything goes wrong with the Oracle7 database 
during migration, you will need to restore the database from the 
backup. Back up your database now as a precaution!

■ Data files SYS1SID.ORA, USR1SID.ORA, RBS1SID.ORA, 
TMP1SID.ORA

■ Initialization parameter file INITSID.ORA

■ Redo log files LOG1SID.ORA, LOG2SID.ORA, 
LOG3SID.ORA, LOG4SID.ORA

(the last two redo log files are only available for 
Oracle release 7.3.4)

■ Control files CTL1SID.ORA and CTL2SID.ORA

Using... Enter at the SQLDBA or SVRMGR Command Prompt...

Oracle7 release 7.1.x SQLDBA> SPOOL V7DBFILES.LOG

Oracle7 release 7.2.x SQLDBA> SPOOL V7DBFILES.LOG

Oracle7 release 7.3.x SVRMGR> SPOOL V7DBFILES.LOG
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c. Turn off the SPOOL command:

See Chapter 13, “Backing Up and Recovering Database Files”, Oracle8 Concepts, 
Oracle8 Backup and Recovery, and Oracle8 Administrator’s Guide for information 
on how to back up a database.

Using... Enter at the SQLDBA or SVRMGR Command Prompt...

Oracle7 release 7.1.x SQLDBA> SELECT MEMBER FROM V$LOGFILE;
SQLDBA> SELECT NAME FROM V$DATAFILE;
SQLDBA> SELECT VALUE FROM V$PARAMETER WHERE NAME = 
’control_files’;

Oracle7 release 7.2.x SQLDBA> SELECT MEMBER FROM V$LOGFILE;
SQLDBA> SELECT NAME FROM V$DATAFILE;
SQLDBA> SELECT VALUE FROM V$PARAMETER WHERE NAME = 
’control_files’;

Oracle7 release 7.3.x SVRMGR> SELECT MEMBER FROM V$LOGFILE;
SVRMGR> SELECT NAME FROM V$DATAFILE;
SVRMGR> SELECT VALUE FROM V$PARAMETER WHERE NAME = 
’control_files’; 

Using... Enter at the SQLDBA or SVRMGR Command Prompt...

Oracle7 release 7.1.x SQLDBA> SPOOL OFF

Oracle7 release 7.2.x SQLDBA> SPOOL OFF

Oracle7 release 7.3.x SVRMGR> SPOOL OFF
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Step 3: Prepare the Oracle7 Database for Migration
You must perform the following tasks to prepare the Oracle7 database for 
migration.

1. Remove all obsolete parameters from the Oracle7 INITSID.ORA file. Obsolete 
parameters can cause errors if used with an Oracle8 database. 

Release 7.x Parameters Obsolete in Release 8.0.4

CCF_IO_SIZE

CHECKPOINT_PROCESS 

GC_DB_LOCKS 

GC_FREELIST_GROUPS 

GC_ROLLBACK_SEGMENTS 

GC_SAVE_ROLLBACK_LOCKS 

GC_SEGMENTS 

GC_TABLESPACES 

IO_TIMEOUT 

INIT_SQL_FILES 

IPQ_ADDRESS 

IPQ_NET 

LM_DOMAINS 

LM_NON_FAULT_TOLERANT 

OPTIMIZER_PARALLEL_PASS 

PARALLEL_DEFAUILT_MAX_SCANS 

PARALLEL_DEFAULT_SCAN_SIZE 

SEQUENCE_CACHE_HASH_BUCKETS 

SERIALIZABLE 

SESSION_CACHED_CURSORS 

UNLIMITED_ROLLBACK_SEGMENTS 

USE_IPQ 

USE_READV 

USE_SIGIO 

V733PLANS_ENABLED
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2. Change any Oracle7 parameter names that have been renamed in Oracle8 
Enterprise Edition:  

See Appendix A “Version 8 INIT.ORA Changes” in Oracle8 Migration for other 
changes you may need to make to the initialization parameter file.

3. Change the names of any Oracle7 database objects (for example, tables and 
columns) that use names that are key words or reserved words for Oracle8 
Enterprise Edition. The key words and reserved words new to Oracle8 
Enterprise Edition are listed in the following table: 

Change Oracle7 Parameter Name...  To Release 8.0.4 Parameter Name...

ASYNC_READ ASYNC_READ

ASYNC_WRITE  DISK_ASYNCH_IO  

DB_FILE_STANDBY_NAME_CONVERT  DB_FILE_NAME_CONVERT

DB_WRITERS DBWR_IO_SLAVES

LOG_FILE_STANDBY_NAME_CONVERT  LOG_FILE_NAME_CONVERT  

SNAPSHOT_REFRESH_INTERVAL  JOB_QUEUE_INTERVAL  

SNAPSHOT_REFRESH_PROCESSES  JOB_QUEUE_PROCESSES  

USE_ASYNC_IO  DISK_ASYNCH_IO  

ACCOUNT ARRAY BFILE BLOB CAST 

CFILE CHAR_CS CHUNK CLOB CLONE

DANGLING DATAOBJNO DEFERRABLE    DEFERRED DEREF 

DIRECTORY ENFORCE EXCHANGE EXPIRE EXTENT

FLOB GLOBALLY HASH HASHKEYS HEAP

IDGENERATORS INITIALLY LIBRARY LOCKED LOGGING

LOGICAL_READS_
PER_CALL 

LOGICAL_READS_
PER_SESSION 

MASTER NATIONAL NCHAR

NCHAR_CS NCLOB NESTED NOLOGGING NOPARALLEL

NOREVERSE NORMAL NVARCHAR2 OBJECT OBJNO_REUSE 

OID OIDINDEX ORGANIZATION OVERFLOW PASSWORD

PCTTHRESHOLD PCTVERSION PRESERVE PURGE QUEUE
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Step 4: Install Oracle8 Enterprise Edition
1. Ensure all Oracle7 services are stopped. See “Managing Oracle Services” in 

Chapter 10, “Administering a Database” for information on how to stop 
services.

2. Insert the Oracle8 Enterprise Edition CD-ROM into the mapped CD-ROM 
drive and install Oracle8 Enterprise Edition. See Oracle8 Enterprise Edition 
Installation for Windows NT for complete installation instructions.

When the Oracle Installation Settings dialog box appears:   

The Select Installation Options dialog box appears.

3. Select Oracle8 Enterprise Edition, then click OK. 

The Select Cartridges and Options dialog box appears.

4. Select the cartridges and options you are licensed to install, then click OK.

The Previous Version of Oracle Database dialog box appears indicating that 
Oracle Installer has detected an earlier version of the database. You are asked if 
you want to migrate your Oracle7 database to release 8.0.4 using Oracle Data 
Migration Assistant.

REF REPLACE RETURN RRETURNING REVERSE

SCOPE SEG_BLOCK SEG_FILE SKIP SYS_OP_NTCIMG 

THAN THE TOPLEVEL UNLOCK USAGE

VALUE VARYING

Using... Do the Following...

One Oracle home 
directory

Accept the default Oracle Home Name, DEFAULT_HOME in 
the Name: field.

Ensure the same directory where the Oracle7 database to be 
migrated is already installed is entered in the Location: field.

Two or more Oracle 
home directories

Enter the name you want to use for the additional Oracle 
home directory in the Name: field.

Enter another directory location where you want to put 
Oracle8 Enterprise Edition release 8.0.4 in the Location: field.
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5. Click No. If you click Yes, Oracle Data Migration Assistant is launched at the 
end of installation. Do not click Yes to run Oracle Data Migration Assistant while 
you are performing a manual migration using MIG80.

The Select a Starter Database Configuration dialog box appears.

6. Choose None when prompted to install a database in the Starter Database 
Installation Options dialog box.

7. After installation is complete, copy the release 7.x INITSID.ORA file to the 
correct location:

■ If you installed Oracle8 Enterprise Edition into the default Oracle home 
where Oracle7 release 7.x is already located: 

■ If you installed Oracle8 Enterprise Edition into another Oracle home:         

Using... Copy...

Oracle7 release 7.1.x INITSID.ORA file from ORACLE_HOME\RDBMS71 to 
ORACLE_HOME\DATABASE

Oracle7 release 7.2.x Not required because the release 7.2.x initialization parameter 
file is already located in ORACLE_HOME\DATABASE

Oracle7 release 7.3.x Not required because the release 7.3.x initialization parameter 
file is already located in ORACLE_HOME\DATABASE

Using... Copy...

Oracle7 release 7.1.x INITSID.ORA file from the release 7.1.x 
ORACLE_HOME\RDBMS71 directory to the release 8.0.4 
ORACLE_HOME\DATABASE directory

Oracle7 release 7.2.x INITSID.ORA file from the release 7.2.x 
ORACLE_HOME\DATABASE directory to the release 8.0.4 
ORACLE_HOME\DATABASE directory

Oracle7 release 7.3.x INITSID.ORA file from the release 7.3.x 
ORACLE_HOME\DATABASE directory to the release 8.0.4 
ORACLE_HOME\DATABASE directory
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8. Shut down and restart the computer if you have installed Oracle8 Enterprise 
Edition into another Oracle home. If you have installed Oracle8 Enterprise Edition 
into the same Oracle home as Oracle7 release 7.x, there is no need to do this.

Step 5: Run the Migration Utility (MIG80) 
The Migration Utility (MIG80) was installed as part of Oracle8 Utilities when you 
installed Oracle8 Enterprise Edition in “Step 4: Install Oracle8 Enterprise Edition”.

1. Ensure that you have DBA privileges, which are necessary to run MIG80.

2. Ensure that no other DBA (connected as INTERNAL or SYS) with 
RESTRICTED SESSION privilege connects to the database while MIG80 is 
running. Normal users cannot connect to the database during this phase.   

3. Do not start the Oracle7 database. MIG80 starts the Oracle7 database as part of its 
processing.

4. Start the Oracle7 service OracleServiceSID at the MS-DOS command prompt:

C:\> NET START OracleServiceSID

5. Set ORACLE_SID to the SID of the database you want to migrate. For example, 
if the database you want to migrate is the starter database SID ORCL, enter the 
following at the MS-DOS command prompt. Note there are no spaces around 
the equal sign (=) character.

C:\> SET ORACLE_SID=ORCL

Note: MIG80 will not be able to connect to the Oracle7 database if 
SQL*Net version 2.x is not installed in the Oracle home directory. You 
will receive the error ORA-12203: TNS: Unable to connect to destination, 
if this is the case. If this product is not installed, install it from the 
Oracle8 Enterprise Edition CD-ROM. See “Installing Appropriate 
Versions of SQL*Net” in this chapter for more information.
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6. Run MIG80: 

■ If you installed Oracle8 Enterprise Edition into the default Oracle home 
where Oracle7 release 7.x is already installed: 

■ If you installed Oracle8 Enterprise Edition into another Oracle home:         

This command creates the MIGSID.ORA file which is required in a later step to 
create Oracle8 Enterprise Edition control files.

You can specify MIG80 HELP=YES at the MS-DOS command prompt for a 
complete list of parameters that can be included with the MIG80 command.

The prompt Oracle7 Password: appears.

7. Enter the password for Oracle7 Password. This is the same password as the 
INTERNAL password for the Oracle7 database.

MIG80 runs and displays the operations being performed. MIG80 can take 
considerable time to run. Please wait until it has finished running.

8. Stop the Oracle7 service at the MS-DOS command prompt when MIG80 has 
completed successfully:

C:\> NET STOP OracleServiceSID

Using... Enter at the MS-DOS Command Prompt...

Oracle7 release 7.1.x C:\> MIG80 PFILE=ORACLE_HOME\RDBMS71\INITSID.ORA 
where ORACLE_HOME is the Oracle7 release 7.1.x Oracle 
home directory.

Oracle7 release 7.2.x C:\> MIG80

Oracle7 release 7.3.x C:\> MIG80

Using... Enter at the MS-DOS Command Prompt...

Oracle7 release 7.1.x C:\> MIG80 PFILE=ORACLE_HOME\RDBMS71\INITSID.ORA 
where ORACLE_HOME is the Oracle7 release 7.1.x Oracle 
home directory.

Oracle7 release 7.2.x C:\> MIG80 PFILE=ORACLE_HOME\DATABASE\INITSID.ORA 
where ORACLE_HOME is the Oracle7 release 7.2.x Oracle 
home directory.

Oracle7 release 7.3.x C:\> MIG80 PFILE=ORACLE_HOME\DATABASE\INITSID.ORA 
where ORACLE_HOME is the Oracle7 release 7.3.x Oracle 
home directory.
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9. Delete the Oracle7 services at the MS-DOS command prompt:    

Step 6: Create Oracle8 Services and Database Files
1. Create the Oracle8 database service at the MS-DOS command prompt:

C:\> ORADIM80 -NEW -STARTMODE AUTO -PFILE ORACLE_HOME\DATABASE\INITSID.ORA  
-SID SID -INTPWD PASSWORD -MAXUSERS USERS -STARTTYPE SRVC

where:

2. Delete the control files from the release 7.x ORACLE_HOME\DATABASE 
directory. Check the file V7DBFILES.LOG that you created in “Step 2: Back Up 
the Oracle7 Database” for the complete list and location of control files you 
must delete. You will recreate them later using the 
ALTER DATABASE CONVERT statement in Step 7.

To delete the control files: 

C:\ORACLE_HOME\DATABASE> DEL CTL1SID.ORA
C:\ORACLE_HOME\DATABASE> DEL CTL2SID.ORA

Using... Enter at the MS-DOS Command Prompt...

Oracle7 release 7.1.x C:\> ORADIM71 -DELETE -SID SID

Oracle7 release 7.2.x C:\> ORADIM72 -DELETE -SID SID

Oracle7 release 7.3.x C:\> ORADIM73 -DELETE -SID SID

Note: If you need to return to the Oracle7 database after MIG80 
has run please restore the Oracle7 database from the backup you 
made in “Step 2: Back Up the Oracle7 Database”.

■ ORACLE_HOME is the release 8.0.4 Oracle home directory. Ensure 
you specify the full pathname with the -PFILE 
option, including drive letter of the Oracle home 
directory.

■ SID is the release 8.0.4 SID.

■ PASSWORD is the password for the new release 8.0.4 database 
instance.

■ USERS is the maximum number of users who can be 
granted SYSDBA and SYSOPER privileges.
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3. Before starting Server Manager:

a. Ensure all release 7.x data files and log files are accessible and in the correct 
directories.

b. Ensure all release 7.x control files are deleted.

c. Change any parameters that point to RDBMS71, RDBMS72, or RDBMS73 to 
point to RDBMS80 in the release 7.x INITSID.ORA file.

d. Ensure the COMPATIBLE parameter is set to 8.0.0.0.0 in the release 7.x 
INITSID.ORA file.

If you use the default setting (8.0.0.0.0), you will not be able to use new 
features of release 8.0.4 such as Propagation in Advanced Queuing (AQ) 
and Improved SCN Generation. To use these new release 8.0.4 features, set 
the COMPATIBLE parameter to the following: 

COMPATIBLE=8.0.4.0.0

See Appendix C “Version 8 INIT.ORA Changes” of Oracle8 Migration for 
more information on COMPATIBLE parameter values.

4. Start the Oracle8 Enterprise Edition version of Server Manager at the MS-DOS 
command prompt:

C:\> SVRMGR30

5. Connect to the Oracle8 instance as INTERNAL:

SVRMGR> CONNECT INTERNAL/PASSWORD

6. Start an Oracle8 instance without mounting the new Oracle8 database:

SVRMGR> STARTUP NOMOUNT 

7. Create new Oracle8 Enterprise Edition control files:

SVRMGR> ALTER DATABASE CONVERT; 

All data files that are online are converted to Oracle8 Enterprise Edition format, 
and new control files are built. This command uses the MIGSID.ORA file 
which was created earlier when you ran the Migration Utility (MIG80).    

WARNING: Starting in any other mode will corrupt the database!
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8. Open the Oracle8 database: 

SVRMGR> ALTER DATABASE OPEN RESETLOGS; 

All rollback segments that are online when the Oracle8 database is opened are 
also opened and converted to the Oracle8 database format. 

9. Create a spool file called CATOUT.LOG by entering the following at the Server 
manager prompt:

SVRMGR> SPOOL CATOUT.LOG

10. Run the following scripts:

Note: Successful execution of this command is the point of no 
return to Oracle7. If you need to return to the Oracle7 database, 
please restore it from the backup you made in “Step 2: Back Up the 
Oracle7 Database”. If an error occurs during this step, you must 
correct the condition(s) that caused the error(s). See Oracle8 
Migration and run the migration again by restarting at Step 1. of 
“Step 5: Run the Migration Utility (MIG80)”.

Script Required by... Enter at the Server Manager Prompt...

CAT8000.SQL All databases SVRMGR> @%ORACLE_HOME%\RDBMS80\ADMIN\CAT8000.SQL

where %ORACLE_HOME% represents your drive letter and release 
8.0.4 Oracle home directory. This script can take over thirty minutes 
to run depending on the size of your database. Check 
CATOUT.LOG to verify that the operation was successful.

CAT8000.SQL creates and alters certain system tables and drops the 
MIGRATE user. Objects in the MIGRATE user’s schema are not 
needed after the conversion is complete. You can also delete the 
binary file (%ORACLE_HOME%\RDBMS80\CONVERT.ORA) that 
is used as part of the conversion process. 

CAT8000.SQL also runs the CATALOG.SQL and CATPROC.SQL 
scripts, which create the system catalog views and all the necessary 
packages for using PL/SQL. 

PUPBLD.SQL All databases SVRMGR> @%ORACLE_HOME%\DBS\PUPBLD.SQL

where %ORACLE_HOME% represents your drive letter and release 
8.0.4 Oracle home directory. This script creates the USER PROFILE 
table.
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Oracle Corporation supplies other scripts with Oracle8 Enterprise Edition that 
create additional structures you can use in managing your database and 
creating database applications. See Oracle8 Reference for a complete list and 
descriptions of available scripts.

11. Turn off the SPOOL command:

SVRMGR> SPOOL OFF

12. Check the spool file CATOUT.LOG and verify that the scripts you ran 
compiled every package and procedure successfully. Correct any problems you 
find in this file.

13. Shut down the Oracle8 database in NORMAL mode. Do not use SHUTDOWN 
IMMEDIATE or SHUTDOWN ABORT. Note that NORMAL is the default 
parameter.

SVRMGR> SHUTDOWN NORMAL   

Performing a clean database shutdown flushes all caches, clears buffers, and 
performs other Object Relational Database Management System (ORDBMS) 
housekeeping activities. These measures are an important final step to ensure 
the integrity and consistency of the newly migrated release 8.0.4 database.

14. Back up the Oracle8 database. See Chapter 13, “Backing Up and Recovering 
Database Files” for a list of tools to back up the database.

The Oracle7 database has now been migrated to the Oracle8 database and is 
ready for use. 

CATREP8M.SQL Advanced 
Replication. Run 
this script only if 
you have 
Advanced 
Replication and 
want to use it. 

SVRMGR> @%ORACLE_HOME%\RDBMS80\ADMIN\CATREP8M.SQL

where %ORACLE_HOME% represents your drive letter and release 
8.0.4 Oracle home directory. The CATREP8M.SQL script 
automatically runs the CATREP.SQL script. CATREP8M.SQL takes 
over an hour to run.

CATPARR.SQL Oracle Parallel 
Server. Run this 
script only if you 
have Oracle 
Parallel Server 
and want to use it. 

SVRMGR> @%ORACLE_HOME%\RDBMS80\ADMIN\CATPARR.SQL

where %ORACLE_HOME% represents your drive letter and release 
8.0.4 Oracle home directory. 

Script Required by... Enter at the Server Manager Prompt...
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Step 7: Remove Oracle7 Software (Optional)
You can remove Oracle7 software if you have successfully migrated to Oracle8 
Enterprise Edition and have a backup of the Oracle7 software. Oracle Installer 
warns you of any product dependencies that might cause problems if particular 
products are removed, and prompts you to confirm the de-installation.

To remove Oracle7 software:

1. Stop all Oracle services. For information on how to stop Oracle services, see 
“Managing Oracle Services” in Chapter 10, “Administering a Database”.

2. Choose Start > Programs > Oracle for Window NT - [HOME_NAME] > Oracle 
Installer to start Oracle Installer.

The Software Asset Manager window appears.

3. Select the Oracle7 product(s) you want to remove from the Installed Products 
window of the Software Asset Manager window.

4. Click Remove.

Note: After a migration, all objects have the status INVALID, 
which is the correct status at this time. To check the status of 
objects, enter the following at the Server Manager prompt.

SVRMGR> SELECT * FROM ALL_OBJECTS WHERE STATUS = ‘INVALID’;
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Upgrading an Oracle8 Database
This section describes how to upgrade an Oracle8 database release 8.0.3 to release 
8.0.4. You can choose either of the following database tools to upgrade:

■ Oracle Data Migration Assistant

■ CAT8004.SQL script

Oracle Corporation recommends that new users use Oracle Data Migration 
Assistant to upgrade databases because it is the easiest and quickest method to 
perform an upgrade. If you already have upgrade scripts from a previous Oracle 
database release, you may want to edit them to include the CAT8004.SQL script.

Upgrading Using Oracle Data Migration Assistant
Oracle Data Migration Assistant helps you upgrade data from an Oracle8 database 
release 8.0.3 to release 8.0.4. During installation of Oracle8 Enterprise Edition, you 
are prompted to upgrade a database with this assistant if Oracle Installer detects 
that a release 8.0.3.0.0 database exists on your system. If you do not want to 
upgrade during the installation process, you can choose to install this assistant and 
use it later. Although you are upgrading, the assistant text refers to this process as 
migrating.    

Before you use this assistant, ensure the Oracle8 database to be migrated meets 
these requirements:

■ the database you want to upgrade is at least release 8.0.3.0.0 

■ the service for the database instance is present in the Services window of the 
Control Panel

■ SQL*Net Server version 2.x or later is installed

Note: Oracle Data Migration Assistant does not upgrade Oracle8 
release 8.0.1 and 8.0.2 Beta releases to release 8.0.4. If you need to 
upgrade these Beta releases, see the README.DOC file in the 
ORACLE_HOME\RDBMS80 directory.
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To upgrade a database using Oracle Data Migration Assistant:

1. Choose Start > Programs > Oracle for Windows NT - [HOME_NAME] > Oracle 
Data Migration Assistant. 

The Oracle Data Migration Assistant welcome window appears: 

 

2. Respond to instructions in each Oracle Data Migration Assistant window, then 
click Next when you are ready to continue to the next window. When you get 
to the last window, click Finish to start the upgrade of the database. More 
documentation on this product is included with the Help.
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Upgrading Using CAT8004.SQL Script
You can run SQL scripts in Server Manager to upgrade an Oracle8 database release 
8.0.3 to release 8.0.4. 

Before Using CAT8004.SQL to Upgrade
Read Chapter 8, “Upgrading and Downgrading” in Oracle8 Migration for 
background information.

Upgrading consists of the following tasks:

Step 1: Shut Down the Release 8.0.3 Database

Step 2: Back Up the Release 8.0.3 Database

Step 3: Edit the COMPATIBLE Parameter in the Release 8.0.3 INITSID.ORA File

Step 4: Install Oracle8 Enterprise Edition Release 8.0.4

Step 5: Run the CAT8004.SQL Script

Step 1: Shut Down the Release 8.0.3 Database
1. Start Server Manager at the MS-DOS command prompt: 

C:\> SVRMGR30

2. Connect to the release 8.0.3 database as INTERNAL, where PASSWORD is the 
password of the database you want to migrate. Note that ORACLE is the 
default password for INTERNAL. 

The message Connected. appears if you successfully connected to the database.

3. Shut down the database. Do not use SHUTDOWN IMMEDIATE or 
SHUTDOWN ABORT. If the database was not cleanly shutdown, any backup 
you make may be useless as it was taken while data was being written to the 
data files. Enter the following at the Server Manager prompt:

SVRMGR> SHUTDOWN    
7-38 Oracle8 Enterprise Edition Getting Started                                                   



Upgrading an Oracle8 Database
Step 2: Back Up the Release 8.0.3 Database
1. Back up the entire Oracle home directory and all of its subdirectories.      

Ensure the database is cleanly shutdown before you back up. Ensure you back 
up the database files in the following list (and any other database files you may 
have created). Also, back up any scripts you may have created.    

To obtain the list of database files you must back up:

a. Create a spool file called V8DBFILES.LOG. Enter the following at the 
Server Manager prompt:

SVRMGR> SPOOL V8DBFILES.LOG

b. Enter the following commands at the Server Manager prompt, where the 
WHERE clause equals control_files, DB_FILES, or LOG_FILES. Note that 
control_files must be lowercase. The list of database files is output to 
V8DBFILES.LOG. 

c. Enter the following commands at the Server Manager prompt: 

SVRMGR> SELECT MEMBER FROM V$LOGFILE;
SVRMGR> SELECT NAME FROM V$DATAFILE;
SVRMGR> SELECT VALUE FROM V$PARAMETER WHERE NAME = ’control_files’;    

d. Turn off the SPOOL command:  

SVRMGR> SPOOL OFF

See Chapter 13, “Backing Up and Recovering Database Files”, Oracle8 Concepts, 
Oracle8 Backup and Recovery, and Oracle8 Administrator’s Guide for information 
on how to back up a database.

WARNING: If anything goes wrong with the release 8.0.3 
database during upgrade, you will need to restore the database 
from the backup. Back up your database now as a precaution. 

■ Data files SYS1SID.ORA, USR1SID.ORA, RBS1SID.ORA, 
TMP1SID.ORA

■ Initialization parameter file INITSID.ORA

■ Redo log files LOG1SID.ORA, LOG2SID.ORA

■ Control files CTL1SID.ORA
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Step 3: Edit the COMPATIBLE Parameter in the Release 8.0.3 INITSID.ORA File
Change the value of the COMPATIBLE parameter in the INITSID.ORA file to the 
release of Oracle8 Enterprise Edition to which you are upgrading. The 
COMPATIBLE parameter is set to the following by default:

COMPATIBLE=8.0.0.0.0

However, if you use the default setting (8.0.0.0.0), you will not be able to use the 
following new features of release 8.0.4:

■ Propagation in Advanced Queuing (AQ) 

■ Improved SCN Generation 

To use these new release 8.0.4 features, set the COMPATIBLE parameter to the 
following: 

COMPATIBLE=8.0.4.0.0

See Appendix C “Version 8 INIT.ORA Changes” of Oracle8 Migration for more 
information on COMPATIBLE parameter values.

Step 4: Install Oracle8 Enterprise Edition Release 8.0.4
1. Ensure all Oracle services are stopped. See “Managing Oracle Services” in 

Chapter 10, “Administering a Database” for information on how to stop 
services.

2. Insert the Oracle8 Enterprise Edition CD-ROM into the mapped CD-ROM 
drive and install Oracle8 Enterprise Edition. See Oracle8 Enterprise Edition 
Installation for Windows NT for complete installation instructions.

When the Oracle Installation Settings dialog box appears:   

Using... Do the Following...

One Oracle home 
directory

Accept the default Oracle Home Name, DEFAULT_HOME in 
the Name: field.

Ensure the same directory where the Oracle7 database to be 
upgraded is already installed is entered in the Location: field.

Two or more Oracle 
home directories

Enter the name you want to use for the additional Oracle 
home directory in the Name: field.

Enter another directory location where you want to put 
Oracle8 Enterprise Edition release 8.0.4 in the Location: field.
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The Select Installation Options dialog box appears.

3. Select Oracle8 Enterprise Edition, then click OK. 

The Select Cartridges and Options dialog box appears.

4. Select the cartridges and options you are licensed to install, then click OK.

The Previous Version of Oracle Database dialog box appears indicating that 
Oracle Installer has detected an earlier version of the database. You are asked if 
you want to upgrade your Oracle8 database to release 8.0.4 using Oracle Data 
Migration Assistant.

5. Click No. If you click Yes, Oracle Data Migration Assistant is launched at the 
end of installation. Do not click Yes to run Oracle Data Migration Assistant while 
you are performing a manual upgrade using CAT8004.SQL.

The Select a Starter Database Configuration dialog box appears.

6. Choose None when prompted to install a database in the Starter Database 
Installation Options dialog box.

7. After installation is complete, if you installed release 8.0.4 into another Oracle 
home, you must copy the release 8.0.3 INITSID.ORA file from the release 8.0.3 
ORACLE_HOME\DATABASE directory to the release 8.0.4 
ORACLE_HOME\DATABASE directory. If you have installed Oracle8 
Enterprise Edition into the same Oracle home as Oracle7 release 7.x, there is no 
need to do this.        

8. Shut down and restart the computer if you have installed Oracle8 Enterprise 
Edition release 8.0.4 into another Oracle home. If you have installed Oracle8 
Enterprise Edition into the same Oracle home as Oracle7 release 7.x, there is no 
need to do this.

Step 5: Run the CAT8004.SQL Script
1. Start the Oracle8 services of the release 8.0.3 database you want to upgrade. For 

example, enter the following at the MS-DOS command prompt to start the 
services of the starter database with a SID of ORCL:

C:\> NET START ORACLESERVICEORCL

2. Set ORACLE_SID to the SID of the release 8.0.3 database you want to upgrade. 
For example, if the database you are upgrading is the starter database with a 
SID of ORCL, enter the following at the MS-DOS command prompt. Note there 
are no spaces around the equal sign (=) character.

C:\> SET ORACLE_SID=ORCL 
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3. Start Server Manager at the MS-DOS command prompt:

C:\> SVRMGR30 

4. Connect to the release 8.0.3 Oracle8 instance as INTERNAL:

SVRMGR> CONNECT INTERNAL/PASSWORD

5. Create a spool file called UPGRADE.LOG:

SVRMGR> SPOOL UPGRADE.LOG

6. Run the following scripts:  

7. Turn off the SPOOL command.

SVRMGR> SPOOL OFF

8. Exit Server Manager:

SVRMGR> EXIT 

Oracle Corporation supplies other scripts with Oracle8 Enterprise Edition that 
create additional structures you can use in managing your database and 
creating database applications. See Oracle8 Reference for a complete list and 
descriptions of available scripts.

Script Required by... Enter at the Server Manager Prompt...

CAT8004.SQL All databases SVRMGR> @%ORACLE_HOME%\RDBMS80\ADMIN\CAT8004.SQL

where %ORACLE_HOME% represents your drive letter and release 
8.0.4 Oracle home directory. This script can take over thirty minutes 
to run depending on the size of your database. Check 
UPGRADE.LOG to verify that the operation was successful.

CAT8004.SQL also runs the CATALOG.SQL and CATPROC.SQL 
scripts, which create the system catalog views and all the necessary 
packages for using PL/SQL. 
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Migrating a Microsoft Access Database
Oracle Migration Assistant for Microsoft Access helps you migrate data from a 
Microsoft Access database to an Oracle8 database. Specifically, Oracle Migration 
Assistant for Microsoft Access:

■ Migrates the structure and data of a Microsoft Access database(s) to an Oracle8 
database. The Oracle8 database is then used to manage the migrated data and 
referential integrity. 

■ Provides an option that enables your unmodified Microsoft Access forms and 
reports to work with the newly created Oracle8 database through an Oracle 
Open Database Connectivity Driver (ODBC) connection. 

■ Enables Oracle products such as Oracle Power Objects to work with the newly 
migrated data. 

Oracle Migration Assistant for Microsoft Access can migrate several types of 
Microsoft Access databases, including: 

■ Single Microsoft Access databases with both fixed and dynamically attached 
tables. 

■ Multiple Microsoft Access databases that share attached tables with other 
Microsoft Access databases. 

■ Microsoft Access databases that contain Object Linking and Embedding (OLE) 
or MEMO fields. 

Oracle Migration Assistant for Microsoft Access can be used to migrate both 16-bit 
Access 2.0 databases and 32-bit Microsoft Access 7.0 databases.

To prepare a Microsoft Access database for migration:

1. Compact and back up your Microsoft Access database files. 

2. Separate your Microsoft Access data tables and referential integrity into a 
different .MDB file from the application (forms, reports, macros, and modules) 
and create attachments. The .MDB file containing the data tables and 
referential integrity is the .MDB file to migrate to Oracle8 Enterprise Edition. 
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To migrate a database using Oracle Migration Assistant for Microsoft Access:

1. Choose Start > Programs > Oracle for Windows NT - [HOME_NAME] > Oracle 
Migration Assistant for Microsoft Access. 

The Oracle Migration Assistant for Microsoft Access welcome window appears:

2. Respond to instructions in each Oracle Migration Assistant for Microsoft 
Access window, then click Next when you are ready to continue to the next 
window. When you get to the last window, click Finish to complete the 
migration of the database. More documentation on this product is included 
with the Help.

Note: Microsoft Access tables with two or more MEMO or OLE 
datatype columns, which need to be mapped to a LONG or 
LONGRAW in Oracle8 Enterprise Edition, are not converted. The 
Oracle Migration Assistant for Microsoft Access tries to convert 
these datatypes to a VARCHAR2(2000) so the table can be 
converted. However, if the existing data does not permit this, the 
Microsoft Access table is not converted. Change the Microsoft 
Access structure to move the additional MEMO or OLE columns to 
a separate table. Oracle8 Enterprise Edition does not support two 
LONG columns in one table.
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Known Issues, Restrictions and Workarounds
This section lists known issues and restrictions with Oracle Migration Assistant for 
Microsoft Access.

■ Can only be used to migrate to Oracle database releases 7.3.3, 7.3.4, 8.0.3, and 
8.0.4.

■ Does not support Microsoft Access 97 or Access dynasets. 

■ Supports only migrating schemas that have English or ISO Latin 1 object 
names; that is, table names, index names, column names, and so on.

■ Cannot migrate a Microsoft Access 2.0 database on Windows NT 4.0 or a 
database that has reference to the attached database.

■ If you do not have a default printer selected, the assistant successfully migrates 
your Microsoft Access database to Oracle. However it will not give you any 
feedback about the progress of the migration.

■ The Oracle account’s password created after the migration is oracle.

■ Takes the name of the .MDB file and creates a user with the same name for 
Oracle. Do not use names for the .MDB files that are Oracle reserved words. 

■ When using Query mapping layer and attachments, a table t1 is attached from 
database db1 to database db2 as attachment t2. The databases are migrated to 
Oracle and the query mapping layer is built. In this case, the backup 
attachment t2_L that is created in database db2 for the original attachment t2 
does not point to the proper table in database db1. 

■ When you create the backup attachment t2_L in database db2, it still points to 
table t1 in database db1. But since table t1 in database db1 no longer exists (a 
query is created with the same name for the table instead), the attachment is no 
longer valid. To avoid the problem, manually delete and re-create the backup 
attachment t2_L in database db2 pointing to table t1_L instead of table t1 in 
database db1.

■ When generating reports, if you select File as the destination for your report, 
you create a Crystal Reports viewable file format. If you want to create a text 
file, select Window as the destination of your report. After generating the 
report, select the briefcase icon at the bottom of the report window. Choose text 
as the format and disk file as the destination to create a text file of the report.

■ Use Windows NT or Windows 95 when migrating the AutoNumber column 
with the Structured Only option. The Oracle sequence number starts with the 
last number of the Microsoft Access auto number.
                                                                   Migrating and Upgrading 7-45



Migrating a Microsoft Access Database
7-46 Oracle8 Enterprise Edition Getting Started                                                   



                                                            Post-Installation Configuration Tasks 8-1

8
Post-Installation Configuration Tasks

This chapter describes post-installation configuration tasks for Oracle8 Enterprise 
Edition.

Specific topics discussed are:

■ What Must You Configure?

■ Net8

■ Oracle Enterprise Manager

■ Oracle8 Spatial Cartridge

■ Oracle8 ConText Cartridge

■ Oracle8 ConText Cartridge Workbench

■ Oracle8 Image Cartridge

■ Oracle8 Time Series Cartridge

■ Oracle8 Visual Information Retrieval Cartridge

■ Advanced Replication
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What Must You Configure?
The configuration tasks that you must perform are determined by the products that 
you install and the network configuration files that you use. Some products such as 
Oracle Enterprise Manager must always be manually configured, while the 
configuration requirements for other products such as Oracle8 cartridges are 
determined by how you install the product and the network configuration files you 
use. The following table describes the circumstances under which Oracle products 
are automatically configured or must be manually configured: 

Review the table below and the sections/documents referenced to identify the 
configuration responsibilities for your products.      

Did You... If Yes... If No...

Install cartridges during the 
same installation as Oracle8 
Enterprise Edition release 8.0.4?

Cartridge configuration was 
automatically performed for you.

You must manually perform 
cartridge configuration.

Manually copy your Oracle7 
TNSNAMES.ORA and 
LISTENER.ORA files into your 
Oracle8 network files directory?

Your TNSNAMES.ORA and 
LISTENER.ORA network 
configuration files require several 
modifications in order for some 
cartridges to function properly.

Your network configuration files 
do not require any modification.

Product Is Configuration Automatic? See the Following for Instructions...

Net8 network software For server configuration files, 
configuration is usually automatic. 
For client configuration files, 
configuration must typically be 
manually performed (unless you use 
the Host Adapter). 

 “Net8” of this chapter

Oracle Enterprise Manager No.  “Oracle Enterprise Manager” of this 
chapter

Oracle8 Options

■ Oracle Parallel Server No. Oracle Parallel Server Getting Started for 
Windows NT 

■ Oracle8 Objects Yes. No manual configuration is required

■ Oracle8 Partitioning Yes No manual configuration is required
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Net8
Net8 is the Oracle network software that enables applications running on Windows 
NT and Windows 95 client workstations to access, modify, share, and store data on 
Oracle8 databases. An easy-to-use network configuration tool, Oracle Net8 Easy 
Config, enables you to configure Windows NT and Windows 95 clients to 
communicate with Oracle8 databases. Use Oracle Net8 Easy Config to create and 
modify server and client configuration files. See “Oracle Products for Windows NT 
and Windows 95” in Chapter 2, “Introducing Oracle8 Enterprise Edition” for 
information on how this product is installed. See also Net8 Getting Started for 
Windows NT and Windows 95 for instructions on using Oracle Net8 Easy Config.

PL/SQL External 
Procedures

Depends upon network configuration 
files used.

 “Building External Procedures” of 
Chapter 15, “Developing Applications”

Oracle8 Cartridges:

■ Oracle8 Spatial Depends upon how product was 
installed.

“Oracle8 Spatial Cartridge” of this 
chapter

■ Oracle8 ConText (and 
Workbench)

Depends upon how product was 
installed and whether you are 
upgrading or migrating from a 
previous release.

“Oracle8 ConText Cartridge” of this 
chapter

■ Oracle8 Image Depends upon how product was 
installed and network configuration 
files used.

“Oracle8 Image Cartridge” of this 
chapter

■ Oracle8 Time Series Depends upon how product was 
installed and network configuration 
files used.

 “Oracle8 Time Series Cartridge” of 
this chapter

■ Oracle8 Visual 
Information Retrieval

Depends upon how product was 
installed and network configuration 
files used.

 “Oracle8 Visual Information Retrieval 
Cartridge” of this chapter

Advanced Replication 
Support

Depends upon how support was 
installed.

“Advanced Replication” of this chapter

Multi-threaded External 
Callouts

No. “Step 6: Enabling Multi-threaded 
Callout Support” of Chapter 15, 
“Developing Applications”

Product Is Configuration Automatic? See the Following for Instructions...
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Oracle Enterprise Manager 
Before describing how to configure Oracle Enterprise Manager, the key 
components are briefly described.

Oracle Enterprise Manager Console  Oracle Enterprise Manager works with 
Oracle Intelligent Agent (installed in the Oracle8 database to be managed) to 
perform remote database management from a single console computer. Oracle 
Enterprise Manager is installed on a console computer, a Windows NT or 
Windows 95 client.

Oracle Intelligent Agent and Managed Oracle8 Databases  Oracle Intelligent 
Agent runs on the Oracle8 database to be managed. This Oracle8 database is the 
one you use for your production work. Oracle Intelligent Agent manages and 
completes tasks on the Oracle8 database that are requested from the Oracle 
Enterprise Manager Console computer. Oracle Intelligent Agent:

■ listens for and responds to job requests initiated by the Oracle Enterprise 
Manager Console computer 

■ schedules job requests (requests can include detecting and correcting abnormal 
conditions, performing standard database administration procedures, and 
monitoring events)

■ executes job requests

Oracle8 Repository Database  The Oracle Enterprise Manager Console uses an 
Oracle8 database as a repository for storing key configuration information. The 
Oracle8 repository database can be installed on:

■ the same computer as the Oracle Enterprise Manager Console if it is a 
Windows NT computer

■ a separate Windows NT computer to which a Windows 95 or Windows NT 
Oracle Enterprise Manager Console can remotely connect

The sole responsibility of the repository database is to act as the Oracle Enterprise 
Manager’s storage resource. The Oracle8 repository database is:

■ a separate database from the managed Oracle8 database that you use for your 
production work

■ installed on a separate computer from the managed Oracle8 database

Do not create a repository and a production database in the same Oracle8 database. 
If you do, you will not be able to perform many database administration tasks, 
such as starting or shutting down the database. 
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Set up your Oracle Enterprise Manager Console, managed Oracle8 database(s), and 
Oracle8 repository environment in either of two ways:

The Oracle Enterprise Manager Console 
remotely manages the Oracle8 databases on 
Server 1 and Server 2. The Console is running 
on a Windows NT or WIndows 95 computer.

Console and Repository on separate computers

The repository is a separate Windows NT 
computer with an Oracle8 database 
installed that is only being used as a 
repository. Oracle Intelligent Agent does not 
need to be running.

Console and Repository on same computer

This computer runs a production Oracle8 
database containing Human Resources data. 
The repository is not created in this database 
and Oracle Intelligent Agent is running.

 
This computer runs a production Oracle8 
database containing Manufacturing data. The 
repository is not created in this database and 
Oracle Intelligent Agent is running.

The Oracle Enterprise Manager Console remotely 
manages the Oracle8 databases on Server 1 and 
Server 2. The Console is running on a Windows NT 
computer with an Oracle8 database installed that is 
only being used as a repository. Oracle Intelligent 
Agent does not need to be running.

Managed
Server 1

Managed
Server 2

Oracle Enterprise Manager Console Oracle8 repository database

Oracle Enterprise Manager Console and Oracle8 
repository database

This computer runs a production Oracle8 
database containing Human Resources 
data. The repository is not created in this 
database and Oracle Intelligent Agent is 
running.

 
This computer runs a production Oracle8 
database containing Manufacturing data. 
The repository is not created in this 
database and Oracle Intelligent Agent is 
running.

Managed
Server 1

Managed
Server 2

Environment 1: 

Environment 2: 
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Oracle Enterprise Manager setup involves configuring the computers on which 
your Oracle Enterprise Manager, managed Oracle8 database(s), and Oracle8 
repository database are installed. This table describes the tasks that must be 
performed to configure the two Oracle Enterprise Manager environments 
illustrated previously and the computers on which to perform these tasks. Each 
task is then fully described in the sections that follow. Use this table as a reference 
as you perform your configuration tasks.  

Step 1: Start Oracle Services on Managed Oracle8 Database
Ensure that the Oracle8 database services OracleServiceSID, OracleTNSListener80 
(or OracleHOME_NAMETNSListener80 if using an Oracle home directory with a 
home name), and OracleAgent are started. Oracle Intelligent Agent automatically 
locates the services on the computer where it resides and passes this information to 
the Oracle Enterprise Manager Console.

Perform This Task... On Managed 
Oracle8 databases?

If Console and Repository 
are on same computer?

If Console and Repository 
are on separate 
computers?

Step 1: Start Oracle 
Services on Managed 
Oracle8 Database

Yes No No

Step 2: Create a 
Repository User 
Account

No Yes Yes, but only perform this 
task on the computer on 
which you create the 
repository 

Step 3: Create a 
Windows NT User 
Account on Managed 
Oracle8 Database Server

Yes No No

Step 4: Create Network 
Configuration Files

No No Yes

Step 5: Create the 
Repository and 
Discover Services

No Yes Yes, but only perform this 
task on the computer on 
which you create the 
repository 
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To start Oracle Services:

1. Go to the Oracle8 database to be managed.

2. Start the Oracle services listed above in either of two ways:

■ From the MS-DOS command prompt, enter:

C:\> NET START SERVICE_NAME

■ From the Control Panel’s Services window, select the service, and click Start.

3. Continue to “Step 2: Create a Repository User Account”.

Step 2: Create a Repository User Account
You need to have a user account with database administrator (DBA) privileges set 
up on the Oracle8 repository database. Oracle Enterprise Manager places the 
repository in the default tablespace of the user account to which you are connected 
when creating the repository. Because of this, Oracle Corporation recommends that 
you create a new user account so that the repository can be created in its own 
tablespace. It is also recommended that you create a new tablespace and the newly-
created user be customized to use this tablespace as their default tablespace. 

To create a repository user account on the Oracle8 repository database:

1. Go to the computer on which the Oracle8 database that will become your 
repository is installed.

2. Start Server Manager:

C:\> SVRMGR30

Note: Oracle Intelligent Agent automatically creates SNMP_RO 
and SNMP_RW. These are used instead of the SNMP.ORA file of 
previous releases. If you want to use an SNMP.ORA file that you 
configured with a previous release instead of SNMP_RO and 
SNMP_RW, set the following line to TRUE in the SNMP.ORA file.

nmi.register_with_names=true 

If you set this line to FALSE, Oracle Intelligent Agent uses 
SNMP_RO and SNMP_RW. 
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3. Connect to the Oracle8 repository database:

SVRMGR> CONNECT SYSTEM/PASSWORD

where PASSWORD is MANAGER for the SYSTEM user account by default. If 
you have changed this password, substitute MANAGER with the correct 
password.

4. Create a special tablespace for the Oracle Enterprise Manager repository: 

SVRMGR> CREATE TABLESPACE REPOSIT_TABLESPACE DATAFILE                  
’ORACLE_HOME\DATABASE\DATAFILE’ SIZE XM;

where: 

■ REPOSIT_TABLESPACE is the tablespace name 

■ ‘ORACLE_HOME\DATABASE\DATAFILE’ is the complete path 
(including drive letter) to the data file (single quotes are required)

■ X is the tablespace size in megabytes (20 MB is a good starting place)

5. Create a user account and password where the user’s default tablespace is the 
one created in step 4: 

SVRMGR> CREATE USER USERNAME IDENTIFIED BY PASSWORD DEFAULT TABLESPACE 
REPOSIT_TABLESPACE;

6. Grant the SYSTEM privileges to this user account: 

SVRMGR> GRANT DBA TO USERNAME IDENTIFIED BY PASSWORD;

7. Exit Server Manager:

SVRMGR> EXIT

Exiting Server Manager closes the database connection.

8. Follow Steps 3-6 for additional repository user accounts.

9. Continue to “Step 3: Create a Windows NT User Account on Managed Oracle8 
Database Server”.
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Step 3: Create a Windows NT User Account on Managed Oracle8 Database Server
After a repository user account is created, an NT user account must be created on 
the managed Oracle8 database server.

To create a user account on the managed Oracle8 database server:

1. Go to the Oracle8 database to be managed.

2. Choose Start > Programs > Administrative Tools > User Manager.

The User Manager window appears:

3. Choose New User from the User menu.
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The New User dialog box appears:

4. Enter the appropriate information in the dialog box:

a. Enter a user name in the Username field.

b. Enter the same password in both the Password and Confirm Password 
fields.

The user name and password that you enter here do not need to match 
those that you created in “Step 2: Create a Repository User Account”.

c. Make sure the User Must Change Password at Next Logon check box is not 
checked and Password Never Expires check box is checked.

d. Make the user a member of the Administrator’s group by clicking Groups.
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The Group Memberships dialog box appears:

e. Select Administrators from the Not member of list box and click <- Add.

Administrators is added to the Member of list box.

f. Click OK to close the Group Memberships dialog box and return to the New 
User dialog box.

5. Click OK in the New User dialog box to accept the user information.

The user is added and the User Manager window reappears.

6. Select the newly-created user and choose User Rights from the Policies menu.

The User Rights Policy dialog box appears:

7. Click the Show Advanced User Rights check box and select Log on as a batch job 
from the Right drop-down list box.
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8. Select Users from the Grant To list box.

If Users does not exist, create it:

a. Click Add.

The Add Users and Groups dialog box appears:

b. Select the name of the local host computer from the List Names From drop-
down list box.

c. Select Users from the Names list box and click Add.

d. Click OK.

Users appears in the Grant To list box.

9. Click OK in the User Rights Policy dialog box.

The User Manager window reappears.

10. Click Exit from the User menu.

11. Repeat Steps 1-9 for any other repository user accounts you created.

12. Continue to “Step 4: Create Network Configuration Files”
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Step 4: Create Network Configuration Files
If Oracle Enterprise Manager is installed on the same computer as the repository 
database, you do not need to configure your network. If Oracle Enterprise Manager 
is installed on a Windows 95 or Windows NT client console separate from the 
computer on which the repository database is installed, you must configure the 
client computer so it can connect to the Oracle8 repository database:

To create network configuration files:

1. Use Oracle Net8 Easy Config to configure your network. See Net8 Getting 
Started for Windows NT and Windows 95 for instructions on using Oracle Net8 
Easy Config.

2. Continue to “Step 5: Create the Repository and Discover Services”

Step 5: Create the Repository and Discover Services
Before you can use Oracle Enterprise Manager, you need a repository on the 
console workstation where Oracle Enterprise Manager will run. The repository is a 
set of base tables in a database that contains status and environment information 
for your managed databases. A separate repository must be created for each user 
wanting to use Oracle Enterprise Manager. 

The Oracle Enterprise Manager Console workstation must also discover network 
services, such as databases, listeners, and nodes, to populate the Oracle Enterprise 
Manager Navigator tree. In addition to discovery, Oracle Enterprise Manager must 
also be able to manage these services for the Job Scheduling and Event 
Management systems. This can be achieved with the Discovery Wizard.

When the agent starts up and is explicitly requested by the Oracle Enterprise 
Manager with the Navigator Discovery feature, the agent passes information from 
the Oracle Enterprise Manager Console to populate the Navigator tree.
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To create a repository:

1. Go to the computer on which the Oracle8 database that will become your 
repository is installed. 

2. Choose Start > Programs > Oracle Enterprise Manager > Enterprise Manager.

The Oracle Enterprise Manager Repository Login Information dialog box appears:

3. Enter the following information and click OK:

■ Repository user name and password you created earlier in “Step 2: Create 
a Repository User Account”

■ Net8 service name (or database alias) of the repository database; it is only 
necessary to enter a service name if you are connecting from a client 
console to the Oracle8 repository database on a different computer

The Oracle Repository Manager window appears, prompting you to build the 
repository:

4. Click OK. 
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The repository is built. A dialog box asking if you want a quick tour of Oracle 
Enterprise Manger appears.

5. Click Continue to dismiss this dialog box.

The Discover New Services Wizard appears:

6. Follow the wizard instructions to discover services.
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Services are discovered when you see the dialog box below with a status of 
Discovered:

If the services are not discovered, click Help for troubleshooting hints. The 
wizard can be restarted by selecting Service Discovery under Navigator in the 
main menu.

7. Click Close.

The Oracle Enterprise Manager Console appears:

 Configuration is complete. Oracle Enterprise Manager is now available for use.
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Oracle8 Spatial Cartridge 
Oracle8 Spatial Cartridge makes the storage, retrieval, and manipulation of spatial 
data easier and more intuitive to users. An example of spatial data is a road map. A 
road map is a 2-dimensional object containing points, lines, and polygons 
representing cities, roads, and political boundaries such as states. A road map 
represents geographic information. The locations of cities, roads, and political 
boundaries are projected onto a 2-dimensional display or piece of paper, 
preserving the relative positions and relative distances of the objects. 

Review the table below to determine your configuration responsibilities: 

Configuring Oracle8 Spatial Cartridge
To configure Oracle8 Spatial Cartridge:

1. Go to the computer on which Oracle8 Spatial Cartridge is installed.

2. Start Server Manager at the MS-DOS command prompt:

C:\> SVRMGR30

3. Start the Oracle8 database if it is not currently running. Otherwise, go to step 4.

a. Connect to the database as INTERNAL:

SVRMGR> CONNECT INTERNAL/PASSWORD

b. Start the Oracle8 database:

SVRMGR> STARTUP

4. Connect to the database as the SYSTEM user:

SVRMGR> CONNECT SYSTEM/PASSWORD

If You Installed... Then...

Oracle8 Spatial Cartridge during 
the same installation as Oracle8 
Enterprise Edition

No manual configuration is required. All tasks described in 
“Configuring Oracle8 Spatial Cartridge” were automatically performed. 

Oracle8 Spatial Cartridge during a 
separate installation from Oracle8 
Enterprise Edition

You must manually configure Oracle8 Spatial Cartridge by either:

■ Performing the tasks in “Configuring Oracle8 Spatial Cartridge”.

■ Starting Oracle Database Assistant and selecting Modify a 
Database. Then following the onscreen instructions.
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where PASSWORD is MANAGER for the SYSTEM user account by default. If 
you have changed this password, substitute MANAGER with the correct 
password.

5. Create a user called MDSYS with a password of MANAGER:

SVRMGR> CREATE USER MDSYS IDENTIFIED BY MANAGER;

6. Grant the following privileges to the MDSYS user:

SVRMGR> GRANT ALL PRIVILEGES TO MDSYS IDENTIFIED BY MANAGER WITH ADMIN 
OPTION;

SVRMGR> ALTER USER MDSYS QUOTA UNLIMITED ON SYSTEM;

7. Exit Server Manager:

SVRMGR> EXIT

8. Start SQL*Plus from the MS-DOS command prompt:

C:\> PLUS80W

9. Connect to the database as MDSYS/MANAGER:

The Host String field can be left blank as this is a local database connection. 
This field is for specifying a service name when connecting to a remote 
database. 

Note: You must use SQL*Plus to run CATMD.SQL. Server 
Manager cannot run CATMD.SQL.
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10. Run the CATMD.SQL script:

SQL> @%ORACLE_HOME%\MD80\ADMIN\CATMD.SQL

This script creates the following:

■ MD3 data dictionary tables

■ MD3 data dictionary user views

■ MDSQL packages for MD operations

■ MDWEX packages for extracting data

■ MDGTRIG package for generating triggers 

For information on using Oracle8 Spatial Cartridge, See the Oracle8 Spatial Cartridge 
User’s Guide and Reference.

Note: In order to develop applications that work with Oracle8 
Spatial Cartridge, you must link with SDO80.LIB, which is located 
in the ORACLE_HOME\MD80 directory.
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Oracle8 ConText Cartridge
Oracle8 ConText Cartridge provides search, retrieval, and viewing capabilities for 
text stored in an Oracle8 database. Oracle8 ConText Cartridge manages textual data 
in concert with traditional data types in an Oracle8 database. When text is inserted, 
updated, or deleted, Oracle8 ConText Cartridge automatically manages the change. 
Oracle8 ConText Cartridge enables text queries to be performed through SQL and 
PL/SQL from most Oracle interfaces, using tools such as SQL*Plus, Oracle Forms, 
and Pro*C.

Review the table below to determine your configuration responsibilities. All 
instructions assume that you have already installed Oracle8 ConText Cartridge 
release 2.3.6 from the Oracle8 Enterprise Edition for Windows NT CD-ROM: 

Upgrading Oracle8 ConText Cartridge
This section describes how to upgrade from previous releases of Oracle ConText 
Option to Oracle8 ConText Cartridge release 2.3.6. The following table lists the 
release numbers of Oracle ConText with the corresponding Oracle Server releases:

If... Then...

You migrated from Oracle7 Server release 7.3.x to 
Oracle8 Enterprise Edition release 8.0.4 and now 
want to migrate ConText to Oracle8 ConText 
Cartridge release 2.3.6

Follow the instructions in:

■ “Upgrading Oracle8 ConText Cartridge”

■ “Configuring Oracle8 ConText Cartridge”

■ “Configuring Oracle8 ConText Cartridge Demos”

You upgraded from Oracle8 Enterprise Edition 
release 8.0.3 to Oracle8 Enterprise Edition release 
8.0.4 by installing release 8.0.4 into the same Oracle 
home directory as your previous installation using 
Oracle Installer

Follow the instructions in:

■ “Load Lexical Data”

■ “Configuring Oracle8 ConText Cartridge” 

■ “Configuring Oracle8 ConText Cartridge Demos”

You installed Oracle8 ConText Cartridge release 2.3.6 
for the first time, and you do not have a previous 
release of ConText installed (fresh installation)

Follow the instructions in:

■ “Configuring Oracle8 ConText Cartridge” 

■ “Configuring Oracle8 ConText Cartridge Demos”

Oracle ConText Release Oracle Server Release

Oracle ConText Option release 1.1.2 Oracle7 Server release 7.3.2

Oracle ConText Option release 2.0.4 Oracle7 Server release 7.3.3

Oracle ConText Option release 2.3.4 Oracle7 Server release 7.3.4
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You cannot migrate directly from release 1.1.2 to release 2.3.6. You need to first 
migrate to release 2.0.4, and then upgrade to release 2.3.6. You do not need to install 
Oracle ConText Option release 2.0.4 from your previous CD-ROM. Follow the 
instructions below appropriate to your situation:

■ Migrate from Oracle ConText release 1.1.2 to release 2.0.4

■ Upgrade from Oracle ConText release 2.0.4 to release 2.3.6

■ Upgrade from release 2.0.6 to release 2.3.6

■ Upgrade from release 2.3.4 to release 2.3.6

■ Load Lexical Data

Migrate from Oracle ConText release 1.1.2 to release 2.0.4
To migrate from release 1.1.2 to release 2.0.4:

1. Migrate the Oracle database from release 7.3.x to release 8.0.4, if you have not 
already done so.

2. Start the ConText database you want to migrate by entering at the MS-DOS 
command prompt:

C:\> SVRMGR30

SVRMGR> CONNECT SYS/PASSWORD

SVRMGR> STARTUP [PFILE=PATH\FILENAME]

where PFILE is the option to specify the full path and file name of an 
initialization parameter file (INITSID.ORA) that exists in a location other than 
that for the default INITSID.ORA file.

3. Exit Server Manager:

SVRMGR> EXIT

Oracle8 ConText Cartridge release 2.0.6 Oracle8 Enterprise Edition release 8.0.3

Oracle8 ConText Cartridge release 2.3.6 Oracle8 Enterprise Edition release 8.0.4

Oracle ConText Release Oracle Server Release
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4. Start SQL*Plus in one of two ways from the directory ORACLE_HOME\ 
CTX80\ADMIN:

5. Connect as SYS:

SQL> CONNECT SYS/PASSWORD;

6. Run the SYS20000.SQL script:

SQL> @SYS20000.SQL;

7. Exit SQL*Plus:

SQL> EXIT

8. Start SQL*Plus again from the directory ORACLE_HOME\CTX80\ADMIN, 
and log in to the database as user CTXSYS.

9. Run the UPG20000.SQL script:

SQL> @UPG20000.SQL;

10. Exit SQL*Plus:

SQL> EXIT

11. Import the linguistics data in to the ConText data dictionary from the file 
CTXSET.DMP:

C:\ORACLE_HOME\CTX80\ADMIN>IMP80 CTXSYS/PASSWORD \FILE=CTXSET.DMP FULL=Y 
IGNORE=Y

12. Upgrade from Oracle ConText release 2.0.4 to release 2.3.6.

Start SQL*Plus... By Doing This...

From the MS-DOS command line Enter:

C:\>PLUS80

From the Taskbar Choose Start > Programs > Oracle for Windows 
NT - [HOME_NAME] > SQL*Plus 8.0
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Upgrade from Oracle ConText release 2.0.4 to release 2.3.6
To upgrade from release 2.0.4 to release 2.3.6:

1. Upgrade the Oracle7 database release 7.3.3 to release 8.0.4, if you have not 
already done so.

2. Start the ConText database you want to upgrade by entering at the MS-DOS 
command prompt:

C:\> SVRMGR30

SVRMGR> CONNECT SYS/PASSWORD

SVRMGR> STARTUP [PFILE=PATH\FILENAME]

where PFILE is the option to specify the full path and file name of an 
initialization parameter file (INITSID.ORA) that exists in a location other than 
that for the default INITSID.ORA file.

3. Exit Server Manager:

4. Start SQL*Plus in one of two ways from the directory ORACLE_HOME\ 
CTX80\ADMIN:

5. Log in to the database as CTXSYS:

SQL> CONNECT CTXSYS/PASSWORD;

6. Run the script UPG23600.SQL:

SQL> @UPG23600.SQL;

7. Exit SQL*Plus:

SQL> EXIT

8. Start at least one ConText server process from the directory 
ORACLE_HOME\BIN:

C:\ORACLE_HOME\BIN> CTXSRV80 -USER CTXSYS/PASSWORD -PERSONALITY DQM

Start SQL*Plus... By Doing This...

From the MS-DOS 
command line

Enter:

C:\> PLUS80

From the Taskbar Choose Start > Programs > Oracle for Windows NT - 
[HOME_NAME] > SQL*Plus 8.0
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9. Run the PL/SQL function CTX_DDL.UPGRADE_INDEX for each existing 
Oracle ConText index that must be upgraded for use with release 2.3.6. The 
owner of the index should perform this task, but it can also be performed by 
CTXSYS. The following syntax assumes the user CTXSYS is performing the 
task:

C:\ORACLE_HOME\CTX80\ADMIN> PLUS80

SQL> CONNECT CTXSYS/PASSWORD

SQL> EXEC CTX_DDL.UPGRADE_INDEX(‘DOC_POL1’);

where DOC_POL1 is the name of the index to be upgraded.

10. Go to “Load Lexical Data”.

Upgrade from release 2.0.6 to release 2.3.6
To upgrade from release 2.0.6 to release 2.3.6:

1. Upgrade the Oracle8 database release 8.0.3 to release 8.0.4, if you have not 
already done so.

2. Start the ConText database you want to upgrade by entering the following:

C:\> SVRMGR30

SVRMGR> CONNECT SYS/PASSWORD

SVRMGR> STARTUP [PFILE=PATH\FILENAME]

where PFILE is the option to specify the full path and file name of an 
initialization parameter file (INITSID.ORA) that exists in a location other than 
that of the default INITSID.ORA file.

3. Exit Server Manager:

4. Start SQL*Plus in one of two ways from the directory ORACLE_HOME\CTX80 
\ADMIN:

Start SQL*Plus... By Doing This...

From the MS-DOS 
command line

Enter:

C:\> PLUS80

From the Taskbar Choose Start > Programs > Oracle for Windows NT - 
[HOME_NAME] > SQL*Plus 8.0
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5. Log in to the database as CTXSYS:

SQL> CONNECT CTXSYS/PASSWORD;

6. Run the script UPG23600.SQL:

SQL> @UPG23600.SQL;

7. Exit SQL*Plus:

SQL> EXIT

8. Start at least one ConText server process from the directory 
ORACLE_HOME\BIN:

C:\ORACLE_HOME\BIN> CTXSRV80 -USER CTXSYS/PASSWORD -PERSONALITY DQM

9. Run the PL/SQL function CTX_DDL.UPGRADE_INDEX for each existing 
Oracle ConText index that must be upgraded for use with release 2.3.6. The 
owner of the index should perform this task, but it can also be performed by 
CTXSYS. The following syntax assumes the user CTXSYS is performing the 
task:

C:\ORACLE_HOME\CTX80\ADMIN> PLUS80

SQL> CONNECT CTXSYS/PASSWORD

SQL> EXEC CTX_DDL.UPGRADE_INDEX(‘DOC_POL1’);

where DOC_POL1 is the name of the index to be upgraded.

10. Go to “Load Lexical Data”.

Upgrade from release 2.3.4 to release 2.3.6
To upgrade from release 2.3.4 to release 2.3.6, you do not need to perform any 
upgrading tasks except loading lexical data. Go to “Load Lexical Data”.

Load Lexical Data
The CTXSRXversion executable, the ConText server without linguistics, has been 
obsoleted for release 2.3.6 of Oracle8 ConText Cartridge. All lexical information is 
now stored in the database. Therefore, if you have upgraded from a previous 
release of ConText, you need to load lexical data into the database.
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To load lexical data into the database:

1. Ensure that:

■ Oracle database has been upgraded to release 8.0.4

■ ConText database has been upgraded to release 2.3.6

2. Ensure the CTXSYS tablespace has at least 30 to 40 MB available. If it does not, 
then extend the tablespace for CTXSYS in one of two ways:

To Enlarge CTXSYS 
Tablespace by... Do This...

Adding a datafile to the 
tablespace

1. Log in to the database using Server Manager as SYS, and start the database:

C:\ORACLE_HOME\BIN> SVRMGR30

SVRMGR> CONNECT SYS/PASSWORD;

SVRMGR> STARTUP [PFILE=PATH/FILENAME];

2. Enter the following command:

SVRMGR> ALTER DATABASE DATAFILE ‘ DATAFILE’ RESIZE SIZE M;

where:

DATAFILE is the name of the data file in the ConText tablespace
SIZE is the current size of the datafile in MB + 30 MB

3. Exit Server Manager:

SVRMGR> EXIT

Resizing the existing 
datafile in the tablespace

1. Log in to the database using Server Manager as SYS, and start the database:

C:\ ORACLE_HOME\BIN> SVRMGR30

SVRMGR> CONNECT SYS/PASSWORD;

SVRMGR> STARTUP [PFILE=PATH/ FILENAME];

2. Enter the following command:

SVRMGR> ALTER TABLESPACE TABLESPACE ADD DATAFILE 
‘ DATAFILE’  SIZE 30 M;

where:

TABLESPACE is the ConText object tablespace name
DATAFILE is the new data file in the ConText tablespace

3. Exit Server Manager:

SVRMGR> EXIT
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3. Create a temporary rollback segment with at least 30 MB available.

In this example, a rollback segment named ROLLBK_TEMP is created in a 
tablespace named DRSYS:

C:\ORACLE_HOME\BIN> SVRMGR30

SVRMGR> CONNECT SYSTEM/PASSWORD

SVRMGR> CREATE ROLLBACK SEGMENT ROLLBK_TEMP TABLESPACE DRSYS STORAGE 
(INITIAL 5M NEXT 5M OPTIMAL 10M MINEXTENTS 2 MAXEXTENTS UNLIMITED);

4. Bring the new temporary rollback segment online, and bring all existing 
rollback segments except SYSTEM offline:

SVRMGR> ALTER ROLLBACK SEGMENT ROLLBK_TEMP ONLINE;

SVRMGR> ALTER ROLLBACK SEGMENT ROLLBACK OFFLINE;

where ROLLBACK is the name of the rollback segment currently online.

5. Import the lexical data into the ConText data dictionary from the file 
CTXLEX.DMP located in the directory ORACLE_HOME\CTX80\ADMIN:

C:\ORACLE_HOME\CTX80\ADMIN> IMP80 CTXSYS/PASSWORD FILE=CTXLEX.DMP FULL=Y 
IGNORE=Y COMMIT=Y

6. Bring the new temporary rollback segment offline, and bring all existing 
rollback segments online:

SVRMGR> ALTER ROLLBACK SEGMENT ROLLBACK ONLINE;

SVRMGR> ALTER ROLLBACK SEGMENT ROLLBK_TEMP OFFLINE;

where ROLLBACK is the name of the rollback segment currently online.

7. Drop the temporary rollback segment named ROLLBK_TEMP in the example:

SVRMGR> DROP ROLLBACK SEGMENT ROLLBK_TEMP;

8. See “Configuring Oracle8 ConText Cartridge”
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Configuring Oracle8 ConText Cartridge Overview
The way you configure Oracle8 ConText Cartridge depends on how it was 
installed:

Configuring Oracle8 ConText Cartridge

Configuring After a Fresh Installation
If you installed Oracle8 ConText Cartridge when you installed Oracle8 Enterprise 
Edition, then you can use Oracle Database Assistant to perform configuration tasks 
after installation.

1. Ensure that your ConText service is started.

To verify that the service is started:

a. From the Taskbar, choose Start > Settings > Control Panel.

b. Double-click Services.

c. Verify that OracleConTextService80 (or 
OracleHOME_NAMEConTextService80, if using an Oracle home directory 
with a home name) is started.

If the service is not started, then select the service name, and click Start.

d. Close the Services control panel.

2. Choose Start > Programs > Oracle for Windows NT - [HOME_NAME] > Oracle 
Database Assistant. 

3. Select Modify a Database, and click Next.

4. Select the instance you want to modify by choosing the appropriate service 
name from the list, and click Next.

If you installed Oracle8 ConText 
Cartridge this way... Then see this section...

Installed Oracle8 ConText Cartridge for the 
first time (and you do not have a previous 
release of ConText installed) or upgraded 
from release 2.0.6 to release 2.3.6

“Configuring After a Fresh Installation”

Upgraded or migrated to Oracle8 ConText 
Cartridge release 2.3.6 from a previous 
release

“Configuring After Upgrading or 
Migrating”
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5. Select Configure Oracle Cartridges, and click Next.

6. Select ConText Cartridge, and then click Finish.

You can also select Enable Demo at this time if you want to use the ConText 
demos. A message appears showing the progress of the configuration. The 
configuration can take up to or more than 30 minutes, depending upon your 
specific environment. 

A message appears informing you that configuration was successful.

7. Click OK to dismiss the message. 

Oracle Database Assistant closes, and your database is now ConText enabled.

Configuring After Upgrading or Migrating
If you upgraded or migrated from a previous release of ConText to release 2.3.6, 
then configure ConText using the instructions below.

To configure Oracle8 ConText Cartridge:

1. Start Server Manager at the MS-DOS command prompt on the computer where 
Oracle8 ConText Cartridge is installed:

C:\> SVRMGR30

2. Start the Oracle8 database if it is not currently running. If the database is 
running, go to step 3.

a. Connect to the database as SYS:

SVRMGR> CONNECT SYS/PASSWORD;

b. Start the Oracle8 database:

SVRMGR> STARTUP [PFILE=PATH/FILENAME]

where PFILE is the option to specify the full path and file name of an 
initialization parameter file (INITSID.ORA) that exists in a location other 
than that of the default INITSID.ORA file.



Oracle8 ConText Cartridge

8-30 Oracle8 Enterprise Edition Getting Started                                                 

3. Create Oracle8 ConText Cartridge dictionary and packages in either of two 
ways:

 

Create Dictionary and 
Packages in... By Doing This...

an existing tablespace 1. Expand an existing tablespace by at least 5 MB:

SVRMGR> ALTER TABLESPACE EXISTING_TABLESPACE ADD DATAFILE 
‘ORACLE_HOME\DATABASE\SYS2ORCL.ORA’ SIZE 30 M; 

where: 

■ EXISTING_TABLESPACE is an existing tablespace name 

■ ‘ORACLE_HOME\DATABASE\SYS2ORCL.ORA’ is the complete path 
(including drive letter) to the new data file (single quotes are required)

2. Exit Server Manager:

SVRMGR> EXIT 

Note: At least 30 MB of database space is needed for this object.

a separate tablespace 
(preferred method)

1. Create a tablespace called DRSYS with a size of at least 5 MB.

SVRMGR> CREATE TABLESPACE DRSYS DATAFILE 
’ORACLE_HOME\DATABASE\DR1ORCL.ORA’ SIZE 30 M; 

2. Exit Server Manager:

SVRMGR> EXIT 

Note: At least 30 MB of database space is needed for this object.

Additional Information: See:

■  Oracle8 ConText Cartridge QuickStart 

■  Oracle8 ConText Cartridge Administrator’s Guide

■  Oracle8 ConText Cartridge Application Developer’s Guide
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Configuring Oracle8 ConText Cartridge Demos
This section provides instructions for performing the initial setup required to use 
the samples. The samples are located in the directory ORACLE_HOME 
\CTX80\DEMO\.

The samples provided with Oracle8 ConText Cartridge are:

To set up the CTXPLUS and CTXLING demos: 

1. Ensure that your ConText service is started.

To verify that the service is started:

a. From the Taskbar, choose Start > Settings > Control Panel.

b. Double-click Services.

c. Look to see that OracleConTextService80 (or 
OracleHOME_NAMEConTextService80) is started.

If the service is not started, then select the service name, and click Start.

d. Close the Services control panel.

2. Start the ConText server:

C:\ORACLE_HOME\BIN> CTXSRV80 -PERSONALITY DQL

3. Enter the CTXSYS user name and password:

Enter user: CTXSYS/PASSWORD

The ConText server is initialized, and the ConText session is opened. The 
prompt returns after the ConText server is started.

4. Start Oracle Database Assistant:

a. Choose Start > Programs > Oracle for Windows NT - [HOME_NAME] > 
Oracle Database Assistant. 

Demonstration Description

CTXPLUS SQL*Plus text query scripts

CTXLING SQL*Plus linguistic extraction sample
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5. Click Modify a Database, and click Next.

6. Select the instance you want to modify by choosing the appropriate service 
name from the list, and click Next.

7. Select Configure Oracle Cartridge, and click Next.

8. Select Enable Demo, and click Finish.

Oracle8 ConText Cartridge Workbench
Oracle8 ConText Cartridge Workbench consists of administrative tools and 
application development tools. Specific topics discussed in this section are:

■ Upgrading Oracle8 ConText Cartridge Workbench

■ Configuring Oracle8 ConText Cartridge Viewer Cartridge

■ Configuring Oracle8 ConText Cartridge Configuration Manager

■ Configuring Oracle8 ConText Cartridge Workbench Demo

Upgrading Oracle8 ConText Cartridge Workbench
To upgrade from previous releases of Workbench, install the current release of 
Oracle8 ConText Cartridge Workbench in the same Oracle home directory as the 
previous release using Oracle Installer. Oracle Installer automatically upgrades all 
Workbench files to the current release.

Configuring Oracle8 ConText Cartridge Viewer Cartridge
To configure Oracle8 ConText Cartridge Workbench:

1. Choose Start > Programs > Oracle for Windows NT (or Windows 95) - 
[HOME_NAME] > Viewer Cartridge Setup.
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Oracle Installer starts, and the Oracle8 ConText Cartridge Viewer Cartridge Setup 
dialog box appears:

2. Enter the appropriate information in each of the fields, and click OK: 

1 Ask your web server administrator for assistance with these values.

Field1 Description

Machine name Enter the machine name of the WebServer or Web 
Application Server.

Admin listener port Enter the admin listener port of the WebServer or Web 
Application Server.

Admin listener user and 
password

Enter the admin listener user and password.

Listener name Enter an existing listener name.

User/Password Enter the CTXSYS user and password. The default 
password is CTXSYS.

Connection alias Enter the database alias for the WebServer or Web 
Application Server to the Oracle8 database.

Note: The alias that you enter here is not the alias that 
connects the client to the Oracle database.
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If your web server is on the same computer as the Viewer Cartridge, then go to 
Step 5. Otherwise, the Remote Web Application Server dialog box appears.

3. Select the platform of the web server, and select how you want to copy 
configuration files to the web server computer (in one of two ways): 

■ automatically

You can only select Automatically if the web server and Configuration 
Manager are installed on the same computer. 

■ manually

Enter the database alias of the client computer to the Oracle8 database. 
Also, note the directory information so that you can copy the files after the 
configuration process.

4. Click OK.

Oracle Installer begins installing Viewer Cartridge files. This process may take 
several minutes.

After installation is complete, an information message appears with important 
post-installation instructions.
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5. Copy the files and directories specified in Step 3.

6. Shut down and restart all web server listeners and services.

7. Double-click the new Viewer Cartridge icon that appears in the Oracle for 
Windows NT (or Windows 95) program group to start the Viewer Cartridge.

Configuring Oracle8 ConText Cartridge Configuration Manager
To configure Oracle8 ConText Cartridge Configuration Manager:

1. Choose Start > Programs > Oracle for Windows NT (or Windows 95) - 
[HOME_NAME]  > Configuration Manager Setup.

Oracle Installer starts, and the Oracle8 ConText Cartridge Configuration Manager 
Setup dialog box appears:
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2. Enter the appropriate information in each of the fields, and click OK: 

If your web server is on the same computer as the Configuration Manager, then 
go to Step 5. Otherwise, the Remote Web Application Server dialog box appears:

1 Ask your web server administrator for assistance with these values.

Field1 Description

Machine name Enter the machine name of the WebServer or 
Web Application Server.

Admin listener port Enter the admin listener port of the WebServer 
or Web Application Server.

Admin listener user and password Enter the admin listener user and password.

Listener name and port Enter an existing listener name and port number.

User/Password Enter the CTXSYS user and password. The 
default password is CTXSYS.

Connection alias Enter the database alias for the WebServer or 
Web Application Server to the Oracle8 database. 
The alias that you enter here is not the alias that 
connects the client to the Oracle database.
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3. Select the platform of the web server, and select how you want to copy 
configuration files to the web server computer (in one of two ways): 

■ Automatically

You can only select Automatically if the web server and Configuration 
Manager are installed on the same computer. 

■ Manually

Enter the database alias of the client computer to the Oracle8 database. 
Also, note the directory information so that you can copy the files after the 
configuration process.

4. Click OK.

Oracle Installer begins installing Configuration Manager files. This process 
may take several minutes.

After installation is complete, an information message appears with important 
post-installation instructions.

5. Copy the files and directories specified in Step 3.

6. Shut down and restart all web server listeners and services.

7. Double-click the new icon Configuration Manager that appears in the Oracle 
for Windows NT (or Windows 95) program group to start the Configuration 
Manager.

Configuring Oracle8 ConText Cartridge Workbench Demo
This section provides instructions for performing the initial set up required to use 
the Oracle8 ConText Cartridge Workbench sample, CTXFORM.

To set up the CTXFORM demo: 

1. Determine the user you will use to log in to the database in order to use the 
demo. You can use the supplied user CTXDEMO, or create an Oracle user for 
the demos.

The CTXDEMO user is provided with the Oracle8 ConText Cartridge. The 
CTXDEMO user has all of the required privileges to set up and use the demos. 
The initial password is CTXDEMO.
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If you want to create a user, note that in addition to the standard privileges 
required for an Oracle user, the demo user must have CREATE privileges for 
the tables and views used in the demos. Also, the demo user must be assigned 
the CTXAPP role.

To create a demo user:

a. Start SQL*Plus:

b. Log in to SQL*Plus as CTXSYS:

SQL> CONNECT CTXSYS/PASSWORD

c. Enter the following commands:

SQL> GRANT CONNECT, RESOURCE TO MYDEMO IDENTIFIED BY MYDEMO;

SQL> GRANT CTXAPP TO MYDEMO;

where MYDEMO is the newly created user.

2. Go to the ORACLE_HOME\CTX80\DEMO\INSTALL directory.

3. Run the IMP80 utility from the MS-DOS command prompt with parameter 
TABLES=ARTICLES to import the DEMO.DMP file into the schema of the 
demonstration user:

ORACLE_HOME\CTX80\DEMO\INSTALL> IMP80 CTXSYS/PASSWORD FILE=DEMO.DMP 
IGNORE=Y TABLES=ARTICLES

Importing the DEMO.DMP file:

■ creates an ARTICLES table for the demonstration user

■ populates ARTICLES.TEXT with the text of the articles used in the demos

Start SQL*Plus... By Doing This...

From the MS-DOS 
command line

Enter:

C:\> PLUS80

From the Taskbar Choose Start > Programs > Oracle for Windows NT - 
[HOME_NAME] > SQL*Plus 8.0
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The DEMO.DMP file was originally exported for CTXDEMO. If you specified a 
user name other than CTXDEMO for your demonstration user, you must 
include the following parameters when running the Oracle Import utility:

■ FROMUSER=CTXDEMO

■ TOUSER=USER_NAME

For example:

IMP80 SYSTEM/PASSWORD FILE=DEMO.DMP FROMUSER=CTXDEMO TOUSER=MYDEMO 
TABLES=ARTICLES

In the example above, a user named SYSTEM imports the ARTICLES table 
from the DEMO.DMP file created by CTXDEMO into the schema for a user 
named MYDEMO.

4. Start a ConText Server with the DDL (D) personality:

C:\ORACLE_HOME\CTX80\DEMO\INSTALL> CTXSRV80 -USER CTXSYS/CTXSYS -
PERSONALITY DDL

5. Log on to SQL*Plus as the demonstration user, and run the DEMOINST.SQL 
script:

SQL> @DEMOINST.SQL

This script serves as an example of the tasks that you must perform to set up 
your tables for processing text queries using Oracle8 ConText Cartridge.

The script creates the policies, preferences, views, and results tables used by the 
demos and creates a text index for the ARTICLES table.
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Oracle8 Image Cartridge 
Oracle8 Image Cartridge provides image storage, retrieval, and format conversion 
capabilities through an object data type (ODT). Oracle8 Image Cartridge supports 
image storage using Binary Large Objects (BLOBS) and references to image data 
residing in external files (BFILEs). 

Review the table below to determine your configuration responsibilities: 

If You... Then...

Installed Oracle8 Image Cartridge 
during the same installation as 
Oracle8 Enterprise Edition

No manual configuration is required. All tasks described in 
“Configuring Oracle8 Image Cartridge” were automatically performed. 

Installed Oracle8 Image Cartridge 
during a separate installation from 
Oracle8 Enterprise Edition

You must manually configure Oracle8 Image Cartridge by either:

■ Performing the tasks in “Configuring Oracle8 Image Cartridge”.

■ Starting Oracle Database Assistant and selecting Modify a 
Database. Then following the onscreen instructions.

Want to use the demos You must manually configure Oracle8 Image Cartridge Demos by 
either:

■ Performing the tasks in “Configuring Oracle8 Image Cartridge 
Demos”

■ Starting Oracle Database Assistant and selecting Modify a 
Database. Then following the onscreen instructions.

Manually copied your Oracle7 
LISTENER.ORA and 
TNSNAMES.ORA files into your 
Oracle8 network directory

You must modify the TNSNAMES.ORA and LISTENER.ORA network 
configuration files on your server to enable external procedure calls to 
work and Oracle8 Image Cartridge to function properly. Follow the 
tasks in “Configuring External Procedure Calls” in Chapter 8 of Net8 
Getting Started for Windows NT and Windows 95.

Want to use Oracle8 Visual 
Information Retrieval Cartridge 
with Oracle8 Image Cartridge

Install Oracle8 Image Cartridge first. If you selected both cartridges for 
installation in the Select Cartridges and Options dialog box, Oracle8 
Image Cartridge was installed first.

Want to build the Oracle8 Image 
Cartridge sample application

Install a C compiler.

Did not install Oracle8 Objects 
Option

Install Oracle8 Objects Option, which is required for Oracle8 Image 
Cartridge to function properly.

Want multi-threaded external 
callout functionality

Perform the tasks in “Step 6: Enabling Multi-threaded Callout 
Support” in Chapter 15, “Developing Applications”. 
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Configuring Oracle8 Image Cartridge
To configure Oracle8 Image Cartridge:

1. Start Server Manager:

C:\> SVRMGR30

2. Connect to the database with the INTERNAL account:

SVRMGR> CONNECT INTERNAL/PASSWORD

3. Start the database:

SVRMGR> STARTUP

4. Run the following script:

SVRMGR> @%ORACLE_HOME%\ORD80\IMG\ADMIN\ORDIINST.SQL

5. Enter the password for INTERNAL when prompted by the ORDIINST.SQL 
script:

Password: PASSWORD

6. Change the password for ORDSYS (if necessary):

a. Connect to the database with the INTERNAL account:

SVRMGR> CONNECT INTERNAL/PASSWORD

b. Enter the following command:

SVRMGR> ALTER USER ORDSYS IDENTIFIED BY NEW_PASSWORD;

7. Exit Server Manager:

SVRMGR> EXIT

Configuring Oracle8 Image Cartridge Demos
Oracle8 Image Cartridge Demos provide a sample demonstration showing how an 
image is extracted from an Oracle8 database.

To configure Oracle8 Image Cartridge Demos: 

1. Start Server Manager:

C:\> SVRMGR30

2. Connect to the database with the INTERNAL account:

SVRMGR> CONNECT INTERNAL/PASSWORD
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3. Run the following script:

SVRMGR> @%ORACLE_HOME%\ORD80\IMG\ADMIN\IMGDEMO.SQL

4. Enter the password for INTERNAL when prompted by the IMGDEMO.SQL 
script:

Password: PASSWORD

5. Exit Server Manager:

SVRMGR> EXIT 

6. Go to the following directory:

C:> CD ORACLE_HOME\ORD80\IMG\DEMO 

7. Make the Oracle8 Image Cartridge Demo program:   

If Using a... Then Enter...

Microsoft C compiler MAKE 

Borland C compiler BMAKE 
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Oracle8 Time Series Cartridge 
Oracle8 Time Series Cartridge stores and retrieves timestamped data through object 
data types (ODTs). Oracle8 Time Series Cartridge is a building block for 
applications, rather than being an end-user application. For example, applications 
can use this cartridge to process historical data derived from financial market 
transactions, such as trades of stocks, bonds, and mutual fund shares. From this 
you can find the opening, closing, low, and high prices for a stock on a specific 
date; calculate monthly volumes for a stock for a specific year; and derive the 30-
day moving average for a stock over a year. 

Review the table below to determine your configuration responsibilities:

If You... Then...

Installed Oracle8 Time Series 
Cartridge during the same installation 
as Oracle8 Enterprise Edition

No manual configuration is required. All tasks described in 
“Configuring Oracle8 Time Series Cartridge” were automatically 
performed. 

Installed Oracle8 Time Series 
Cartridge during a separate 
installation from Oracle8 Enterprise 
Edition

You must manually configure Oracle8 Image Cartridge by either:

■ Performing the tasks in “Configuring Oracle8 Time Series 
Cartridge”.

■ Starting Oracle Database Assistant and selecting Modify a 
Database. Then following the onscreen instructions.

Want to use the demos Perform the tasks in “Configuring Oracle8 Time Series Cartridge 
Demos”. 

Manually copied your Oracle7 
LISTENER.ORA and 
TNSNAMES.ORA files into your 
Oracle8 network directory

You must modify the TNSNAMES.ORA and LISTENER.ORA 
network configuration files on your server to enable external 
procedure calls to work and Oracle8 Time Series Cartridge to 
function properly. Follow the tasks in “Configuring External 
Procedure Calls” in Chapter 8 of Net8 Getting Started for Windows NT 
and Windows 95.

Did not install Oracle8 Objects Option Install Oracle8 Objects Option, which is required for Oracle8 Time 
Series Cartridge to function properly.

Want multi-threaded external callout 
functionality

Perform the tasks in “Step 6: Enabling Multi-threaded Callout 
Support” in Chapter 15, “Developing Applications”. 
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Configuring Oracle8 Time Series Cartridge

To configure Oracle8 Time Series Cartridge:

1. Start Server Manager:

C:\> SVRMGR30

2. Connect to the database with the INTERNAL account:

SVRMGR> CONNECT INTERNAL/PASSWORD

3. Create the user ORDSYS (if it does not currently exist):

SVRMGR> CREATE USER ORDSYS IDENTIFIED BY ORDSYS;

4. Grant the following privileges to ORDSYS:

SVRMGR> GRANT CONNECT,RESOURCE,CREATE LIBRARY TO ORDSYS;

SVRMGR> GRANT GRANT ANY PRIVILEGE TO ORDSYS;

5. Connect as ORDSYS:

SVRMGR> CONNECT ORDSYS/PASSWORD

6. Run the following script:

SVRMGR> @%ORACLE_HOME%\ORD80\TS\ADMIN\ORDTINST.SQL

This script: 

■ defines calendar and time series types 

■ defines utility, calendar, and time series functions

■ grants EXECUTE privileges to PUBLIC for all public types and packages 

7. Change the password for ORDSYS (if necessary):

a. Connect to the database with the INTERNAL account:

SVRMGR> CONNECT INTERNAL/PASSWORD

Note: Oracle8 Time Series Cartridge uses the same user name as 
Oracle8 Image Cartridge and Oracle8 Visual Information Retrieval 
Cartridge (ORDSYS). If you automatically or manually configured 
either of these cartridges first, then the error ORA-01920 can 
appear on-screen when running the script below. This error 
message can be ignored.
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b. Enter the following command:

SVRMGR> ALTER USER ORDSYS IDENTIFIED BY NEW_PASSWORD;

8. Exit Server Manager:

SVRMGR> EXIT

Configuring Oracle8 Time Series Cartridge Demos
Five Oracle8 Time Series Cartridge Demos are provided:

To configure Oracle8 Time Series Cartridge Demos:

1. Go to the ORACLE_HOME\ORD80\TS\DEMO directory.

2. Read the README file in this directory for an overview of the five Oracle8 
Time Series Cartridge Demos.

3. Go to the appropriate subdirectory of ORACLE_HOME\ORD80\TS\DEMO 
for instructions on configuring the demo that you want to use (for example, 
directory PROC for Pro*C).

4. Follow the README file instructions in the subdirectory to configure the demo.

Demo This Demo...

Usage Creates a sample database for use with Oracle8 Time Series Cartridge 
and demonstrates several basic queries. This demo is used as the basis 
for all five demos. 

Extend Includes sample PL/SQL code to extend the functionality of Oracle8 
Time Series Cartridge with new functions. The Oracle8 Objects Option 
is required to extend the Oracle8 Time Series Cartridge.

OCI Provides C examples of client side time series access.

Pro*C Provides examples of several approaches to client side time series 
access. Users must have Pro*C to build this demo.

Developers Includes a Developer 2000 Form that incorporates a Developer 2000 
Graphic, both of which access data using the Oracle8 Time Series 
Cartridge. This demo requires Developer 2000 Release 2.0 or higher.

Note: Each of the five subdirectories contains a README that 
provides configuration instructions.
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Oracle8 Visual Information Retrieval Cartridge 
Oracle Visual Information Retrieval Cartridge stores, retrieves, and manipulates 
image data managed by an Oracle8 database. This cartridge supports image 
storage using BLOBS and references to image data residing in external files 
(BFILEs). This cartridge is a building block for various imaging applications, rather 
than being an end-user application. Some example applications for this cartridge 
are digital art galleries and museums, real estate marketing, document imaging, 
and stock photo collections (such as for fashion designers and architects).

Review the table below to determine your configuration responsibilities:

Note: When you select Oracle8 Visual Information Retrieval 
Cartridge for installation, Oracle8 Image Cartridge is installed 
automatically. To function properly, Oracle8 Visual Information 
Retrieval Cartridge requires Oracle8 Image Cartridge.

If You... Then...

Installed Oracle8 Visual Information 
Retrieval Cartridge during the same 
installation as Oracle8 Enterprise Edition

No manual configuration is required. All tasks described in 
“Configuring Oracle8 Visual Information Retrieval Cartridge” 
were automatically performed. 

Installed Oracle8 Visual Information 
Retrieval Cartridge during a separate 
installation from Oracle8 Enterprise 
Edition

You must manually configure Oracle8 Visual Information 
Retrieval by either:

■ Performing the tasks in “Configuring Oracle8 Visual 
Information Retrieval Cartridge”.

■ Starting Oracle Database Assistant and selecting Modify a 
Database. Then following the onscreen instructions.

Want to use the demos Perform the tasks in “Configuring Oracle8 Visual Information 
Retrieval Cartridge Demos”. 

Want to build an Oracle8 Visual 
Information Retrieval Cartridge sample 
application.

Install a C compiler.

Manually copied your Oracle7 
LISTENER.ORA and TNSNAMES.ORA 
files into your Oracle8 network directory

You must modify the TNSNAMES.ORA and LISTENER.ORA 
network configuration files on your server to enable external 
procedure calls to work and Oracle8 Visual Information Retrieval 
Cartridge to function properly. Follow the tasks in “Configuring 
External Procedure Calls” in Chapter 8 of Net8 Getting Started for 
Windows NT and Windows 95.
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Configuring Oracle8 Visual Information Retrieval Cartridge 

To configure Oracle8 Visual Information Retrieval Cartridge:

1. Ensure that Oracle8 Image Cartridge is already configured. If not, see “Oracle8 
Image Cartridge” for instructions.

2. Start Server Manager:

C:\> SVRMGR30

3. Connect to the database with the INTERNAL account:

SVRMGR> CONNECT INTERNAL/PASSWORD

4. Run the following script:

SVRMGR> @%ORACLE_HOME%\ORD80\VIR\ADMIN\ORDRINST.SQL

5. Enter the password for INTERNAL when prompted by the ORDRINST.SQL 
script:

Password: PASSWORD

6. Change the password for ORDSYS (if necessary):

a. Connect to the database with the INTERNAL account:

SVRMGR> CONNECT INTERNAL/PASSWORD

Did not install Oracle8 Objects Option Install Oracle8 Objects Option, which is required for Oracle8 
Visual Information Retrieval Cartridge to function properly.

Want multi-threaded external callout 
functionality

Perform the tasks in “Step 6: Enabling Multi-threaded Callout 
Support” in Chapter 15, “Developing Applications”. 

Note: Oracle8 Visual Information Retrieval Cartridge uses the 
same user name as Oracle8 Image Cartridge and Oracle8 Time 
Series Cartridge (ORDSYS). If you automatically or manually 
configured either of these cartridges first, then the error ORA-
01920 can appear on-screen when running the script below. This 
error message can be ignored.

If You... Then...
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b. Enter the following command:

SVRMGR> ALTER USER ORDSYS IDENTIFIED BY NEW_PASSWORD;

7. Exit Server Manager:

SVRMGR> EXIT

Configuring Oracle8 Visual Information Retrieval Cartridge Demos
Oracle8 Visual Information Retrieval Demos provide a sample demonstration 
showing how an image is extracted from an Oracle8 database.

To configure Oracle8 Visual Information Retrieval Cartridge Demos:

1. Start Server Manager:

C:\> SVRMGR30

2. Connect to the database with the INTERNAL account:

SVRMGR> CONNECT INTERNAL/PASSWORD

3. Run the following script:

SVRMGR> @%ORACLE_HOME%\ORD80\VIR\ADMIN\VIRDEMO.SQL

4. Enter the password for INTERNAL when prompted by the VIRDEMO.SQL 
script:

Password: PASSWORD

5. Exit Server Manager:

SVRMGR> EXIT 

6. Go to the following directory:

CD ORACLE_HOME\ORD80\VIR\DEMO 

7. Make the Oracle8 Visual Information Retrieval Demos program:   

If Using a... Then Enter...

Microsoft C compiler MAKE 

Borland C compiler BMAKE 
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Advanced Replication 
Review the table below to determine your configuration responsibilities:

Configuring Advanced Replication Support
Follow the procedures described below:

■ Step 1: Checking Tablespace Requirements

■ Step 2: Checking Initialization Parameters

■ Step 3: Performing Configuration Tasks

■ Step 4: Monitoring Data Dictionary Tables

■ Step 5: Upgrading Advanced Replication

If You... Then...

Selected:

■ Typical Configuration when 
prompted for a database type 
during Oracle8 Enterprise 
Edition installation. 

■ Oracle8 Enterprise Edition 
during Custom installation in the 
Software Asset Manager window.

■ Advanced Replication while 
creating a customized Oracle8 
Enterprise Edition with Oracle 
Database Assistant

All configuration tasks described in “Configuring Advanced 
Replication Support” were automatically performed. No manual 
configuration is required.

Decided to add replication support to 
a previously installed Oracle8 
Enterprise Edition

You must manually configure Advanced Replication support by 
following the procedures in “Configuring Advanced Replication 
Support”.
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See Oracle8 Enterprise Edition Installation for Windows NT for Advanced Replication 
installation requirements. 

Step 1: Checking Tablespace Requirements
The following are recommended tablespace requirements for Advanced 
Replication:

Additional Information: There are many configuration and 
usage possibilities with Advanced Replication. For more 
information about advanced replication and for definitions of 
master sites and snapshot sites, see:

■ Oracle8 Distributed Database Systems

■ Oracle8 Replication

■ Oracle8 Concepts

■ Oracle8 Administrator’s Guide

Tablespace Requirement

SYSTEM At least 20 MB of free space is required for replication 
packages. Replication triggers and procedures are stored here.

ROLLBACK SEGMENTS ■ Rollback Initial Extent = 50 KB

■ Rollback Next Extent = 50 KB

ROLLBACK At least 5 MB of free space.

TEMPORARY At least 10 MB of free space.

USER No specific requirement.
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Step 2: Checking Initialization Parameters
Certain initialization parameter values must be set or added to the INITSID.ORA 
file (recommended values are included) if you use Advanced Replication.

Master Site  Add these initialization parameters to the master site:

Snapshot Sites  Add these initialization parameters for snapshot sites: 

Step 3: Performing Configuration Tasks
After setting up the INITSID.ORA file with the initialization parameters for 
Advanced Replication, perform the following steps:

To configure Advanced Replication:

1. Start Server Manager:

C:\> SVRMGR30

Parameter Name Recommended Value

SHARED_POOL_SIZE At least 10 MB

DISTRIBUTED_LOCK_TIMEOUT 300 seconds

DISTRIBUTED_TRANSACTIONS 5

GLOBAL_NAMES TRUE

OPEN_LINKS 4

PROCESSES Add 9 to current value

JOB_QUEUE_PROCESSES 2 (depends on number of n-way sites)

JOB_QUEUE_INTERVAL 10 seconds

JOB_QUEUE_KEEP_CONNECTIONS FALSE

Parameter Name Recommended Value

JOB_QUEUE_PROCESSES 2

JOB_QUEUE_INTERVAL 60 seconds

SNAPSHOT_REFRESH_KEEP_CONNECTIONS FALSE
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2. Connect to the database with the INTERNAL account:

SVRMGR> CONNECT INTERNAL/PASSWORD

3. Start the database if it is not currently running:

SVRMGR> STARTUP

4. Run the script CATREP8M.SQL once the database has started. 

The script is found in the ORACLE_HOME\RDBMS80\ADMIN directory. It 
takes approximately one hour to run. Spool output to a log file first before 
running CATREP.SQL.

a. Enter the following command:

SVRMGR> SPOOL OUTPUT.LOG

This creates a file called OUTPUT.LOG to which to output all on-screen 
activity while the SPOOL session is open. 

b. Run CATREP8M.SQL:

SVRMGR> @%RDBMS80%\ADMIN\CATREP8M.SQL

c. Close the SPOOL file by entering OFF when the script completes running:

SVRMGR> SPOOL OFF

OUTPUT.LOG is saved to your current directory.

5. Confirm that CATREP.SQL ran correctly by running a query on ALL_OBJECTS 
where STATUS = ’INVALID’:

SVRMGR> SELECT * FROM ALL_OBJECTS WHERE STATUS = ’INVALID’;

If all package bodies compiled successfully, the following message displays:

0 rows selected.

If you find that any of the package bodies compiled incorrectly, recompile 
them manually. The syntax for running them manually is:

SVRMGR> ALTER PACKAGE PACKAGE NAME COMPILE BODY;

If CATREP.SQL ran successfully, a number of replication tables are created in 
the SYSTEM subdirectory. The database is now set up for Advanced 
Replication support. 

6. Exit Server Manager:

SVRMGR> EXIT
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7. See Oracle8 Replication for details on setting up: 

■ master definition site

■ master sites 

■ updatable snapshot sites

■ conflict resolution

Step 4: Monitoring Data Dictionary Tables
The practical limit to the number of master sites an environment can have is 36. The 
processes SNP0 to SNP9 (total of 10) and SNPA to SNPZ (total of 26) each handle 
one destination master at a time.

If you use Advanced Replication and intend to set up a large number of replicated 
objects, monitor the following data dictionary tables with the SQL SELECT 
command:

If necessary, increase the storage parameters to accommodate the storage 
requirements of large numbers of replicated objects.

Step 5: Upgrading Advanced Replication
If you are upgrading from a previous version of the Oracle8 database and want to 
use Advanced Replication, you must first complete the upgrade (see Chapter 7, 
“Migrating and Upgrading” in this guide). After upgrading, Advanced Replication 
is automatically installed with the Oracle8 database during Release 8.0 installation 
(see Oracle8 Enterprise Edition Installation for Windows NT).

Note:   Execute the following statement on the master site when setting up 
updatable snapshot sites:

SVRMGR> GRANT EXECUTE ON DBMSOBJGWRAPPER TO PUBLIC;

SOURCE$ I_ARGUMENT1

IDL_UB1$ IDL_SB4$

IDL_UB2$ IDL_CHAR$

I_SOURCE1I$ TRIGGER$

ARGUMENT$
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Advanced Replication is an advanced feature. Please consult your Oracle8 
Replication documentation for concepts and details before proceeding. For 
additional information, contact Oracle Education.



                                                            Creating a Data
9

Creating a Database

This chapter describes how to create a database.

Specific topics discussed are:

■ Naming Conventions for Oracle8 Databases

■ Creating a Database Overview

■ Using Oracle Database Assistant

■ Using BUILD_DB.SQL
base 9-1



Creating a Database Overview
Naming Conventions for Oracle8 Databases 
Before creating a database, it is important to understand that starting with Oracle8 
Enterprise Edition, all mounted Oracle databases in a network must have unique 
database names. A database name is associated with a database at “CREATE 
DATABASE” time and stored in the control file(s) of the database. If the database 
keyword is provided in the CREATE DATABASE statement, then that value 
becomes the database name for that database. If not, then the value of the 
DB_NAME parameter in the INITSID.ORA file is used. If the DB_NAME 
parameter is not specified, then the default DB_NAME value is ORACLE. 

If you attempt to mount two Oracle8 databases with the same database name, you 
receive the following error during the second mount:

ORA-01102: cannot mount database in EXCLUSIVE mode 

If there are two or more Oracle8 databases on the same computer located in 
different Oracle homes:

■ each database name must be unique

■ each SID must be unique

To change the name of an existing database, you must use the CREATE 
CONTROLFILE statement to recreate your control file(s) and specify a new 
database name. This restriction is imposed only on Oracle8 instances. Any Oracle7 
instances running simultaneously with an Oracle8 instance are not subject to this 
restriction.

Creating a Database Overview
This section describes how to create a new database. You can choose either of the 
following tools to create a database:

■ Oracle Database Assistant

■ BUILD_DB.SQL script

Use Oracle Database Assistant to create a database because it is the easiest method. 
If you want to create a database using command line tools, you can use the 
BUILD_DB.SQL script located in ORACLE_HOME\RDBMS80\ADMIN. 
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Using Oracle Database Assistant
During installation of Oracle8 Enterprise Edition, you can select either the Typical 
Configuration option or Custom Configuration option to create a database with 
Oracle Database Assistant. If you already have a database, or do not want to create 
a database during the installation process, you can choose to use this assistant to 
create a database at a later date.

To create a database using Oracle Database Assistant:

1. Choose Start > Programs > Oracle for Windows NT - [HOME_NAME] > Oracle 
Database Assistant.

The Oracle Database Assistant welcome window appears:

  

2. Select Create a database, then click Next.
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The following window appears:

3. Choose the Typical or Custom option to create a database.

4. Respond to instructions in each Oracle Database Assistant window, then click 
Next when you are ready to continue to the next screen. When you get to the 
last screen, click Finish to start the creation of the Oracle8 database. 

Option Description

Typical Creates a standard database with default INITSID.ORA 
parameter settings.

Custom Customizes the creation of your database. This option is 
only for Oracle database administrators experienced with 
advanced database creation procedures, such as 
customizing: 

■ Data, control, and redo log file settings 

■ Tablespace sizes 

■ Extent sizes 

■ Database memory parameters 

■ Archiving formats and destinations 

■ Trace file destinations 

■ Character set values 
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Configure Oracle8 Cartridges Using Oracle Database Assistant
You can modify a Custom Configuration Oracle8 database to support the following 
cartridges that you installed through the Custom installation option on your CD-
ROM, but have not yet configured:

■ Oracle8 Spatial Cartridge

■ Oracle8 Image Cartridge

■ Oracle8 ConText Cartridge

■ Oracle8 Time Series Cartridge

■ Oracle8 Visual Information Retrieval Cartridge

Cartridges installed through the Custom Installation option are not automatically 
configured during installation. The Modify option of Oracle Database Assistant 
automatically configures your cartridges. If you installed Oracle cartridges through 
the Oracle8 Enterprise Edition option on the CD-ROM, your cartridges were 
automatically configured for the starter database ORCL. 

Delete a Database Using Oracle Database Assistant
The Delete a Database option of Oracle Database Assistant lets you quickly and 
easily delete databases.

Enable and Disable Multi-Threaded Support Using Oracle Database Assistant
You can choose options in Oracle Database Assistant to enable or disable multi-
threaded server support in your Oracle8 database. Multi-threaded server (MTS) 
support enables many client user processes to share a small number of server 
processes. Many client users can connect to a dispatcher process. The dispatcher 
process then routes client requests to the next available shared server process. 
There is no dedicated server process for each user process that remains associated 
with the client user process for the duration of the connection. Instead, inactive 
server processes are “recycled” and used as needed. This reduces system overhead 
and enables you to increase the number of supported users. See Net8 
Administrator’s Guide, Oracle8 Server Concepts, and Oracle8 Reference for more 
information. 

Note: If you installed the Oracle8 Visual Information Retrieval 
Cartridge and its check box is shaded, you must select the Oracle8 
Image Cartridge check box first. This action clears the Oracle8 
Visual Information Retrieval Cartridge check box.
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Using BUILD_DB.SQL
This section describes the steps to create a database manually. There are a number 
of ways to create a database depending on if you want to:

■ Copy an existing database to a new database and remove the old database.

■ Copy an existing database to a new database and keep the old database.

■ Create a new database when no other database exists on your system that you 
can copy.

The table below summarizes the steps to create a new database for each of the 
above database creation scenarios. Each step is explained in detail in the following 
sub-sections.

Perform These Tasks... If You Want To...

Copy an existing 
database and 
remove the old 
database

Copy an existing 
database and keep 
the old database

Create a new 
database when no 
other database 
exists that you can 
copy

Export an Existing Database Yes Yes. Only if you want 
to copy data from an 
existing database to the 
additional database

Not applicable

Delete Database Files Yes No Not applicable

Modify the INITSID.ORA File Yes Yes Yes

Create and Start an Oracle8 Service No Yes Yes

Put CREATE DATABASE Statement in a Script Yes Yes Yes

Create a Database Yes Yes Yes

Import a Database Yes Yes. Only if you want 
to import tables and 
other objects exported 
from an existing 
database

Not applicable

Update ORACLE_SID in the Registry No Only if you want to 
change the default SID

Yes

Back Up the New Database Yes Yes Yes
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Create Database Example
An example is used in the following sections to demonstrate the commands to 
create a database. In this example, you will copy an existing database (the starter 
database with a SID of ORCL located in the C:\ ORANT directory) to a new 
database with a SID of PROD located in the C:\MYDIR directory. You will delete 
the ORCL database after you have created the PROD database.

Create \MYDIR Directory
Create a directory, for example, C:\MYDIR in which to put the new database 
PROD.

Export an Existing Database 
It is only necessary to export if you want to copy the contents of an existing 
database to a new database. You must perform this task if you are going to remove 
the old database and put its data in the new database. If you are going to create an 
additional database, you only need to this if you want a copy of the data from the 
old database in the new database.

To export all data from an existing database to a new database:

1. Set ORACLE_SID to the database service of the database whose contents you 
want to export. For example, if the database you want to export is the starter 
database ORCL, enter the following at the MS-DOS command prompt. Note 
there are no spaces around the equal sign (=) character.

C:\ORANT> SET ORACLE_SID=ORCL 

2. Start the Export utility from the MS-DOS command prompt: 

C:\ORANT> EXP80 SYSTEM/PASSWORD FILE=MYEXP.DMP FULL=Y LOG=MYEXP.LOG 

You now have a full database export of the starter database ORCL in the file 
MYEXP.DMP, with all messages from the Export utility logged in the 
MYEXP.LOG file.
                                                                   Creating a Database 9-7



Using BUILD_DB.SQL
Delete Database Files
It is only necessary to delete database files if you want to copy an existing database 
to a new database and then remove the old database.

To delete database files:

1. Shut down the starter database ORCL at the MS-DOS command prompt:

C:\ORANT> ORADIM80 -SHUTDOWN -SID ORCL -USRPWD PASSWORD -SHUTTYPE INST 

-SHUTMODE I

2. Delete the following database files located in the ORANT\DATABASE 
directory:

■ SYS1ORCL.ORA

■ USR1ORCL.ORA

■ RBS1ORCL.ORA

■ TMP1ORCL.ORA

■ LOG1ORCL.ORA

■ LOG2ORCL.ORA

■ LOG3ORCL.ORA

■ LOG4ORCL.ORA

■ CTL1ORCL.ORA

LOG3ORCL.ORA AND LOG4ORCL.ORA database files are only available with 
release 7.3.4 and 8.0.4 databases. Do not delete the INITORCL.ORA file, as it will be 
the basis for the new initialization parameter file INITPROD.ORA in “Modify the 
INITSID.ORA File”.    
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Modify the INITSID.ORA File 
If you are using the starter database ORCL as the basis for your new database, copy 
C:\ORANT\DATABASE\INITORCL.ORA to C:\MYDIR\DATABASE\ 
INITPROD.ORA and modify the file.

If you do not have an existing database on your system, you cannot copy an 
initialization parameter file to use as the basis for your INITPROD.ORA file. You 
can use the sample initialization parameter file INITORCL.80 provided in the 
C:\ORANT\DATABASE directory as the basis for INITPROD.ORA. 

You must modify the CONTROL_FILES and DB_NAME initialization parameters 
in the INITPROD.ORA file or you will not be able to start the PROD database. 
Modifying the initialization parameters GLOBAL_NAMES and DB_FILES is highly 
recommended to optimize performance.  

Initialization Parameter How to Modify...

CONTROL_FILES This parameter lists the control files of the database. You do 
not have the control files on your file system at this point, 
because the control files are created when you execute the 
CREATE DATABASE statement. 

Ensure you specify the complete path and file name, 
including drive letter. For example,

CONTROL_FILES = 
(C:\MYDIR\DATABASE\CTL1PROD.ORA, 

ORACLE_HOME\DATABASE\CTL2PROD.ORA) 

DB_NAME This parameter indicates the name of the database, and 
must match the name used in the CREATE DATABASE 
statement in “Using BUILD_DB.SQL” in this chapter. This 
name does not need to match the SID of the database 
service. You give a unique database name to each database. 
For example, 

DB_NAME=PROD.

You can use up to eight characters for the database name. 

GLOBAL_NAMES The default value of this parameter is FALSE; however, it is 
recommended to set this parameter to TRUE. See the Oracle8 
Administrator’s Guide to find out more about global names 
and how they relate to database links. 
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Create and Start an Oracle8 Service
It is only necessary to create and start an Oracle8 service if you want to:

■ Copy an existing database to a new database and keep the old database.

■ Create a new database when no other database exists on your system that you 
can copy.

Before you create the database, first create a Windows NT service to run the 
database. This service is the Oracle8 database process, ORACLE80.EXE, installed in 
the form of a Windows NT service. Use ORADIM80 to create the service. Upon 
creation, the service starts automatically. See “Using ORADIM80” in Chapter 3, 
“Database Tools Overview”, for information on how to use ORADIM80. 

To create a Windows NT service:

1. Go to the \MYDIR directory.

C:\> CD MYDIR

2. Run ORADIM80 from the MS-DOS command prompt:

C:\MYDIR> ORADIM80 -NEW -SID PROD -INTPWD PASSWORD -STARTMODE AUTO 

-PFILE C:\MYDIR\DATABASE\INITPROD.ORA 

Note that the previously created INITPROD.ORA file is specified, with 
complete path, including drive name. You do not receive a message indicating 
the success or failure of this command. You can check if the service is started in 
the services window of the Windows NT Control Panel. 

3. Set ORACLE_SID to equal PROD. Note there are no spaces around the equal 
sign (=) character:

C:\MYDIR> SET ORACLE_SID=PROD 

DB_FILES Set this initialization parameter to the same number as the 
value of the MAXDATAFILES option of the CREATE 
DATABASE statement. The value of 100 is used for this 
example. 

DB_FILES=100

Additional Information: See Appendix B, “Initialization 
Parameters” for information on other initialization parameters you 
may want to add to the INITPROD.ORA file.

Initialization Parameter How to Modify...
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Put CREATE DATABASE Statement in a Script
The CREATE DATABASE statement is a sequence of SQL statements that creates 
the database. Create a script containing this statement that you can reuse anytime 
you want to create a database. Use the BUILD_DB.SQL script located in 
C:\ORANT\RDBMS80\ADMIN as a basis for your script. 

To prepare the CREATE DATABASE script:

1. Copy C:\ORANT\RDBMS80\ADMIN\BUILD_DB.SQL to 
C:\MYDIR\RDBMS80\ADMIN\BUILD_PROD.SQL and make the following 
changes to the BUILD_PROD.SQL script:

a. Set PFILE so it points to the C:\MYDIR\DATABASE\INITPROD.ORA 
initialization file.

b. Modify CREATE DATABASE ORACLE to CREATE DATABASE PROD.

c. Modify all the log file and data file names. Change all occurrences of ORCL 
to PROD. For example, change LOG1ORCL.ORA to LOG1PROD.ORA.

d. Modify the location of the Oracle home directory including drive name if 
necessary. Change all occurrences of ORANT to MYDIR. For example, 
change C:\ORANT\DATABASE to C:\MYDIR\DATABASE.

A sample script follows:

-- This file must be run out of the directory containing the 

-- initialization file. 

startup nomount pfile=C:\mydir\DATABASE\initprod.ora 

--  Create database 

create database prod 

controlfile reuse 

logfile ’C:\mydir\DATABASE\log1prod.ora’ size 1M reuse, 

’C:\mydir\DATABASE\log2prod.ora’ size 1M reuse, 

’C:\mydir\DATABASE\log3prod.ora’ size 1M reuse, 

’C:\mydir\DATABASE\log4prod.ora’ size 1M reuse, 

datafile ’C:\mydir\DATABASE\sys1prod.ora’ size 10M reuse autoextend on 

next 10M maxsize 200M 

character set WE8ISO8859P1;  
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create rollback segment rb_temp;  

-- Create additioanal tablespaces ...  

-- USER_DATA: Create user sets this as the default tablespace 

-- TEMPORARY_DATA: Create user sets this as the temporary tablespace 

-- ROLLBACK_DATA: For rollback segments 

create tablespace user_data 

datafile ’C:\mydir\DATABASE\usr1prod.ora’ size 3M reuse autoextend on 

next 5M maxsize 150M; 

create tablespace rollback_data 

datafile ’C:\mydir\DATABASE\rbs1prod.ora’ size 5M reuse autoextend on 

next 5M maxsize 150M; 

create tablespace temporary_data 

datafile ’C:\mydir\DATABASE\tmp1prod.ora’ size 2M reuse autoextend on 

next 5M maxsize 150M; 

alter rollback segment rb_temp online;- 

-- Change the SYSTEM users' password, default tablespace and 

-- temporary tablespace. 

alter user system temporary tablespace temporary_data; 

alter user system default tablespace user_data; 

-- Create 16 rollback segments.  Allows 16 concurrent users with open 

-- transactions updating the database. This should be enough. 

create public rollback segment rb1 storage(initial 50K next 50K) 

tablespace rollback_data; 

create public rollback segment rb2 storage(initial 50K next 50K) 

tablespace rollback_data; 

create public rollback segment rb3 storage(initial 50K next 50K) 

tablespace rollback_data; 

create public rollback segment rb4 storage(initial 50K next 50K) 

tablespace rollback_data; 
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create public rollback segment rb5 storage(initial 50K next 50K) 

tablespace rollback_data; 

create public rollback segment rb6 storage(initial 50K next 50K) 

tablespace rollback_data; 

create public rollback segment rb7 storage(initial 50K next 50K) 

tablespace rollback_data; 

create public rollback segment rb8 storage(initial 50K next 50K) 

tablespace rollback_data; 

create public rollback segment rb9 storage(initial 50K next 50K) 

tablespace rollback_data; 

create public rollback segment rb10 storage(initial 50K next 50K) 

tablespace rollback_data; 

create public rollback segment rb11 storage(initial 50K next 50K) 

tablespace rollback_data; 

create public rollback segment rb12 storage(initial 50K next 50K) 

tablespace rollback_data; 

create public rollback segment rb13 storage(initial 50K next 50K) 

tablespace rollback_data; 

create public rollback segment rb14 storage(initial 50K next 50K) 

tablespace rollback_data; 

create public rollback segment rb15 storage(initial 50K next 50K) 

tablespace rollback_data; 

create public rollback segment rb16 storage(initial 50K next 50K) 

tablespace rollback_data; 

You will run this script at the Server Manager prompt in the section, “Create a 
Database”. 
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Create a Database
Before you run the BUILD_PROD.SQL script to create a database, you must 
perform the following tasks:

1. Check if the service is started in the Windows NT Control Panel. In this 
example, the service name is OracleServicePROD, and its status column should 
display Started. If not, single-click the service name and choose the Start button 
to start the service. Alternatively, check the status of the service by entering the 
following at the MS-DOS command prompt. 

C:\MYDIR> NET START 

A list of all Windows NT services currently running on the system appears. If 
OracleServicePROD is missing from the list, enter: 

C:\MYDIR> NET START ORACLESERVICEPROD 

2. Make PROD the current SID: 

C:\MYDIR> SET ORACLE_SID=PROD 

3. Start Server Manager from the MS-DOS command prompt, and connect to the 
database as INTERNAL:

C:\MYDIR> SVRMGR30
SVRMGR> CONNECT INTERNAL/PASSWORD 

The password is the one you previously used to create the service, with the 
ORADIM80 -NEW command in “To create a Windows NT service:”. You 
should see the message Connected.

4. Start the database in NOMOUNT mode: 

SVRMGR> STARTUP NOMOUNT PFILE=C:\MYDIR\DATABASE\INITPROD.ORA 

When the initialization parameter file INITPROD.ORA is located in the 
DATABASE subdirectory of your Oracle home directory, the PFILE 
specification is optional. Otherwise, you must specify the PFILE option with 
the complete path and file name of the initialization parameter file. Note that 
there is an equal sign (=) between the keyword PFILE and the path/filename. 
There are no space characters around the equal sign (=). 

5. Turn on spooling to save the messages and run the BUILD_PROD.SQL script 
you created in the section, “Put CREATE DATABASE Statement in a Script”:  

SVRMGR> SPOOL BUILD_PROD.SQL.LOG 
SVRMGR> @BUILD_PROD.SQL 
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This command assumes the script file is located in the directory from which 
Server Manager was invoked. If this is not the case, specify the complete path 
in front of the file name. If the database is created successfully, the message 
Statement processed appears. If you receive any errors, there are three possible 
causes: 

■ The BUILD_PROD.SQL script contained syntax errors. Correct them.

■ Some of the files to be created by the BUILD_PROD.SQL script already 
exist in the file system. Make sure you are not using any file names already 
used by another database on the system.

■ There was an error at the operating system level, such as a file or directory 
permission problem. You should have received a series of errors in Server 
Manager, the last one of which should have the OSD- prefix. At the end of 
the OSD error you typically see an operating system error number in 
parentheses. To see what the error means:

From the MS-DOS command prompt, enter:

C:\> NET HELPMSG n 
or 

From the Server Manager prompt, enter: 

SVRMGR> HOST NET HELPMSG n 
where n is the operating system error number. See “Operating System 
Permission Issues” in Appendix F, “Troubleshooting” for more 
information.

You must correct these problems before attempting to recreate a database.   

6. Run the following script to generate the data dictionary:

SVRMGR> @%RDBMS80%\ADMIN\CATALOG.SQL 

7. Run the following script to install the objects used by the Oracle8 database's 
PL/SQL functionality: 

SVRMGR> @%RDBMS80%\ADMIN\CATPROC.SQL 

8. Run the following script if you want Advanced Replication functionality with 
the new database: 

SVRMGR> @%RDBMS80%\ADMIN\CATREP8M.SQL 

Note that CATREP8M.SQL requires at least an hour to run, depending on your 
system.
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9. Turn off spooling after all scripts have finished running: 

SVRMGR> SPOOL OFF 

10. Examine the BUILD_PROD.SQL.LOG file for any errors.  

Import a Database
You can choose to import the full export created in the section “Export an Existing 
Database” into the new database. 

1. Exit Server Manager:

SVRMGR> EXIT 

2. Run the Import utility:

C:\MYDIR> IMP80 SYSTEM/PASSWORD FILE=MYEXP.DMP FULL=Y LOG=MYIMP.LOG  

Note: You may see many messages such as object to be dropped does 
not exist and name already used by another object while the scripts are 
running. These are information messages and are intended to 
occur while creating a new database. If you see any unusual errors 
in the BUILD_PROD.SQL.LOG log file, see Oracle8 Server Messages 
for suggested actions. 

IMPORTANT: The new database contains two users, SYS and 
SYSTEM, with passwords CHANGE_ON_INSTALL and 
MANAGER, respectively. For security reasons, change the 
passwords now. Use the ALTER USER statement to change the 
passwords:

SVRMGR> ALTER USER SYS IDENTIFIED BY NEW_SYS_PASSWORD; 
SVRMGR> ALTER USER SYSTEM IDENTIFIED BY NEW_SYSTEM_PASSWORD; 
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Update ORACLE_SID in the Registry 
If this is the first database on the system or if you want to make the new database 
the default database, you must make a change in the registry. 

1. Invoke the registry editor at the MS-DOS command prompt by entering 
REGEDT32. For example:

C:\MYDIR> REGEDT32 

The registry editor window appears.

2. Choose the \HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID 
subkey for the first Oracle home on your computer. For subsequent 
installations to different Oracle homes on the same computer, the path is 
\HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\NLS_LANG\HOMEID 
WHERE ID is the unique number identifying the Oracle home. See 
Appendix C, “Configuration Parameters and the Registry” for more 
information on the subkey locations for multiple Oracle homes. 

3. Locate the ORACLE_SID parameter on the right side of the registry editor 
window.

4. Double-click the parameter name, and change the data to the new SID, which is 
PROD in this example.

If you do not have ORACLE_SID because this is the first database on your system, 
you must create the ORACLE_SID parameter.

To create ORACLE_SID parameter:

1. Start the registry in either of two ways:

■ From the MS-DOS command prompt, enter:

C:\> REGEDT32

■ Choose Start > Run, enter REGEDT32 in the Open field, and click OK.

IMPORTANT: If the original database from which the export file 
was generated contains tablespaces that are not in the new 
database, then the Import utility attempts to create those 
tablespaces with associated data files. The easy solution is to 
ensure both databases contain the same tablespaces. The data 
files do not have to be identical. Only the tablespace names are 
important.
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The registry editor window appears.

2. Navigate to the 
\HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID key. 

3. Choose the Add Value... option in the Edit menu.

The Add Value dialog box appears:

4. Enter ORACLE_SID in the Value Name field.

5. Enter REG_EXPAND_SZ (for an expandable string) in the Data Type box

6. Click OK.

A string editor dialog box appropriate for the data type appears:

7. Enter PROD in the string editor dialog box

The registry editor adds the ORACLE_SID parameter. 

8. Choose Exit from the registry menu.

The registry exits.
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Back Up the New Database 

To back up the new database:

1. Shut down the database instance and stop the service: 

C:\MYDIR> ORADIM80 -SHUTDOWN -SID PROD -USRPWD PASSWORD 

-SHUTTYPE SRVC,INST -SHUTMODE I 

2. Using the tool of your choice, back up the database files. Data files consist of 
the initialization parameter file, control files, online redo log files, and data files.

You can now start the database again, create users and objects if necessary, 
make any other changes, and use the database. Ensure you make a database 
backup, if possible, after making any significant change to the database, such 
as switching the ARCHIVELOG mode or adding a tablespace or data file.

WARNING: If anything goes wrong while operating the new 
database without a backup, you must repeat the database 
creation procedure. Back up your database now to prevent such 
damage. 

WARNING: Although ORADIM80 returns the prompt 
immediately, you must wait for the database and the service to 
stop completely before continuing to Step 2. Wait until the 
Control Panel indicates the OracleServicePROD service has 
stopped. If you do not do this, the backup may be useless as it 
was taken while data was being written to the data files.

Additional Information: See Chapter 13, “Backing Up and 
Recovering Database Files”, Oracle8 Concepts, Oracle8 Backup and 
Recovery, and Oracle8 Administrator’s Guide for more information on 
archiving and backup/recovery.
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10
 Administering a Database

This chapter describes how to administer Oracle8 Enterprise Edition.

Specific topics discussed are:

■ Managing Oracle Services

■ Starting and Shutting Down a Database with Server Manager

■ Starting and Shutting Down a Database with Oracle Enterprise Manager

■ Shutting Down a Database By Stopping a Service

■ Running Multiple Instances

■ Creating Password Files

■ Connecting as INTERNAL with a Password File

■ Changing the INTERNAL Password

■ Encrypting Database Passwords

■ Downloading Patches from Oracle Worldwide Customer Support

■ Using the ORADEBUG Utility
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This section provides information on the following:

■ Oracle Service Naming Conventions for Multiple Oracle Homes

■ Available Oracle Services

■ Starting Oracle Services

■ Stopping Oracle Services

■ Auto-starting Oracle Services

Oracle Service Naming Conventions for Multiple Oracle Homes
Oracle8 Enterprise Edition allows you to have multiple, active Oracle home 
directories on a single computer. Chapter 6, “Using Multiple Oracle Homes” 
describes this feature. Multiple Oracle homes affect the naming conventions for 
Oracle services. If you have only one Oracle home directory on a computer, there 
are no differences between the naming conventions for service names in this 
release and previous releases (that is, no Oracle home name and the SID is typically 
the default of ORCL). However, as you perform additional installations into Oracle 
home directories:

■ you must specify a different Oracle Home name for each Oracle home 
directory during installation, which is added to some service names

■ your system identifier (SID) is automatically incremented with each Oracle8 
database installation

This affects service names. This table describes how two service names, 
OracleTNSListener80 and OracleServiceORCL, are affected when you install three 
Oracle8 databases into separate directories:

For the... The Home Name is... The SID is Named... The Services are Named...

First Oracle home 
installation on a 
computer.

Not required. ORCL OracleTNSListener80 
OracleServiceORCL

Second Oracle home 
installation on a 
computer.

Required; for this example, 
PROD is entered when 
prompted during installation.

ORC1 OraclePRODTNSListener80
OracleServiceORC1

Third Oracle home 
installation on a 
computer.

Required; for this example, 
SALES is entered when 
prompted during installation.

ORC2 OracleSALESTNSListener80
OracleServiceORC2
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These two figures show how the Services dialog box appears with two Oracle8 
database on a single computer: 

.

Service names for first 
Oracle8 database 
installation. No home 
name is required or 
part of service names.

Service names for 
second Oracle8 
database installation. 
The home name of 
PROD is part of service 
names.

Service name for 
second Oracle8 
database installation. 
SID is incremented 
to ORC1.

Service name for first 
Oracle8 database 
installation. Default 
SID of ORCL is used.
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Available Oracle Services
Depending on the products that you have installed, a number of Oracle services are 
started when you restart your Windows NT computer. The three main Oracle 
services are:

See Chapter F, “Troubleshooting” for error messages that you can receive if you 
attempt to connect to the Oracle8 database without these services running.

1 This is the name for this service if you have only one Oracle home directory on your computer. Each 
additional Oracle home directory on your computer uses the naming convention 
OracleHOME_NAMETNSListener80 for this service. See Chapter 6, “Using Multiple Oracle Homes” 
for information.

Service Name Description

OracleServiceSID Created for the database instance SID. An Oracle instance is a 
logical term that refers to:

■ an Oracle service called OracleServiceSID

■ a database

Each Oracle instance must have a system identifier (SID). A 
SID is a unique name for an Oracle database instance that can 
be up to four alphanumeric characters in length. 

For example, if the SID for the Oracle8 database is ORCL, it is 
appended to the service OracleService. Each file for the 
database instance ORCL in the ORACLE_HOME\ 
DATABASE directory has ORCL as part of its name (for 
example, CTL1ORCL.ORA, LOG1ORCL.ORA, and 
INITORCL.ORA). The instance name is the same as the value 
of the ORACLE_SID registry configuration parameter.

To connect to a specific Oracle database, users must specify a 
service name (database alias) that contains a SID for that 
database.

OracleStartSID Starts the database instance SID automatically whenever the 
Windows NT computer restarts.

OracleTNSListener801 Listens for and accepts incoming connection requests from 
client applications. Automatically starts when the Windows 
NT computer restarts.
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Additional Oracle services related to specific products or database features are also 
available:   

Services for network products are also available. See Net8 Getting Started for 
Windows NT and Windows 95 for information on Oracle network services.

1 These are the names for these services if you have only one Oracle home directory on your computer. 
Each additional Oracle home directory on your computer uses the naming convention 
OracleHOME_NAMEConTextService80 or OracleHOME_NAMEExtprocAgent for these services. See 
Chapter 6, “Using Multiple Oracle Homes” for information.

2 This is the name for this service if you have only one Oracle home directory on your computer. Each 
additional Oracle home directory on your computer uses the naming convention 
OracleWebAssistant1, OracleWebAssistant2, and so on for this service. See Chapter 6, “Using 
Multiple Oracle Homes” for information.

Service Name Description

OracleAgent Listens for and responds to job and event requests 
sent from the Oracle Enterprise Manager console.

OracleConTextService801 ConText server processes started on an NT server 
are normally terminated by Windows NT when the 
user logs off. This service can be used to start server 
processes that survive logouts.

OracleExtprocAgent1 Enables external procedure callouts from PL/SQL to 
the database to be implemented with multiple, light-
weight threads instead of a single dedicated process.

OracleWebAssistant2 Enables information from database queries to be 
published to a web page at specified time intervals.
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Starting Oracle Services
Oracle services must be started for you to use the Oracle8 database and its products.

Start Oracle services in either of two ways:

■ From the Control Panel

■ From the MS-DOS command prompt

To start Oracle Services from the Control Panel:

1. Choose Start > Settings > Control Panel.

The Control Panel window appears.

2. Double-click Services.

The Services dialog box appears.

3. Find the service you want to start in the list, and verify that it has a status of 
Started. If it does not, select it and choose Start.

To start Oracle Services from the MS-DOS command prompt:

1. Enter the following command to start an Oracle service at the MS-DOS 
command prompt:

C:\> NET START SERVICE

where SERVICE is a specific service name, such as OracleServiceORCL.

If you cannot find OracleServiceSID or OracleTNSListener80 (or 
OracleHOME_NAMETNSListener80) in the list, use ORADIM80 to create them. See 
Chapter 3, “Database Tools Overview” for instructions on using ORADIM80.

Stopping Oracle Services
On occasion (for example, if you want to re-install the Oracle8 database), you must 
stop Oracle services. Stop Oracle services in either of two ways:

■ From the Control Panel

■ From the MS-DOS Command Prompt

To stop Oracle8 Services from the Control Panel:

1. Choose Start > Settings > Control Panel.

The Control Panel window appears.
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2. Double-click Services.

The Services dialog box appears.

3. Select OracleTNSListener80 (or OracleHOME_NAMETNSListener80, where 
HOME_NAME is the Oracle home name for the listener to stop) and choose 
Stop.

4. Select OracleServiceSID and choose Stop.

The Stopping dialog box informs you that OracleStartSID will also be stopped.

5. Click OK.

Both OracleServiceSID and OracleStartSID are stopped.

To stop Oracle Services from the MS-DOS command prompt:

1. Enter the following command to stop an Oracle service at the MS-DOS 
command prompt:

C:\> NET STOP SERVICE

where SERVICE is a specific service name, such as OracleServiceORCL.

Auto-starting Oracle Services
You can start Oracle services whenever the Windows NT computer is restarted. 
Use the Service dialog box to configure when and how the Oracle8 database is 
started. 

To automatically start the Oracle8 database each time you restart:

1. Choose Start > Settings > Control Panel.

The Control Panel window appears.

2. Double-click Services.

The Services dialog box appears.

3. Select the service OracleStartSID and choose the Startup button.

The Service dialog box appears.

4. Choose Automatic from the Startup Type field.

5. Click OK.

6. Click Close to exit the Services dialog box.
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Starting and Shutting Down a Database with Server Manager
These instructions assume that a database instance is created and the services are 
started.

To start or shut down an Oracle8 database:

1. Go to your Oracle8 database server.

2. Start Server Manager at the MS-DOS command prompt:

C:\> SVRMGR30

3. Connect to the Oracle8 database with the INTERNAL user name:

SVRMGR> CONNECT INTERNAL/PASSWORD

4. Follow the instructions below: 

If You Want to... Then Enter...

Start a database with 
the default parameter 
file

SVRMGR> STARTUP 

This command uses the default INITSID.ORA file located in the 
ORACLE_HOME\DATABASE directory

Start a database with a 
file other than the 
default parameter file

SVRMGR> STARTUP PFILE=PATH\FILENAME 

This command uses the INITSID.ORA file specified in PATH\FILENAME. This 
example starts the database using a file named INIT2.ORA in C:\ORANT 
\RDBMS80:

SVRMGR> STARTUP PFILE=C:\ORANT\RDBMS80\INIT2.ORA

Stop the database SVRMGR> SHUTDOWN [MODE]

where MODE is one of the following:

■ Normal

 The database waits for all currently connected users to disconnect and 
disallows any new connections before shutting down. This is the default mode.

■ Immediate

The database terminates and rolls back active transactions, disconnects clients, 
and shuts down.

■ Abort

The database terminates active transactions and disconnects users; it does not 
roll back transactions. The database performs automatic recovery and rollback 
the next time it is started. Use this mode only in emergencies.



Starting and Shutting Down a Database with Oracle Enterprise Manager

                                                       Administering a Database 10-9

Starting and Shutting Down a Database with Oracle Enterprise Manager
Oracle Enterprise Manager enables you to start and shut down your Oracle8 
database in several different ways. This section describes how to use the Navigator. 
You can also use:

■ SQL Worksheet 

■ Instance Manager 

See the Oracle Enterprise Manager Administrator’s Guide for information on using 
these tools to start your database. 

These instructions assume that a database instance is created and the services are 
started.

To start or shut down a database:

1. Ensure that you:

■ Configured Oracle Enterprise Manager by following the procedures in 
“Oracle Enterprise Manager” in Chapter 8, “Post-Installation 
Configuration Tasks”.

■ Used Net8 Easy Config or Oracle Net8 Assistant to create a network 
connection from your Oracle Enterprise Manager Console computer to the 
Oracle8 database you want to start or shut down. See Net8 Getting Started 
for Windows NT and Windows 95 for instructions.

2. Go to your Oracle Enterprise Manager Console computer.

3. Choose Start > Programs > Oracle Enterprise Manager > Enterprise Manager.

Note:   See “Choosing a Database Tool” in Chapter 3, “Database Tools 
Overview” for a list of other tools that can start the database and the 
Oracle8 Administrator’s Guide for information on options you can specify 
when starting your database.
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The Repository Login Information dialog box appears:

4. Enter the login information you created in “Step 2: Create a Repository User 
Account” of Chapter 8, “Post-Installation Configuration Tasks”:

■ Repository user name and password

■ Net8 service name (or database alias) of the repository database; it is only 
necessary to enter a service name if you are connecting from a client 
console to the Oracle8 repository database on a different computer

The Oracle Enterprise Manager Console appears. The Navigator Window 
displays in the upper-left portion of the console.

Navigator 
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5. Double-click Databases in the Navigator window of the Oracle Enterprise 
Manager Console.

The list of databases in your Oracle Enterprise Manager network appears.

6. If you have never started or shut down a database with the Navigator, you 
must first perform steps 6a through 6h. If you have previously started or shut 
down a database with the Navigator, go to step 7.

a. Select the database to administer.

b. Choose Tools > Applications > Oracle Instance Manager from the main 
menu.

The Login Information dialog box appears.

c. Enter the INTERNAL user name and password, and Net8 service name for 
the Oracle8 database to start up or shut down.

d. Click OK.

The Oracle Instance Manager window appears.

e. Double-click Initialization Parameters in the Navigator tree.

The initialization parameters appear for the Oracle8 database that you 
want to start or shut down.

f. Click Save.

The Save Configuration dialog box appears.

g. Enter an appropriate configuration name for the initialization parameters 
(for example, SALES_DB) and click OK.

This stores the initialization parameter information for the Oracle8 
database in the repository.

h. Choose Exit to Console from the File menu.

You are returned to the Oracle Enterprise Manager Console.
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7. Right-click the database in the Navigator tree that you want to start or stop.

A menu appears with options for starting or shutting down the database:

8. If you have never started or shut down a database with the Navigator, you 
must first perform steps 8a through 8b. If you have previously started or shut 
down a database with the Navigator, go to step 9.

a. Choose Connect from the menu that appears.

The Login Information dialog box appears.

b. Enter the INTERNAL user name and password, and click OK.

You are returned to the same menu with options for starting and shutting 
down the database.
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9. Select one of the following:

If You Want to... Then...

Start the database 1. Choose Startup.

The Startup dialog box appears:

2. Provide the appropriate information and choose OK.

Your Oracle8 database starts.

Shut down the database 1. Choose Shutdown.

The Shutdown Options dialog box appears:

2. Provide the appropriate information and choose OK.

Your Oracle8 database shuts down.
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Shutting Down a Database By Stopping a Service
You can immediately shut down the Oracle8 database by stopping the service 
OracleServiceSID. This automated procedure is equivalent to manually entering 
the following commands:

C:\> SVRMGR30

SVRMGR> CONNECT INTERNAL/PASSWORD

SVRMGR> SHUTDOWN IMMEDIATE

This causes the database to terminate and roll back active transactions, disconnect 
clients, and shut down.

To use this feature, you must set either of two registry parameter values to TRUE in 
registry.

If either of these parameters is set to FALSE (the default setting), you cannot shut 
down the database by stopping OracleServiceSID. In addition, two other registry 
parameters are available:

■ ORA_SHUTDOWN_TIMEOUT, which sets the maximum time to wait for the 
shutdown to complete for any database instance in the current Oracle home.

■ ORA_SID_SHUTDOWN_TIMEOUT, which sets the maximum time to wait 
before the service for a particular SID stops.

ORA_SHUTDOWN_TIMEOUT, ORA_SID_SHUTDOWN, and 
ORA_SID_SHUTDOWN_TIMEOUT must be added to the registry. Where to add 
these parameters is determined by the Oracle home directory that you are using: 

Registry Parameter When set to TRUE...

ORA_SHUTDOWN Enables the selected Oracle8 database to be shut down. This 
includes any database in the current Oracle home.

ORA_SID_SHUTDOWN Shuts down the Oracle8 database identified by the SID value.

If You Have... Then Add These Parameters in...

One home directory HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE

Additional 
directories

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID

where ID is incremented for each additional Oracle home directory 
on your computer.
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To immediately shut down the database by selecting OracleServiceSID:

1. Set ORA_SHUTDOWN or ORA_SID_SHUTDOWN to TRUE in the registry. 
The exact location of these parameters is determined by the number of Oracle 
home directories on your computer: 

See Appendix C, “Configuration Parameters and the Registry” for instructions 
on adding and editing registry parameters.

2. Stop and restart OracleServiceSID and restart the database for the change to 
take effect.

3. Choose Start > Settings > Control Panel.

The Control Panel window appears.

4. Double-click Services.

The Services dialog box appears.

5. Select OracleServiceSID and choose Stop.

This automatically starts Server Manager, issues the SHUTDOWN 
IMMEDIATE command, and shuts down your Oracle8 database.

If You Have... These Parameters are Located in...

One home directory HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE

Two or more home 
directories

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ 
HOMEID

where ID is incremented for each additional Oracle home 
directory on your computer.
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Running Multiple Instances
To run multiple instances, ensure that you have already created each instance and 
started the services for each instance using ORADIM80 or the Services dialog box in 
Windows NT. You then run multiple instances by starting each of the instances 
using Server Manager. 

To run multiple instances:

1. Set the ORACLE_SID configuration parameter at the MS-DOS command 
prompt to the SID for each instance you want to run:

C:\> SET ORACLE_SID=SID

where SID is the name of the Oracle8 database instance.

2. Start Server Manager:

C:\> SVRMGR30

3. Connect as INTERNAL:

SVRMGR> CONNECT INTERNAL/PASSWORD

4. Start up the database with the new instance:

SVRMGR> STARTUP PFILE=ORACLE_HOME\DATABASE\INITSID.ORA

where SID is the name of the instance. With Server Manager, you can use the 
%ORACLE_HOME% variable for ORACLE_HOME.
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Creating Password Files
Use the Password Utility ORAPWD80 to create password files. ORAPWD80 is 
automatically installed with the Oracle8 Utilities. Password files are located in the 
ORACLE_HOME\DATABASE directory and are named PWDSID.ORA, where SID 
identifies the Oracle8 database instance. Password files can be used for local or 
remote connections to an Oracle8 database. The example below describes how to 
perform a local connection. 

To create a password file:

1. Create a password file with ORAPWD80:

C:\> ORAPWD80 FILE=PWDSID.ORA PASSWORD=PASSWORD ENTRIES=MAX_USERS

The essential elements of a password file are:

2. Set the INITSID.ORA file parameter REMOTE_LOGIN_PASSWORDFILE to 
EXCLUSIVE or SHARED. Definitions for all possible values are described 
below:

Element Description

FILE Specifies the password file name.

PASSWORD Sets the password for the INTERNAL and SYS accounts.

ENTRIES Sets the maximum number of entries in the password file. This 
corresponds to the maximum number of distinct users allowed to 
connect to the database with the SYSDBA and SYSOPER DBA 
privileges simultaneously.

Element Description

EXCLUSIVE Specifies that only one instance can use the password file and that the 
password file contains names other than SYS and INTERNAL. Oracle8 
looks in the registry for the value of the ORA_SID_PWFILE 
parameter. If a value is unspecified, it looks in the registry for the 
value of the ORA_PWFILE parameter, which points to a file 
containing the INTERNAL password as well as user names, 
passwords, and privileges. If that is not set, it uses the default of 
ORACLE_HOME\DATABASE\PWDSID.ORA.
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3. Start Server Manager:

C:\> SVRMGR30

4. Connect as INTERNAL:

SVRMGR> CONNECT INTERNAL/PASSWORD

5. Start the Oracle8 database:

SVRMGR> STARTUP

6. Grant appropriate privileges to each user who needs to perform database 
administration. For example:

SVRMGR> GRANT SYSDBA TO SCOTT;

If successful, the following message displays:

Statement Processed.

This adds SCOTT to the password file and enables SCOTT to connect to the 
database with SYSDBA privileges. Use Server Manager to add or delete user 
names, user passwords, and user privileges in password files.

7. Connect to the Oracle8 database with DBA privileges for SCOTT:

SVRMGR> CONNECT SCOTT/TIGER AS SYSDBA

You are connected to the Oracle8 database.

SHARED Specifies that multiple instances can use the password file (for 
example, a parallel server environment). However, the only users 
recognized by the password file are SYS and INTERNAL. You cannot 
log in with SYSOPER or SYSDBA privileges even if those privileges 
are granted in the password file. The SHARED value of this parameter 
affords backward compatibility with earlier releases. The Oracle8 
database looks for the same files as it does when the value is 
EXCLUSIVE, but only the INTERNAL account is available for 
privileged access. This is the default value. 

NONE Specifies that the Oracle8 database ignores the password file and that 
privileged users are authenticated by the Windows NT operating 
system.

Caution:     Copying or manually moving password files may result in 
ORADIM80 not being able to find a password to start an instance.

Element Description
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The password file is automatically hidden. This table describes how to see the 
password file: 

Connecting as INTERNAL with a Password File
You can connect as INTERNAL with a password file. The password for 
INTERNAL is ORACLE if you installed Oracle8 Enterprise Edition through the 
Oracle8 Enterprise Edition option. If you installed Oracle8 Enterprise Edition 
through the Custom installation option, the password for INTERNAL is whatever 
you entered when prompted during installation.

To connect as INTERNAL with a password file:

1. Follow the procedures in “Creating Password Files” to create a password file 
with ORAPWD80.

2. Set the INITSID.ORA file parameter REMOTE_LOGIN_PASSWORDFILE to 
EXCLUSIVE or SHARED.

3. Connect to your Oracle8 database as follows:

SVRMGR> CONNECT INTERNAL/PASSWORD

where PASSWORD is the password created with ORAPWD80 or ORADIM80.

To... Enter...

See the password file C:\ORANT\DATABASE> ATTRIB

The password file displays:

A   H      C:\ORANT\DATABASE\PWDSID.ORA

Make the password file 
visible

C:\ORANT\DATABASE> ATTRIB -H PWDSID.ORA

Note: The password file must be visible before you 
can move or copy it. 

Hide the password file again C:\ORANT\DATABASE> ATTRIB +H PWDSID.ORA

Note:   When REMOTE_LOGIN_PASSWORDFILE is set to NONE, 
connecting remotely to a database as INTERNAL is prohibited even if the 
correct password is supplied.
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Changing the INTERNAL Password
Change the INTERNAL user account password with either ORADIM80 or 
ORAPWD80.

To change the password with ORADIM80:

1. Delete the SID for the password you want to change:

C:\> ORADIM80 -DELETE -SID SID 

where SID is the SID to delete.

2. Create the same SID again and specify a new INTERNAL password:

C:\> ORADIM80 -NEW -SID SID -INTPWD NEW_PASSWORD - MAXUSERS N

where SID is the same SID to recreate, NEW_PASSWORD is the new 
INTERNAL password, and N is the maximum number of DBAs/operators 
who can be logged in at once with this password.

To change the password with ORAPWD80:

1. See the Oracle8 Administrator’s Guide for specific instructions on using the 
ORAPWD80 Password Utility.

Encrypting Database Passwords 
With the Oracle8 database, you can encrypt the password used to verify a remote 
database connection. 

To enable password encryption:

1. Add DBLINK_ENCRYPT_LOGIN to the initialization parameter INITSID.ORA 
file on the server computer.

2. Set DBLINK_ENCRYPT_LOGIN equal to TRUE.

3. Set the ORA_ENCRYPT_LOGIN configuration variable on the client computer 
to TRUE. See Appendix C, “Configuration Parameters and the Registry” for 
instructions on adding and setting configuration parameters in the registry.

Once these parameters are set to TRUE, whenever a user attempts a remote login, 
the Oracle8 database encrypts the password before sending it to the remote 
database. If the connection fails, the failure is noted in the audit log. The Oracle8 
database then checks if either of these parameters is set to FALSE. If so, the Oracle8 
database attempts the connection again using an unencrypted version of the 
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password. If the connection is successful, the success is noted in the audit log, and 
the connection proceeds.

Downloading Patches from Oracle Worldwide Customer Support
Oracle Patch Assistant enables you to quickly and easily download patches for 
your Oracle products on Windows NT and Windows 95 through the World Wide 
Web. Two types of patches are available for download and installation:

■ Patch sets

These are collections of bug fixes. If you encounter a bug, it is likely that a fix is 
already available in a patch set.

■ Individual patches

These are patches created for individual customers.

Note that these registry keys are used by Oracle Patch Assistant to start a browser:, 
and to view proxy information. 

Note:   Releases prior to release 7.1 do not support encrypted passwords. If 
you are connecting to an earlier version of the Oracle database, you must 
set the initialization parameter DBLINK_ENCRYPT_LOGIN to FALSE for 
the connection to succeed.

Registry Key Browser

HKEY_CLASSES_ROOT\HTTP\SHELL\OPEN\COMMAND\DDEXEC\APPLICATION Your default browser

HKEY_CURRENT_USER\SOFTWARE\MICROSOFT\WINDOWS\CURRENTVERSION\ 
INTERNET SETTINGS 

Internet Explorer

HKEY_LOCAL_MACHINE\Software\Netscape\NetscapeNavigator\Users\username\DirRot

where username is the logon account name that is currently running the program.

Netscape 4.0

HKEY_CURRENT_USER\SOFTWARE\NETSCAPE\NETSCAPE NAVIGATOR\PROXY 
INFORMATION 

Netscape (below 4.0)
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To download and install a patch using Oracle Patch Assistant:

1. Ensure you have a Java-enabled browser on your system. If you do not have 
such a browser, you can download one from either of these sites: 

■ Netscape Navigator Version 3.0 or later

Visit http://www.netscape.com

■ Microsoft Internet Explorer Version 3.0 or later

Visit http://www.microsoft.com

Oracle Patch Assistant can only work with a Java-enabled browser.

1. Choose Start > Programs > Oracle for Windows NT - [HOME_NAME] > Oracle 
Patch Assistant. 

The Oracle Patch Assistant welcome window appears:

2. Respond to instructions on each Oracle Patch Assistant window, and click Next 
when you are ready to continue to the next window. When you get to the last 
window, click Finish to complete the downloading and installation of patches. 
More documentation on this product is included with the online help. 
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Using the ORADEBUG Utility
The ORADEBUG utility is a debugging tool that sends debug commands through 
Server Manager to Oracle processes. It is primarily for use by developers and 
Oracle Worldwide Customer Support personnel. Only use this utility when 
instructed to do so by Oracle Worldwide Customer Support. Note that you must 
have database administrator privileges to use ORADEBUG.

To start ORADEBUG: 

1. Start Server Manager from the MS-DOS command prompt and connect to the 
database as INTERNAL. For example:

C:\> SVRMGR30
SVRMGR> CONNECT INTERNAL/PASSWORD

2. Enter the following at the Server Manager prompt:

SVRMGR> ORADEBUG

ORADEBUG runs and prompts you for parameters. To obtain a list of these 
parameters, enter the following at the Server Manager prompt:

SVRMGR> ORADEBUG HELP

The output from most debug commands is written to a trace file. Trace files are 
created in the directory specified by the INITSID.ORA initialization parameters 
BACKGROUND_DUMP_DEST and USER_DUMP_DEST. By default, these 
parameters are set to ORACLE_HOME\RDBMS80\TRACE. If you want to find 
the location of your trace file, enter the following at the Server Manager 
prompt:

SVRMGR> ORADEBUG TRACEFILE_NAME

If the output from a debug command produces more than one line of output, 
the result is sent to a trace file, and a message indicating that the command has 
completed is relayed to Server Manager. If the output from a debug command 
produces only one line of output, the output is relayed directly to Server 
Manager. 

Note: There is currently a limitation when using ORADEBUG 
that can cause Server Manager to hang if you attempt to debug a 
thread that is blocking on input/output (I/O) until that I/O 
completes.
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11
 Authenticating Database Users with

Windows NT

This chapter describes how to authenticate Oracle8 database users with Windows 
NT.

Specific topics discussed are:

■ Authentication Overview

■ Connecting Without a Password as a Nonprivileged Database User

■ Connecting as SYSOPER and SYSDBA Without a Password

■ Connecting as INTERNAL Without a Password

■ Granting Database Roles through Windows NT
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Authentication Overview
The Oracle8 database can use information maintained by Windows NT to 
authenticate database users. The benefits of Windows NT authentication include:

■ Enabling users to connect to an Oracle8 database without supplying a user 
name or password

■ Centralizing Oracle8 database user authorization information in Windows NT, 
which frees Oracle8 from storing or managing user passwords

■ Allowing Oracle8 and Windows NT user names to be the same

The Windows NT Native Authentication Adapter (automatically installed with 
Net8 Server and Net8 Client) enables database user authentication through 
Windows NT. This enables client computers to make secure connections to an 
Oracle8 database on a Windows NT server. A secure connection is when a 
Windows NT client user name is retrieved on a Windows NT server through the 
Windows NT Native Authentication Adapter. The Windows NT server then 
permits the user name to perform the database actions on the server. 

The Windows NT Native Authentication Adapter provides database users with the 
following privileges:

■ Connecting Without a Password as a Nonprivileged Database User

■ Connecting as SYSOPER and SYSDBA Without a Password

■ Connecting as INTERNAL Without a Password

■ Granting Database Roles through Windows NT

Each connection privilege is described in this chapter. 

Attention: Granting database roles through Windows NT is an 
advanced database administration task not appropriate for all 
database environments. You cannot use both Windows NT and the 
Oracle8 database to grant roles concurrently. Select a role granting 
process appropriate to your database environment.
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Connecting Without a Password as a Nonprivileged Database User
This section describes how to authenticate nonprivileged database users 
(nondatabase administrators) using Windows NT so that a password is not 
required when accessing the database. When you use Windows NT to authenticate 
nonprivileged database users, your database relies solely on Windows NT to 
restrict access to database user names. In the steps below, the following Windows 
NT user names are authenticated:

The local and domain user name FRANK and the domain SALES are used in the 
steps below. Substitute the appropriate local and domain user name and domain 
name for your environment.

Follow the steps below to connect without a password as a nonprivileged database 
user:

■ Step 1: Perform Authentication Tasks on the Oracle8 Database Server

■ Step 2: Perform Authentication Tasks on the Client Computer

Note: For Windows NT authentication to work, the 
SQLNET.AUTHENTICATION_SERVICES parameter must be set as 
follows in your ORACLE_HOME\NET80\ADMIN\SQLNET.ORA 
file on both client and server:

SQLNET.AUTHENTICATION_SERVICES = (NTS)

This is the default setting after Net8 Server and Net8 Client 
installation.

User Name This User...

Local user FRANK Logs into their local Windows NT client computer to access an 
Oracle8 database. The database can be on a different computer. 
To access other databases and resources on other computers, 
the local user must provide a user name and password each 
time. 

Domain user FRANK 
on domain SALES

Logs into a domain (SALES in the steps below) that includes 
many other Windows NT computers and resources, one of 
which contains an Oracle8 database. The domain user can 
access all the resources the domain provides with a single user 
name and password.
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Step 1: Perform Authentication Tasks on the Oracle8 Database Server
To perform authentication tasks on an Oracle8 database server:

1. Add the OS_AUTHENT_PREFIX parameter to your INITSID.ORA file.

The OS_AUTHENT_PREFIX value is prefixed to local or domain user names 
attempting to connect to the server with the user’s operating system name and 
password. The prefixed user name is compared with the Oracle user names in 
the database when a connection request is attempted.

2. Set OS_AUTHENT_PREFIX to an appropriate value. For example:

The parameter value XYZ is used in the steps below. Substitute XYZ with the 
value you set for OS_AUTHENT_PREFIX.

3. Use User Manager to create a Windows NT local or domain user name for 
FRANK (if the appropriate name does not currently exist). See your Windows 
NT documentation or your network administrator if you do not know how to 
do this.

Set OS_AUTHENT_PREFIX to... Result

XYZ XYZ is prefixed to the beginning of the 
Windows NT user name (for example, 
XYZFRANK for local user FRANK or 
XYZSALES\FRANK for domain user FRANK 
on domain SALES).

Note:   XYZ is only an example of an 
acceptable parameter value. Use a value 
appropriate to your environment.

 “” This is recommended, as it eliminates the need 
for any prefix to the Windows NT user names 
(for example, FRANK for local user FRANK or 
SALES\FRANK for domain user FRANK on 
domain SALES). 

Not included in INITSID.ORA file The value defaults to OPS$ (for example, 
OPS$FRANK for local user FRANK or 
OPS$SALES\FRANK for domain user FRANK 
on domain SALES).
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4. Follow the substeps below to create a new registry parameter only if you are 
authenticating a domain name (FRANK on domain SALES). Otherwise, go to 
step 5.

a. Start the registry editor from the MS-DOS command prompt:

C:\> REGEDT32

b. Go to the registry subkey of the Oracle home directory that you are using. 
The location in which to add this parameter is determined by how many 
Oracle home directories are on your machine:

c. Choose the Add Value option in the Edit menu.

The Add Value dialog box appears:

d. Enter OSAUTH_PREFIX_DOMAIN in the Value Name field.

e. Choose REG_EXPAND_SZ from the Data Type drop-down list box.

f. Click OK.

If You Have... Go to...

One home directory HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE

Additional 
directories

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ 
HOMEID

where ID is incremented for each additional Oracle home 
directory on your computer.
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The String Editor dialog box appears:

g. Enter TRUE in the String field to enable authentication at the domain level.

TRUE enables the server to differentiate between multiple FRANK user 
names, whether they be local user FRANK, domain user FRANK on 
SALES, or domain user FRANK on another domain in your network. 
Entering FALSE causes the domain to be ignored and local user FRANK to 
become the default value of the operating system user returned to the 
server.

h. Click OK.

The Registry Editor adds the parameter. 

i. Choose Exit from the registry menu.

The registry exits.

5. Ensure that SQLNET.AUTHENTICATION_SERVICES is set as follows in your 
ORACLE_HOME\NET80\ADMIN\SQLNET.ORA file:

SQLNET.AUTHENTICATION_SERVICES = (NTS)

6. Start Server Manager:

C:\> SVRMGR30

7. Connect to the database with the SYSTEM database administrator (DBA) name:

SVRMGR> CONNECT SYSTEM/PASSWORD

Unless you have changed it, the SYSTEM password is MANAGER by default.
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8. Create an operating system-authenticated user by entering the following:

9. Grant the Windows NT local user FRANK or domain user FRANK appropriate 
database roles:

10. Connect to the database with the INTERNAL DBA name:

SVRMGR> CONNECT INTERNAL/PASSWORD

11. Shut down the database:

SVRMGR> SHUTDOWN

12. Restart the database:

SVRMGR> STARTUP

This causes the change to the OS_AUTHENT_PREFIX parameter value to take 
effect.

1 Enter the syntax for domain users in uppercase and with double quotes around the domain user 
name.

If Authenticating a... Then Enter...

Local user name SVRMGR> CREATE USER XYZFRANK IDENTIFIED EXTERNALLY;

Domain user name SVRMGR> CREATE USER “XYZSALES\FRANK” IDENTIFIED 
EXTERNALLY;

where: Is the...

XYZ Value set for the OS_AUTHENT_PREFIX initialization parameter.

FRANK Windows NT local user name.

SALES\FRANK Domain name and Windows NT domain user name. The double 
quotes are required and the entire syntax must be in uppercase.

If Authenticating a... Then Enter...

Local user name SVRMGR> GRANT RESOURCE TO XYZFRANK;

SVRMGR> GRANT CONNECT TO XYZFRANK;

Domain user name1 SVRMGR> GRANT RESOURCE TO “XYZSALES\FRANK”;

SVRMGR> GRANT CONNECT TO “XYZSALES\FRANK”;
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Step 2: Perform Authentication Tasks on the Client Computer
To perform authentication tasks on the client computer:

1. Create Windows NT local or domain user name FRANK with the same user 
name and password that exist on the Windows NT server (if the appropriate 
name does not currently exist).

2. Ensure that SQLNET.AUTHENTICATION_SERVICES is set as follows in your 
ORACLE_HOME\NET80\ADMIN\SQLNET.ORA file:

SQLNET.AUTHENTICATION_SERVICES = (NTS)

3. Use Net8 Assistant or Oracle Net8 Easy Config to create a network connection 
from your client computer to the Windows NT server on which your Oracle8 
database is installed. See Net8 Getting Started for Windows NT and Windows 95 
for instructions.

4. Access the Oracle8 database from your client computer in either of two ways:

■ Log onto a client computer with local or domain user name FRANK.

■ Access a shared area on the Windows NT computer hosting the Oracle8 
database with the local or domain user name (for example, using NET 
USE).

5.  Start Server Manager:

C:\> SVRMGR30

6. Connect to your Windows NT server:

SVRMGR> CONNECT /@SERVICE_NAME

where SERVICE_NAME is the Net8 service name for the Oracle8 database that 
you created in Step 3.

The Oracle8 database searches the data dictionary for an automatic login user 
name corresponding to the Windows NT local or domain user name, verifies it, 
and allows you to connect as XYZFRANK or XYZSALES\FRANK.
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7. Verify that you have connected to the Oracle8 database as local or domain user 
FRANK by viewing the roles assigned in Step 9 of  “Step 1: Perform 
Authentication Tasks on the Oracle8 Database Server”.

SVRMGR> SELECT * FROM USER_ROLE_PRIVS;

which outputs for local user FRANK:

USERNAME                       GRANTED_ROLE                   ADM DEF OS_
------------------------------ ------------------------------ --- --- ---
XYZFRANK                       CONNECT                        NO  YES NO 
XYZFRANK                       RESOURCE                       NO  YES NO 
2 rows selected.

or, for domain user FRANK:

USERNAME                       GRANTED_ROLE                   ADM DEF OS_
------------------------------ ------------------------------ --- --- ---
XYZSALES\FRANK                 CONNECT                        NO  YES NO 
XYZSALES\FRANK                 RESOURCE                       NO  YES NO 
2 rows selected.

As the Oracle8 user name is the whole name XYZFRANK or 
XYZSALES\FRANK, all objects created by XYZFRANK or 
XYZSALES\FRANK (that is tables, views, indexes, etc.) are prefixed by this 
name. For another user to reference the table SHARK owned by XYZFRANK, 
for example, the user must enter:

SVRMGR> SELECT * FROM XYZFRANK.SHARK 

Attention:   Automatic authorization is supported for all Net8 
protocols. 
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Connecting as SYSOPER and SYSDBA Without a Password
This section describes how to enable Windows NT to grant the SYSOPER and 
SYSDBA privileges to DBAs. This enables DBAs to issue the following commands 
from a client computer and connect to the Oracle8 database without entering a 
password:

■ CONNECT / AS SYSOPER

■ CONNECT / AS SYSDBA

To enable this feature, the Windows NT local or domain user name must belong to 
one of the following four Windows NT local groups: 

The SYSOPER and SYSDBA privileges are mapped to the following Windows NT 
local groups:

Follow the steps below to connect as SYSOPER or SYSDBA without a password:

■ Step 1: Perform Authentication Tasks on the Oracle8 Database Server

■ Step 2: Perform Authentication Tasks on the Client Computer

Local Group This Local Group Includes All...

ORA_OPER SYSOPER database privileges; applicable for all system 
identifiers (SIDs).

ORA_DBA SYSDBA database privileges; applicable for all SIDs.

ORA_SID_DBA SYSDBA database privileges; applicable only for the SID 
specified in the name.

ORA_SID_OPER SYSOPER database privileges; applicable only for the SID 
specified in the name.

This Privilege... Maps to the Local Group...

SYSOPER ORA_SID_OPER, ORA_OPER

SYSDBA ORA_SID_DBA, ORA_DBA, ORA_SID_OPER, ORA_OPER
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Step 1: Perform Authentication Tasks on the Oracle8 Database Server
To perform authentication tasks on the Oracle8 database server:

1. Open User Manager on the Windows NT server where your Oracle8 database 
is installed.

2. Select New Local Group from the User Menu.

The New Local Group dialog box appears.

3. Enter the appropriate Windows NT local group name in the Group Name field. 
For this example, the SID entered is ORCL.

4. Click Add.
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The Add Users and Groups dialog box appears:

5. Select an appropriate Windows NT user from the Names field and click Add.

6. Click OK.

Your selection is added to the Members field of the New Local Group dialog box:
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7. Click OK.

8. Exit User Manager.

9. Ensure that SQLNET.AUTHENTICATION_SERVICES is set as follows in your 
ORACLE_HOME\NET80\ADMIN\SQLNET.ORA file:

SQLNET.AUTHENTICATION_SERVICES = (NTS)

Step 2: Perform Authentication Tasks on the Client Computer
To perform authentication tasks on the client computer:

1. Create a Windows NT local or domain user name with the same user name and 
password that exist on the Windows NT server (if the appropriate user name 
does not currently exist).

2. Ensure that SQLNET.AUTHENTICATION_SERVICES is set as follows in your 
ORACLE_HOME\NET80\ADMIN\SQLNET.ORA file:

SQLNET.AUTHENTICATION_SERVICES = (NTS)

3. Use Net8 Assistant or Oracle Net8 Easy Config to create a network connection 
from your client computer to the Windows NT server on which your Oracle8 
database is installed. See Net8 Getting Started for Windows NT and Windows 95 
for instructions.

4. Access the Oracle8 database in either of two ways:

■ Log onto a client computer with the local or domain user name.

■ Access a shared area on the Windows NT computer hosting the Oracle8 
database with the local or domain user name (for example, using NET 
USE).

5. Start Server Manager:

C:\> SVRMGR30

6. Connect to the Oracle8 database:

SVRMGR> SET INSTANCE SERVICE_NAME

where SERVICE_NAME is the Net8 service name for the Oracle8 database that 
you created in Step 3.
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7. Connect as SYSOPER or SYSDBA based on the local group you specified in 
step 3 of  “Step 1: Perform Authentication Tasks on the Oracle8 Database 
Server”:

You are connected to the Windows NT server. If you connect with SYSDBA, 
you are given DBA privileges.

Connecting as INTERNAL Without a Password
This section describes how to connect as INTERNAL without a password. To do 
this, you must create one of the following new local Windows NT user groups and 
add a Windows NT operating system local or domain user to that group: 

This enables you to log into a local computer or a Windows NT domain. In the 
domain, your Oracle8 database is just one of many resources to which you have 
access. Once you access this domain, you are automatically validated as an 
authorized DBA who can access the Oracle8 database without a password.

If The Local Group Is... Then Enter...

ORA_DBA or ORA_SID_DBA SVRMGR> CONNECT / AS SYSOPER

or

SVRMGR> CONNECT / AS SYSDBA

ORA_OPER or ORA_SID_OPER SVRMGR> CONNECT / AS SYSOPER

Local Group This Local Group Includes All...

ORA_DBA SYSDBA database privileges. This group is applicable for all 
SIDs.

ORA_SID_DBA SYSDBA database privileges. This group is applicable only for 
the SID specified in the name.

Note:  The Oracle8 database does not support setting the registry 
DBA_AUTHORIZATION parameter to the value of BYPASS. Server 
Manager uses the value of DBA_AUTHORIZATION as a password for 
INTERNAL to retry a failed login attempt when no password is provided.
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Follow the steps below to connect as INTERNAL without a password:

■ Step 1: Perform Authentication Tasks on the Oracle8 Database Server

■ Step 2: Perform Authentication Tasks on the Client Computer

Step 1: Perform Authentication Tasks on the Oracle8 Database Server
To perform authentication tasks on the Oracle8 database server:

1. Create a Windows NT user name (local or domain) if one does not already 
exist.

2. Set the INITSID.ORA file REMOTE_LOGIN_PASSWORDFILE parameter to 
NONE to enable operating system authenticated logins for the INTERNAL 
user name.

3. Ensure that SQLNET.AUTHENTICATION_SERVICES is set as follows in your 
ORACLE_HOME\NET80\ADMIN\SQLNET.ORA file:

SQLNET.AUTHENTICATION_SERVICES = (NTS)

4. Open User Manager.

5. Go to New Local Group from the User Menu.

The New Local Group dialog box appears.

6. Enter the ORA_SID_DBA or ORA_DBA Windows NT local group name in the 
Group Name field. For this example, the SID entered is ORCL:

7. Click Add.
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The Add Users and Groups dialog box appears:

8. Select an appropriate Windows NT local or domain user from the Names field 
and click Add.

9. Click OK.

Your selection is added to the Members field of the New Local Group dialog box:
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10. Click OK.

11. Exit User Manager.

12. Connect to the database with the INTERNAL DBA name:

SVRMGR> CONNECT INTERNAL/PASSWORD

13. Shut down the database:

SVRMGR> SHUTDOWN

14. Restart the database:

SVRMGR> STARTUP

Step 2: Perform Authentication Tasks on the Client Computer
To perform authentication tasks on the client computer:

1. Create a Windows NT local or domain user name with the same user name and 
password that exist on the Windows NT server (if the appropriate user name 
does not currently exist).

2. Ensure that SQLNET.AUTHENTICATION_SERVICES is set as follows in your 
ORACLE_HOME\NET80\ADMIN\SQLNET.ORA file:

SQLNET.AUTHENTICATION_SERVICES = (NTS)

3. Use Net8 Assistant or Oracle Net8 Easy Config to create a network connection 
from your client computer to your Oracle8 database. See Net8 Getting Started for 
Windows NT and Windows 95 for instructions.

4. Access the Oracle8 database in either of two ways:

■  Log onto a client computer with a local or domain user name.

■ Access a shared area on the Windows NT computer hosting the Oracle8 
database with the local or domain user name (for example, using NET 
USE).

5. Start Server Manager:

C:\> SVRMGR30

6. Connect to the Oracle8 database:

SVRMGR> SET INSTANCE SERVICE_NAME

where SERVICE_NAME is the Net8 service name for the Oracle8 database that 
you created in Step 3.
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7. Connect to your Windows NT server:

SVRMGR> CONNECT INTERNAL

You are connected to the Windows NT server. 

Granting Database Roles through Windows NT
This section describes how to grant Oracle8 database roles to users directly through 
Windows NT. When you use Windows NT to authenticate users, Windows NT 
local groups can grant these users database roles. Through User Manager, you can 
create, grant, or revoke database roles to users.  

Follow the steps below to grant database roles with Windows NT:

■ Step 1: Perform Authentication Tasks on the Oracle8 Database Server

■ Step 2: Perform Authentication Tasks on the Client Computer

Step 1: Perform Authentication Tasks on the Oracle8 Database Server
To perform authentication tasks on the Oracle8 database server:

1. Add the OS_ROLES initialization parameter to the INITSID.ORA file. 

2. Set OS_ROLES to TRUE. 

The default setting for this parameter is FALSE. 

3. Ensure that SQLNET.AUTHENTICATION_SERVICES is set as follows in your 
ORACLE_HOME\NET80\ADMIN\SQLNET.ORA file:

SQLNET.AUTHENTICATION_SERVICES = (NTS)

4. Create a new database role:

SVRMGR> CREATE ROLE DBSALES3 IDENTIFIED EXTERNALLY;

where DBSALES3 is the name of the role for these steps. Substitute a role name 
appropriate to your database environment.

Note:   All privileges for these roles are active when the user 
connects. When using operating system roles, all roles are 
granted and managed through the operating system. You 
cannot use both operating system roles and Oracle roles at the 
same time.
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5. Grant Oracle roles to DBSALES3 that are appropriate to your database 
environment:

SVRMGR> GRANT DBA TO DBSALES3 WITH ADMIN OPTION;

SVRMGR> GRANT RESOURCE TO DBSALES3 WITH ADMIN OPTION;

SVRMGR> GRANT CONNECT TO DBSALES3 WITH ADMIN OPTION;

6. Connect to the database with the INTERNAL DBA name:

SVRMGR> CONNECT INTERNAL/PASSWORD

7. Shut down the database:

SVRMGR> SHUTDOWN

8. Restart the database:

SVRMGR> STARTUP

9. Open the Windows NT User Manager.

10. Choose New Local Group from the User menu.

The New Local Group dialog box appears:
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11. Enter the Windows NT local group name corresponding to the database role in 
the Group Name field with the following syntax:

ORA_SID_ROLENAME [_D] [_A] 

where:

For this example, ORA_ORCL_DBSALES3_D is entered.

12. Click Add.

SID Indicates the database instance.

ROLENAME Identifies the database role granted to users of a database 
session.

D Optional character indicating that this database role is to 
be the default role of the database user. If specified, this 
character must be preceded by an underscore.

A Optional character indicating that this database role 
includes the ADMIN OPTION. This enables the user to 
grant the role to other roles only. If specified, this 
character must be preceded by an underscore.
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The Add Users and Groups dialog box appears:

13. Select the appropriate Windows NT local or domain user name and click Add.

14. Click OK.

Your selection is added to the Members field of the New Local Group dialog box:
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You can convert additional database roles to several possible Windows NT 
groups, as shown in the following table. Then, users connecting to the ORCL 
instance in this example and authenticated by Windows NT as members of 
these Windows NT local groups have the privileges associated with DBSALES3 
and DBSALES4 by default (because of the _D option). DBSALES1 and 
DBSALES2 are available for use by the user if they first connect as members of 
DBSALES3 or DBSALES4 and use the SET ROLE command. If a user tries to 
connect with DBSALES1 or DBSALES2_A without first connecting with a 
default role, they are unable to connect. Additionally, users can grant 
DBSALES2 and DBSALES4 to other roles.

15. Click OK.

16. Exit User Manager.

Step 2: Perform Authentication Tasks on the Client Computer
To perform authentication tasks on the client computer:

1. Create a Windows NT local or domain user name with the same user name and 
password that exist on the Windows NT server (if the appropriate user name 
does not currently exist).

2. Ensure that SQLNET.AUTHENTICATION_SERVICES is set as follows in your 
ORACLE_HOME\NET80\ADMIN\SQLNET.ORA file:

SQLNET.AUTHENTICATION_SERVICES = (NTS)

3. Use Net8 Assistant or Oracle Net8 Easy Config to create a network connection 
from your client computer to your Oracle8 database. See Net8 Getting Started for 
Windows NT and Windows 95 for instructions.

Database Roles Windows NT Groups

DBSALES1 ORA_ORCL_DBSALES1

DBSALES2 ORA_ORCL_DBSALES2_A

DBSALES3 ORA_ORCL_DBSALES3_D

DBSALES4 ORA_ORCL_DBSALES4_DA

Note:   When the Oracle8 database converts the group name to a 
role name, it changes the name to uppercase.
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4. Access the Oracle8 database in either of two ways:

■  Log onto a client computer with a local or domain user name.

■ Access a shared area on the Windows NT computer hosting the Oracle8 
database with the local or domain user name (for example, using NET 
USE).

5. Start Server Manager:

C:\> SVRMGR30

6. Connect to the correct instance:

SVRMGR> SET INSTANCE SERVICE_NAME

where SERVICE_NAME is the Net8 service name for the Oracle8 database that 
you created in Step 3.

7. Connect to the Oracle8 database:

SVRMGR> CONNECT SCOTT/TIGER

You are connected to the Windows NT server over Net8 with the Oracle user 
name SCOTT/TIGER. The roles applied to the Oracle user name SCOTT 
consist of all roles defined for the Windows NT user name that were mapped 
to the database roles above (in this case, ORA_DBSALES3_D). All roles 
available under an authenticated connection are determined by the Windows 
NT user ID and the Oracle-specific Windows NT local groups to which the user 
belongs (for example, ORA_SID_DBSALES1 or ORA_SID_DBSALES4_DA).
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12
 Monitoring a Database

This chapter describes how to monitor Oracle8 Enterprise Edition.

Specific topics discussed are:

■ Database Monitoring Overview

■ Using Oracle8 Performance Monitor

■ Using the Event Viewer

■ Using Trace and Alert Files

■ Using the Performance Pack
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Database Monitoring Overview
The following tools enable you to monitor your Oracle8 database:

Each tool is described in the following sections. 

This Tool Enables You To...

Oracle8 Performance 
Monitor

Monitor database objects, such as CPU usage, buffer cache, 
and background processes.

Event Viewer Monitor database events.

Trace Files Record occurrences and exceptions of database operations.

Alert Files Record important information about error messages and 
exceptions during database operations.

Oracle Enterprise 
Manager’s Performance 
Pack

Monitor and tune using tools with real-time graphical 
performance information.

Additional Information: See Oracle8 Tuning for general tuning 
information and your operating system documentation for 
additional information on Windows NT Performance Monitor 
results and optimizing database performance.
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Using Oracle8 Performance Monitor
Oracle8 Performance Monitor is a graphical tool for measuring the performance of 
Oracle8 Enterprise Edition objects on a local server or other servers on a network. 
This tool is the same in appearance and operation as the Windows NT Performance 
Monitor, except it has been preloaded with Oracle8 database performance elements.

On each computer, you can view the behavior of objects, such as the buffer cache, 
data dictionary cache, data files, threads, and processes. An object is a graphical 
representation of an element in your system. Every element, resource, and device 
in your system can be represented as an object.

There is a set of counters associated with each object. A counter is a unit of 
measurement used by the Performance Monitor to display activity. The type of 
activity the counter measures is dependent upon the type of object.

Certain object types and their respective counters are present on all systems. Other 
counters, such as application-specific counters (like Server Manager), appear only if 
the computer is running the associated software.

Each of these objects has an associated set of counters that provide information 
about device usage, queue lengths, delays, and information used to measure 
throughput and internal congestion.

Installation
To use Oracle8 Performance Monitor to monitor and analyze Oracle8 database 
performance, you must first install Oracle8 Performance Utility. The Oracle8 
Performance Utility enables the Windows NT Performance Monitor to monitor 
Oracle8 database objects.
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Registry Information
When you install Oracle8 Performance Utility, values are automatically set in the 
registry as described in Appendix C, “Configuration Parameters and the Registry”.

The Oracle8 Performance Monitor allows you to monitor only one database 
instance at a time. For this reason, the registry contains the following values located 
in HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services
\Oracle80\Performance that point to a particular database instance:

■ Hostname 

■ Username

■ Password

To use Oracle8 Performance Monitor for another database instance on the same 
computer or a UNIX computer, change the values appropriately in the registry. 
You can also monitor non-NT Oracle databases by changing the Hostname registry 
value so it points to another computer specified in the TNSNAMES.ORA file.

Note: Oracle Corporation recommends setting the security level 
on each of these registry values. 
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Accessing Oracle8 Performance Monitor
To access Oracle8 Performance Monitor:

Choose Start > Programs > Oracle for Windows NT - [HOME_NAME] > Oracle8 
Performance Monitor.

The Performance Monitor window appears with the Chart View:

counters objects
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The Performance Monitor has four views you can choose from the View menu:

Monitoring Oracle8 Objects
For each view (Chart, Alert, Log, and Report), you can decide on the objects you 
want to monitor and save those settings to a file. When an object is chosen, it is 
assigned a counter, a color, and added to the status bar at the bottom of Oracle8 
Performance Monitor.

To add objects to a view:

1. Choose Add To (Chart, Alert, Log, Report) from the Edit menu.

The Add to (Chart, Alert, Log, Report) dialog box appears. 

Below is the Add to Chart dialog box. Note the corresponding dialog boxes for 
the other views are different.

 

View Description

Chart View Displays database activity in real-time.

Alert View Lets you know when certain minimum performance criteria are 
not being met, or maximum criteria are being exceeded.

Log View Maintains continuous records on performance.

Report View Saves information about specific criteria.

Additional Information: For complete information about the four 
views, see your Windows NT documentation.
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2. Select the objects you want to monitor, then click Add.

Below are the elements of the Add to Chart dialog box. The other views’ dialog 
boxes have similar features.

3. Click Done when you are finished.

The selections you have chosen to monitor are displayed.

Element Description

Computer list box Specify the computer you want to monitor.

Object drop-down list box Select an object to monitor.

Note: If no data or Oracle8 objects appear, either the 
database is not running, or an invalid host string or 
password has been entered. If the database is not 
started, exit Performance Monitor, start the database, 
and restart Performance Monitor.

Counter list box Select a counter (or multiple counters) for the object 
you have selected. Note that the contents of the Counter 
box change depending upon your selection in the 
Object box.

If you want details on how a counter works, highlight 
the counter and choose Explain.

Instance box Select an instance for this counter.

Color box Choose a color for the display of the selected counter.

Scale box Choose the scale at which you want to display the 
counter.

Width box Specify the width of the line on the graph.

Style box Choose a different style for your graph line.
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Understanding Oracle8 Performance Objects
All Oracle8 system resources that can be monitored through Oracle8 Performance 
Monitor begin with Oracle8. These measures are defined in ORACLE_HOME\DBS\ 
PERF80.ORA. The following table shows the Oracle8 objects and their associated 
counters. For additional information on these objects, see Oracle8 Tuning.

Note:   You can only monitor one instance at a time using Performance 
Monitor on a given computer. 

Object Counter Description

Oracle8 Buffer Cache phyrds/gets % The percentage of phyrds/gets is calculated as a Miss ratio. If 
the Miss counter is higher than 30% to 40%, increase the 
number of buffers in the buffer cache to improve 
performance. To make the buffer cache larger, increase the 
value of the DB_BLOCK_BUFFERS initialization parameter. 

This value is not time-derived.

Oracle8 Data 
Dictionary Cache

getmisses/gets % The value of this counter must be less than 10 or 15% for 
frequently accessed data dictionary caches. If the ratio 
continues to increase above this threshold while your 
application is running, increase the amount of memory 
available to the data dictionary cache.

To increase the memory available to the cache, increase the 
value of the initialization parameter SHARED_POOL_SIZE. 
(See Oracle8 Tuning for more detailed information on tuning 
memory allocation in the Oracle8 database.)

This value is not time-derived. 

Oracle8 Data Files ■ phyrds/sec

■ phywrts/sec

Disk contention occurs when multiple processes try to access 
the same disk simultaneously. There are many ways of 
reducing disk contention, depending on the results from 
monitoring disk activity. Some corrective actions include: 

■ distributing I/O

■ separating data files and redo log files 

■ separating tables and indexes

■ striping table data 

These values are time-derived.
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Oracle8 Redo Log 
Buffer

redo log space 
requests

The value of this counter must be near zero. If this value 
increments consistently, processes have had to wait for space 
in the redo log buffer. In this case, it may be necessary to 
increase the size of the redo log buffer. 

Oracle8 DBWR stats1 These counters are helpful in tuning the Buffer Cache. 

■ buffers 
scanned/sec

Buffers scanned/sec is the number of buffers the DBWR 
scanned per second. The buffers scanned are on the LRU list. 

■ LRU scans/sec LRU_scans/sec is the number of times the DBWR scanned 
the Least Recently Used buffer list per second.

Oracle8 DBWR stats2 These counters are helpful in determining how much work 
the DBWR has been requested to perform. 

■ timeouts/sec Timeouts/sec is the number of times the DBWR timed-out 
per second. The DBWR is on a three second timeout interval. 
If the DBWR has not been posted within a three second 
interval, it times out. 

■ checkpoints/sec Checkpoints/sec is the number of checkpoint messages 
processed by the database writer per second. Whenever a 
check point occurs, the DBWR must be messaged (posted) to 
“write dirty buffers to disk”. 

Oracle8 Dynamic 
Space Management

recursive/calls per 
second

Dynamic extension causes Oracle8 to execute SQL statements 
in addition to those SQL statements issued by user processes. 
These SQL statements are called recursive calls. If Oracle8 
makes excessive recursive calls while an application is 
running, it may be necessary to determine the cause.

Examine the recursive calls statistic through the dynamic 
performance table V$SYSSTAT.

Oracle8 Free List free list waits/       
requests %

Contention for free lists is reflected by contention for free 
data blocks in the buffer cache. You can determine if 
contention for free lists is reducing performance by querying 
V$WAITSTAT.

If the number of free list waits for free blocks is greater than 
1% of the total number of requests, consider adding more free 
lists to reduce contention.

Object Counter Description
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Oracle8 Performance Monitor Troubleshooting Information
If no data or Oracle8 objects appear in the Objects list of the Add to Chart dialog 
box, either:

■ the database is not running 

■ an invalid host string or password has been entered in the registry

The OPERF80.LOG file located in ORACLE_HOME\DBS contains error messages 
about Oracle8 Performance Monitor. 

To resolve this problem:

1. Check the ORACLE_HOME\DBS\OPERF80.LOG file for error messages.

2. Resolve the problem as follows:

■ If the log file indicates an invalid host string or password, check the 
registry for correct values for Hostname, Password, and Username. See 
“Parameters for Oracle8 Performance Monitor” in Appendix C, 
“Configuration Parameters and the Registry” for further information about 
these values.

■ If the database is not started, exit Oracle8 Performance Monitor and restart 
the database.

3. Restart Oracle8 Performance Monitor.

Oracle8 Library Cache reloads/pins % The percentage of SQL statements, PL/SQL blocks, and 
object definitions that required reparsing. Total Reloads must 
be near zero. If the ratio of Reloads to Pins is greater than 1%, 
then reduce the library cache misses.

This value is not time-derived. 

Oracle8 Sorts ■ sorts in 
memory/sec

■ sorts on disk/
sec

The default sort area size is adequate to hold all the data for 
most sorts. However, if your application often performs large 
sorts on data that does not fit into the sort area, then you may 
want to increase the sort area size. 

Object Counter Description
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Using the Event Viewer
Oracle8 Enterprise Edition problems and other significant occurrences are recorded 
as events. These events are recorded in an application event log. View and manage 
these recorded events in the Event Viewer. 

Accessing the Event Viewer
To access the Event Viewer:

1. Choose Start > Programs > Administrative Tools > Event Viewer.

The Event Viewer window appears.

2. Choose Application from the Log menu.

The Application view displays the following information:

The date event took place.
The time event took place.

Application that recorded event.

Classification of event.

Unique number assigned to event.
Computer name on 
which event occurred.
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Reading the Event Viewer
The icons beside each event determine the type of event. 

Oracle8 Enterprise Edition events display with a source of Oracle80.orcl. 
Oracle80.orcl consists of the following event IDs:

Icon Event Type Description

red (stop sign) Error Indicates an error. Always check these icons.

blue 
(informational) 

Information Indicates a non-critical system event. You can 
ignore these icons unless you want to track a 
specific event.

yellow 
(exclamation 
point) 

Warning Indicates a special event, such as the 
termination of an instance or the shutdown of 
services. Investigate these icons, but they are 
usually non-critical.

 Event ID Description

IDs other than 34 Specifies general database activities, such as an instance being 
started or stopped.

34 Specifies an audit trail event. These events are recorded if the 
AUDIT_TRAIL parameter is set to DB (TRUE) or OS in the 
INITSID.ORA file.

The OS option enables system-wide auditing and causes 
audited records to be written to the Event Viewer.

The DB option enables system-wide auditing and causes 
audited records to be written to the database audit trail (the 
SYS.AUD$ table). Some records, however, are written to the 
Event Viewer.
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Using the Event Viewer
To use the Event Viewer:

1. Look at the icons.

2. Double-click an icon to analyze (especially red icons).

The Event Detail dialog box appears with more information about the selected 
event:

Additional Information: See your Microsoft Windows NT 
documentation for more additional information on using the 
Windows NT Event Viewer.

A text description of the event.

Click Binary to see the 
information in hexadecimal 
format. Or, click Words to see 
DWORDS for the same data.
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Using Trace and Alert Files
Oracle8 Enterprise Edition background threads use trace files to record occurrences 
and exceptions of database operations, as well as errors. Background thread trace 
files are created regardless of whether the BACKGROUND_DUMP_DEST 
parameter is set in the INITSID.ORA initialization parameter file. If 
BACKGROUND_DUMP_DEST is set, the trace files are stored in the directory 
specified. If the parameter is not set, the trace files are stored in the 
ORACLE_HOME\RDBMS80\TRACE directory.

Oracle8 database creates a different trace file for each background thread. The 
name of the trace file contains the name of the background thread, followed by the 
extension .TRC. Sample trace file syntax includes:

■ SIDDBWR.TRC 

■ SIDSMON.TRC 

where SID represents the name of the instance.

Trace files are also created for user threads if the USER_DUMP_DEST parameter is 
set in the initialization parameter file. The trace files for the user threads have the 
form ORAxxxxx.TRC, where xxxxx is a 5-digit number indicating the Windows NT 
thread ID.

The alert file contains important information about error messages and exceptions 
that occur during database operations. Each Oracle8 Enterprise Edition instance 
has one alert file; information is appended to the file each time you start the 
instance. All threads can write to the alert file.

For example, when automatic archiving of redo logs is halted because no disk 
space is available, a message is placed in the alert file. The alert file is the first place 
to check if something goes wrong with the database and the cause is not 
immediately obvious.

The alert file is named SIDALRT.LOG and is found in the directory specified by the 
BACKGROUND_DUMP_DEST parameter in the INITSID.ORA initialization 
parameter file. If the BACKGROUND_DUMP_DEST parameter is not set, the 
SIDALRT.LOG file is generated in ORACLE_HOME\RDBMS80\TRACE.
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Using the Performance Pack
Oracle Corporation offers an optional Performance Pack attachment to Oracle 
Enterprise Manager. The Performance Pack is a powerful set of performance 
monitoring and tuning tools designed to provide real-time graphical performance 
information to customers who need to manage their dynamic database 
environments. The Performance Pack includes:

■ Performance Monitor Applications

■ Oracle Trace

■ Oracle Expert

Performance Monitor Applications
Oracle Enterprise Manager contains the following optional performance 
monitoring applications:

■ Oracle Performance Manager

■ Oracle TopSessions

■ Oracle Lock Manager

■ Oracle Tablespace Manager

Oracle Performance Manager
Oracle Performance Manager is a tool for monitoring database performance in real 
time. It provides dozens of predefined charts for displaying a wide variety of 
database performance statistics regarding:

■ users ■ buffers

■ throughput ■ caches

■ tablespaces ■ I/O

■ redo logs

Additional Information: See Oracle Enterprise Manager Performance 
Monitoring User’s Guide for specific information on using this tool.
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Oracle TopSessions
Oracle TopSessions enables you to monitor how connected sessions use database 
instance resources in real time. You can obtain an overview of session activity by 
displaying the top n sessions sorted by a statistic of your choice. For any given 
session, you can drill down for more detail. You can further customize the 
information you display by specifying manual or automatic data refresh, the rate of 
automatic refresh, and the number of sessions to display. 

In addition to these monitoring capabilities, Oracle TopSessions provides a 
methodology for identifying and correcting certain database performance 
problems. For example, when a sudden file I/O load is detected, you can first 
identify the sessions contributing to most of the problem, and then isolate the 
executing SQL statements in user applications for those sessions. You can then 
analyze the SQL explain plans for those SQL statements to determine how best to 
resolve the problem. 

Oracle Lock Manager
With Oracle Lock Manager you can monitor locks, which are mechanisms that 
prevent destructive interaction between users accessing the same resource. 

The main window displays a multi-column list that includes a row for each current 
lock in the database. The information displayed in the columns includes:

■ user name

■ session ID

■ owner of the locked object

■ name of the object

■ type of the object

Additional Information: See Oracle Enterprise Manager Performance 
Monitoring User’s Guide for specific information on using this tool.

Additional Information: See Oracle Enterprise Manager Performance 
Monitoring User’s Guide for specific information on using this tool.



Using the Performance Pack

                                                                   Monitoring a Database 12-17

Oracle Tablespace Manager
Oracle Tablespace Manager enables you to monitor and manage tablespace 
fragmentation. You can display an overview table of space usage information, 
either for all tablespaces in a database, or for the data file(s) within a tablespace.

To find out more about a given tablespace or data file, you can display how storage 
has been allocated for its segments. Clicking a segment in a segment list displays 
the extents in the tablespace or data file storing data for that segment. If data 
storage for a segment is fragmented, you can defragment it. You can also use the 
coalescing feature of Oracle Tablespace Manager to join adjacent free blocks. 

Starting Performance Monitor Applications
To start these applications from the Oracle Enterprise Manager Console, first select 
a database instance in the Oracle Enterprise Manager navigator tree with which to 
establish a connection. Then, proceed in one of two ways:

■ Click the appropriate application icon from the Performance Pack launch 
palette.

■ Choose Tools > Performance Pack > application name menu option

Oracle Trace
Oracle Trace is a general-purpose data collection product that captures data for 
specific software events, such as an application transaction, a user log on, or any 
event particular to the software product. With Oracle Trace, you can collect a wide 
variety of data, such as performance statistics, diagnostics data, system resource 
usage, and business transaction details. 

Two Oracle Corporation products are currently enabled for Oracle Trace collection:

■ Oracle8 database (for performance data collection)

■ Net8 (for diagnostics data collection)

The Oracle8 Enterprise Edition performance data collected by Oracle Trace includes 
SQL statements, detailed statistics on SQL events, transactions events, and other 
useful information.

Additional Information: See Oracle Enterprise Manager Performance 
Monitoring User’s Guide for specific information on using this tool.
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Oracle Trace provides a graphical Oracle Trace Manager application to create, 
schedule, and administer Oracle Trace collections for host products containing the 
Oracle Trace application programming interface (API). You can store data collected 
by Oracle Trace in Oracle8 database tables for access by SQL reporting tools and 
other products.

Oracle Trace has an API that contains data collection service calls. Software 
developers can use the Oracle Trace API to pre-configure their products for Oracle 
Trace data collection. Users of a product containing the Oracle Trace API calls, such 
as the Oracle8 database, can then automatically use Oracle Trace to collect data 
about specific events that occur in that product. 

Most Oracle Trace users perform collections for products that already include the 
Oracle Trace API. Therefore, most users only need to be familiar with the data that 
can be collected for the host product and how to use the Oracle Trace Collection 
Manager application to create and administer data collections.

Starting Oracle Trace
Start Oracle Trace from the Enterprise Manager Console in one of two ways:

■ Click the Oracle Trace icon from the Performance Pack launch palette.

■ Choose Tools > Performance Pack > Oracle Trace menu option

Oracle Expert
Oracle Expert enables you to optimize the performance of your database 
environment. It assists you with the initial Oracle8 database configuration and the 
collection and evaluation of the performance characteristics of existing databases. 
Oracle Expert provides many advantages. Oracle Expert:

■ uses trends to ensure continued performance as the database environment 
changes over time

■ provides consistent and complete recommendations

■ performs interdependency checking during analysis

■ detects and reports symptoms of poor performance

■ sifts through vast quantities of data quickly to identify performance problems

■ identifies situations where advanced performance features of the database can 
be applied

Additional Information: See Oracle Enterprise Manager Oracle Trace 
User’s Guide for specific information on using this tool.
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Oracle Expert also serves as:

■ an educational tool that explains all of its tuning recommendations through 
detailed reports

■ a methodology tool that guides DBAs, analysts, and designers through the 
process of improving Oracle8 database performance

■ a maintenance tool that uses historical trends to inform DBAs of degrading 
performance and impending bottlenecks

■ an information tool that collects tuning data from numerous sources. This data 
not only feeds the tuning process, but can be displayed, edited, and reported on

Starting Oracle Expert
To start Oracle Expert from the Oracle Enterprise Manager Console:

1. Select a database instance in the Oracle Enterprise Manager navigator tree with 
which to establish a connection.

2. Access Oracle Expert by:

■ Clicking the Oracle Expert icon from the Performance Pack launch palette.

■ Double-clicking the Expert icon in the Oracle Enterprise Manager Program 
Manager.

Additional Information: See Oracle Enterprise Manager Expert 
User’s Guide for specific information on using this tool.
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13
  Backing Up and Recovering Database

Files

This chapter provides information on backing up and recovering your database.

Specific topics discussed are:

■ Selecting a Backup and Recovery Tool

■ Backing Up Files with OCOPY

■ Recovering Files with OCOPY
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Selecting a Backup and Recovery Tool
Backing up and recovering your Oracle8 database is one of the most critical 
operations that a database administrator (DBA) performs. For this reason, it is 
extremely important to choose the correct tools. The table below describes available 
backup and recovery tools and makes recommendations on which tool to use with 
your Oracle8 database: 

Tool Tool and Description Analysis of Tool To Use this Tool, 
See...

Oracle 
Enterprise 
Manager 
Backup Manager

The Oracle Enterprise Manager Database 
Application Tools include a Backup 
Manager for backing up and recovering 
your Oracle8 database. The Backup 
Manager:

■ Enables users to perform database 
backups to disk and tape.

■ Creates backup scripts guided by a 
backup wizard.

■ Enables users to administer redo logs 
and online tablespace backups. 

■ Enables users to perform both hot 
and cold backups.

The Backup Manager enables you to back 
up and recover your database through a 
graphical user interface (GUI). This GUI 
enables you to use either of the two 
backup subsystems: 

■ Operating system backup 

■ Recovery Manager (which uses the 
executable RMAN80.EXE as its 
underlying functionality)

Highly recommended 
for backing up and 
recovering your 
Oracle8 database 
because of capabilities 
and ease of use. 
Works in conjunction 
with Recovery 
Manager 
(RMAN80.EXE). 
Backing up to tape 
requires an optional 
media management 
layer (MML) from a 
third-party vendor, 
such as Legato Storage 
Manager (LSM).

Oracle Enterprise 
Manager 
Administrator’s 
Guide for 
instructions.
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Recovery 
Manager 
(RMAN80.EXE) 
in command 
line mode 

Recovery Manager in command line 
mode is an Oracle8 tool that manages the 
process of backing up, restoring, and 
recovering files. Recovery Manager is 
automatically installed with Oracle8 
Utilities. Recovery Manager uses a special 
PL/SQL interface to the server for 
invoking backup functions. The user is 
unaware of this interface and instead 
interfaces only with a command line.

Command line usage 
only. Must clearly 
understand the 
command line syntax 
described in Oracle8 
Backup and Recovery 
before using. Backing 
up to tape requires an 
optional MML from a 
third-party vendor.

Chapter 3, 
“Database Tools 
Overview” for 
instructions on 
accessing this tool 
and Oracle8 Backup 
and Recovery for 
instructions on 
using this tool.

Third-party 
vendor products

Third-party vendors such as Legato 
provide tape backup software that works 
with Backup Manager and RMAN80.EXE.

Can back up to tape. 
Contact your third-
party vendors for 
additional information.

Legato Storage 
Manager 
Administrator’s 
Guide and other 
third-party vendor 
documentation.

NT Backup 
Manager and 
NT Recovery 
Manager (GUI 
tools)

NT Backup Manager and NT Recovery 
Manager are Oracle tools that enable you 
to perform database backups to disk or 
tape. Both tools are automatically 
installed with the Oracle8 Utilities.

Can back up to 4mm 
tape. Can perform hot 
and cold backups. 
This is the last release 
of this product on 
Oracle8. 

Online help 
included with these 
tools.

OCOPY An Oracle executable that behaves like 
Windows NT’s XCOPY command. 
OCOPY is needed when performing a hot 
backup manually (that is, backing up a 
tablespace that is in offline backup mode).

Command line usage 
only. Can back up 
only to disk. Can only 
perform local backups.

“Backing Up Files 
with OCOPY” and 
“Recovering Files 
with OCOPY” in 
this chapter.

Tool Tool and Description Analysis of Tool To Use this Tool, 
See...
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Backing Up Files with OCOPY 
Use OCOPY for both hot and raw database file backups of the following file types:

This table describes the two copy modes in which to use OCOPY:

File Description

File Allocation Table (FAT) or 
NT File System (NTFS) files

File allocation table (FAT) or NT file system (NTFS) 
files you want to back up.

Logical raw files A logical drive (accessed with the direct I/O) identified 
by the name:

\\.\x:

where x: is the logical drive designator.

Physical raw files A physical hard drive (accessed with direct I/O) 
identified by a device name of the form:

\\.\physicaldriveN

where N is 0, 1, 2, and so on, representing each of the 
physical drives in the system.

Copy Mode OCOPY is used to...

Hard disk Copy hot files to a new name and location on a hard disk where you 
can use an archive utility to back them up.

Multiple diskettes Back up large hot files directly to multiple diskettes.
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This table describes the syntax to use when backing up all file types to hard disk or 
multiple diskettes:            

Copy Mode File Type Syntax

Hard disk FAT or NTFS 
files

C:\> OCOPY80 old_file new_file

Logical raw C:\> OCOPY80 \\.\C: new_file

Physical raw C:\>OCOPY80 \\.\physicaldriveN 
new_file

Multiple diskettes FAT or NTFS 
files

C:\> OCOPY80 /B hot_file a:

Logical raw C:\> OCOPY80 /B \\.\C: a:

Physical raw C:\> OCOPY80 /B \\.\physicaldriveN a:

Where... Indicates the...

old_file Name and location of the hot file you want to back up.

new_file Name and location of the backup copy.

C: Raw drive that holds a single RAW database file.

physical drive Physical drive that holds a single RAW database file.

N Number(s) representing each of the physical drives in the system.

hot_file Path and filename of the hot file you want to back up. 

a: Diskette drive containing the diskette on which to save the backup 
copy. If the file is too large to fit on one diskette, OCOPY prompts you 
to insert new diskettes as needed. OCOPY catalogs the parts of the file 
automatically so that it can be reconstructed at a later time. 

/B Large files must be split over multiple diskettes.

Note:   Always use a fresh diskette for each OCOPY procedure; do not use 
OCOPY to back up a file onto a diskette that contains part or all of another 
file backed up using OCOPY. 
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Recovering Files with OCOPY
The table below describes the syntax to use when recovering all file types from 
hard disk or multiple diskettes.  

1 These are files originally backed up without the /B option.
2 These are files originally backed up with the /B option.

Restore 
From...

File Type to 
Restore

Syntax

Hard Disk1 FAT or NTFS files Use the Windows NT COPY command.

Logical raw C:\> OCOPY80 new_file \\.\c: 

Physical raw C:\> OCOPY80 new_file \\.\physicaldriveN

Multiple 
diskettes2

FAT or NTFS files C:\> OCOPY80 /R a: restore_dir

Note: First insert the diskette containing the initial 
part of the backed up file.

Logical raw C:\> OCOPY80 /R a: \\.\c: 

Physical raw C:\> OCOPY80 /R a: \\.\physicaldriveN

Where... Indicates the...

C: Raw drive, which holds a single RAW database file. If you use a different 
drive as your raw drive, substitute it for C:. OCOPY prompts you to 
insert diskettes as needed.

new_file File name to which to restore the file.

physicaldrive Physical drive that holds a single RAW database file.

N Number(s) representing each of the physical drives in the system.

/R Restore option.

a: Drive containing the diskette with the backed up file.

restore_dir Directory on the server in which to place the file. (The restored file has the 
same name as the original file).
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14
  Distributing and Managing Oracle

Software

This chapter describes how to distribute and manage Oracle8 Enterprise Edition 
products across a network.

Specific topics discussed are:

■ Overview

■ Systems Management Server
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Overview
Microsoft Systems Management Server (SMS) enables you to distribute and 
manage Oracle software across a network.

This chapter provides a brief overview of SMS features, including installation, 
configuration, and usage instructions (where necessary).

Systems Management Server
SMS manages networked PCs running Windows operating systems. Specifically, 
SMS provides:

■ PC hardware and software inventory 

■ Software distribution

■ PC troubleshooting 

SMS is a component of Microsoft Backoffice, and is sometimes used in companies 
running their businesses on Windows NT.

Oracle8 Enterprise Edition SMS Support 
Oracle products for Windows 95 and Windows NT support remote installation and 
software inventory and auditing capabilities through SMS release 1.2. SMS 
integration with Windows 3.1 and Windows for Workgroups is not currently 
supported. Oracle Corporation provides customizable package definition files 
(.PDFs) that SMS administrators can use to distribute and maintain Oracle products 
in Windows NT and Windows 95 networks. These packages contain the same 
products as the corresponding packages in a traditional installation.

Attention: SMS .PDF files are not the same as Adobe Acrobat 
.PDF files. Adobe Acrobat .PDF files contain only documentation, 
do not contain products, and cannot be used to distribute and 
maintain Oracle products.
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Distributing Oracle Software with SMS
To distribute Oracle software with SMS: 

1. Open the Packages window from the SMS Administrator’s console. 

2. Select New from the File menu.

3. Select Import in the dialog box that appears in order to specify the .PDF 
package that describes the Oracle software package to SMS.

4. Navigate to the SMS directory at the root of the Oracle8 Enterprise Edition for 
Windows NT CD-ROM.

5. Select the appropriate PDF package:

6. Select Workstations to see more properties of the package.

Note: You must be an SMS administrator to perform these 
procedures.

Package Enables You to...

ServerNT.PDF Install and de-install Oracle8 Server software. This package 
includes Recovery Manager, which requires Legato Storage 
Manager (LSM) for Oracle to be installed. LSM is not 
automatically installed by SMS. You must manually install LSM 
by executing SETUP.EXE from the Legato directory at the root of 
the Oracle8 Enterprise Edition for Windows NT CD-ROM.

Client32.PDF Install and de-install Oracle8 Client software.

Deinstal.PDF De-install any Oracle8 software package. You can use this option 
if you have the software installed but have not already created an 
install/de-install package with SMS, or if you have deleted the 
install/de-install package. Job sending time is greatly reduced.
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7. Select the source directory for the package as follows: 

One or more command line options listed for the package appear. They are 
defined in the .PDF file and must not be modified.

8. Click Close to exit the window. 

9. Click OK to exit the Package Properties window. 

SMS creates the package.

10. Create a Run Command on Workstation job to distribute the new Oracle8 
Enterprise Edition product package. You can choose the appropriate command 
line option for the package during job creation (for example, Oracle8 Client/
DBA for Win95 or Oracle8 Client/AppUser for Win95). Consult your SMS 
documentation for more information about creating jobs.

11. Restart all client and server machines after installing Oracle software with SMS.

For... Set the Source Directory...

ServerNT.PDF or Client32.PDF (the 
two install/de-install packages)

To the root directory of the Oracle8 
Enterprise Edition for Windows NT CD-
ROM

Deinstal.PDF (the de-install only 
package)

To the SMS directory located at the root of 
the Oracle8 Enterprise Edition for Windows 
NT CD-ROM

Attention: Setting the source directory is important, as 
installation command lines specified in the .PDF file are 
interpreted relative to the source directory.

Note: When you schedule an SMS job to distribute software, the 
source directory that was specified during package creation must 
be accessible to SMS. If you specified the Oracle8 Enterprise 
Edition for Windows NT CD-ROM as the source, be sure the CD-
ROM is loaded into your CD-ROM drive during job creation.
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De-installation Issue 
Before running an Oracle de-installation job on an SMS client machine, be sure that 
all Oracle applications and services are stopped. De-installation will fail if services 
are running.

Note: Oracle documentation distributed in an SMS package 
points to the initial installation location in order to save client disk 
space. This location is the SMS_PKGD directory of the SMS 
distribution server. As a result, the client machine requires a drive 
mapping to the initial installation location for access to 
documentation files. On Windows 95 and Windows NT 4.0, this 
drive mapping occurs automatically when the documentation icon 
is selected. 
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15
 Developing Applications

This chapter describes Windows NT-specific issues for application developers. 

Specific topics discussed are:

■ Building External Procedures

■ Compiling and Linking the Oracle XA Library

■ Accessing Web Data with Intercartridge Exchange
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Building External Procedures
This section describes how to create and use external procedures on Windows NT. 

External Procedures Overview
External procedures are functions written in a third-generation language (3GL), 
such as C, and callable from within PL/SQL or SQL as if they were a PL/SQL 
procedure or function. External procedures enable you to take advantage of the 
strengths and capabilities of a 3GL programming language in a PL/SQL 
environment.

The main advantages of external procedures are: 

■ Performance, as some tasks are more efficiently performed in a 3GL language 
than in PL/SQL, which is better suited for SQL transaction processing

■ Code re-usability, as dynamic link libraries (DLLs) can be called directly from 
PL/SQL programs on the server or in client tools such as SQL*Forms

You can use external procedures to perform specific processes, such as:

■ Solving scientific and engineering problems

■ Analyzing data

■ Controlling real-time devices and processes

Follow these instructions to create and use an external procedure:

■ Step 1: Installing and Configuring

■ Step 2: Writing an External Procedure

■ Step 3: Building a DLL

■ Step 4: Registering an External Procedure

■ Step 5: Executing an External Procedure

■ Step 6: Enabling Multi-threaded Callout Support

Attention: You can combine the instructions described in Steps 4 
and 5 into one SQL script that automates the process of registering 
and executing your external procedure. For an example of a SQL 
script that combines these steps, see 
ORACLE_HOME\RDBMS80\EXTPROC\EXTERN.SQL. 
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Step 1: Installing and Configuring
This section describes:

■ Installing Oracle8 Enterprise Edition

■ Configuring Net8

Installing Oracle8 Enterprise Edition
Follow the procedures in Oracle8 Enterprise Edition Installation for Windows NT to 
install these products on your Windows NT server:

■ Oracle8 Enterprise Edition

Contains PL/SQL, from which external procedures are called, and the PL/SQL 
external procedure program (EXTPROC), which executes external procedures

■ Net8 Client, Net8 Server, and Oracle Protocol Adapters

Configuring Net8
If you install Net8 Server from your Oracle8 Enterprise Edition CD-ROM, your 
server network files are automatically configured to use external procedures. 

When PL/SQL calls an external procedure, the Net8 listener launches a session-
specific process called EXTPROC. Through Net8, PL/SQL passes the following 
information to EXTPROC:

■ DLL name

■ external procedure name

■ parameters (if necessary)

EXTPROC then loads the DLL and invokes the external procedure.

Note: You must also have a C compiler and linker installed on 
your system to build DLLs.
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If you copy your Oracle7 server network files into your Oracle8 network files 
directory, the following files must be manually configured for the external 
procedure behavior described above to occur:

■ ORACLE_HOME\NET80\ADMIN\LISTENER.ORA file

■ ORACLE_HOME\NET80\ADMIN\TNSNAMES.ORA file

 See “Configuring External Procedure Calls” in Chapter 8 of Net8 Getting Started for 
Windows NT and Windows 95.

Step 2: Writing an External Procedure
Using a 3GL programming language, such as C, you can write functions to be built 
into DLLs and invoked by EXTPROC. The following is a simple Microsoft Visual 
C++ example of an external procedure:

Note: The SQLNET.ORA file requires no changes. By default, the 
values for the parameters NAMES.DEFAULT_DOMAIN and 
NAME.DEFAULT_ZONE are set to WORLD. These values match 
with the .WORLD extension on the end of 
EXTPROC_CONNECTION_DATA in the TNSNAMES.ORA file.

Note: Since external procedures are built into DLLs, they must be 
explicitly exported. In this example, the dllexport storage class 
modifier exports the function find_max from a dynamic link 
library.
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#include <windows.h>
#define NullValue -1
/*
  This function simply returns the larger of x and y.
*/
long __declspec(dllexport) find_max(long x, 
 short x_indicator, 
long y, 
short y_indicator, 
 short *ret_indicator)
{
   /* It can be tricky to debug DLL’s that are being called by a process
      that is spawned only when needed, as in this case.  
      Therefore try using the DebugBreak(); command.  
      This will start your debugger.  Uncomment the following line and
      you can step right into your code.
   */
   /* DebugBreak();  */

   /* first check to see if you have any nulls */
   /* Just return a null if either x or y is null */

   if ( x_indicator==NullValue || y_indicator==NullValue) {
      *ret_indicator = NullValue;   
      return(0);
   } else { 
      *ret_indicator = 0;        /* Signify that return value is not null */
      if (x >= y) return x;
      else return y;
   }
}

Step 3: Building a DLL
After you have written your external procedure(s) in a 3GL programming 
language, use the appropriate compiler and linker to build a DLL, making sure to 
export the external procedures, as noted above. See your compiler and linker 
documentation for instructions on building a DLL and exporting its functions. 

After building the DLL, you can move it to any directory on your system. For the 
example above, you can build the external procedure find_max into a DLL called 
EXTERN.DLL. To build the above example, go to ORACLE_HOME\ 
RDBMS80\EXTPROC and type MAKE.
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Step 4: Registering an External Procedure
Once you have built a DLL containing your external procedure(s), you must 
register your external procedure(s) with the Oracle8 database. This involves two 
distinct steps:

1. Create a PL/SQL library to map to the DLL.

a. Start Server Manager:

C:\> SVRMGR30

b. Create the PL/SQL library using the CREATE LIBRARY command:

SVRMGR> CREATE LIBRARY externProcedures AS ’C:\ORANT\RDBMS80\ 
EXTPROC\EXTERN.DLL’;

2. Create a PL/SQL program unit specification. 

Do this by writing a PL/SQL subprogram that uses the EXTERNAL clause 
instead of declarations and a BEGIN...END block. The EXTERNAL clause is the 
interface between PL/SQL and the external procedure. The EXTERNAL clause 
identifies the following information about the external procedure:

■ name

■ DLL alias

■ programming language in which it was written

■ calling standard (defaults to C if omitted)

Where... Represents the...

externProcedures Alias library (essentially a schema 
object in the database)

C:\ORANT\RDBMS80\EXTPROC\EXTERN.DLL Path to the Windows NT operating 
system DLL EXTERN.DLL. This 
example uses C:\ORANT as your 
Oracle home.

Note: The DBA must grant EXECUTE privileges on the PL/SQL 
library to users that want to call the library’s external procedures 
from PL/SQL or SQL.
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For example:

Step 5: Executing an External Procedure
To execute an external procedure, you must call the PL/SQL program unit (that is, 
the alias for the external function) that registered the external procedure. These 
calls can appear in:

■ anonymous blocks

■ stand-alone and packaged subprograms

■ methods of an object type

■ database triggers

■ SQL statements (calls to packaged functions only)

DLL alias. You need EXECUTE 

 

External procedure to call. If enclosed in 

Language in which the external procedure 
   

privileges on this library.

was written.

double quotes, it becomes case sensitive.

CREATE OR REPLACE FUNCTION PLS_MAX(

      x BINARY_INTEGER, 

      y BINARY_INTEGER) 

RETURN BINARY_INTEGER AS 

   EXTERNAL LIBRARY externProcedures

   NAME "find_max"  

   LANGUAGE C

   PARAMETERS (

      x long,            -- stores value of x

      x_INDICATOR short,  -- this is used to determine if x is a NULL value

      y long,            -- stores value of y

      y INDICATOR short,  -- this is used to determine if y is a NULL value

      RETURN INDICATOR short ); -- need to pass pointer to return value’s   

-- indicator variable to 
determine if NULL.
   --This means that my function will be defined as:
   --long max(long x, short x_indicator, 
   --         long y, short y_indicator, short * ret_indicator)
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In “Step 4: Registering an External Procedure”, the PL/SQL function PLS_MAX 
registered the external procedure find_max. Follow the procedures below to 
execute find_max:

1. Call the PL/SQL function PLS_MAX from a PL/SQL procedure named Useit:

CREATE OR REPLACE PROCEDURE UseIt AS
         a integer;
         b integer;
         c integer;
BEGIN
         a := 1;
         b := 2;
         c := PLS_MAX(a,b);
         dbms_output.put_line(’The maximum of ’||a||’ and ’||b||’ is  ’||c);
END;

2. Run the procedure:

SVRMGR> EXECUTE UseIt;

Step 6: Enabling Multi-threaded Callout Support
You can increase the speed of external procedure invocations when making calls to 
external programs from PL/SQL stored procedures or PL/SQL methods of object 
types in the database by taking advantage of multiple, light-weight threads instead 
of a single dedicated process per user session. 

WARNING: Do not enable multi-threaded callout support if 
your C code is not thread-enabled. For example, do not use 
global variables in DLLs. Ensure also that there is synchronized 
access to variables in DLLs. See your Microsoft programming 
documentation for information on making your code thread-
enabled. 
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To enable multi-threaded callouts:

1. Open the Windows NT Control Panel.

2. Double-click Services.

The Services window appears.

3. Select OracleExtprocAgent (or OracleHOME_NAMEExtprocAgent, where 
HOME_NAME is the home name of the Oracle home directory you want to 
use).

4. Click Start.

5. Exit from the Windows NT Control Panel.

6. Set ORA_EXTPROC_THREADED to TRUE in the registry subkey of the Oracle 
home directory that you are using. The location of this parameter is determined 
by how many Oracle home directories are on your machine:

See Appendix C, “Configuration Parameters and the Registry” for instructions 
on accessing and modifying the registry. 

This enables you to use multiple, light-weight threads when making calls to 
EXTPROC from PL/SQL programs.

If You Have... ORA_EXTPROC_THREADED is Located in...

One home directory HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE

Additional 
directories

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ 
HOMEID

where ID is incremented for each additional Oracle home 
directory on your computer.
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 Additional Documentation
See the following documents for additional information on external procedures:

■ Oracle8 Administrator’s Guide

■ PL/SQL User’s Guide and Reference

■ The following files in ORACLE_HOME\RDBMS80\EXTPROC:

■ EXTERN.C (code example shown in “Step 2: Writing an External 
Procedure”)

■ MAKE.BAT (batch file that builds the dynamic link library)

■ EXTERN.SQL (automates the instructions described in “Step 4: Registering 
an External Procedure” and “Step 5: Executing an External Procedure”) 

■ README.DOC (explains how to run the sample and provides debugging 
advice)

Compiling and Linking the Oracle XA Library
The XA Application Program Interface (API) is typically used to enable an Oracle8 
database to interact with a transaction processing (TP) monitor, such as:

■ BEA Tuxedo 

■ IBM Transarc Encina

■ IBM CICS

The Oracle XA Library is automatically installed as part of Oracle8 Enterprise 
Edition. The following components are created in your Oracle home directory:  

You can also use TP monitor statements in your client programs. The use of the XA 
API is also supported from both Pro*C and Oracle Call Interface (OCI). In either 
case, the XA80.DLL must be contained in the execution path of the calling program.

Component Location

XA80.DLL ORACLE_HOME\BIN

XA80.LIB ORACLE_HOME\RDBMS80\XA

XA.H ORACLE_HOME\RDBMS80\XA
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Compiling and Linking a Pro*C Program
To compile and link a Pro*C program:

1. Precompile PROGRAM.PC using Pro*C to generate PROGRAM.C.

2. Compile PROGRAM.C, making sure to include ORACLE_HOME\ 
RDBMS80\XA in your path.

3. Link PROGRAM.OBJ with the following libraries:   

4. Run PROGRAM.EXE. (XA80.LIB makes the function calls to XA80.DLL.) 

Compiling and Linking an OCI Program
To compile and link an OCI program:

1. Compile PROGRAM.C by using MSVC++ or Borland C, making sure to 
include ORACLE_HOME\RDBMS80\XA in your path.

2. Link PROGRAM.OBJ with the following libraries:

3. Run PROGRAM.EXE. 

Library Located in...

XA80.LIB ORACLE_HOME\RDBMS80\XA

OCI.LIB ORACLE_HOME\OCI80\LIB\MSVC

or

ORACLE_HOME\OCI80\LIB\BORLAND

SQLLIB80.LIB ORACLE_HOME\PRO80\LIB\MSVC

or

ORACLE_HOME\PRO80\LIB\BORLAND

Library Located in...

XA80.LIB ORACLE_HOME\RDBMS80\XA

OCI.LIB ORACLE_HOME\OCI80\LIB\MSVC

or

ORACLE_HOME\OCI80\LIB\BORLAND
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XA and TP Monitor Information
See the following general information about XA and TP monitors: 

■ Distributed Transaction Processing: The XA Specification published by X/
Open, (now part of OpenGroup). Visit: http://www.rdg.opengroup.org/public/
pubs/catalog/full_lst.htm 

■ Transaction Processing XPG4 X/Open CAE Specification XO/CAE/91/300 or 
C193 2/92

■ Your specific TP monitor documentation

For more information about the Oracle XA Library, see the chapter “Oracle 
XA” of the Oracle8 Server Application Developer’s Guide.

Accessing Web Data with Intercartridge Exchange
This section discusses the following Intercartridge Exchange (ICX) topics:

■ Configuring Intercartridge Exchange

■ Using Intercartridge Exchange

■ UTL_HTTP Exception Conditions

■ Exceptional Conditions and Error Messages

■ Troubleshooting

Configuring Intercartridge Exchange
You must add a parameter to the registry before using ICX.

To configure ICX:

1. Start the registry editor from the MS-DOS command prompt:

C:\> REGEDT32

The Registry Editor window appears.
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2. Add HTTP_PROXY to the registry subkey of the Oracle home directory that 
you are using. The location of this parameter is determined by how many 
Oracle home directories are on your machine:

a. Choose Add Value from the Edit menu.

The Add Value dialog box appears.

b. Enter HTTP_PROXY in the Value Name field and REG_SZ in the Data 
Type field:

c. Click OK.

d. Enter www-proxy.your-site in the String field:

where marketing.com is only an example of a web site. Enter your real web 
site.

If You Have... ORA_EXTPROC_THREADED is Located in...

One home directory HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE

Additional 
directories

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ 
HOMEID

where ID is incremented for each additional Oracle home 
directory on your computer.
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Using Intercartridge Exchange
ICX enables you to use a stored package called UTL_HTTP to make hypertext 
transfer protocol (HTTP) calls from PL/SQL, SQL, and Server Manager statements. 
UTL_HTTP can:

■ access data on the Internet 

■ call Oracle Web Application Server Cartridges 

UTL_HTTP contains two similar entry points, known as packaged functions, that 
make HTTP callouts from PL/SQL and SQL statements:

■ UTL_HTTP.REQUEST

■ UTL_HTTP.REQUEST_PIECES

 Both packaged functions:

■ take a string universal resource locator (URL) of a site

■ contact that site

■ return the data (typically HTML) obtained from that site

The declarations to use with both packaged functions are described in the 
following sections.

Packaged Function UTL_HTTP.REQUEST
UTL_HTTP.REQUEST takes a URL as its argument and returns up to the first 2000 
bytes of data retrieved from the given URL. 

UTL_HTTP.REQUEST is specified as:

FUNCTION REQUEST (URL IN VARCHAR2) RETURN VARCHAR2;

To use UTL_HTTP.REQUEST from Server Manager, enter:

SVRMGR> SELECT UTL_HTTP.REQUEST(’HTTP://WWW.ORACLE.COM/’) FROM DUAL;
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which outputs:

UTL_HTTP.REQUEST(’HTTP://WWW.ORACLE.COM/’)                         

------------------------------------------------------

<html>

<head><title>Oracle Corporation Home Page</title>

<!--changed Jan. 16, 19

1 row selected.

Packaged Function UTL_HTTP.REQUEST_PIECES
UTL_HTTP.REQUEST_PIECES takes a URL as its argument and returns a PL/SQL 
table of 2000 bytes of data retrieved from the given URL. The final element may be 
shorter than 2000 characters. The UTL_HTTP.REQUEST_PIECES return type is a 
PL/SQL table of type UTL_HTTP.HTML_PIECES. 

UTL_HTTP.REQUEST_PIECES, which uses type UTL_HTTP.HTML_PIECES, is 
specified as:

type html_pieces is table of varchar2(2000) index by binary_integer;

function request_pieces (url in varchar2, 

   max_pieces natural default 32767)

return html_pieces;

A call to REQUEST_PIECES can look like the example below. Note the use of the 
PL/SQL table method COUNT to discover the number of pieces returned, which 
may be zero or more:

declare pieces utl_http.html_pieces;

begin 

  pieces := utl_http.request_pieces(’http://www.oracle.com/’); 

   for i in 1 .. pieces.count loop

     .... -- process each piece

   end loop;

end;
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The second argument to UTL_HTTP.REQUEST_PIECES, (MAX_PIECES) is 
optional. MAX_PIECES is the maximum number of pieces (each 2000 characters in 
length, except for the last, which may be shorter) that 
UTL_HTTP.REQUEST_PIECES returns. If provided, that argument is likely a 
positive integer. 

For example, the following block retrieves up to 100 pieces of data (each 2000 bytes, 
except perhaps the last) from the URL. The block prints the number of pieces 
retrieved and the total length, in bytes, of the data retrieved. 

set serveroutput on

/

declare 

  x utl_http.html_pieces;

begin

  x := utl_http.request_pieces(’http://www.oracle.com/’, 100);

  dbms_output.put_line(x.count || ’ pieces were retrieved.’);

  dbms_output.put_line(’with total length ’);

  if x.count < 1 

  then dbms_output.put_line(’0’);

  else dbms_output.put_line

((2000 * (x.count - 1)) + length(x(x.count)));

  end if;

end;

/

which outputs:

Statement processed.

4 pieces were retrieved.

with total length 

7687

The elements of the PL/SQL table returned by UTL_HTTP.REQUEST_PIECES are 
successive pieces of data obtained from the HTTP request to that URL. 
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UTL_HTTP Exception Conditions
This section describes the exceptions that can be raised by packaged functions 
UTL_HTTP.REQUEST and UTL_HTTP.REQUEST_PIECES.

UTL_HTTP.REQUEST
The PRAGMA RESTRICT_REFERENCES enables exceptions (errors) to be 
displayed:

create or replace package utl_http is

function request (url in varchar2) return varchar2;

pragma restrict_references (request, wnds, rnds, wnps, rnps);

UTL_HTTP.REQUEST_PIECES
The PRAGMA RESTRICT_REFERENCES enables exceptions (errors) to be 
displayed:

create or replace package utl_http is

type html_pieces is table of varchar2(2000) index by binary_integer;

function request_pieces (url in varchar2, 

       max_pieces natural default 32767)

return html_pieces;

pragma restrict_references (request_pieces, wnds, rnds, wnps, rnps);

Exceptional Conditions and Error Messages
This table describes possible error messages that can display: 

If... Then...

Initialization of the HTTP callout subsystem 
fails for environmental reasons such as lack of 
available memory 

Exception UTL_HTTP.INIT_FAILED is raised:

init_failed exception;

The HTTP call fails because of failure of the 
HTTP daemon or because the argument to 
REQUEST or REQUEST_PIECES cannot be 
interpreted as a URL because it is NULL or has 
non-HTTP syntax

Exception UTL_HTTP.REQUEST_FAILED is raised:

request_failed exception;
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No response is received from a request to the 
given URL because no site corresponding to 
that URL was contacted

A formatted HTML error message may be returned:

<HTML>

<HEAD>

<TITLE>Error Message</TITLE>

</HEAD>

<BODY>

<H1>Fatal Error 500</H1>

Can’t Access Document: http://home.nothing.comm.

<P>

<B>Reason:</B> Can’t locate remote host:  
home.nothing.comm.

<P>

<P><HR>

<ADDRESS><A HREF="http://www.w3.org">

CERN-HTTPD3.0A</A></ADDRESS>

</BODY>

</HTML>

Note: The first two exceptions in the table above, unless explicitly 
caught by an exception handler, are reported by this generic 
message:

ORA-06510: PL/SQL: unhandled user-defined exception

that shows them as "user-defined" exceptions, although they are 
defined in this system package.

If any other exception is raised during the processing of the HTTP 
request (for example, an out-of-memory error), then function 
UTL_HTTP.REQUEST or UTL_HTTP.REQUEST_PIECES reraises 
that exception.

If... Then...
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Troubleshooting
Do not expect UTL_HTTP.REQUEST or UTL_HTTP.REQUEST_PIECES to succeed 
in contacting a URL unless you can contact that URL by using a browser on the 
same computer (and with the same privileges, environment variables, etc.). If 
UTL_HTTP.REQUEST or UTL_HTTP.REQUEST_PIECES fails (that is, if it raises an 
exception or returns an HTML-formatted error message, yet you believe that the 
URL argument is correct), try contacting that same URL with a browser to verify 
network availability from your computer.
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 16
  Using Oracle8 ConText Cartridge

This chapter describes how to use Oracle8 ConText Cartridge supplied external 
filters and Oracle8 ConText Cartridge demos that are provided as an addition to 
Oracle8 ConText Cartridge. It also describes how to set up and use the components 
of Oracle8 ConText Cartridge Workbench. 

Before performing the tasks described in this chapter, complete the implementation 
tasks described in Oracle8 ConText Cartridge QuickStart Release 2.3

Specific topics discussed are:

■ Starting Oracle8 ConText Cartridge

■ Using Oracle8 ConText Cartridge Supplied External Filters

■ Using Oracle8 ConText Cartridge Workbench
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Starting Oracle8 ConText Cartridge
Oracle8 ConText Cartridge servers can be started using one of two methods:

■ Oracle8 ConText Cartridge Control Utility

■ MS-DOS command prompt

Oracle8 ConText Cartridge Control Utility
To help Oracle8 ConText Cartridge servers survive Windows NT console log off, 
use the Oracle8 ConText Cartridge control utility CTXCTL80.EXE to start, stop, and 
view the Oracle8 ConText Cartridge servers running on the Windows NT server/
workstation. 

The Oracle8 ConText Cartridge control utility interacts with a Windows NT service 
for Oracle8 ConText Cartridge. It is this service that manages the various Oracle8 
ConText Cartridge server processes on that Windows NT server/workstation. The 
service is called OracleHOME_NAMEConTextService80 and must be started prior 
to using the Oracle8 ConText Cartridge control utility. By default the service start 
type is AUTO. 

The Oracle8 ConText Cartridge control utility cannot list or kill Oracle8 ConText 
Cartridge servers started directly by executing CTXSRV80.EXE. It can only manage 
Oracle8 ConText Cartridge servers through the 
OracleHOME_NAMEConTextService80 Windows NT service. 

To start Oracle8 ConText Cartridge Servers using the control utility:

1. Enter at the MS-DOS command prompt:

C:\> CTXCTL80 

2. Enter at the control utility prompt:

COMMAND> START 1 [DML | DDL | LOAD | LING | QUERY] 
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MS-DOS Command Prompt
To start Oracle8 ConText Cartridge server from the MS-DOS command prompt:

1. Enter at the MS-DOS command prompt:

C:\> START CTXSRV80 -USER CTXSYS/PASSWORD@CONNECT_STRING -PERSONALITY LIST

where:

■ PASSWORD is the password for the CTXSYS user

■ CONNECT_STRING is the service name or alias to the database you want 
to connect to

■ LIST is the list of personalities you want to start the ConText server with

Oracle8 ConText Cartridge server processes started from the MS-DOS 
command prompt are killed by Windows NT when a console user logs off the 
Windows NT console. 

Using Oracle8 ConText Cartridge Supplied External Filters
External filters extend the filtering capabilities of Oracle8 ConText Cartridge. 
Oracle8 ConText Cartridge Supplied External Filters are provided as a part of 
Oracle8 ConText Cartridge. These supplied external filters are installed and used 
on the server. You may also define your own external filters. See the section “Using 
User Defined External Filters” for more information on user defined external filters.

New in this release of Oracle8 ConText Cartridge, you do not need to create 
wrappers if you are installing Oracle8 ConText Cartridge for the first time (a fresh 
installation). If you have upgraded from release 8.0.3, then you need to upgrade 
your existing wrappers.

The steps to using Oracle8 ConText Cartridge Supplied External Filters are as 
follows:

■ Step 1: Identify Supplied External Filter and Wrapper

■ Step 2: Setting Up Oracle8 ConText Cartridge External Filters

■ Step 3: Specifying Oracle8 ConText Cartridge External Filters
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Step 1: Identify Supplied External Filter and Wrapper
The following Oracle8 ConText Cartridge Supplied External Filters are supplied 
with Oracle8 ConText Cartridge for Windows NT. These filters can be used for 
filtering documents in many of the popular desktop publishing and word 
processor formats. The executables for the filters do not provide ConText with the 
required arguments, so ConText also provides scripts which act as wrappers for the 
executables.

The supplied external filters and their wrappers are installed automatically when 
you install Oracle8 ConText Cartridge. If your text file format is not listed in this 
table, then you need to provide your own external filter and wrapper. See the 
sections “Creating Wrappers for Oracle8 ConText Cartridge External Filters” and 
“Using User Defined External Filters” if your text file format is not listed in this 
table.

Note: If you have upgraded from a release prior to release 2.3 of 
ConText, you may have existing external filters supplied by 
ConText. These external filters are no longer current and need to be 
replaced by the external filters provided in this release.

You may also need to change your wrappers accordingly or use the 
wrappers provided by ConText in this release.



Using Oracle8 ConText Cartridge Supplied External Filters

                                                                   Using Oracle8 ConText Cartridge 16-5

Document Format Version Format 
ID1

Wrapper Name Windows NT 
Executable

AmiPro for Windows 1, 2, 3 19 AMIPRO W033B16D.EXE

Lotus Freelance for 
Windows

2 85 LOTUSFRE W114B16D.EXE

Lotus 123 2, 3, 4 20 LOTUS123 W020B16D.EXE

Lotus 123 5 N/A LOTUS123 W020B16D.EXE

MS Excel 5 21 MSEXCEL W021B16D.EXE

MS Excel 7 N/A MSEXCEL W021B16D.EXE

MS PowerPoint for 
Windows

2, 3, 4 84 POWER234 W109B16D.EXE

MS PowerPoint for 
Windows

7 N/A POWER7 W116B16D.EXE

MS Word for DOS 5.0, 5.5 8 WORDDOS W005B16D.EXE

MS Word for Macintosh 3, 4, 5 28 WORDMAC W054B16D.EXE

MS Word for Windows 2 18 WORDWN2 W044B16D.EXE

MS Word for Windows 6 68 WORDWN67 W049B16D.EXE

MS Word for Windows 7 N/A WORDWN67 W049B16D.EXE

PDF/Adobe Acrobat N/A 57 ACROPDF ACRONT.EXE

WordPerfect for DOS

WordPerfect for 
Windows

5.0, 5.1

5.x

3 WP5 W007B16D.EXE

WordPerfect for DOS

WordPerfect for 
Windows

6.0

6.x

1 WP67 W048B16D.EXE

WordPerfect for 
Windows

7.0 N/A WP67 W048B16D.EXE

Xerox XIF 5, 6 43 XEROXXIF W103B16D.EXE
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Step 2: Setting Up Oracle8 ConText Cartridge External Filters
This section provides instructions on setting up Oracle8 ConText Cartridge 
External Filters. On Windows NT, external filters must be placed in the directory 
ORACLE_HOME\BIN.

1 The information provided in the column Format ID is used to create filter preferences for mixed-format 
columns that require external filters. A format id is not provided for the following formats, because 
Oracle8 ConText Cartridge does not support mixed-format columns for these document formats:
*  Microsoft PowerPoint for Windows, version 7
*  Microsoft Word for Windows, version 7
*  Microsoft Excel for Windows, version 7
*  WordPerfect for Windows, version 7
However, the Oracle8 ConText Cartridge External Filters for these formats can be used for 
single-format columns that contain any one of these formats.

How Did you Install Oracle8 ConText 
Cartridge?

Set up the Supplied External Files This 
Way...

If you are installing Oracle8 ConText 
Cartridge for the first time...

The supplied external filters do not require 
any setup, aside from creating preferences 
that call the wrappers for the filters.

If you have upgraded from a previous 
release of Oracle8 ConText Cartridge, 
already have wrappers for the supplied 
external filters provided in the previous 
release, already have preferences that call 
the wrappers, and want to use the new 
wrappers provided in this release...

You must drop your indexes, policies, and 
preferences, then create new preferences, 
policies, and indexes.

To avoid this situation, choose one of the 
following actions:

■ modify the names of the new wrappers 
to match the names of the existing 
wrappers

■ modify the names of the new external 
filters to match the names of the 
previous external filters

■ modify your existing wrappers to call 
the new external filter executables

If you upgraded from a previous release of 
ConText and do not have any wrappers for 
your external filters...

Create wrappers. See the section “Creating 
Wrappers for Oracle8 ConText Cartridge 
External Filters”.
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Creating Wrappers for Oracle8 ConText Cartridge External Filters
If you upgraded from a previous release of Oracle8 ConText Cartridge, and you do 
not have wrappers already created and specified, then a wrapper must be created 
for each of the Oracle8 ConText Cartridge External Filters to be used to filter text 
stored in a column. The wrapper can be any type of executable, such as a Windows 
NT batch file, that calls the filter executable and provides two system-supplied 
variables as arguments. Once the required wrappers have been created, the 
external filters can be specified as the filters for the text column.

Two requirements for wrappers are:

■ the file must be located in the ORACLE_HOME\BIN directory 

■ the file extension must be .BAT or .CMD

The batch files for all other required external filters for Windows NT are identical to 
this example, except for the name of the filter executable supplied in each batch file.

The following example illustrates a simple Windows NT batch file that can be used 
as the wrapper AMIPRO.BAT for calling the AmiPro filter executable 
W033B16D.EXE for Windows NT: 

REM AMIPRO FILTER

ORACLE_HOME\BIN\W033B16D %1 /N /T=%2

where:

■ AMIPRO is the wrapper name.

■ ORACLE_HOME is the drive letter and name of your Oracle home directory.

■ W033B16D is the filter executable name. Note that the .EXE extension for the 
filter executable file is not specified, because Windows NT does not require it.

Note: If you modify your existing wrappers, in general, the only 
information that needs to change in the wrappers is the name of 
the filter executable.

If you are using the BETA PDF filter provided for Windows NT in 
the previous release and wish to use the new production PDF filter, 
drop any ConText indexes that you created with the BETA PDF 
filter, as well as the policies and preferences that called the filter. 
Create new policies and preferences that use the new filter and 
create new ConText indexes using the policies.
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The instructions for creating a wrapper for ACRONT.EXE are different than the 
instructions for creating wrappers for the rest of the executables. 

For ACRONT.EXE, the wrapper text must be as follows:

REM PDF FILTER 

ORACLE_HOME\BIN\ACRONT %1 %2

Step 3: Specifying Oracle8 ConText Cartridge External Filters
To specify one or more of the supplied external filters for a column, you first create 
a Filter preference in which you specify the wrapper (file name) for each of the 
filters to be used, then create a policy that calls the Filter preference. 

You can create filter preferences for:

■ Single Format Columns

■ Mixed Format Columns

Single Format Columns
For single format columns, create a Filter preference that uses the COMMAND 
attribute (USER FILTER Tile) to specify the wrapper that invokes the filter 
executable for the format used in your column. The following example illustrates a 
script which calls PL/SQL packages that create a Filter preference for a column that 
contains documents only in AmiPro format: 

BEGIN

CTX_DDL.SET_ATTRIBUTE(’COMMAND’,’AMIPRO.BAT’); 

CTX_DDL.CREATE_PREFERENCE(’AMIPRO_FILT’, 

                             ’AMIPRO FILTER’, 

                             ’USER FILTER’); 

END;  

Additional Information: For examples of using the supplied 
external filters, see Chapter 9 in Oracle8 ConText Cartridge 
Administrator’s Guide.
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Mixed Format Columns 
For mixed-format columns, create a Filter preference that sets the EXECUTABLE 
attribute (BLASTER Tile) once for each of the wrappers that invoke the formats you 
want to use in your column. The following example illustrates a script which calls 
PL/SQL packages that create a Filter preference for a column that contains 
documents in AmiPro, Adobe Acrobat, and WordPerfect 6.0 formats: 

BEGIN 

CTX_DDL.SET_ATTRIBUTE(’EXECUTABLE’,19,’AMIPRO.BAT’, 1); 

CTX_DDL.SET_ATTRIBUTE(’EXECUTABLE’,57,’ACROBAT.BAT’, 2); 

CTX_DDL.CREATE_PREFERENCE(’MULT_FILT’, 

                            ’MULTIPLE FILTERS’, 

                            ’BLASTER’); 

END; 

In this example, it is not necessary to specify the filter executable for WordPerfect 
6.0, because Oracle8 ConText Cartridge provides an internal filter for WordPerfect 
6.0. By default, when the Filter preference for a column uses the EXECUTABLE 
attribute (BLASTER Tile), Oracle8 ConText Cartridge uses internal filters for all 
supported formats for which an external filter is not explicitly specified. 

Additional Information: See Chapter 6 in Oracle8 ConText 
Cartridge Administrator’s Guide for more information about Oracle8 
ConText Cartridge External Filters.
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Using Oracle8 ConText Cartridge Supplied External Filters for Manual Filtering 
The external filters can also be used to manually filter your documents (files) prior 
to storing them in the database. 

To use the manual filtering method:

1. Call the appropriate external filter executable from the MS-DOS command 
prompt for each document to be filtered, and specify two arguments: 

■ the name of the document to be filtered 

■ the name of the output file used to store the filtered text 

C:\ORACLE_HOME\BIN>W049B16D TEST.DOC /N /T=OUTPUT.TXT 

In the above example, a Microsoft Word 6 (or 7) document named TEST.DOC is 
filtered using the W049B16D.EXE filter executable. The filtered output is stored 
in OUTPUT.TXT. 

For a Portable Document Format (PDF) file, the syntax is:

C:\ORACLE_HOME\BIN>ACRONT TEST.PDF OUTPUT.TXT

2. Load the filtered, plain (ASCII) text from the output file into a database column.

3. Create a policy for the column.

Be sure to specify a Filter preference that uses either the ASCII internal filter or 
no filter. 

4. Index the column. 

Additional Information: See Chapter 7 and Chapter 9 of Oracle8 
ConText Cartridge Administrator’s Guide for more information on 
policies.
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Oracle8 ConText Cartridge Demos
The following Oracle8 ConText Cartridge Demos are installed and used on the 
server:  

Using User Defined External Filters
If you define your own external filters (user defined external filters), the following 
list describes information specific to using user defined external filters on Windows 
NT:

■ On UNIX operating systems, Perl scripts and UNIX shell scripts can be 
executed as user defined external filters. On Windows NT, only .EXE, .CMD, 
and .BAT files are executed as user defined external filters by default.

■ To implement a filter as a shell script or Perl script on Windows NT, (for 
example, to run a Perl script FOO.PL), associate files with a .PL extension with 
a script processor such as CCPERL.EXE. When the Oracle8 ConText Cartridge 
server process executes your FOO.PL user defined filter, it calls CCPERL.EXE 
FOO.PL input file output file.

Product Demo Is Installed Under the Directory...

SQL*Plus ORACLE_HOME\CTX80\DEMO\CTXPLUS

Linguistics ORACLE_HOME\CTX80\DEMO\CTXLING

Additional Information: See “Configuring Oracle8 ConText 
Cartridge Demos” in Chapter 8, “Post-Installation Configuration 
Tasks” for further information on enabling the demo applications.

Additional Information: See:

■  Oracle8 ConText Cartridge QuickStart Release 2.3

■  Oracle8 ConText Cartridge Administrator’s Guide

■  Oracle8 ConText Cartridge Workbench User’s Guide 

for more information about configuring and using ConText 
components.
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Using Oracle8 ConText Cartridge Workbench
Oracle8 ConText Cartridge Workbench provides administration and development 
applications for Oracle8 ConText Cartridge. The Workbench can be installed on 
both server and client and consists of the following components:

Administration Tools

■ Oracle8 ConText Cartridge Configuration Manager

■ Oracle8 ConText Cartridge System Administration

Document Viewers

■ Oracle8 ConText Cartridge Viewer Plugin

■ Oracle8 ConText Cartridge Viewer Cartridge

■ Oracle8 ConText Cartridge Viewer Control

TextServer3 Dictionary Migration Tool

Oracle8 ConText Cartridge I/O Utility

Oracle8 ConText Cartridge Workbench Demo

Administration Tools
Oracle8 ConText Cartridge Workbench includes two administration tools for 
Oracle8 ConText Cartridge:

■ Oracle8 ConText Cartridge Configuration Manager

■ Oracle8 ConText Cartridge System Administration

Both tools offer the same functionality, except for two distinctions:

■ the Configuration Manager is web-based and platform-independent, whereas 
the System Administration Tool is supported on Windows NT and Windows 95 
platforms only

■ there is one installation of the Configuration Manager per database, in contrast 
to the System Administration Tool, which may be installed on multiple client 
machines



Using Oracle8 ConText Cartridge Workbench

                                                                   Using Oracle8 ConText Cartridge 16-13

Oracle8 ConText Cartridge Configuration Manager
The Configuration Manager is a web-based application that allows a ConText 
administrator to manage various administration tasks quickly and easily. It also 
incorporates a simple adhoc query tool.

In contrast to the System Administration Tool, which may be installed on multiple 
client machines, there is one installation of the Configuration Manager per 
database. Each installation of Configuration Manager runs under the CTXSYS user.

Configuration Manager includes a generic PL/SQL package for processing HTML 
pages extended with special tags that allow transparent interaction with a database.

An HTML-based online help system is delivered with the Configuration Manager. 
This online help system incorporates full text indexing facilities that enable you to 
search the help system. Therefore, usage information for the Configuration 
Manager is not included in this guide.

Oracle8 ConText Cartridge System Administration
The Oracle8 ConText Cartridge System Administration tool is a GUI application 
that can be used to perform system and text administration tasks. Before you can 
connect to the database using the Oracle8 ConText Cartridge System 
Administration tool:

■ an alias for the database that you want to connect to must be added to the 
TNSNAMES.ORA file on the computer where System Administration is 
installed. Centrally managed networks, for example those using Oracle Names 
Server, are not supported by the System Administration tool.

■ the CTXSYS user needs to connect once to each ConText database.The Oracle8 
ConText Cartridge System Administration tool prompts you when you attempt 
to connect to the database.

Note: The CTXSYS user needs to connect only once per database. 
Once CTXSYS connects to a database, the database is enabled 
thereafter for all users. See the online help with the Oracle8 
ConText Cartridge System Administration tool for details on 
connecting to the database.
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Document Viewers
Oracle8 ConText Cartridge Workbench includes three document viewer product 
components:

■ Oracle8 ConText Cartridge Viewer Plugin

■ Oracle8 ConText Cartridge Viewer Cartridge

■ Oracle8 ConText Cartridge Viewer Control

Oracle8 ConText Cartridge Viewer Plugin
The client-side Viewer Plugin can display most documents on the World Wide Web 
just as they would appear in their native format. 

The Viewer Plugin actually consists of a set of libraries. These libraries provide the 
means for viewing the file. The plugin currently supports WYSIWYG viewing and 
query term highlighting in the following formats:

■ WordPerfect 5.x, 6.x

■ MS Word 2, 6

All other formats supported by ConText are displayed, by default, as plain (ASCII) 
text.

In the Configuration Manager, the View Data form uses the Viewer Plugin to view 
a hit from the available query hitlist.
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Oracle8 ConText Cartridge Viewer Cartridge
The Viewer Plugin requires the Viewer Cartridge. The Viewer Cartridge is installed 
separately. Viewer Cartridge is used to package data for the Viewer Plugin. It 
generates the highlight information for a document, fetches the document from the 
ConText database, and then sends the document as a file (Mime-type “application/
x-ctxv”) to the web browser, which uses the Viewer Plugin (if available) to display 
the document.

Alternatively, for other Mime-types, the web browser can use its own mapping to 
invoke a helper application or plugin which can display the ConText-indexed 
documents. In such cases, Viewer Cartridge does not need the Viewer Plugin as 
long as suitable URLs have been specified.

The URL format is:

http://machinename.domain:port/ctxwview/
CtxwViewCart?colspec=policyname&textkey=xy&queryex=keyword

where:

■ machinename is the name of the web server computer

■ port is the port number of the listener (not the admin listener)

■ policyname is the name of the ConText policy

■ xy is the text key numerical identifier (this key can be identified using 
Configuration Manager)

■ keyword is the word that you want highlighted (this word must exist in the 
document)

Oracle8 ConText Cartridge Viewer Control
The Viewer Control is a 32-bit Windows custom control for use in client/server 
configurations. It can be embedded in Windows applications or in HTML pages 
(for display in Internet Explorer using the Object tag).

The Viewer Control is used to display retrieved documents using the intended 
layout and with search terms highlighted. The Viewer Control is delivered with a 
sample application implemented as a stand-alone container.

A viewed document can be in any of the supported server-side formats. For 
example, a Microsoft Word document can be viewed with the Viewer Control in a 
way similar to how it appears within Microsoft Word. The user can scroll through 
the document using the Next and Previous buttons to jump to other occurrences of 
the search term(s).
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Oracle8 ConText Cartridge I/O Utility
The I/O Utility enables you to load and unload data between database tables and 
client-side files. The I/O Utility is a 32-bit, stand-alone executable that performs a 
series of operations carried out in sequence as defined by a parameter file.

Example parameter files are documented in Oracle8 ConText Cartridge Workbench 
User’s Guide.

TextServer3 Dictionary Migration Tool
The TextServer3 Dictionary Migration tool has been developed to assist users who 
are migrating from TextServer3 to ConText. It allows you to:

■ create a policy in ConText for each indexable column of a TextServer3 table

■ migrate TextServer3 thesauri and synonym rings to ConText

■ create a section group in ConText for each section group in TextServer3

The tool is delivered as a PL/SQL package called CTXWMG_MIGRATE. The 
package generates SQL scripts that you can customize to your requirements before 
running them.

This package must be created in the ConText database on the server after the 
ConText Workbench is installed on a client machine. The scripts for creating the 
CTXWMG_MIGRATE package are automatically copied to the client machine 
during installation of the ConText Workbench. The scripts must then be run after 
installation to create the package.

Additional Information: See Chapter 3 in Oracle8 ConText 
Cartridge Workbench User’s Guide for more information about the 
I/O Utility.

Note: The TextServer3 Dictionary Migration Tool is not listed, in 
the Oracle Installer, under the list of available components for the 
ConText Workbench.
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Oracle8 ConText Cartridge Workbench Demo
There is a sample application using Oracle Forms provided with Oracle8 ConText 
Cartridge Workbench. See Oracle8 ConText Cartridge Workbench User’s Guide for 
more information.

Additional Information: See Chapter 2 in Oracle8 ConText 
Cartridge Workbench User’s Guide for more information about the 
Viewer Control and Viewer Plugin.

A Windows-based online help system is delivered with the Viewer 
Control. Therefore, usage information for the viewer is not 
included in the Oracle8 ConText Cartridge Workbench User’s Guide.

For more information about manually configuring the Viewer 
Cartridge, see Appendix A in Oracle8 ConText Cartridge Workbench 
User’s Guide.

Additional Information: See:

■ the online help provided with Oracle8 ConText Cartridge 
Workbench product components for usage information

■ Oracle8 ConText Cartridge Workbench User’s Guide for 
information on how to use the Workbench products
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A
Directory Structures

This appendix describes the default directory structures created when Oracle8 
database is installed on a Windows NT server and client machines.

Specific topics discussed are:

■ Windows NT Server Directory Structure

■ Client Directory Structure
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Windows NT Server Directory Structure
Oracle Installer places all Oracle8 database products for the Windows NT Server by 
default into subdirectories of ORANT. This will be a different location if you 
changed the default Oracle home during installation.

The subdirectories of a basic Oracle8 Enterprise Edition installation are shown 
below. If you installed additional products, other subdirectories are created.

For Oracle8 Enterprise Edition, all .DLL and .EXE files and configuration variables 
have their version numbers appended. This convention allows you to maintain 
multiple releases of these items for backward compatibility. For example, the 
executable for the Oracle Names Control Utility version 8.0 is NAMESCTL80.EXE.

Directory Name Contents

\A2OWIZ80 Oracle Migration Assistant for Microsoft Access 
files

\AGENTBIN Oracle Intelligent Agent files and subdirectories

\BIN Executables, help files, and library files

\CORE40 Oracle8 database message files

\CTX80 Oracle8 ConText Cartridge files. \CTX80 contains 
the following subdirectories:

 \ADMIN Oracle8 ConText Cartridge upgrading scripts

 \DATA Oracle8 ConText Cartridge files

 \DEMO Oracle8 ConText Cartridge demos

 \DOC Oracle8 ConText Cartridge documentation

\CTXW Oracle8 ConText Cartridge Workbench files. 
\CTXW contains the following subdirectories:

 \DEMO Oracle8 ConText Cartridge Workbench demos

 \IO Oracle8 ConText Cartridge I/O utility files

 \MIDDLE Oracle8 ConText Cartridge Workbench 
common files

 \MIGRATE Migration tool and documentation

 \VIEWER Oracle8 ConText Cartridge Viewer files
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\DATABASE Oracle8 Enterprise Edition starter database, 
password, and initialization files. \DATABASE 
contains the following subdirectory:

 \ARCHIVE Archive files

\DBS Oracle Toolkit II message files, SQL scripts, and 
other utility files

\EERN804 Oracle8 Enterprise Edition Release Notes

\JRE11 Files and subdirectories that allow Java 
applications to run. It is required by many of the 
Oracle Assistants. \JRE11 contains the following 
subdirectories:

 \BIN Java executable files.

 \CLASSES Oracle Assistants executable files

 \LIB Library files

\MD80 Oracle8 Spatial Cartridge files. \MD80 contains 
the following subdirectories:

 \ADMIN Oracle8 Spatial Cartridge scripts and files

 \DOC Oracle8 Spatial Cartridge documentation

\MSHELP Windows help files

\NET80 Message files and subdirectories for Net8 
products. \NET8 contains the following 
subdirectories:

Additional Information: See Net8 Getting Started 
for Windows NT and Windows 95 for additional 
information on the \NET8 directory and its 
subdirectories.

\ADMIN Configuration files used by Net8 for 
Windows NT

\AGENT Oracle Enterprise Manager intelligent agent

\DOCS Readme files

\ERROR Error files placed here by default

\LOG Log files placed here by default

Directory Name Contents
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\MESG Message files

\NAMES SQL scripts used to set up Oracle Names

\NET8ASST Oracle Net8 Assistant files

\TNSAPI TNS API library file

\TRACE Trace files placed here by default

\NLSRTL33 NLS message files. \NLSRTL33 contains the 
following subdirectory:

\DATA Loadable NLS files

\OCI80 Oracle Call Interface (OCI) files. \OCI80 contains 
the following subdirectories:

\INCLUDE Header files

\LIB Borland and Microsoft Visual C++ files

\SAMPLES Sample files

\OISFP10 Oracle File Packager files

\OPS Oracle Parallel Server Option files

\ORAINST Files used by Oracle Installer. \ORAINST contains 
the following subdirectory:

\NLB .NLB files

\ORD80 Object Data Cartridges: \ORD80 contains the 
following subdirectories:

\IMG Oracle8 Image Cartridge files

\TS Oracle8 Time Series Cartridge files

\VIR Oracle8 Visual Information Retrieval 
Cartridge files

\OTRACE80 Oracle Trace files. \OTRACE80 contains the 
following subdirectories:

\ADMIN Oracle Trace administration files, including 
SQL scripts

\INCLUDE Oracle Trace header files

\LIB Oracle Trace library file

Directory Name Contents
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\OTT80 Object Type Translator (OTT) message and 
configuration files

\OWAST Oracle Web Publishing Assistant files

\PLSQL80 Message files, SQL scripts, and demonstration 
files for PL/SQL

\PLUS80 SQL*Plus SQL and message files. \PLUS80 
contains the following subdirectory:

\HELP SQL*Plus help files

\PRO80 Oracle8 database message files for Pro*C/C++

\RDBMS80 Oracle8 Enterprise Edition message, resource, and 
README files. \RDBMS80 contains the following 
subdirectories:

\ADMIN Oracle8 database SQL scripts. Use SQL scripts 
to create data dictionary tables/views, and 
other views used by Oracle software.

\AQ Advanced Queuing demos

\EXTPROC External procedures demos

\LOADER Sample files for SQL*Loader

\RMAN Recovery Manager files

\TRACE Informational trace and alert files generated 
by Oracle8 Enterprise Edition

\XA Oracle XA Library files

\SYSMAN Oracle Enterprise Manager files. \SYSMAN 
contains the following subdirectories:

\ADMIN Oracle Enterprise Manager files and tools

\BMP Oracle Enterprise Manager bitmap image files

\DOC Oracle Enterprise Manager documentation

\OLE2 Oracle Enterprise Manager Oracle Objects for 
OLE (OLE) files

\QTOUR Oracle Enterprise Manager Quick Tour files

Directory Name Contents
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\SCRIPTS Oracle Enterprise Manager scripts

\SDK Oracle Enterprise Manager SDK files

\TEMP Oracle Enterprise Manager temporary files 
placed here

\VS10 NT Backup Manager and NT Recovery Manager 
files

Directory Name Contents
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Client Directory Structure
Oracle Installer places all client products by default into subdirectories of 
ORACLE_HOME. 

The subdirectories of a basic Oracle8 Enterprise Edition client installation are 
shown below. If you installed additional products, other subdirectories are created: 

Directory Name Contents

\BIN Executables, help files, and library files

\CLRN80 Oracle8 Client Release Notes

\CORE40 Oracle8 database message files

\DBS Oracle Toolkit II message files, SQL scripts, and 
other utility files

\JDBC JDBC Drivers

\JRE11 Files and subdirectories that allow Java 
applications to run. It is required by many of the 
Oracle Assistants. \JRE11 contains the following 
subdirectories:

 \BIN Java executable files.

 \CLASSES Oracle Assistants executable files

 \LIB Library files

\MSHELP Windows help files

\NET80 Message files and subdirectories for Net8 
products. \NET8 contains the following 
subdirectories:

Additional Information: See Net8 Getting Started 
for Windows NT and Windows 95 for additional 
information on the \NET8 directory and its 
subdirectories.

\ADMIN Configuration files used by Net8 for 
Windows NT

\AGENT Oracle Enterprise Manager intelligent agent

\DOCS Readme files

\ERROR Error files placed here by default
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\LOG Log files placed here by default

\MESG Message files

\NAMES SQL scripts used to set up Oracle Names

\NET8ASST Oracle Net8 Assistant files

\TNSAPI TNS API library file

\TRACE Trace files placed here by default

\NLSRTL33 NLS message files. \NLSRTL33 contains the 
following subdirectory:

\DATA Loadable NLS files

\OCI80 Oracle Call Interface (OCI) files. \OCI80 contains 
the following subdirectories:

\INCLUDE Header files

\LIB Borland and Microsoft Visual C++ files

\SAMPLES Sample files

\ORAINST Files used by Oracle Installer. \ORAINST contains 
the following subdirectory:

\NLB .NLB files

\OTRACE80 Oracle Trace files. \OTRACE80 contains the 
following subdirectories:

\ADMIN Oracle Trace administration files, including 
SQL scripts

\INCLUDE Oracle Trace header files

\LIB Oracle Trace library file

\OWAST Oracle Web Publishing Assistant files

\PLSQL80 Message files, SQL scripts, and demonstration 
files for PL/SQL

\PLUS80 SQL*Plus SQL and message files. \PLUS80 
contains the following subdirectory:

\HELP SQL*Plus help files

\PRO80 Oracle8 database message files for Pro*C/C++

Directory Name Contents
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\RDBMS80 Oracle8 Enterprise Edition message, resource, and 
README files. \RDBMS80 contains the following 
subdirectories:

\ADMIN Oracle8 database SQL scripts. Use SQL scripts 
to create data dictionary tables/views, and 
other views used by Oracle software.

\AQ Advanced Queuing demos

\EXTPROC External procedures demos

\LOADER Sample files for SQL*Loader

\RMAN Recovery Manager files

\TRACE Informational trace and alert files generated 
by Oracle8 Enterprise Edition

\XA Oracle XA Library files

\SYSMAN Oracle Enterprise Manager files. \SYSMAN 
contains the following subdirectories:

\ADMIN Oracle Enterprise Manager files and tools

\BMP Oracle Enterprise Manager bitmap image files

\DOC Oracle Enterprise Manager documentation

\OLE2 Oracle Enterprise Manager Oracle Objects for 
OLE (OLE) files

\QTOUR Oracle Enterprise Manager Quick Tour files

\SCRIPTS Oracle Enterprise Manager scripts

\SDK Oracle Enterprise Manager SDK files

\TEMP Oracle Enterprise Manager temporary files 
placed here

Directory Name Contents
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B
Initialization Parameters

Oracle8 Enterprise Edition uses initialization parameters to enable various features 
of the database every time an instance is started.

Specific topics discussed are:

■ Initialization Parameter File Overview

■ Initialization Parameters
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Initialization Parameter File Overview
An initialization parameter file is an ASCII text file containing parameters. By 
changing the parameters and values in an initialization file, you can specify, for 
example:

■ the amount of memory the database uses

■ whether to archive filled online redo logs

■ which control files currently exist for the database

Every database instance has a corresponding initialization parameter file and 
ORACLE_SID registry parameter that points to the system identifier (SID) for the 
instance.

The initialization parameter file name takes the form INITSID.ORA, where SID is 
the name of the database instance. For example, the initialization parameter file for 
the first starter database on your computer is named INITORCL.ORA. For each 
subsequent starter database installed on the same computer, the last letter of ORCL 
is replaced by a number and automatically incremented (that is for an initialization 
parameter file for a second starter database, the SID is ORC1, for a third starter 
database, the SID is ORC2, and so on.

A single instance might also have several initialization parameter files, each having 
some differences that affect system performance.   

Location 
By default, Oracle8 Enterprise Edition uses the initialization parameter files located 
in ORACLE_HOME\DATABASE, unless you specify a different initialization file 
with the PFILE option at database startup. 

Editing
To customize Oracle8 database functions, you may need to edit the initialization 
parameter files. Use any ASCII text editor to modify the file.

Additional Information: See Oracle8 Reference for a complete list 
and descriptions of all initialization parameters.
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Sample File
A sample file called INITORCL.80 is located in the ORACLE_HOME\DATABASE 
directory. If you want to use this file as part of database creation:

1. Rename the file INITSID.ORA where SID is the system identifier of the 
database instance you want to create.

2. Edit this file to reflect the correct location of your database files and the name 
of your database.

If you installed a starter database, the initialization parameter file INITSID.ORA 
used by the starter database is also located in ORACLE_HOME\DATABASE. You 
can use either INITORCL.80 or INITSID.ORA as a model for creating a new 
Oracle8 database initialization parameter file.

The annotated, sample initialization parameter file contains alternative values for 
the initialization parameters. These values and the annotations are preceded by 
comment signs (#), which prevent them from being processed. To activate a 
particular parameter, remove the preceding # sign. When you no longer want to 
use a particular parameter, edit the initialization parameter file to add a comment 
sign.

For example, several initialization parameters are specified with three different 
values to create small, medium, or large System Global Areas (SGAs), respectively. 
The parameter that creates a small SGA is active in the following example:

  db_block_buffers = 200 # SMALL 
# db_block_buffers = 550 # MEDIUM 
# db_block_buffers = 3200 # LARGE 

To create a medium-sized SGA, comment out the small parameter definition and 
activate the medium parameter definition. Edit the initialization parameter file as 
follows:

# db_block_buffers = 200 # SMALL 
  db_block_buffers = 550 # MEDIUM 
# db_block_buffers = 3200 # LARGE 
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Initialization Parameters
Oracle8 Reference includes descriptions of all initialization parameters and 
instructions for setting and displaying their values. The following table describes 
initialization parameters and default values for Oracle8 Enterprise Edition for 
Windows NT. 

Initialization Parameter Name Default Value Range of Values

AUDIT_TRAIL TRUE NONE (FALSE), 
DB (TRUE), OS

BACKGROUND_DUMP_ DEST %RDBMSnn%\TRACE\ Any valid directory 

COMPATIBLE 8.0.0.0.0 Default release to current 
release

COMMIT_POINT_ STRENGTH 1 0 - 255 

CONTROL_FILES %ORACLE_HOME%\DATABASE\ 
CTL1%ORACLE_SID%.ORA

Any valid path and 
filename 

DB_BLOCK_BUFFERS 200 200 to 3200

DB_BLOCK_SIZE 2048 512 - 16384

DB_FILES 1022 0 - 1022

DB_FILE_MULTIBLOCK_ READ_ COUNT1 8 1 - 312 

DB_FILE_SIMULTANEOUS_ WRITES 4 1 - 24 

DB_NAME ORACLE Any valid database name 
limited to a maximum of 
eight characters.

DISTRIBUTED_TRANSACTIONS 25 * TRANSACTIONS 0 - TRANSACTIONS 

DML_LOCKS 4 * transactions 20 to unlimited

LOG_ARCHIVE_BUFFER_ SIZE 127 1 - 127 

LOG_ARCHIVE_BUFFERS 4 1 - 8

LOG_ARCHIVE_DEST %RDBMSnn%\ Any valid directory

LOG_ARCHIVE_FORMAT %%ORACLE_SID%%%S.%T A valid filename format 

LOG_ARCHIVE_START None TRUE or FALSE

LOG_CHECKPOINT_ INTERVAL 8000 2 - Unlimited 

LOG_FILES 255 2 - 255 

LOG_SMALL_ENTRY_MAX_ SIZE 800 0 - Unlimited 

MAX_DUMP_FILE_SIZE 10240 0 to 4,000,000
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1 MAX_IO_SIZE is not an initialization parameter. It is used to calculate the maximum size of input/output (I/O) data. For 
example, to achieve an I/O data size of 128 KB:

For a given DB_BLOCK_SIZE (for example, 8 KB) set DB_FILE_MULTIBLOCK_READ_COUNT to 16. Multiply both values (8 
* 16) to achieve a user-defined I/O data size of 128 KB. Note that the value for DB_BLOCK_SIZE is set in the INITSID.ORA 
file. Ensure that the user-defined I/O data size does not exceed the MAX_IO_SIZE limit of 1 MB for release 8.0.4. However, 
if the values you set for DB_BLOCK_SIZE and DB_FILE_MULTIBLOCK_READ_COUNT exceed 1 MB, you do not receive 
an error message, but the I/O data size value defaults to 1 MB.

2 Depends on value for DB_BLOCK_SIZE parameter.
3 The parameters prefixed with MTS are for enabling your database to support a multi-threaded server configuration. See 

Oracle8 Server Concepts for specific information on this feature.

MTS_LISTENER_ADDRESS3 "(ADDRESS=(PROTOCOL=tcp)(PORT=15
21)(HOST=IP Address))"

User specific

MTS_MAX_DISPATCHERS 3 User specific

MTS_MAX_SERVERS 3 User specific

MTS_SERVERS 3 User specific

MTS_SERVICE SID SID

NLS_LANGUAGE AMERICAN Any valid language

NLS_SORT (Language dependent) (Language dependent)

NLS_TERRITORY AMERICA Any valid territory

OPEN_CURSORS 50 1 - Unlimited

OS_AUTHENT_PREFIX OPS$ Any character string 

PROCESSES 25 3 - Unlimited 

REMOTE_LOGIN_ PASSWORDFILE SHARED SHARED, EXCLUSIVE, 
NONE

SNAPSHOT_REFRESH_PROCESSES 0 0 to 10

SEQUENCE_CACHE_ENTRIES 10 10 to 32000

SHARED_POOL_SIZE 6,500,000 300 KB - Unlimited 

SORT_AREA_SIZE 65536 0 - Unlimited 

SORT_READ_FAC 20 0 - Unlimited 

SORT_SPACEMAP_SIZES 512 0 - Unlimited 

TEXT_ENABLE TRUE TRUE or FALSE

TEMPORARY_TABLE_ LOCKS SESSIONS 0 - Unlimited 

TIMED_STATISTICS None TRUE or FALSE

TRANSACTIONS_PER_ ROLLBACK_ SEGMENT 30 1 - 255 

USER_DUMP_DEST %RDBMSnn%\TRACE Any valid directory 

Initialization Parameter Name Default Value Range of Values
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Database Initialization Parameters
Check the following initialization parameters when creating a new database. They 
cannot be modified after you have created the database. See Chapter 9, “Creating a 
Database” for details on creating a new database, including the part of the 
procedure when you modify these parameters. 

1 Not an initialization parameter, but rather a clause in the CREATE DATABASE statement. See 
Chapter 9, “Creating a Database” for an example of using this clause.

Parameter Description

CHARACTER SET1 Specifies the database National Language Support (NLS) 
character set to use. This parameter can be set only when you 
create the database.

DB_BLOCK_SIZE Specifies the size in bytes of Oracle database blocks.

DB_NAME Specifies the name of the database to be created. The database 
name is a string of eight characters or less. You cannot change 
the name of a database.
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C
 Configuration Parameters and the Registry

The registry stores Oracle configuration parameters. This appendix describes only 
the configuration parameters that apply to Oracle8 Enterprise Edition. 

Specific topics discussed are:

■ About Configuration Parameters

■ Registry Overview

■ Registry Parameters

■ Modifying a Registry Value

■ Adding a Registry Parameter
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About Configuration Parameters
Oracle8 Enterprise Edition uses configuration parameters to locate files and specify 
runtime parameters common to all Oracle products. When an Oracle program or 
application requires a translation for a particular configuration variable, Oracle8 
Enterprise Edition consults the associated parameter. Oracle parameters are stored 
in the registry.

Registry Overview
Oracle8 Enterprise Edition stores its configuration information in a database (the 
registry) that is organized in a tree format. The tree format consists of keys in the 
registry and parameter values for the keys. Keys and parameter values can be 
viewed and modified in the Registry Editor. 

Keys are folders that appear in the left pane of a Registry Editor window. A key 
contains subkeys or parameters.

Parameters in the Registry Editor appear as a string that consists of three 
components:

■ name of the parameter

■ value class or type of entry

■ value itself

For example, parameter ORACLE_SID can have the following entry in the registry:

ORACLE_SID:REG_EXPAND_SZ:ORCL

Value classes for Oracle8 Enterprise Edition parameters are: 

■ string value with a REG_SZ, REG_EXPAND_SZ (for an expandable string), or 
REG_MULTI_SZ (for multiple strings) prefix to identify a parameter value 
entry as a data string

■ binary value with a REG_DWORD prefix to identify a value entry as a 
DWORD (hexadecimal data) entry

WARNING: The Registry Editor allows you to view and modify 
registry keys and parameter values. Normally, you do not need to 
do so, and in fact, are liable to break your system if you make 
incorrect changes. Only advanced users should use the registry!
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Registry Parameters
This section describes the following Oracle8 database registry parameters. Other 
products, such as Oracle Enterprise Manager and the Oracle8 Cartridges, have 
additional keys and parameters not described in this appendix. 

■ Parameters for Most Oracle Products

■ Parameters Describing Each Oracle Home Directory on a Computer

■ Parameters for Oracle8 Performance Monitor

■ Parameters for Oracle Services

To modify the registry values described below, see “Modifying a Registry Value” 
in this appendix.

Parameters for Most Oracle Products
This section describes the following parameter types:

■ Product and Installation Parameters

■ Installation Parameters for Computers with One Oracle Home

Parameters for most Oracle products are contained within the 
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE subkey. The exact location of 
parameters within this key depends on the number of Oracle home directories 
created on your computer. For the first installation, two registry subkeys are 
created for storing product and installation parameters. For all additional 
installations, only one registry subkey is created for storing product and 
installation parameters. 
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The following table describes this process:

For... Parameters are Created in Subkey... This Subkey Contains...

The first Oracle 
home installation

HKEY_LOCAL_MACHINE\SOFTWARE\ 
ORACLE

Product and installation parameters.

See “Product and Installation 
Parameters” for parameter 
descriptions.

HKEY_LOCAL_MACHINE\SOFTWARE\ 
ORACLE\HOME0

Several parameters specific to Oracle 
Installer. 

See “Installation Parameters for 
Computers with One Oracle Home” 
for parameter descriptions.

The second Oracle 
home installation

HKEY_LOCAL_MACHINE\SOFTWARE\ 
ORACLE\HOME1

Product and installation parameters.

See “Product and Installation 
Parameters” for parameter descriptions

The third Oracle 
home installation

HKEY_LOCAL_MACHINE\SOFTWARE\ 
ORACLE\HOME2

Product and installation parameters.

See “Product and Installation 
Parameters” for parameter descriptions

All additional 
Oracle home 
installations

HKEY_LOCAL_MACHINE\SOFTWARE\ 
ORACLE \HOMEID 

where ID is incremented for each additional 
Oracle home installation.

Product and installation parameters.

See “Product and Installation 
Parameters” for parameter descriptions
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This figure shows the parameter subkeys created with two Oracle home directories 
on the same computer:

The first Oracle installation 
on a computer creates 
parameter subkeys 
ORACLE and HOME0.

The second Oracle installation on a 
computer creates parameter subkey 
HOME1. With each installation, 
HOMEID is incremented.
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 Product and Installation Parameters
This section lists the product and installation parameters for most Oracle products. 
See the table in the previous section “Parameters for Most Oracle Products” to 
identify the subkey under which these parameters appear.      

Parameter Description Default Value Entry

A2OWIZ80 Specifies the location of Oracle Migration Assistant 
for Microsoft Access files.

ORACLE_HOME\A20WIZ80

API Specifies the location of files for Oracle Installer. ORACLE_HOME\DBS

COMPANY_NAME Specifies the name of the company entered during 
the installation process.

company name entered during 
installation

CORE40 Specifies the location of the database message files. ORACLE_HOME\CORE40

EXECUTE_SQL Specifies the executable to spawn SQL*Plus for the 
Oracle Installer.

PLUS40

ID Specifies the HOMEID of the Oracle home 
directory. The first Oracle home is always specified 
as zero.

0

MSHELP Specifies the location from where Windows help is 
invoked.

ORACLE_HOME\MSHELP

MSHELP_TOOLS Specifies the location of the Windows help files. ORACLE_HOME\MSHELP

NET80 Specifies the location of the Net8 directory. ORACLE_HOME\NET80

NLS_LANG Specifies the supported language, territory, and 
character set. This parameter specifies the language 
in which the messages are displayed, the territory 
and its conventions for calculating week and day 
numbers, and the character set displayed. The 
default value causes all messages to be displayed 
in American English.

AMERICAN_AMERICA. 
WE8ISO885981

NLSRTL32 Specifies the location of the Oracle7 NLS message 
files.

ORACLE_HOME\NLSRTL32

NLSRTL33 Specifies the location of the Oracle8 database NLS 
message files.

ORACLE_HOME\ORAINST\NLB

OI_NLS32 Specifies the value of ORA_NLS32 used by Oracle 
Installer during the installation process.

ORACLE_HOME\ORAINST\NLB
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ORA_EXTPROC_ 
THREADED

Specifies to use multiple, lightweight threads 
instead of a single dedicated user process when 
using external procedures.

FALSE

ORA_NLS32 Specifies the location of the system boot file and 
NLS loadable data files used by the Oracle7 
NLSRTL.

ORACLE_HOME\NLSRTL32
\DATA

ORA_NLS33 Specifies the location of the system boot file and 
NLS loadable data files used by Oracle8 Enterprise 
Edition NLSRTL.

ORACLE_HOME\NLSRTL33
\DATA

ORA_SID_ PWFILE Specifies the name of the password file containing 
the password for the database instance designated 
by the system identifier (SID).

ORACLE_HOME\DATABASE\ 
PWDSID.ORA

ORA_SID_ 
SHUTDOWN

When set to TRUE, shuts down the Oracle8 
database identified by the SID value when 
OracleServiceSID is stopped.

Note: This registry entry must be manually added.

Not applicable

ORA_SID_
SHUTDOWN_
TIMEOUT

Sets the maximum time to wait for the shutdown to 
complete before the service for a particular SID 
stops.

Note: This registry entry must be manually added.

Not applicable

ORA_SHUTDOWN When set to TRUE, enables the selected Oracle8 
database to be shut down when OracleServiceSID 
is stopped.

FALSE

ORA_SHUTDOWN
_TIMEOUT

Sets the maximum time to wait for the service to 
stop. 

You may set ORA_SHUTDOWN_TIMEOUT to any 
value greater than 30 seconds; values less than 30 
are ignored. 

Note: This registry entry must be manually added.

Not applicable

ORACLE_GROUP_
NAME

Specifies the name of the group containing icons of 
the Oracle products installed. The parameter is 
added to your registry when you first install Oracle 
products, even if Oracle Installer does not create a 
program group for the Oracle products you have 
installed. (For example, if you have installed only 
Net8 software.)

Oracle for Windows NT

Parameter Description Default Value Entry
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ORACLE_HOME Specifies the Oracle home directory in which 
Oracle products are installed. This directory is the 
top directory in the Oracle directory hierarchy. 

C:\ORANT

ORACLE_HOME_ 
NAME

Specifies the home name of the Oracle home 
directory in which Oracle products are installed. 

DEFAULT_HOME

ORACLE_HOME_ 
SERVICE

Specifies the home name of the Oracle home 
directory. This value appears in Oracle service 
names. Since no home name is required for the first 
Oracle installation, this parameter is not available 
for the first Oracle home installation; only 
subsequent Oracle home installations (for example, 
HOME1, HOME2, etc.) use this parameter.

The name that you specify during 
installation.

ORACLE_SID Specifies the name of the Oracle8 database instance 
on the host machine. The value of this parameter is 
the SID for the instance.

ORCL for the first Oracle product 
installation on a computer. For 
additional Oracle home 
installations, ORCL is incremented 
(for example, ORC1 for a second 
installation, ORC2 for a third 
installation, and so on)

OTRACE73 Specifies the location of the Oracle7 trace files. ORACLE_HOME\OTRACE73

OTRACE80 Specifies the location of the Oracle8 Enterprise 
Edition trace files.

ORACLE_HOME\OTRACE80

OTT_DFLT Specifies the executable used when OTT80.EXE is 
called. 

OTT80

OTT80 Specifies the location of the Object Type Translator 
(OTT) files.

ORACLE_HOME\OTT80

OWAST Specifies the location of the Oracle Web Publishing 
Assistant files.

ORACLE_HOME\OWAST

PLSQL23 Specifies the directory in which Oracle7 looks for 
PL/SQL message files. 

ORACLE_HOME\PLSQL23

PLSQL80 Specifies the directory in which Oracle8 Enterprise 
Edition looks for PL/SQL message files. 

ORACLE_HOME\PLSQL80

PLUS_DFLT Specifies the executable used when SQLPLUS.EXE 
is called. 

PLUS80

PLUS80 Specifies the location in which to find the files 
needed to run SQL*Plus.

ORACLE_HOME\PLUS40

Parameter Description Default Value Entry
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Installation Parameters for Computers with One Oracle Home
The HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME0 subkey only 
contains the following parameters for the first Oracle home directory on a 
computer. This information is largely duplicated in HKEY_LOCAL_MACHINE\ 
SOFTWARE \ORACLE. 

PRO18 Specifies the location of Oracle7 Pro*C/C++ files. ORACLE_HOME\PRO18

PRO80 Specifies the location of Oracle8 Enterprise Edition 
Pro*C/C++ files.

ORACLE_HOME\PRO80

RDBMS73 Specifies the directory Oracle7 Server and the 
Oracle7 Utilities use to locate messages, resource 
files, and SQL scripts. 

ORACLE_HOME\RDBMS73

RDBMS80 Specifies the directory Oracle8 database and the 
Oracle8 Utilities use to locate messages, resource 
files, and SQL scripts. 

ORACLE_HOME\RDBMS80

RDBMS80_
ARCHIVE

Specifies the location of the backup database files. ORACLE_HOME\DATABASE
\ARCHIVE

RDBMS80_
CONTROL

Specifies the location of the database control files. ORACLE_HOME\DATABASE

SHARED_ORACLE
_HOME

Specifies the Oracle home directory used by Oracle 
Installer.

ORACLE_HOME

SQLPATH Specifies the location of the SQL scripts that 
SQL*Plus uses for searching SQL scripts. 

ORACLE_HOME\DBS

SVRMGR Specifies the location of Server Manager support 
files.

ORACLE_HOME\DBS

Parameter Description Default Value Entry

API Specifies the location of files for Oracle Installer. ORACLE_HOME\DBS

COMPANY_
NAME

Specifies the name of the company entered during 
the installation process.

company name entered during 
installation

ID Specifies the HOMEID of the Oracle home. The first 
Oracle home is always specified as zero.

0

Parameter Description Default Value Entry
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Parameters Describing Each Oracle Home Directory on a Computer
The HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ALL_HOMES subkey 
provides general information on each Oracle home directory on a computer. This 
subkey contains the following parameters:

■ IDx subkey(s)

■ the following parameters:

NLS_LANG Specifies the language in which the messages are 
displayed, the territory and its conventions for 
calculating week and day numbers, and the 
character set displayed. The default value causes all 
messages to be displayed in American English.

AMERICAN_AMERICA. 
WE8ISO885981

ORACLE_GROUP_
NAME

Specifies the name of the group containing icons of 
the Oracle products installed. The parameter is 
added to your registry when you first install Oracle 
products, even if Oracle Installer does not create a 
program group for the Oracle products you have 
installed. (For example, if you have installed only 
Net8 software.)

Oracle for Windows NT

ORACLE_HOME Specifies the Oracle home directory in which Oracle 
products are installed. This directory is the top 
directory in the Oracle directory hierarchy. 

ORACLE_HOME

ORACLE_HOME_ 
NAME

Specifies the home name of the Oracle home 
directory in which Oracle products are installed. 

DEFAULT_HOME

SHARED_ORACLE
_HOME

Specifies the Oracle home directory used by Oracle 
Installer.

ORACLE_HOME\DATABASE

Parameter Description Default Value Entry

DEFAULT_HOME Specifies the default Oracle home name (that is, the 
first Oracle home installed on your machine).

DEFAULT_HOME

HOME_COUNTER Specifies the number of installed Oracle homes. 1

LAST_HOME Displays the ID number of the most recently 
installed Oracle home. For example, if HOME1 was 
the most recently installed, the number 1 appears.

1

Parameter Description Default Value Entry
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IDx
This subkey corresponds to the HOMEID of the same number (for example, 
HOME0 for the first installation, HOME1 for the second installation, etc). IDx 
contains the following parameters. The values that display are determined by what 
you select during installation in the Oracle Installation Settings dialog box.

Parameters for Oracle8 Performance Monitor 

Depending on the number of Oracle home directories on your computer, Oracle8 
Performance Monitor parameters appear in one of the following subkeys:  

Parameter Description Default Value Entry

NAME Specifies the home name of the Oracle home for 
IDx. This is the value you specify when prompted 
for an Oracle home name.

DEFAULT_HOME for the first 
Oracle home

NLS_LANG Specifies the supported language, territory, and 
character set for IDx.

AMERICAN_AMERICA. 
WE8ISO885981

PATH Specifies the Oracle home directory for IDx. ORACLE_HOME

If You Have... Then Parameters Appear in...

One Oracle 
home 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet 
\Services\Oracle80\Performance

Additional 
Oracle homes

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet 
\Services\OracleHOME_NAME80\Performance

where HOME_NAME is the unique Oracle home name you specified 
during installation for each additional Oracle home.

Note: Modify only the Hostname, Password, and Username 
values to point to any database.
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For Oracle8 Performance Monitor to display information for Oracle8 performance 
objects, it must log onto the database. Modify the following parameters if the 
default information is not applicable or you want to access another database:

1 The 2:, 2:orcl, and 2:sid connect strings for local connections to Oracle8 Enterprise Edition are not supported. Instead, the 
new default connect string for a local connection uses the Bequeath Protocol Adapter.

Parameter Description Default Value 
Entry

Password Displays the password for the user name to access the database. Manager

Username Displays the user name to access the database. SYSTEM

Hostname Displays a Net8 connect string that allows you to edit the SID (two 
entries labeled SID in this example):1

DESCRIPTION=

  (ADDRESS_LIST=

    (ADDRESS=

      (PROTOCOL=BEQ)

      (PROGRAM=oracle80)

      (ARGV0=oracle80SID)

      (ARGS=’(DESCRIPTION=(LOCAL=YES)(ADDRESS=
(PROTOCOL=beq)))’)

    )

  )

  (CONNECT_DATA=(SID=SID)) 

)

Not applicable
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The following parameters are needed by the Oracle8 Performance Monitor as entry 
points:     

The following parameters specify the Oracle8 Performance Monitor log file and 
object configuration files:   

Parameter Description Default Value Entry

Close Specifies the close entry point for the DLL. CloseOracle8PerformanceData

Collect Specifies the collect entry point for the DLL. CollectOracle8PerformanceData

Open Specifies the open entry point for the DLL. OpenOracle8PerformanceData

Library Specifies the name of the Oracle8 Perfor-
mance Monitor DLL.

OPERF80.DLL

Parameter Description Default Value Entry

LOGFILE Specifies the name of the Oracle8 Performance 
Monitor log file. This log file reports any errors, 
such as Oracle8 objects not displaying or database 
access problems.

ORACLE_HOME\DBS
\OPERF80.LOG

PERF__FILE_
NAME

Specifies the location of PERF80.ORA. 
PERF80.ORA contains all the performance objects 
displayed by the Oracle8 Performance Monitor.

ORACLE_HOME\DBS\PERF80.ORA
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Parameters for Oracle Services
The HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services subkey 
contains subkeys that correspond to each Oracle service.

Each service subkey contains the following parameters:

Modifying a Registry Value

To edit the Oracle-related settings:

1. Start the registry in either of two ways:

■ From the command prompt, enter:

C:\> REGEDT32

■ Choose Start > Run, enter REGEDT32 in the Open field, and click OK.

Parameter Description Default Value Entry

DisplayName Specifies the service name of the instances whose 
SID is SID.

Name of the service. For example, 
OracleServiceORCL, where ORCL 
is the SID.

ImagePath Specifies the fully-qualified path name of the 
executable invoked by the service and any 
command-line arguments passed into the 
executable at runtime. 

Path to the executable file of the 
product. For example, 
ORACLE_HOME\BIN
\ORACLE80.EXE, if 
OracleNames80 is selected.

ObjectName Specifies the logon user account and machine to 
which the service should log on.

LocalSystem

CAUTION: Do not edit your registry unless it is absolutely 
necessary. If there is an error in your registry, your Oracle8 
Enterprise Edition may become nonfunctional. In fact, the 
registry itself can become unstable.
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The Registry Editor window appears:

2. Navigate to the values you want to view or modify by double-clicking keys.

The left-hand side of the window shows the hierarchy of registry keys, and the 
right-hand side of the window shows various values associated with a key.

3. Double-click the parameter to edit.
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An editor dialog box appears:

4. Make any necessary edits.

5. Click OK.

6. Choose Exit from the registry menu.

Adding a Registry Parameter
To add a parameter to the registry:

1. Start the registry in either of two ways:

■ From the MS-DOS command prompt, enter:

C:\> REGEDT32

■ Choose Start > Run, enter REGEDT32 in the Open field, and click OK.

The Registry Editor window appears.

2. Navigate to the key where you want to add the new value.

3. Choose the Add Value option in the Edit menu.

The Add Value dialog box appears:

4. In the Value Name field, enter the name that you want to assign to the 
currently selected key.
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5. In the Data Type box, select the value class that you want to assign to the 
added value:

■ REG_SZ, REG_EXPAND_SZ (for an expandable string), or 
REG_MULTI_SZ (for multiple strings) for a data string

■ binary value with a REG_DWORD prefix to identify a value entry as a 
DWORD (hexadecimal data) entry

6. Click OK.

An editor dialog box appropriate for the data type appears:

7. Enter the value itself for the parameter.

The Registry Editor adds the parameter. 

8. Choose Exit from the Registry menu.

The registry exits.
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D
Messages and Codes

This appendix lists the error messages, causes, and corrective actions that are 
specific to the installation and operation of Oracle8 Enterprise Edition for Windows 
NT. 

Specific topics discussed are:

■ Logging Error Messages

■ Oracle Installer Error Messages

■ Codes 09200-09499: Oracle8 Database Messages

■ Codes 04000-04999: Windows NT-Specific Oracle Messages



Oracle Installer Error Messages

D-2 Oracle8 Enterprise Edition Getting Started                                                    

Logging Error Messages 
Keep a log of error messages you receive from the Oracle8 Utilities by redirecting 
the messages to a file. You can record the contents of normal utility messages by 
using the LOGFILE parameter discussed in Oracle8 Utilities. You can separately 
record the error message portion by using standard Windows NT file redirection. 
For example, use the following syntax to redirect the output from the Export utility: 

C:\> EXP80 USERNAME/PASSWORD PARFILE=FILENAME >FILE1.LOG 2>FILE2.ERR

In this command line, FILE1.LOG receives the standard output from Export, while 
FILE2.ERR receives the standard error messages.

Oracle Installer Error Messages
This section lists error messages that can occur while using Oracle Installer. Most 
Oracle Installer error messages are accompanied with corrective information on the 
screen; therefore, they are not listed in this appendix. This appendix lists error 
messages in alphabetical order and provides the probable cause and corrective 
action.

Error Cause Action

DISK_FULL There is not enough disk space on the 
destination volume to copy the selected 
program.

Create space on the destination 
volume.

DRIVE_LOCKED The device specified in the full error 
message is in use or locked by another 
process.

Terminate or release the other 
process, or wait for it to complete.

FILE_CORRUPTED The file or directory specified in the full 
error message is damaged or not readable.

Try to repair or replace the file or 
repair the directory specified.

FILE_NOT_FOUND It was not possible to locate a file on the 
source or destination media. 

Run a utility program to locate any 
problems with the source or 
destination media; the media could 
be the CD-ROM drive, a network 
drive, or a floppy drive. 

INVALID_FILE_NAME The file or directory name or volume 
label specified in the full message is 
syntactically incorrect.

Specify the file, directory, or 
volume using the correct syntax.

LEXICAL_ERROR An error has been detected in the 
installation scripts.

Call Oracle Worldwide Customer 
Support.
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LOCKING_ VIOLATION A portion of the file specified in the full 
message has been locked by another 
process.

Release or terminate the other 
process, or wait for it to complete.

OS_ERROR There is an unexpected operating system 
error. 

Run a utility program to locate any 
problems with the source or 
destination media; the media could 
be the CD-ROM drive, a network 
drive, or a floppy drive. 

PERMISSION_ DENIED The network has denied permission to 
perform the selected action. 

Check with the network 
administrator; make sure you have 
Administrator privileges and can 
perform the selected action. 

READ_ERROR A problem has been detected on the 
source or destination media while 
executing an I/O operation. 

1. If in a networking 
environment, verify that you 
have read permission for the 
networking file.

2. Run a utility program to locate 
any problems with the source 
or destination media; the 
media could be the CD-ROM 
drive, a network drive, or a 
floppy drive.

RECALIBRATION_FAILURE A hardware problem has been detected 
on the hard drive to which you are 
installing.

Run a utility program to diagnose 
the hard drive.

SHARING_VIOLATION The file specified in the full message has 
been locked by another process. (This 
error is similar to the 
LOCKING_VIOLATION message, which 
relates to a portion of a file.)

Release or terminate the other 
process, or wait until it completes.

TOO_MANY_OPEN_FILES Too many files are open on Windows NT. Close some of the open files.

Error Cause Action



Codes 09200-09499: Oracle8 Database Messages

D-4 Oracle8 Enterprise Edition Getting Started                                                    

Codes 09200-09499: Oracle8 Database Messages
This section lists error messages issued by the Oracle8 database. Each one is 
triggered by an operating system-dependent (OSD) message specific to Windows 
NT that specifies the error condition signalled. The OSD messages appear in the 
next section. When you receive one of these messages, look up the accompanying 
OSD message number listed in the section, “Codes 04000-04999: Windows 
NT-Specific Oracle Messages” for an explanation of the error. 

WRITE_ERROR A problem has been detected on the 
destination media while executing an 
input/output (I/O) operation. 

1. If you are in a network 
environment and installing 
onto the network, verify that 
you have permission to write 
to a network directory. 

2. Run a utility program to locate 
any problems with the source 
or destination media; the 
media could be the CD-ROM 
drive, a network drive, or a 
floppy drive.

WRITE_PROTECTED The file or directory specified in the full 
message (in which Oracle software is to 
be installed) is write-protected. 

Remove the write-protection from 
the specified file or directory.

Message Signal

ORA-09200 sfccf: error creating file

ORA-09201 sfcopy: error copying file

ORA-09202 sfifi: error identifying file

ORA-09203 sfofi: error opening file

ORA-09204 sfotf: error opening temporary file

ORA-09205 sfqio: error reading or writing to disk

ORA-09206 sfrfb: error reading from file

ORA-09207 sfsrd: error reading from file

ORA-09208 sftcls: error closing file

ORA-09209 sftget: error reading from file

ORA-09210 sftopn: error opening file

ORA-09211 sfwfb: error writing to file

Error Cause Action
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ORA-09212 sfwfbmt: error writing to file

ORA-09213 slgfn: error fabricating file name

ORA-09214 sfdone: I/O error detected 

ORA-09215 sfqio: error detected in I/O completion routine

ORA-09216 sdnfy: bad value ’%s’ for parameter %s

ORA-09217 sfsfs: failed to resize file

ORA-09218 sfrfs: failed to refresh file size

ORA-09240 smpalo: error allocating PGA memory

ORA-09241 smsalo: error allocating SGA memory

ORA-09242 smscre: error creating SGA

ORA-09243 smsget: error attaching to SGA

ORA-09244 smprset: error setting memory protections

ORA-09245 smcstk: error switching stacks

ORA-09246 sfsmap: unable to map SGA

ORA-09247 smsdes: error destroying the SGA

ORA-09260 sigpidu: error obtaining process id

ORA-09261 spdcr: error creating detached (background) process

ORA-09262 spdde: error terminating detached (background) process

ORA-09263 spini: error initializing process

ORA-09264 sptpa: error flagging process

ORA-09265 spwat: error temporarily suspending process 

ORA-09266 spawn: error starting an Oracle process

ORA-09270 szalloc: error allocating memory for security

ORA-09271 szlon: error verifying user name

ORA-09272 remote OS log on is not allowed

ORA-09273 szrfc: error verifying role name

ORA-09274 szrfc: insufficient role name buffer space

ORA-09280 sllfcf: error closing file

ORA-09281 sllfop: error opening file

ORA-09282 sllfrb: error reading records

ORA-09283 sllfsk: error skipping records

ORA-09290 sksaalo: error allocating memory for archival

Message Signal



Codes 09200-09499: Oracle8 Database Messages

D-6 Oracle8 Enterprise Edition Getting Started                                                    

ORA-09291 sksachk: invalid device specification for LOG_ARCHIVE_DEST

ORA-09292 sksabln: unable to build file name

ORA-09293 sksasmo: unable to send message to console

ORA-09300 osncon: unable to connect, DPMI not available

ORA-09301 osncon: local kernel only supported in standard mode

ORA-09310 sclgt: error freeing latch

ORA-09311 slsleep: error temporarily suspending process

ORA-09312 slspool: error spooling file to printer

ORA-09313 slsprom: error prompting user

ORA-09314 sltln: error translating logical name

ORA-09315 sql2tt: two-task error translating ORACLE_EXECUTABLE

ORA-09316 szrpc: unable to verify password for role

ORA-09317 szprv: insufficient privileges

ORA-09318 slkhst: error hosting out to operating system

ORA-09319 slgtd: unable to obtain the current date and time

ORA-09320 szrfc: unable to obtain the list of valid OS roles

ORA-09321 slzdtb: unable to convert zoned decimal to binary

ORA-09322 slpdtb: unable to convert packed decimal to binary

ORA-09330 session terminated internally by Oracle or by an Oracle DBA

ORA-09331 scgcan: unable to process lk_sync_cancel return code

ORA-09332 scgcc: unable to process lk_close return code

ORA-09333 scggc: unable to process lk_open_convert return code

ORA-09334 scggc: unable to process lk_convert return code

ORA-09335 scgcm: unable to process return code in completion procedure

ORA-09340 specified ORACLE_SID is either invalid or too long 

ORA-09341 scumnt: unable to mount database

ORA-09342 Detached process terminated by Oracle during SHUTDOWN ABORT

Message Signal
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Codes 04000-04999: Windows NT-Specific Oracle Messages
The error messages in this section are Oracle operating system-dependent (OSD) 
messages issued in response to an error condition in Windows NT. Each message in 
this section triggers an Oracle8 database error message, listed in the previous 
section, “Codes 09200-09499: Oracle8 Database Messages”. 

■ File I/O Errors: OSD-04000 to OSD-04099

■ Memory Errors: OSD-04100 to OSD-04199

■ Process Errors: OSD-04200 to OSD-04299

■ ORADEBUG Errors: OSD-04221 to OSD-04225

■ Loader Errors: OSD-04300 to OSD-04399

■ Semaphore Errors: OSD-04400 to OSD-04499

■ Miscellaneous Errors: OSD-04500 to OSD-04599

File I/O Errors: OSD-04000 to OSD-04099
OSD-04000

Logical block size mismatch
Cause:  The database block size specified in the initialization parameter file 
does not match the block size of the actual database files.

Action:  Use matching logical block sizes.

OSD-04001
Invalid logical block size
Cause:  The logical block size is not a multiple of 512 bytes, or it is too large. 

Action:  Change the value of DB_BLOCK_SIZE in the initialization parameter 
file.

OSD-04002
Unable to open file
Cause:  The specified path or file name is invalid, or the destination device is 
full. This error can also be caused by insufficient Windows NT file handles. 

Action:  Make sure the path and file exist, and the device has free space. If this 
fails, increase the number of Windows NT file handles. 
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OSD-04003
Unable to read file header block
Cause:  The media has been damaged. 

Action:  Recover the file if necessary, and verify that Windows NT is 
functioning correctly. 

OSD-04004
Invalid file header
Cause:  The file is corrupted. 

Action:  Recover the file. 

OSD-04005
SetFilePointer() failure, unable to read from file
Cause:  There was an unexpected return from the Windows NT system service, 
SetFilePointer(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04006
ReadFile() failure, unable to read from file
Cause:  There was an unexpected return from the Windows NT system service, 
ReadFile(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation.

OSD-04007
Truncated read
Cause:  The system encountered an unexpected end-of-file, which is due to 
damaged media. 

Action:  Verify that the file is not damaged. 
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OSD-04008
WriteFile() failure, unable to write to file
Cause:  There was an unexpected return from the Windows NT system service, 
WriteFile(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04009
Truncated write
Cause:  The destination device is full or the media is damaged.

Action:  Verify that the device has free space and the file is not damaged. 

OSD-04010
<create> option specified, file already exists
Cause:  The file you attempted to create already exists.

Action:  Delete the existing file or use the REUSE option in the SQL statement. 

OSD-04011
GetFileInformationByHandle() failure, unable to obtain file info
Cause:  There was an unexpected return from the Windows NT system service, 
GetFileInformationByHandle().

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04012
File size mismatch
Cause:  The file to be re-used is either too large or too small.

Action:  Specify the correct file size or delete the existing file. 

OSD-04013
Unable to read line from file
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
verify that the media is not damaged. 



Codes 04000-04999: Windows NT-Specific Oracle Messages

D-10 Oracle8 Enterprise Edition Getting Started                                                    

OSD-04014
Unable to close file
Cause:  The media has been damaged. 

Action:  Recover the file, if necessary, and verify that Windows NT is 
functioning correctly. 

OSD-04015
Asynchronous I/O request returned an error
Cause:  There was an unexpected return from the Windows NT system service. 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04016
Error queuing an asynchronous I/O request
Cause:  There was an unexpected return from the Windows NT system service. 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04017
Unable to open the specified RAW device
Cause:  An invalid path or file name was specified or the device is full.

Action:  Make sure the file exists and/or device is not full; verify that the 
operating system is functioning correctly.

OSD-04018
Unable to access the specified directory or device
Cause:  An invalid path name was specified. 

Action:  Make sure the directory or device exists and is accessible. 

OSD-04019
Unable to set file pointer
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
verify that the media is not damaged. 
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OSD-04020
Unable to set eof file marker
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
verify that the media is not damaged. 

OSD-04021
Unable to read file
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
verify that the media is not damaged. 

OSD-04022
Unable to write file
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
verify that the media is not damaged. 

OSD-04023
SleepEx() failure, unable to Sleep
Cause:  There was an unexpected return from the Windows NT system service. 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04024
Unable to delete file
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
verify that the media is not damaged. 
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OSD-04025
Invalid question asked
Cause:  This is an internal error, not normally expected to occur.

Action:  Contact Oracle Worldwide Customer Support. 

OSD-04026
Invalid parameter passed
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Worldwide Customer Support. 

Memory Errors: OSD-04100 to OSD-04199
OSD-04100

Malloc() failure, unable to allocate memory
Cause:  The program is out of memory. 

Action:  Shut down all unnecessary processes or install more memory in the 
computer. 

OSD-04101
Invalid SGA: SGA not initialized
Cause:  The System Global Area (SGA) has been allocated but not initialized.

Action:  Wait until the STARTUP has completed before attempting to connect.

OSD-04102
Unable to open/create file for shared memory object
Cause:  There was an unexpected return from the Windows NT system service, 
CreateFile(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04103
Unable to attach to SGA: SGA does not exist
Cause:  The SGA does not exist. 

Action:  Start up an Oracle instance.
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OSD-04104
Unable to map shared memory (SGA) into the address space
Cause:  There was an unexpected return from the Windows NT system service, 
MapViewOfFileEx(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04105
Shared memory (SGA) mapped to wrong address
Cause:  There was an unexpected return from the Windows NT system service, 
MapViewOfFileEx(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04106
Unable to allocate memory with VirtualAlloc
Cause:  The program is out of memory. 

Action:  Shut down all unnecessary processes or install more memory in the 
computer. 

OSD-04107
Unable to deallocate memory with VirtualFree
Cause:  There was an unexpected return from the Windows NT system service, 
VirtualFree(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04108
Unable to protect memory with VirtualProtect
Cause:  There was an unexpected return from the Windows NT system service, 
VirtualProtect(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation.
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Process Errors: OSD-04200 to OSD-04299
OSD-04200

Unable to begin another thread
Cause:  The program has run out of system resources. 

Action:  Shut down all unnecessary processes; install more memory in the 
computer.

OSD-04201
No pid structure supplied to spdcr()
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Worldwide Customer Support. 

OSD-04202
DosSetPriority() failure, unable to set process priority
Cause:  There was an unexpected return from the Windows NT system service, 
DosSetPriority(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04203
DosKillProcess() failure, unable to kill process
Cause:  There was an unexpected return from the Windows NT system service, 
DosKillProcess(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04204
Invalid pid
Cause:  Process ID not recognized by system, process previously terminated.

Action:  Verify that process ID is correct and that process is active. 
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OSD-04205
CreateProcess() failure, unable to spawn process
Cause:  There was an unexpected return from the Windows NT system service, 
CreateProcess().

Action:  Check the operating system error code and consult the Windows NT 
documentation.

OSD-04207
Invalid priority specified in CONFIG parameter ORACLE_PRIORITY
Cause:  The priority specified is invalid or out of range. 

Action:  Specify a valid setting for ORACLE_PRIORITY. 

OSD-04208
OpenProcess() failure, unable to open process handle
Cause:  There was an unexpected return from the Windows NT system service, 
OpenProcess(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04209
Incorrect or unknown background image name given to spdcr()
Cause:  There was an unexpected background name given to spdcr(). 

Action:  Contact Oracle Worldwide Customer Support. 

OSD-04210
Timeout waiting for thread semaphore
Cause:  An Oracle8 database thread died holding the semaphore. 

Action:  Restart Oracle8 database instance. 

OSD-04211
Thread information not found
Cause:  An Oracle8 database thread died without deleting its information. 

Action:  Restart Oracle8 database instance. 
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OSD-04212
Maximum number of Oracle threads reached
Cause:  The maximum number of Oracle8 database threads for the instance is 
reached.

Action:  Wait until some connections exit before trying again. 

OSD-04213
Oracle thread unable to DuplicateHandle()
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Worldwide Customer Support. 

OSD-04214
Oracle thread unable to CreateEvent()
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Worldwide Customer Support. 

OSD-04215
Bad function code supplied to ssthreadop
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Worldwide Customer Support. 

OSD-04216
Unable to find file handle for that thread
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Worldwide Customer Support. 

OSD-04217
Unable to retrieve system username for current user
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Worldwide Customer Support. 

OSD-04218
Cannot post thread
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Worldwide Customer Support. 
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OSD-04219
Bad thread list semaphore
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Worldwide Customer Support. 

ORADEBUG Errors: OSD-04221 to OSD-04225
OSD-04221

Target thread is currently busy
Cause:  The target thread is processing an oradebug command.

Action:  Wait and re-issue command.

OSD-04222
Unable to get the threads context
Cause:  Check OS error code.

Action:  Remedy OS error.

OSD-04223
Unable to set the threads context
Cause:  Check OS error code.

Action:  Remedy OS error.

OSD-04224
Unable to suspend the target thread
Cause:  Check OS error code.

Action:  Remedy OS error.

OSD-04225
Unable to resume the target thread
Cause:  Check OS error code.

Action:  Remedy OS error.

Loader Errors: OSD-04300 to OSD-04399
OSD-04300

Unable to read complete record from data file
Cause:  The data file ended in the middle of a record. This error occurs when 
loading files with a fixed record length. 
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Action:  Verify that the data file is of the correct length and contains complete 
records. 

OSD-04301
Record size too large
Cause:  The specified record size is too large to load. 

Action:  Reduce record size and reload the data. 

OSD-04302
Invalid record type and/or load options
Cause:  The control file’s Windows NT file processing options string contains 
an invalid option or keyword. 

Action:  Set the Windows NT file processing options string to an acceptable 
value. 

Semaphore Errors: OSD-04400 to OSD-04499
OSD-04400

Unable to acquire internal semaphore for process
Cause:  Oracle8 database has exceeded the maximum number of connections. 

Action:  Delete any unused connections and try again. 

OSD-04401
WaitForSingleObject() failure, unable to obtain semaphorex
Cause:  There was an unexpected return from the Windows NT system service, 
WaitForSingleObject(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

Miscellaneous Errors: OSD-04500 to OSD-04599
OSD-04500

Illegal option specified
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Worldwide Customer Support.
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OSD-04501
Internal buffer overflow
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Worldwide Customer Support.Support.

OSD-04502
Translations nested too deep
Cause:  The program encountered too many intermediate translations while 
attempting to translate a configuration variable. 

Action:  Simplify the values of configuration parameters to include fewer 
intermediate translations. 

OSD-04503
Text contains no translatable elementsx
Cause:  The program cannot recognize variables in the text to be translated.

Action:  Check and, if necessary, correct the text to be translated. 

OSD-04505
Stdin not responding
Cause:  The system is unable to receive input from the standard input stream.

Action:  Verify that the process has access to an input device. 

OSD-04506
Unable to spawn process via system()
Cause:  The system is out of memory or the executable is invalid. 

Action:  Shut down unnecessary processes; install more memory in the 
computer. Verify the name of the executable. 
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OSD-04507
Password for ’internal’ is incorrect
Cause:  An attempt was made to connect as ’internal’ with an invalid password. 

Action:  Verify that the password is correct and try again. 

OSD-04508
No password given
Cause:  An attempt was made to connect as ’internal’ without a password.

Action:  Enter a valid password when connecting as internal. 

OSD-04509
No password found
Cause:  Oracle was unable to locate and retrieve the password for ’internal’.

Action:  Verify that Oracle is installed and configured correctly. 

OSD-04510
Operating system roles are not supported
Cause:  An attempt was made to use an operating system role. 

Action:  Only use roles that were created ’IDENTIFIED BY PASSWORD’ as 
opposed to ’IDENTIFIED EXTERNALLY’. 

OSD-04511
Unable to get date and time from the operating system
Cause:  There was an unexpected return from GetLocalTime() call. 

Action:  Verify that the system time is correct on the computer. 

OSD-04512
Unable to translate the ’USERNAME’ configuration variable on server
Cause:  The ’USERNAME’ configuration parameter variable on the host is not 
properly set. 

Action:  Verify the ’USERNAME’ variable is set. 
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OSD-04513
’REMOTE_OS_AUTHENT’ variable not set to TRUE’
Cause:  For remote operating system log on to function, the 
’REMOTE_OS_AUTHENT’ parameter must be set to TRUE. 

Action:  Shut down and start up the instance with ’REMOTE_OS_AUTHENT = 
TRUE’ in the initialization parameter file. 

OSD-04514
The Windows NT Group name is too long for internal buffer
Cause:  The Windows NT Group name is too long.

Action:  Use a shorter Windows NT group name.
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E
National Language Support

This appendix describes National Language Support (NLS).

Specific topics discussed are:

■ NLS_LANG Parameters and Components

■ Default Values for NLS_LANG

■ Installing Additional Languages
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NLS_LANG Parameters and Components
Oracle8 Enterprise Edition provides NLS that enables users to interact with the 
database in their selected language. When you install Oracle8 Enterprise Edition, 
you select a language for database messages. Oracle Installer supplies a value for 
the NLS_LANG parameter based on the language selected. 

The NLS_LANG parameter uses the following format:

NLS_LANG = LANGUAGE_TERRITORY.CHARACTER_SET 

where:

The default language at installation is either the operating system language or the 
NLS_LANG setting of the currently selected Oracle home.

The NLS_LANG parameter is stored in the registry under the 
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\NLS_LANG subkey for the 
first Oracle home on your computer. For subsequent installations to different 
Oracle homes on the same computer, the path is HKEY_LOCAL_MACHINE\ 
SOFTWARE\ORACLE\HOMEID\NLS_LANG, where ID is the unique number 
identifying the Oracle home. See Appendix C, “Configuration Parameters and the 
Registry” for more information on the subkey locations for multiple Oracle homes.  

LANGUAGE Specifies the language and conventions for displaying 
messages, day name, and month name.

TERRITORY Specifies the territory and conventions for calculating week 
and day numbers.

CHARACTER_SET Controls the character set used for displaying messages.

Additional Information: See Oracle8 Reference for information on 
the NLS_LANG parameter and NLS initialization parameters.
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Default Values for NLS_LANG
The following table lists the default NLS_LANG values if you select any of these 
languages during installation of Oracle8 Enterprise Edition. 

If You Select... Then the NLS_LANG Value is...

Arabic ARABIC_UNITED ARAB EMIRATES.AR8MSWIN1256

Brazilian Portuguese BRAZILIAN PORTUGUESE_BRAZIL.WE8ISO8859P1

Catalan CATALAN_CATALONIA.WE8ISO8859P1

Croatian CROATIAN_CROATIA.EE8MSWIN1250

Czech CZECH_CZECH REPUBLIC.EE8MSWIN1250

Danish DANISH_DENMARK.WE8ISO8859P1

Dutch DUTCH_THE NETHERLANDS.WE8ISO8859P1

English AMERICAN_AMERICA.WE8ISO8859P1

Finnish FINNISH_FINLAND.WE8ISO8859P1

French FRENCH_FRANCE.WE8ISO8859P1

German GERMAN_GERMANY.WE8ISO8859P1

Greek GREEK_GREECE.EL8MSWIN1253

Hebrew HEBREW_ISRAEL.IW8MSWIN1255

Hungarian HUNGARIAN_HUNGARY.EE8MSWIN1250

Italian ITALIAN_ITALY.WE8ISO8859P1

Japanese JAPANESE_JAPAN.JA16SJIS

Korean KOREAN_KOREA.KO16KSC5601

Latin American Spanish LATIN AMERICAN SPANISH_AMERICA.WE8ISO8859P1

Norwegian NORWEGIAN_NORWAY.WE8ISO8859P1

Polish POLISH_POLAND.EE8MSWIN1250

Portuguese PORTUGUESE_PORTUGAL.WE8ISO8859P1

Romanian ROMANIAN_ROMANIA.EE8MSWIN1250

Russian RUSSIAN_CIS.CL8MSWIN1251

Simplified Chinese SIMPLIFIED CHINESE_CHINA.ZHS16GBK

Slovak SLOVAK_SLOVAKIA.EE8MSWIN1250
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NLS_LANG Settings in MS-DOS Mode and Batch Mode 
When using Oracle utilities such as Server Manager, SQL Loader, SQL*Plus, 
Import, and Export in MS-DOS mode, the character set field of the NLS_LANG 
parameter for the session must first be set to the correct value. This is required 
because MS-DOS mode uses, with a few exceptions, a different code page (OEM 
Code-page) from Windows (ANSI Code-page), and the default Oracle Home 
NLS_LANG parameter in the registry is always set to the appropriate Windows 
code-page. If the NLS_LANG parameter for the MS-DOS mode session is not set 
appropriately, error messages and data can be corrupted due to incorrect character 
set conversion. The following table lists the Oracle character sets that correspond to 
the OEM Primary Code-page in MS-DOS mode for each of the supported 
languages. 

Slovenian SLOVENIAN_SLOVENIA.EE8MSWIN1250

Spanish SPANISH_SPAIN.WE8ISO8859P1

Swedish SWEDISH_SWEDEN.WE8ISO8859P1

Traditional Chinese TRADITIONAL CHINESE_TAIWAN.ZHT16BIG5

Turkish TURKISH_TURKEY.WE8ISO8859P9

Language Character Set

Arabic AR8ASMO8X

Brazilian Portuguese WE8PC850

Catalan WE8PC850

Czech EE8PC852 

Danish WE8PC850 

Dutch WE8PC850 

English US8PC437

Finnish WE8PC850 

French WE8PC850 

German WE8PC850 

Greek EL8PC737 

If You Select... Then the NLS_LANG Value is...
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For Japanese, Korean, Simplified Chinese, and Traditional Chinese, the OEM 
Code-page is identical to the ANSI Code-page. In this case, there is no need to set 
the NLS_LANG in MS-DOS mode. 

Similarly, in Batch mode, set the correct character set value of the NLS_LANG by 
inserting a SET NLS_LANG command at the start of the batch procedure, 
according to the character set of the files to be processed in the procedure.

Hungarian EE8PC852 

Italian JA16SJIS

Japanese JA16SJIS

Korean KO16KSC5601

Latin American Spanish WE8PC850

Norwegian WE8PC850 

Polish EE8PC852 

Portuguese WE8PC850

Romanian EE8PC852 

Russian RU8PC866 

Simplified Chinese ZHS16CGBK

Slovak EE8PC852 

Slovenian EE8PC852

Spanish WE8PC850 

Swedish WE8PC850 

Traditional Chinese ZHT16BIG5

Turkish TR8PC857

Language Character Set
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Installing Additional Languages
To install an additional language:

1. Run Oracle Installer.

2. Enter the language you want to install in the Oracle Installation Settings dialog 
box.

3. Install the Oracle products again.

This method keeps any language support that was previously installed and adds 
the new language.
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F
Troubleshooting

This appendix describes how to troubleshoot problems with Oracle8 Enterprise 
Edition. 

Specific topics discussed are:

■ Database Connection Issues

■ Oracle8 Performance Monitor Issues

■ Migration Issues

■ Operating System Permission Issues

■ Using Oracle Trace
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Database Connection Issues
This table lists and provides answers to common Oracle8 database connection 
issues: 

1 Ensure that OracleHOME_NAMETNSListener is started if you are using an Oracle8 database that has a home name.

If You Receive This Error... Ensure Your...

TNS-12203 TNS: unable to connect to 
destination

OracleServiceSID and OracleTNSListener80 
services are started. See Managing Oracle 
Services in Chapter 10, “Administering a 
Database” and Chapter 10 “Troubleshooting 
Net8” in Net8 Administrator’s Guide.

ORA-12547 TNS: lost contact OracleServiceSID, OracleStartSID, and 
OracleTNSListener801 services are started. You 
receive this error if you attempt to use any of 
the Oracle8 Utilities, such as Server Manager. 
See “Managing Oracle Services” in Chapter 10, 
“Administering a Database” for instructions.

Note: This error is analogous to the following 
Oracle7 error: 

ORA-09352: Windows 32-bit Two-Task 
driver unable to spawn new ORACLE 
task

ORA-28575: unable to open RPC connection to 
external procedure agent 
ORA-06512: at "APPLICATIONS.OSEXEC", line 0 
ORA-06512: at "APPLICATIONS.TEST", line 4 
ORA-06512: at line 2 

TNSNAMES.ORA and LISTENER.ORA files 
have been correctly configured to use external 
procedures. See “Configuring External 
Procedure Calls” in Chapter 8 of Net8 Getting 
Started for Windows NT and Windows 95.
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Oracle8 Performance Monitor Issues
See “Oracle8 Performance Monitor Troubleshooting Information” in Chapter 12, 
“Monitoring a Database”, for information on Oracle8 Performance Monitor 
troubleshooting issues.

Migration Issues
This section includes the following topics:

■ Migration Error ORA-54 with Batch Migration Scripts

■ Oracle Data Migration Assistant

Migration Error ORA-54 with Batch Migration Scripts
If you are migrating from Oracle7 to Oracle8 Enterprise Edition with your own 
customized batch migration script, and the system seems to be taking unusually 
long to complete the migration, you may be experiencing an ORA-54 error. Follow 
these steps to complete migration:

1. Start Server Manager at the MS-DOS command prompt:

C:\>SVRMGR30

2. Connect to the Oracle8 database using your user name:

SVRMGR> CONNECT INTERNAL/PASSWORD
3. Start up the database by entering one of the following commands: 

Command Description

SVRMGR> STARTUP Uses the default INITSID.ORA file located in your 
ORACLE_HOME\DATABASE directory to start the 
Oracle8 database.

SVRMGR> STARTUP 
PFILE=PATH\FILENAME 

Uses an initialization file other than the default to start 
your database. PATH\FILENAME specifies an 
initialization parameter file other than the default, 
INITSID.ORA. The following example starts the database 
using a file named INIT2.ORA. 

SVRMGR> STARTUP 
PFILE=%ORACLE_HOME%\RDBMS80\INIT2.ORA
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4. Run the following scripts in order using Server Manager: 

■ CAT8000.SQL 

■ CAT8004.SQL 

■ CATREP8M.SQL (if using Advanced Replication)

5. Exit Server Manager:

SVRMGR> EXIT  

Oracle Data Migration Assistant
Note that the migration of replication support renders packages and views invalid.

If you migrate an Oracle7 database that has a different database character set from 
the NLS_LANG environment variable, the text in the log file is written in English.

When trying to start your database with Server Manager after migrating from a 
7.1.3.3.6 database, ensure that you use the PFILE option to identify the correct 
INITSID.ORA file. For example:

SVRMGR> STARTUP PFILE=C:\ORANT\RDBMS71\INITSID.ORA

where SID is the system identifier (SID) for the database you want to start.

Operating System Permission Issues
The permission problem (OS 5 or 3) is typically caused by inadequate configuration 
of the NTFS permissions. By default, the Oracle8 database service runs using the 
SYSTEM account instead of a named Windows NT user such as Administrator. In 
File Manager or Windows NT Explorer, you must grant Full Control on the 
ORACLE_HOME directory and all of its subdirectories to the SYSTEM user. The 
SYSTEM user has the full name The operating system and has an icon of a computer 
chip. For this and other Windows NT problems, consult your Windows NT 
documentation or contact your Windows NT System Administrator. 

After correcting the problem, you must delete any files created as a result of partial 
completion of the CREATE DATABASE command. The files to delete are the:

■ Data files: SYS1SID.ORA, USR1SID.ORA, RBS1SID.ORA, TMP1SID.ORA

■ Redo log files: LOG1SID.ORA, LOG2SID.ORA, LOG3SID.ORA, LOG4SID.ORA 

■ Control files: CTL1SID.ORA and CTL2SID.ORA

Then, run the BUILD_DB.SQL script again in Server Manager. 
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Using Oracle Trace
Oracle Trace is a general-purpose data collection tool that is part of the Oracle 
Enterprise Manager Performance Pack (not contained on this CD-ROM disc). 
Oracle Trace collects data from Oracle applications and databases. This data can 
include:

■ performance statistics

■ diagnostics data

■ system resource usage

■ business transaction details

This data can be:

■ formatted into a report for your review

■ input to the Oracle Expert tool of Oracle Enterprise Manager, an expert system 
that applies rules to this data and provides suggestions for optimizing your 
application or database.

See Oracle Enterprise Manager Oracle Trace User’s Guide for information on starting 
and using Oracle Trace.

Contacting Oracle Worldwide Customer Support
If after reading this appendix, you still cannot resolve your problems, call Oracle 
Worldwide Customer Support to report the error. See Contact Us! in this manual 
for information on how to contact Oracle Worldwide Customer Support. Please 
have the following information at hand:

■ The hardware and operating system release number on which your 
application(s) is running.

■ The release numbers (up to five digits in release) of all Oracle networking 
products involved in the current problem. 

■ The third-party vendor and version you are using.

■ The kind of links that are between the client and server.

■ A description of what does work.

■ The exact error message.

■ A Net8 trace if possible. If not, the log file is sufficient.
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Glossary

admin privileges

The authorization to perform certain administrative procedures on a system.

alias

(1) An alternative name for an existing network object, such as a host (server), or a 
set of parameters. (2) In SQL, a temporary name assigned to a table, view, column, 
or value within a SQL statement, used to refer to that item later in the same state-
ment or in associated SQL*Plus commands.

application

One or more program modules used to achieve a specific result. Applications can 
be nested within other applications.

authenticate

The process of verifying the identity of a user, device, or other entity in a computer 
system, often as a prerequisite for allowing access to resources in a system.

authorization

Permission given to a user, program, or process to access an Oracle8 database.

call interface

A set of standard software routines used to access an Oracle8 database. Also called 
the Oracle Call Interface (OCI).
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data dictionary

Where the Oracle8 database stores information about the structure of the database; 
describes how the data in the server is organized. Collection of tables and views 
commonly used by the Oracle8 database. Owned by the user SYS. Includes:

■ names of all tables and views in the database

■ names and datatypes of columns in database tables

■ privileges of all Oracle users

dynamic data dictionary

An online data dictionary is an integral part of the data source and always reflects 
the current definition of the data source. Data structures can be changed while the 
data source is being accessed. See also data dictionary.

DLL

Dynamic Link Libraries. Microsoft Windows operating system-loadable executable 
files.

external procedure

Function or procedure written in a third-generation language (3GL) that can be 
called from PL/SQL code. Only C is supported for Oracle8 external procedures.

HOME_NAME

Represents the Oracle home name if you use multiple Oracle homes. This convention 
is not applicable for a single Oracle home.

HOMEID

Represents a unique registry subkey for each Oracle home directory in which you 
install products. A new HOMEID is created and incremented each time you install 
products to a different Oracle home directory on one computer. Each HOMEID con-
tains its own configuration parameter settings for installed Oracle products.

initialization parameter file

File that contains information to initialize the database and instance.

instance

Combination of processes and threads that begins each time a database is started. 
Identified with a unique SID. A default SID, ORCx, is installed during installation 
of the Oracle8 database. 
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When you install Oracle8 database for the first time on a machine, your SID is 
typically ORCL. For each subsequent Oracle8 database installation into a different 
Oracle home on the same computer, ORCL is automatically incremented by one 
(that is, for a second Oracle8 database installation, the SID is ORC1, for a third 
Oracle8 database installation, the SID is ORC2, etc.).

The background threads and memory areas required to access an Oracle8 database. 
A database system requires one instance and one database. Every Oracle8 instance 
has a single system global area (SGA); a multiple-user instance also requires several 
background threads.

instance recovery

Recovery of an instance in the event of software or hardware failure, so that the 
database is again available to users. If the instance terminates abnormally, then 
instance recovery automatically occurs at the next instance startup.

instance failure

Failure that occurs when a problem arises that prevents a database instance (SGA 
and background processes) from continuing work. Instance failure can result from 
a hardware problem such as an outage, or a software problem such as an operating 
system crash. When an instance failure occurs, the data in the buffers of the SGA is 
not written to the data files.

instance identifier

A name or ID used to distinguish one instance from another when multiple 
instances exist on one CPU. The identifier is specified in an operating-system 
specific manner.

listener

The server process that listens for and accepts incoming connection requests from 
client applications. Oracle listener processes start up Oracle database processes to 
handle subsequent communications with the client.

LISTENER.ORA

A configuration file that describes one or more Transparent Network Substrate 
(TNS) listeners on a server.

mount

To associate a database with a started instance, in order to perform maintenance on 
the database, or to open it and make a database accessible to database users.
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mounted database

A database associated with an Oracle instance. The database can be opened or 
closed. A database must be both mounted and opened to be accessed by users. A 
database that has been mounted but not opened can be accessed by DBAs for some 
maintenance purposes.

NLS

National Language Support. Oracle support of national languages. Data can be 
entered, stored, and displayed in the language of the administrator’s choice.

Net8

The Oracle client/server communication software that offers transparent operation 
to Oracle tools or databases over any type of network protocol and operating 
system.

Network Computing Architecture

Network Computing Architecture is a common set of technologies that enables all 
PCs, network computers, and other client devices to work with all Web servers, 
database servers, and application servers over any network. It is a robust, scalable, 
and open infrastructure that serves as the basis for the next generation of 
distributed computing. 

network listener

A listener on a server that listens for connection requests for one or more databases 
on one or more protocols. See listener.

network service 

In an Oracle application network, a service performs tasks for its service 
consumers; for example, a Names Server provides name resolution services for 
clients.

NULL value

 The absence of a value.

ORANT

Default Oracle home directory where Oracle Installer installs the Oracle8 database 
on Windows NT.
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ORAWIN95

Default Oracle home directory where Oracle Installer installs the Oracle8 database 
on Windows 95.

offline redo log

A redo log file that has been archived.

online redo log

Redo log files that have not been archived, but are either available to the instance 
for recording database activity or are filled and waiting to be archived or re-used.

online redo log file

File that records all committed changes made to the database. Whenever a 
transaction is committed, the corresponding redo entries temporarily stored in redo 
log buffers of the SGA are written to an online redo log file by the background 
process LGWR. An online redo log file can be individual or mirrored; in the latter 
case, it is an online redo log group, made up of online redo log members.

Oracle Call Interface (OCI)

An optional Oracle product that allows users to embed Oracle calls directly into 
high-level languages. It is the program call interface to an Oracle8 database. See 
also call interface.

Oracle Protocol Adapter

A product that maps the functions of a given network protocol into Oracle 
Transparent Network Substrate (TNS) architecture. This process translates TNS 
function calls into requests to the underlying network protocol. This allows TNS to 
act as an interface among all protocols. Net8 requires protocol adapters.

Oracle service

Created and associated with an Oracle8 database. Similar to Windows NT services.

Oracle8 Database

Known formally as either Oracle7 Server or Oracle8, the Oracle8 database is an 
Object Relational Database Management System (ORDBMS). 

Oracle8 Enterprise Edition

The formal name for the Oracle8 database. Oracle7 Server is an Object Relational 
Database Management System (ORDBMS). 
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PL/SQL

The Oracle procedural language extension of SQL. PL/SQL combines the ease and 
flexibility of SQL with the procedural functionality of a structured programming 
language, such as IF ...THEN, WHILE, and LOOP. Even when PL/SQL is not 
stored in the database, applications can send blocks of PL/SQL to the database 
rather than individual SQL statements, thereby reducing network traffic.

precompiler

A tool that enables a user to embed any SQL statement in a third-generation 
language (3GL) (host language) program. The precompiler takes this program as 
input and produces as output another program, in the same 3GL, in which all the 
embedded SQL calls are translated into host language procedure calls. This 
resulting program can be compiled, linked, and executed. Oracle supports 
precompilers for the languages C, FORTRAN, Pascal, PL/I, COBOL, and Ada.

privilege

A right to successfully execute a particular type of SQL statement. Some examples 
of privileges include rights to connect to the database (create a session), create a 
table in your schema, select rows from someone else’s table, and execute someone 
else’s stored procedure. The privileges of an Oracle8 database can be divided into 
two distinct categories: system privileges and object privileges.

process

(1) A thread of control in an operating system; that is, a mechanism in an operating 
system that can execute a series of steps. Some operating systems use the terms job 
or task. A process normally has its own private memory area in which it runs. An 
Oracle8 database has two general types of processes: user processes and Oracle 
processes. (2) A synonym for “user,” a single entity performing a set of tasks in an 
operating system environment or a database.

query

A SQL SELECT statement that retrieves data, in any combination, expression, or 
order. Queries are read-only operations; they do not change data, they only retrieve.

quota

A limit on a resource, such as a limit on the amount of database storage used by a 
database user. A DBA can set tablespace quotas for each Oracle user name.
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redo log

A sequential log of all changes made to the data. The redo log is written and used 
in the event that a failure caused the changes to not be written to disk; it is used to 
re-apply the changes to disk. The redo log consists of two or more redo log files; 
one is optionally being saved while the other is being written to by the Oracle8 
database. When the file currently being written fills, the other file is re-used. See 
also online redo log and off-line redo log.

 redo log file 

A file containing records of changes to the databases. These files are used for 
recovery purposes. See also redo log. 

remote computer

A computer on a network other than the local computer.

remote database

A database on a computer other than the local database. Usually a computer on the 
same network, but at a different node (that is, a database that you use through a 
database link).

replication

A database feature in which identical (and updateable) copies of a table are stored 
in the database, on more than one node. 

role

A list of user names that can be granted privileges to use form and/or menu 
modules.

roles

Named groups of related privileges that are granted to users or other roles.

rollback

The second half of the recovery procedure. After the roll forward, any changes that 
were not committed must be undone. After the redo log files have been applied, 
the rollback segments are used to identify and undo transactions that were never 
committed, yet were recorded in the redo log. Oracle completes this step 
automatically.
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SQL

Structured Query Language—the internationally accepted standard for defining 
and manipulating relational databases.

SID

A unique name for an Oracle database instance. To switch between Oracle 
databases, users must specify the desired SID. The SID is included in the 
CONNECT DATA parts of the connect descriptors in a TNSNAMES.ORA file, and 
in the definition of the network listener in the LISTENER.ORA file. Also known as 
system ID.

schema

A collection of table definitions.

schema objects

A collection of related objects. Schema objects are the logical structures that directly 
refer to the database’s data. Schema objects include such structures as tables, views, 
sequences, stored procedures, synonyms, indexes, clusters, and database links. 
There is no relationship between a tablespace and a schema: objects in the same 
schema can be in different tablespaces, and a tablespace can hold objects from 
different schemas.

server

(1) The provider of services requested by a client.

service

An executable process installed in the Windows NT Registry database and 
administered by Windows NT. Once created and started, it can run even while no 
user is logged on to the Oracle8 database.

service name

The name used by clients to identify a Net8 server. A service name is mapped to a 
port number and protocol.

snapshot

Information stored in rollback segments to provide transaction recovery and read 
consistency. Rollback segment information can be used to recreate a snapshot of a 
row before an update.
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snapshots

Read-only copies of a master table located on a remote node. A snapshot can be 
queried, but not updated; only the master table can be updated. A snapshot is 
periodically refreshed to reflect changes made to the master table.

Starter Database

The starter database named ORACLE is the core of Oracle7 Server. Oracle 
Corporation recommends that you use the starter database and modify it to suit 
your needs.

static data dictionary

A data dictionary that contains data definitions that are not an integral part of the 
data source. Changes to data structures require the data source to be rebuilt. See 
also dynamic data dictionary.

synonym

An alias for a table, view, sequence, or program unit; a synonym is not actually an 
object itself, it is a direct reference to its base object. Synonyms are used to mask the 
real name and owner of an object, provide public access to an object, provide 
location transparency for tables, views, or program units of a remote database, and 
simplify the SQL statements for database users. A synonym can be public or 
private.

SYSDBA

A special database administer role that contains all system privileges with the 
ADMIN OPTION, and the SYSOPER system privilege. SYSDBA also permits 
CREATE DATABASE and time–based recovery.

SYSOPER

A special database administer role that permits a database administrator to 
perform STARTUP, SHUTDOWN, ALTER DATABASE OPEN/MOUNT, ALTER 
DATABASE BACKUP, ARCHIVE LOG, and RECOVER, and includes the 
RESTRICTED SESSION privilege.

system ID

A synonym for instance identifier. Often abbreviated to SID.
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SYSTEM user name

One of two standard DBA user names automatically created with each database 
(the other is SYS). The Oracle user SYSTEM is created with the password 
MANAGER. The SYSTEM user name is the preferred user name for DBAs to use 
when performing database maintenance.

TNSNAMES.ORA

A file that contains connect descriptors mapped to service names. The file may be 
maintained centrally or locally, for use by all or individual clients.

table

The basic unit of storage in a relational database management system. A table 
represents entities and relationships, and consists of one or more units of 
information (rows), each of which contains the same kinds of values (columns). 

tablespace

A logical portion of an Oracle8 database used to allocate storage for table and index 
data. Each tablespace corresponds to one or more physical database files. Every 
Oracle8 database has a tablespace called SYSTEM and may have additional 
tablespaces. A tablespace is used to group related logical structures together. For 
example, tablespaces commonly group all of an application’s objects to simplify 
certain administrative operations.

thread

Objects within processes that concurrently execute program instructions. This 
enables one process to use threads to run different parts of its program on different 
processors simultaneously.

trace file

A file created when a problem or exceptional condition is encountered while using 
a software program. Also called a dump file, the file contains information useful in 
diagnosing or locating the problem. 

variable

A named object that can be assigned a value and whose assigned value may change 
over time. SQL*Plus uses substitution, system, and user variables.
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variable parameters

(1) Parameters whose value can change or can be reset. (2) The INITSID.ORA 
parameters whose values can vary and affect the performance of a database. DBAs 
may wish to “tune” or experiment with the variable parameter values in order to 
optimize their database’s performance.
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Index
Symbols
"", SQL*Loader parameter, 3-17
"FIX n", SQL*Loader parameter, 3-17
"VAR xxxx", SQL*Loader parameter, 3-17

A
A2OWIZ80 parameter, C-6
Adobe Acrobat Reader, starting, 1-9
Advanced Replication support

additional documentation, 8-53
configuration requirements, 8-3
configuration responsibilities, 8-49
configuration tasks, 8-51
creating a SPOOL file, 8-51, 8-52
data dictionary

tables, 8-53
for custom database, 5-2
for starter database, 5-2
initialization parameter requirements, 8-51
tablespace requirements, 8-50, 8-53
using, 8-54

alert files, 12-14
for monitoring a database, 12-2
using, 12-14

alert view, 12-6
ALL_HOMES, registry subkey for multiple Oracle 

homes, C-10
ALTER DATABASE CONVERT, 7-32
ALTER DATABASE OPEN RESETLOGS, 7-33
ALTER PACKAGE, using, 8-52
ALTER USER command, 5-6
AmiPro format, supplied external filter, 16-5

API
parameter, C-9
value, C-6

Application Programming Interface. See API
assistant common files, 2-5
assistants

operating system compatibility, 3-3
Oracle Data Migration Assistant, 2-8
Oracle Database Assistant, 2-8
Oracle INTYPE File Assistant, 2-12
Oracle Migration Assistant for Microsoft 

Access, 2-9
Oracle Net8 Assistant, 2-9
Oracle Net8 Easy Config, 2-9
Oracle Patch Assistant, 2-3
Oracle Web Publishing Assistant, 2-13
starting, 3-13

ASYNC_READ, 7-26
ASYNC_WRITE, 7-26
audit trail, operating system, 3-21
AUDIT_TRAIL parameter, 12-12
auditing, 12-12
authentication

connecting as INTERNAL without a 
password, 11-14

connecting as SYSOPER or SYSDBA without a 
password, 11-10

connecting without a password as a 
nonprivileged database user, 11-3

creating an operating system-authenticated 
user, 11-7

granting database roles through Windows 
NT, 11-18

overview, 11-2
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setting OS_AUTHENT_PREFIX, 11-4
setting OSAUTH_PREFIX_DOMAIN, 11-5
SQLNET.ORA file, 11-3
using a password file, 10-17
using Windows NT Native Authentication 

Adapter, 11-2
auto-starting

Oracle Services, 10-7

B
BACKGROUND_DUMP_DEST parameter, using 

with trace files, 12-14
backup

databases, 9-19
OCOPY80 file types, 13-4

backup and recovery tools
Backup Manager, 13-2
NT Backup and Recovery Manager, 13-3
OCOPY80, 13-3
Recovery Manager (RMAN80.EXE), 13-3
selecting, 13-2
third-party backup and recovery vendors, 13-3

Backup Manager
capabilities, 4-16, 13-2
starting, 3-12

Bali, defined, 2-5
browsers

Java-enabled, 1-9
Microsoft Internet Explorer, 1-8, 10-22
Netscape Navigator, 1-8, 10-22

BUILD_DB.SQL script, 9-6, 9-11

C
cartridges

configuration guidelines, 8-2
for custom database, 5-2
for starter database, 5-2

CAT8000.SQL, 7-33
CAT8004.SQL, 7-38, 7-42
CATMD.SQL

creating data dictionary tables and views, 8-19
packages created, 8-19

CATNSNMP.SQL, capabilities, 5-5

CATOUT.LOG file, 7-33
CATPARR.SQL, 7-34
CATREP8M.SQL, 7-34

executing, 8-52
running, 8-52

CCF_IO_SIZE, 7-25
CD-ROMs, order of installation, 2-4
chart view, 12-6
CHECKPOINT_PROCESS, 7-25
COMMIT_POINT_ STRENGTH parameter, B-4
communication daemon, responsibilities, 4-7
COMPANY_NAME parameter, C-6, C-9
COMPATIBLE parameter, 7-32, B-4
compiling

OCI with Oracle XA, 15-11
Oracle XA Library, 15-10
Pro*C with Oracle XA, 15-11

composite jobs, Job Scheduling System, 4-10
configuration parameters

defined, C-2
registry, C-1

configuration requirements
Advanced Replication support, 8-3
for Oracle products, 8-2
multi-threaded external callouts, 8-3
Net8, 8-2
Oracle Enterprise Manager, 8-2
Oracle Parallel Server, 8-2
Oracle8 ConText Cartridge, 8-3
Oracle8 ConText Cartridge System 

Administration tool, 16-13
Oracle8 ConText Cartridge Workbench 

demo, 8-37
Oracle8 Image Cartridge, 8-3
Oracle8 Spatial Cartridge, 8-3
Oracle8 Time Series Cartridge, 8-3
Oracle8 Visual Information Retrieval 

Cartridge, 8-3
PL/SQL external procedures, 8-3

configuration responsibilities
Advanced Replication support, 8-49
Net8, 8-3
Oracle Enterprise Manager, 8-4
Oracle8 ConText Cartridge, 8-20
Oracle8 Image Cartridge, 8-40
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Oracle8 Spatial Cartridge, 8-17
Oracle8 Time Series Cartridge, 8-43
Oracle8 Visual Information Retrieval 

Cartridge, 8-46
configuration tasks

Advanced Replication support, 8-51
Oracle8 ConText Cartridge, 8-28
Oracle8 ConText Cartridge Demos, 8-31
Oracle8 ConText Cartridge demos, 8-31
Oracle8 ConText Cartridge Workbench, 8-32
Oracle8 ConText Cartridge Workbench 

Demos, 8-37
Oracle8 ConText Cartridge Workbench Viewer 

Cartridge, 8-32
Oracle8 Image Cartridge, 8-41
Oracle8 Image Cartridge Demos, 8-41
Oracle8 Spatial Cartridge, 8-17
Oracle8 Time Series Cartridge, 8-44
Oracle8 Time Series Cartridge Demos, 8-45
Oracle8 Visual Information Retrieval 

Cartridge, 8-47
Oracle8 Visual Information Retrieval Cartridge 

Demos, 8-48
configuring, LISTENER.ORA file, 15-3
CONNECT INTERNAL, 10-19

changing the INTERNAL password, 10-20
connecting without a password, 11-14
password, 10-19
using, 10-8, 10-19, F-3

connecting
to a database, 10-8, F-3

console
features, 4-3
Oracle Enterprise Manager, 4-2
windows, 4-5

contact information
documentation sales, 1-2
Legato, 2-6
Oracle Technical Publications, xv
Oracle Worldwide Customer Support, xv

control files
description, 5-9
starter database, 5-9

Control Panel
defined, 3-19

integration with Oracle8 database, 3-19, 10-3
starting, 3-10

CONTROL_FILES parameter, 9-9, B-4
conventions, used in this manual, xxiii
copy modes, for OCOPY80, 13-4
CORE40 parameter, C-6
CREATE DATABASE statement, 9-11
CREATE LIBRARY command, 15-6
CREATE USER, 11-7
creating, wrappers, 16-7
cross-platform job scripts, 4-10
CTXFORM demo, 8-37
CTXLING, Oracle8 ConText Cartridge 

demonstration, 8-31
CTXPLUS, Oracle8 ConText Cartridge 

demonstration, 8-31
Custom Configuration

contents, 5-2
database installation type, 5-2
using Oracle Database Assistant, 5-2

custom database
advanced replication support, 5-2
cartridges and options, 5-2
contents, 5-2
database files, 5-3
database name, 5-2
system identifier, 5-2
tablespaces, 5-3
user names, 5-3
using Oracle Database Assistant, 5-2

Customer Support
contacting, F-5
downloading patches with Oracle Patch 

Assistant, 10-21

D
data dictionary

Advanced Replication tables, 8-53
contents, 5-10
description, 5-10
starter database, 5-10

data files
description, 5-8
RBS1SID.ORA, 5-8
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starter database, 5-8
SYS1SID.ORA, 5-8
TMP1SID.ORA, 5-8
USR1SID.ORA, 5-8

Data Manager
capabilities, 4-17
starting, 3-12

database administration applications
Backup Manager, 4-16
common features, 4-18
Data Manager, 4-17
Instance Manager, 4-16
Oracle Enterprise Manager, 4-15
Schema Manager, 4-17
Security Manager, 4-16
Software Manager, 4-18
SQL Worksheet, 4-16
Storage Manager, 4-16

database backup and recovery tools, 13-3
Backup Manager, 13-2
NT Backup and Recovery Manager, 13-2
OCOPY80, 13-3
Recovery Manager (RMAN80), 13-3
third-party vendors, 13-3

database coexistence
issues, 7-4
overview, 7-2

database files
deleting, 9-8
for custom database, 5-3
for starter database, 5-3

database monitoring
using Performance Monitor, 12-3
with alert files, 12-14
with Event Viewer, 12-11
with trace files, 12-14

database name
for custom database, 5-2
for starter database, 5-2

database privileges
in Windows NT local groups, 11-10, 11-14,     

11-20, 11-22
database roles

DBSNMP user name, 5-5
DEMO user name, 5-5

granting through Windows NT, 11-18
MDSYS user name, 5-5
of SYS user name, 5-5
ORDSYS user name, 5-5
SCOTT user name, 5-5
SYSTEM user name, 5-5

database tools
operating system support, 3-2
starting, 3-5

database user, connecting without a password,   
11-3

databases
backing up, 9-19
BUILD_DB.SQL script, 9-6
changing passwords, 9-16
coexistence, 7-2
connecting to, 10-8, F-3
contents of starter database, 5-4
control file in starter database, 5-9
creating, 9-1
data dictionary in starter database, 5-10
data files in starter database, 5-8
deleting, 9-8
exporting, 9-7
importing, 9-16
installation in multiple homes, 7-8, 7-15
installation in the same home, 7-7, 7-13
installation on separate computers, 7-9
migrating Microsoft Access, 7-43
migration, 7-3, 7-10
monitoring, 12-1, 12-2
naming conventions, 9-2
Oracle Database Assistant, 9-2
parameters for a new database, B-4
password encryption, 10-20
redo log files in starter database, 5-9
shutting down, 10-8, 10-9, 10-14
starting, 10-8, 10-9
system identifier, 5-6
tablespaces in starter database, 5-7
upgrading, 7-3, 7-11, 7-36
user names in starter database, 5-4
what to do with existing databases, 7-2

DB_BLOCK_SIZE parameter, B-4
DB_FILE_MULTIBLOCK_ READ_ COUNT 
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parameter, B-4
DB_FILE_NAME_CONVERT, 7-26
DB_FILE_SIMULTANEOUS_ WRITES 

parameter, B-4
DB_FILE_STANDBY_NAME_CONVERT, 7-26
DB_FILES parameter, 9-10, B-4
DB_NAME parameter, 9-9
DB_WRITERS, 7-26
DBA_AUTHORIZATION parameter, 11-14
DBLINK_ENCRYPT_LOGIN parameter, 10-20
DBSNMP user account

dropping with CATNSNMP.SQL, 5-5
DBSNMP user name, 5-5

database roles, 5-5
password, 5-5

DBVERIFY
operating system compatibility, 3-2
starting, 3-7

DBWR_IO_SLAVES, 7-26
default control file, CTL1SID.ORA, 5-9
default data files

RBS1SID.ORA, 5-8
SYS1SID.ORA, 5-8
TMP1SID.ORA, 5-8
USR1SID.ORA, 5-8

default initialization parameter file, 
INITSID.ORA, 5-8

default redo log files
LOG1SID.ORA, 5-9
LOG2SID.ORA, 5-9
LOG3SID.ORA, 5-9
LOG4SID.ORA, 5-9

default tablespaces, 5-7
default user names, 5-4
DEFAULT_HOME parameter, C-10
DEMO user name, 5-5

database roles, 5-5
passwords, 5-5

demos
configuring for Oracle8 Image Cartridge, 8-41
configuring for Oracle8 Time Series 

Cartridge, 8-45
configuring for Oracle8 Visual Information 

Retrieval Cartridge, 8-48
Oracle8 ConText Cartridge, 8-31

directory structure
client, A-7
Windows NT Server, A-2

discovering services, for Oracle Enterprise 
Manager, 8-13

DISK_ASYNCH_IO, 7-26
DISK_FULL error message, D-2
DisplayName parameter, C-14
distributing software

Oracle, 14-2
Systems Management Server, 14-3

DLL, external procedures, 15-5
documentation

Adobe Acrobat Reader, 1-9
finding specific information, 1-8
formats, 1-2
generic, 1-3
HTML, 1-2
included manuals, 1-3
Oracle Information Navigator, 1-2
PDF, 1-2
printed, 1-2

documentation sales, 1-2
documentation set, (list of included manuals), 1-3
DRIVE_LOCKED error message, D-2

E
encrypting, database passwords, 10-20
error messages

Intercartridge Exchange, 15-17
logging, D-2
ORA-01102, 9-2
ORA-12547, F-2
Oracle Installer, D-2
Oracle8 database, D-4
OSD-04000 to OSD-04099, D-7
OSD-04100 to OSD-04199, D-12
OSD-04200 to OSD-04299, D-14
OSD-04300 to OSD-04399, D-17
OSD-04400 to OSD-04499, D-18
OSD-04500 to OSD-04599, D-18
resolving, F-5

Event Management System
Oracle Enterprise Manager, 4-12
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proactive events management, 4-12
Event Management Window, Oracle Enterprise 

Manager, 4-5
event scripts, with Job Scheduling System, 4-14
Event Viewer, 12-11

34 ID, 12-12
auditing, 12-12
blue (informational) icon, 12-12
defined, 3-20
for monitoring a database, 12-2
IDs other than 34, 12-12
integration with Oracle8 database, 3-20
logging operating system audit trail, 3-21
overview, 3-20
reading, 12-12
red (stop sign) icon, 12-12
starting, 3-10
using, 12-11
yellow (exclamation point) icon, 12-12

exception conditions, Intercartridge Exchange,   
15-17

EXECUTE privileges, on a PL/SQL library, 15-6
EXECUTE_SQL parameter, C-6
existing databases, installation types, 7-2
EXP80. See Export Utility
Export Utility

databases, 9-7
operating system compatibility, 3-2
redirecting output, D-2
starting, 3-7

EXTERNAL clause, 15-6
external filters (supplied), Oracle8 ConText 

Cartridge, 16-4
external procedures

additional documentation, 15-10
building, 15-2
building a DLL, 15-5
configuring, 15-3
creating, 15-2
creating a PL/SQL library, 15-6
defined, 15-2
enabling multi-threaded callout support, 15-8
EXTERNAL clause, 15-6
features, 15-2
granting EXECUTE privileges, 15-6

installing, 15-3
registering with Oracle8 database, 15-6
using EXTPROC, 15-3
using Oracle7 network configuration files, 8-2
writing, 15-4

EXTPROC, responsibilities, 15-3

F
FILE_CORRUPTED error message, D-2
FILE_NOT_FOUND error message, D-2
files

alert, 12-14
assistant common, 2-5
LISTENER.ORA, 15-3
sample INIT.ORA, B-3
trace, 12-14

G
GC_DB_LOCKS, 7-25
GC_FREELIST_GROUPS, 7-25
GC_ROLLBACK_SEGMENTS, 7-25
GC_SAVE_ROLLBACK_LOCKS, 7-25
GC_SEGMENTS, 7-25
GC_TABLESPACES, 7-25
GLOBAL_NAMES parameter, 9-9
GRANT EXECUTE ON command, 8-53

H
HOME_COUNTER parameter, C-10
HOME_NAME, defined, xxiv
HOMEID

defined, xxiv
registry naming convention, C-4

Hostname parameter, 12-4, C-12
hostname value, 12-4

I
ICX. See Intercartridge Exchange
ID parameter, C-6, C-9
ImagePath parameter, C-14
IMP80. See Import Utility
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Import Utility
databases, 9-16
operating system compatibility, 3-2
starting, 3-8

infowin@us.oracle.com, xviii
INIT.ORA file. See initialization parameter file
INIT_SQL_FILES, 7-25
initialization parameter file

creating a customized version, 5-2
defined, B-2
description, 5-8
editing, B-2
INITSID.ORA, 5-8
location, B-2
modifying, 9-9
starter database, 5-8
using PFILE option for database startup, 10-8
using the default file for database startup, 10-8

initialization parameter requirements
Advanced Replication Support, 8-51

initialization parameters
BACKGROUND_DUMP_ DEST, B-4
COMMIT_POINT_ STRENGTH, B-4
COMPATIBLE, B-4
CONTROL_FILES, B-4
DB_BLOCK_SIZE, B-4
DB_FILE_MULTIBLOCK_ READ_ COUNT, B-4
DB_FILE_SIMULTANEOUS_ WRITES, B-4
DB_FILES, B-4
LOG_ARCHIVE_BUFFER_ SIZE, B-4
LOG_ARCHIVE_BUFFERS, B-4
LOG_ARCHIVE_DEST, B-4
LOG_ARCHIVE_FORMAT, B-4
LOG_CHECKPOINT_ INTERVAL, B-4
LOG_FILES, B-4
LOG_SMALL_ENTRY_MAX_ SIZE, B-4
MTS_MAX_DISPATCHERS, B-5
MTS_MAX_SERVERS, B-5
MTS_SERVERS, B-5
NLS_LANGUAGE, B-5
NLS_SORT, B-5
NLS_TERRITORY, B-5
OPEN_CURSORS, B-5
OS_AUTHENT_PREFIX, 11-4, B-5
PROCESSES, B-5

REMOTE_LOGIN_PASSWORDFILE, B-5
SHARED_POOL_SIZE, B-5
SORT_READ_FAC, B-5
SORT_SPACEMAP_SIZES, B-5
TEMPORARY_TABLE_ LOCKS, B-5
TRANSACTIONS_PER_ ROLLBACK_ 

SEGMENT, B-5
USER_DUMP_DEST, B-5

installing, Oracle8 ConText Cartridge wrappers and 
external filters, 16-4

Instance Manager
capabilities, 4-16
Oracle Enterprise Manager, 4-16
starting, 3-12

instances
creating, 3-14
defined, 10-4
deleting, 3-14
editing, 3-16
running multiple instances, 10-16
starting, 3-15
stopping, 3-15

integrated applications, of Oracle Enterprise 
Manager, 4-15

Intercartridge Exchange
accessing web data, 15-12
configuring, 15-12
error messages, 15-17
exception conditions, 15-17
packaged functions, 15-14
stored packages, 15-14
troubleshooting, 15-19
using, 15-14

INTERNAL, 11-18
alias for SYS and SYSDBA, 5-4
changing the INTERNAL password, 10-20
connecting as, 10-19
connecting without a password, 11-14
password, 5-4, 10-19
user name, 5-4

INVALID_FILE_NAME error message, D-2
IO_TIMEOUT, 7-25
IPQ_ADDRESS, 7-25
IPQ_NET, 7-25
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J
Java Database Connectivity

JDBC OCI Driver, 2-7
JDBC Thin Driver, 2-6

Java Runtime Environment, 2-6
Java-enabled browsers, 1-9
JDBC. See Java Database Connectivity
Job Scheduling System

composite jobs, 4-10
event scripts, 4-14
lights out management, 4-10
optimized intelligent agent, 4-13
Oracle Enterprise Manager, 4-8
predefined event sets, 4-13
predefined job tasks, 4-9
scalability, 4-11, 4-13
scripts, 4-10
security, 4-11
storing and forwarding job scheduling, 4-9
unsolicited error detection, 4-12

Job Scheduling Window, Oracle Enterprise 
Manager Console, 4-5

JOB_QUEUE_INTERVAL, 7-26
JOB_QUEUE_PROCESSES, 7-26

L
LAST_HOME parameter, C-10
Legato NetWorker, defined, 2-6
Legato Storage Manager, 2-4
Legato Storage Manager, defined, 2-6
lexical data, loading, 8-25
LEXICAL_ERROR error message, D-2
lights out management, 4-10
linking

OCI with Oracle XA, 15-11
Oracle XA Library, 15-10
Pro*C with Oracle XA, 15-11

LISTENER.ORA file
external procedures, 15-3
migration, 7-19

LM_DOMAINS, 7-25
LM_NON_FAULT_TOLERANT, 7-25
local groups

with database privileges, 11-10, 11-14, 11-20,  
11-22

LOCKING_VIOLATION error message, D-3
log view, 12-6
LOG_ARCHIVE_BUFFER_ SIZE parameter, B-4
LOG_ARCHIVE_BUFFERS parameter, B-4
LOG_ARCHIVE_DEST parameter, B-4
LOG_ARCHIVE_FORMAT parameter, B-4
LOG_CHECKPOINT_ INTERVAL parameter, B-4
LOG_FILE_NAME_CONVERT, 7-26
LOG_FILE_STANDBY_NAME_CONVERT, 7-26
LOG_FILES parameter, B-4
LOG_SMALL_ENTRY_MAX_ SIZE parameter, B-4
LOG1SID.ORA file, 5-9
LOG2SID.ORA file, 5-9
LOG3SID.ORA file, 5-9
LOG4SID.ORA file, 5-9
LOGFILE parameter, C-13
logging error messages, D-2
Lotus 123 format, supplied external filter, 16-5
Lotus Freelance format, supplied external filter,  

16-5

M
managing jobs, Oracle Enterprise Manager, 4-12
managing, Oracle Services, 10-2
Map Window, Oracle Enterprise Manager, 4-5
MAX_IO_SIZE, B-5
MDSYS user name, 5-5

creating manually, 8-18
database roles, 5-5
password, 5-5

Microsoft Access, migrating to Oracle8, 7-43
Microsoft Excel format, supplied external filter,  

16-5
Microsoft Internet Explorer, 1-8, 10-22
Microsoft PowerPoint format, supplied external 

filters, 16-5
Microsoft Word format, supplied external 

filters, 16-5
MIG80. See Migration Utility
migration

instructions, 7-20
LISTENER.ORA file, 7-19
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multiple Oracle homes, 7-3
Net8 Listener, 7-17
networking issues, 7-16
Oracle7 Clients, 7-16
overview, 7-3
SQL*Net, 7-17
tools, 7-16

Migration Utility
operating system compatibility, 3-2
starting, 3-8
using, 7-20

MIGSID.ORA file, 7-30, 7-32
monitoring

alert files, 12-2
databases, 12-1
Event Viewer, 12-2
Oracle events, 3-20, 3-22
Oracle8 Objects, 12-6
Performance Monitor, 12-2
Performance Pack, 12-2
trace files, 12-2

MS_HELP parameter, C-6
MSHELP parameter, C-6
MTS_MAX_DISPATCHERS parameter, B-5
MTS_MAX_SERVERS parameter, B-5
MTS_SERVERS parameter, B-5
multiple instances, running, 10-16
multiple Oracle homes, 6-1

ALL_HOMES registry subkey, C-10
defined, xxiv, 2-4
environment, 6-4
HOMEID registry naming convention, C-4
impact on registry, C-3
migration, 7-3
overview, 6-2, 7-2
registry subkeys, C-4, C-5
service naming conventions, 10-2, 10-4, 10-5
system identifier, 5-6
upgrading, 7-3
working with, 6-6

multi-threaded callout support
configuration requirements, 8-3
enabling, 15-8
setting ORA_EXTPROC_THREADED, 15-9
setting OracleExtprocAgent, 15-9

multi-threaded server
configuring with Oracle Database Assistant, 2-8
initialization parameters, B-5

N
NAME parameter, C-11
naming conventions for multiple Oracle 

homes, 10-2
Navigator Window, 4-5
NET START command, 9-14
Net8

configuration requirements, 8-2
configuration responsibilities, 8-3
configuring for external procedures, 15-3
products, 2-10

Net8 Client, defined, 2-10
Net8 Listener, migration, 7-17
Net8 Server, defined, 2-10
NET80 parameter, C-6
Netscape Navigator, 1-8, 10-22
networking, migration, 7-16
NLS support, E-2
NLS_LANG environment variable, 7-21
NLS_LANG parameter, C-6, C-10, C-11, E-2

default values, E-2
territory and character set defaults, E-3

NLS_LANGUAGE parameter, B-5
NLS_SORT parameter, B-5
NLS_TERRITORY parameter, B-5
NLSRTL32 parameter, C-6
NLSRTL33 parameter, C-6
NT Backup Manager

capabilities, 13-3
operating system compatibility, 3-2
starting, 3-8

NT Recovery Manager
capabilities, 13-3
operating system compatibility, 3-2
starting, 3-8

ntdoc@us.oracle.com, xv
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O
Object Type Translator (OTT), defined, 2-12
ObjectName parameter, C-14
obsolete Oracle7 parameters, 7-25
OCI

defined, 2-7, 2-19
Oracle XA Library, 15-11

OCOPY80
backup file types, 13-4
capabilities, 13-3
copy modes, 13-4
operating system compatibility, 3-2
recovery file types, 13-6
starting, 3-8
syntax for backing up files, 13-5
syntax for recovering files, 13-6

ODBC. See Oracle Open Database Connectivity 
Driver

OI_NLS32 parameter, C-6
OPEN_CURSORS parameter, B-5
operating system

audit trail, 3-21
authentication overview, 11-2
troubleshooting, F-4

operating system authentication
connecting as INTERNAL without a 

password, 11-14
connecting as SYSOPER or SYSDBA without a 

password, 11-10
connecting without a password as a 

nonprivileged database user, 11-3
creating an authenticated user

creating, 11-7
granting database roles through Windows 

NT, 11-18
setting OS_AUTHENT_PREFIX, 11-4
setting OSAUTH_PREFIX_DOMAIN, 11-5
SQLNET.ORA file, 11-3

OPERF80.LOG file, 12-10
viewing Performance Monitor status, 12-10

OPS$, 11-4
optimized intelligent agent, Job Scheduling 

System, 4-13
OPTIMIZER_PARALLEL_PASS, 7-25

options
for custom database, 5-2
for starter database, 5-2

ORA_ENCRYPT_LOGIN parameter, 10-20
ORA_EXTPROC_THREADED

setting for multi-threaded callout support, 15-9
ORA_EXTPROC_THREADED parameter, C-7
ORA_NLS33 parameter, C-7
ORA_SHUTDOWN parameter, C-7
ORA_SHUTDOWN value, 10-14
ORA_SHUTDOWN_TIMEOUT parameter, C-7
ORA_SHUTDOWN_TIMEOUT value, 10-14
ORA_SID_PWFILE parameter, C-7
ORA_SID_SHUTDOWN parameter, C-7
ORA_SID_SHUTDOWN value, 10-14
ORA_SID_SHUTDOWN_TIMEOUT parameter,  

C-7
ORA_SID_SHUTDOWN_TIMEOUT value, 10-14
ORA-12547 error, F-2
Oracle Administrator Toolbar, defined, 2-7
Oracle Biometrics Manager, defined, 2-7
Oracle Call Interface. See OCI
Oracle Connection Manager, defined, 2-7
Oracle Data Gatherer, 2-3
Oracle Data Gatherer, defined, 2-8
Oracle Data Migration Assistant

defined, 2-8
starting, 3-13
using, 7-19, 7-36

Oracle Database Assistant
configuring cartridges, 9-5
creating an initialization parameter file, 5-2
defined, 2-8
deleting databases, 9-5
multi-threaded support, 9-5
starting, 3-13

Oracle DECnet Protocol Adapter, defined, 2-20
Oracle Enterprise Manager

Backup Manager, 4-16, 13-2
common services, 4-6
communication daemon, 4-7
configuration files, 8-13
configuration requirements, 8-2
configuration responsibilities, 8-4
configuration tasks, 8-6
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console capabilities, 4-2
console features, 4-3
console windows, 4-5
creating a repository, 8-13
Data Manager, 4-17
database administration applications, 4-15
defined, 2-8
discovering services, 8-13
Event Management System, 4-12
Event Management Window, 4-5
Instance Manager, 4-16
integrated applications, 4-15
Job Scheduling System, 4-8
Job Scheduling Window, 4-5
key components, 4-3
managing jobs, 4-12
Map Window defined, 4-5
Navigator Window, 4-5
operating system compatibility, 3-3
Oracle Intelligent Agent, 4-7
overview, 4-2, 8-4
Performance Pack, 12-2
Replication Manager, integrating, 4-19
repository, 4-14
scheduling jobs, 4-8
Schema Manager, 4-17
security, 4-15
Security Manager, 4-16
service discovery, 4-8
setup environments, 8-5
shutting down the database, 10-9
Software Manager, 4-18
SQL Worksheet, 4-16
starting, 3-11
starting the database, 10-9
Storage Manager, 4-16
Tcl scripts
User Manager, 8-9

Oracle Enterprise Manager configuration
creating a repository user account, 8-7
creating an NT user account, 8-9
starting Oracle Services, 8-6

Oracle Enterprise Manager SDK, defined, 2-9
Oracle File Packager, defined, 2-9
Oracle Home Selector, 2-3, 6-6

Oracle home, See multiple Oracle homes
Oracle Information Navigator, starting, 1-8
Oracle Installer

defined, 2-9
error messages, D-2

Oracle Intelligent Agent
communicating with the console, 4-7
defined, 2-9
overview, 8-4
responsibilities, 4-7
starting, 8-6

Oracle INTYPE File Assistant, defined, 2-12
Oracle Lock Manager, 12-16
Oracle LU6.2 Protocol Adapter

defined, 2-11, 2-20
Oracle Migration Assistant for Microsoft Access

defined, 2-9
restrictions, 7-45
starting, 3-13
using, 7-44

Oracle Named Pipes Protocol Adapter
defined, 2-11, 2-20

Oracle Names Server
defined, 2-10, 2-18

Oracle Net8 Assistant
defined, 2-9
starting, 3-13

Oracle Net8 Easy Config, 8-3
defined, 2-9
starting, 3-13

Oracle NetBIOS Protocol Adapter, defined, 2-20
Oracle Objects for OLE, defined, 2-12, 2-20
Oracle Open Database Connectivity Driver, 2-7,   

2-19
Oracle Parallel Server Manager Server, defined,    

2-12
Oracle Parallel Server Option, 2-3

defined, 2-12
Oracle Parallel Server, configuration 

requirements, 8-2
Oracle Patch Assistant, 2-3

defined, 2-12
starting, 3-13
using, 10-21

Oracle products
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configuration guidelines, 8-2
for Windows 3.1, 2-19
for Windows NT and Windows 95, 2-5
package definition files, 14-2
Systems Management Server support, 14-2

Oracle Replication Manager, defined, 2-13
Oracle Security Server Manager, defined, 2-13
Oracle Services

auto-starting, 10-7
for Oracle8 database, 3-19
naming conventions for multiple Oracle 

homes, 10-2
OracleAgent, 10-5
OracleConTextService80, 10-5
OracleExtprocAgent, 10-5
OracleServiceSID, 10-4
OracleStartSID, 10-4
OracleTNSListener80, 10-4
OracleWebAssistant, 10-5
shutting down a database by stopping a 

service, 10-14
starting, 10-6
stopping, 10-6
viewing in the Control Panel, 3-19

Oracle SPX Protocol Adapter
defined, 2-11, 2-20

Oracle TCP/IP Protocol Adapter
defined, 2-11, 2-20

Oracle Technical Publications, contact 
information, xv

Oracle Trace
overview, 12-17
starting, 12-18
troubleshooting, F-5

Oracle Trace Collection Services, defined, 2-13
Oracle Web Publishing Assistant, defined, 2-13
Oracle WebServer Manager, defined, 2-13
Oracle WebServer, installation sequence, 2-4
Oracle Worldwide Customer Support

contact information, xv
Oracle XA Library

additional documentation, 15-12
compiling and linking a Pro*C program, 15-11
compiling and linking an OCI program, 15-11
functions, 15-10

overview, 15-10
ORACLE_GROUP_NAME parameter, C-7, C-10
ORACLE_HOME parameter, C-8, C-10
ORACLE_HOME_NAME parameter, C-8, C-10
ORACLE_HOME_SERVICE parameter, C-8
ORACLE_SID parameter, C-8
ORACLE_SID parameter, 9-17, 10-4, 10-16
Oracle7

changed parameter names in Oracle8, 7-26
obsolete parameters, 7-25

Oracle7 applications, database coexistence, 7-4
Oracle7 Clients

connecting to Oracle8 databases, 7-5
migration, 7-16
migration to Oracle8, 7-12

Oracle7 database, migrating, 7-16
Oracle7 Utilities, defined, 2-14
Oracle8 Buffer Cache, 12-8
Oracle8 Clients, connecting to Oracle7 

databases, 7-6
Oracle8 ConText Cartridge

configuration requirements, 8-3
configuration responsibilities, 8-20
configuration tasks, 8-28
configuring Oracle8 ConText Cartridge 

Configuration Manager, 8-35
configuring Oracle8 ConText Cartridge 

Workbench Viewer Cartridge, 8-32
creating wrappers, 16-7
defined, 2-14
demons, 8-31
installing wrappers and external filters, 16-4
loading lexical data, 8-25
Oracle8 ConText Cartridge Workbench 

demo, 8-37
starting servers, 16-2
supplied external filters, setting up, 16-6
upgrading, 8-20
upgrading Oracle8 ConText Cartridge 

Workbench, 8-32
user defined external filters, 16-11

Oracle8 ConText Cartridge Demos, defined, 2-14
Oracle8 ConText Cartridge I/O Utility, defined,   

2-15
Oracle8 ConText Cartridge System Administration
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defined, 2-15
tool, 16-13

Oracle8 ConText Cartridge Viewer
defined, 2-15

Oracle8 ConText Cartridge Viewer Cartridge, 
defined, 2-15

Oracle8 ConText Cartridge Workbench
administration tools, 16-12
defined, 2-14
demo, 16-17
described, 16-12
document viewers, 16-14
I/O Utility, 16-16
TextServer3 Dictionary Migration Tool, 16-16

Oracle8 ConText ConText Cartridge Configuration 
Manager, defined, 2-14

Oracle8 Data Dictionary Cache, 12-8
Oracle8 Data Files, 12-8
Oracle8 database

available Oracle Services, 3-19
connecting to, 10-8, F-3
error messages, D-4
operating system permission problems, F-4
password encryption, 10-20
selecting a backup and recovery tool, 13-2
shutting down, 10-8, 10-9, 10-14
shutting down a database with a service, 10-14
starter database contents, 5-4
starter database control file, 5-9
starter database data dictionary, 5-10
starter database data files, 5-8
starter database initialization parameter file, 5-8
starter database redo log files, 5-9
starter database tablespaces, 5-7
starter database user names, 5-4
starting, 10-8, 10-9
system identifier, 5-6
transaction processing monitor, 15-10
using Control Panel, 3-19
using Event Viewer, 3-20
using Performance Monitor, 3-22
using User Manager, 3-26

Oracle8 database backup and recovery tools
Backup Manager, 13-2
NT Backup and Recovery Manager, 13-2

OCOPY80, 13-3
Recovery Manager (RMAN80.EXE), 13-3
third-party vendors, 13-3

Oracle8 DBWR stats1, 12-9
Oracle8 DBWR stats2, 12-9
Oracle8 Dynamic Space Management, 12-9
Oracle8 Enterprise Edition

defined, 2-2, 2-16
installable products, 2-4
key features, 2-2
key words, 7-26
new features, 2-3
new products, 2-3
reserved words, 7-26

Oracle8 Free List, 12-9
Oracle8 Image Cartridge

configuration requirements, 8-3
configuration responsibilities, 8-40
configuration tasks, 8-41
defined, 2-16
running ORDIINST.SQL, 8-41

Oracle8 Image Cartridge Demos, configuration 
tasks, 8-41

Oracle8 Library Cache, 12-10
Oracle8 Objects, 12-5
Oracle8 Objects Option, 8-2
Oracle8 Objects Option, defined, 2-16
Oracle8 Objects, monitoring, 12-6
Oracle8 Partioning Option, 8-2
Oracle8 Partitioning Option, defined, 2-17
Oracle8 Performance Monitor

accessing, 12-5
alert view, 12-6
chart view, 12-6
for monitoring a database, 12-2
Hostname parameter, 12-4
installation, 12-3
log view, 12-6
monitoring Oracle8 Objects, 12-6
OPERF80.LOG, 12-10
Oracle8 Buffer Cache, 12-8
Oracle8 Data Dictionary Cache, 12-8
Oracle8 Data Files, 12-8
Oracle8 DBWR stats1, 12-9
Oracle8 DBWR stats2, 12-9
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Oracle8 Dynamic Space Management, 12-9
Oracle8 Free List, 12-9
Oracle8 Library Cache, 12-10
Oracle8 Redo Log Buffer, 12-9
password, 12-4
registry information, 12-4
Report View, 12-6
troubleshooting information, 12-10
Username parameter, 12-4
using, 12-3

Oracle8 Performance Utility, defined, 2-17
Oracle8 Redo Log Buffer, 12-9
Oracle8 Sorts, 12-10
Oracle8 Spatial Cartridge

configuration requirements, 8-3
configuration responsibilities, 8-17
configuration tasks, 8-17
creating MDSYS user, 8-18
defined, 2-17
developing applications with SDO80.LIB, 8-19
running CATMD.SQL, 8-19

Oracle8 Spatial Data Cartridge Utilities, defined,  
2-17

Oracle8 Time Series Cartridge, 2-3
configuration requirements, 8-3
configuration responsibilities, 8-43
configuration tasks, 8-44
defined, 2-17

Oracle8 Time Series Cartridge Demos, 
configuration tasks, 8-45

Oracle8 Utilities
defined, 2-17
operating system compatibility, 3-2

Oracle8 Visual Information Retrieval Cartridge,   
2-3

configuration requirements, 8-3
configuration responsibilities, 8-46
configuration tasks, 8-47
defined, 2-18

Oracle8 Visual Information Retrieval Cartridge 
Demos, configuration tasks, 8-48

ORACLE80 parameter, C-8
OracleAgent

defined, 10-5
starting, 8-6

OracleConTextService80, defined, 10-5
OracleExtprocAgent, defined, 10-5
OracleServiceSID, defined, 10-4
OracleStartSID, defined, 10-4
OracleTNSListener80, defined, 10-4
OracleWebAssistant, defined, 10-5
ORADEBUG

debugging utility, 10-23
starting, 10-23

ORADIM80
changing the INTERNAL password, 10-20
list of parameters, 3-16
moving or copying password files, 10-18
operating system compatibility, 3-2
starting, 3-8
using, 3-14

ORAPWD80
creating password files, 10-17
operating system compatibility, 3-2
starting, 3-9

OraTcl, using with database commands, 4-10
ORDIINST.SQL, running, 8-41
ORDSYS user name, 5-5

database roles, 5-5
password, 5-5

OS_AUTHENT_PREFIX parameter, 11-4, B-5
OS_ERROR error message, D-3
OS_ROLES parameter, 11-18
OSAUTH_PREFIX_DOMAIN parameter, 11-5
OSD-04000 to OSD-04099 error codes, D-7
OSD-04100 to OSD-04199 error codes, D-12, D-14
OSD-04300 to OSD-04399 error codes, D-17
OSD-04400 to OSD-04499 error codes, D-18
OSD-04500 to OSD-04599 error codes, D-18
OTRACE73 parameter, C-8
OTT_DFLT parameter, C-8
OTT80 parameter, C-8
overview

managing and distributing Oracle software,   
14-2

monitoring a database, 12-2
Oracle Enterprise Manager, 4-2

OWAST parameter, C-8
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P
package definition files, Oracle products, 14-2
packaged functions

Intercartridge Exchange, 15-14
UTL_HTTP.REQUEST, 15-14
UTL_HTTP.REQUEST_PIECES, 15-15

PARALLEL_DEFAUILT_MAX_SCANS, 7-25
PARALLEL_DEFAULT_SCAN_SIZE, 7-25
parameters

defined, C-2
registry, C-1

PARFILE, using, D-2
password file

authenticating database administrators, 10-17
connecting as INTERNAL, 10-19
creating, 10-17
hiding, 10-17

Password parameter, C-12
Password Utility. See ORAPWD80
passwords

changing for SYS user name, 5-6
changing for SYSTEM user name, 5-6
changing the INTERNAL password, 10-20
changing with ALTER USER command, 5-6
connecting without an INTERNAL 

password, 11-14
encryption, 10-20
for databases, 9-16
for DBSNMP user name, 5-5
for DEMO user name, 5-5
for INTERNAL user name, 5-4, 10-19
for MDSYS user name, 5-5
for ORDSYS user name, 5-5
for SCOTT user name, 5-5
for SYS user name, 5-5
for SYSTEM user name, 5-5

patches, downloading from Customer Support,  
10-21

PATH, 6-6
PATH parameter, C-11
PDF format, supplied external filter, 16-5
PERF_FILE_NAME parameter, C-13
PERFORMANCE key, C-11
Performance Monitor, 12-3

defined, 3-22
integration with Oracle8 database, 3-22
monitoring specific Oracle events, 3-22
starting, 3-10
viewing OPERF80.LOG file status, 12-10

Performance Pack, monitoring a database, 12-2
PERMISSION_DENIED error message, D-3
PFILE option, using, 10-8
PL/SQL

configuring external procedures, 8-3
external procedures, 15-2

PLSQL23 parameter, C-8
PLSQL80 parameter, C-8
PLUS_DFLT parameter, C-8
PLUS80 parameter, C-8
PRAGMA RESTRICT_REFERENCES, with 

Intercartridge Exchange, 15-17
predefined event sets

with Job Scheduling System, 4-13
privileges

in Windows NT local groups, 11-10, 11-14,     
11-20, 11-22

Pro*C, compiling and linking, 15-11
PRO18 parameter, C-9
PRO80 parameter, C-9
proactive events management

Event Management System, 4-12
PROCESSES parameter, B-5
protocol adapters, defined, 2-11
PUPBLD.SQL, 7-33
PWDSID.ORA file, 10-17

R
RBS1SID.ORA

data file, 5-8
tablespace contained in, 5-8

RDBMS73 parameter, C-9
RDBMS80 parameter, C-9
RDBMS80_ARCHIVE parameter, C-9
RDBMS80_CONTROL parameter, C-9
READ_ERROR error message, D-3
RECALIBRATION_FAILURE error message, D-3
recovering, an Oracle8 database, 13-2
recovery file types, OCOPY80, 13-6
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Recovery Manager, 13-3
capabilities, 13-3
operating system compatibility, 3-2
starting, 3-9

redo log files
LOG1SID.ORA, 5-9
LOG2SID.ORA, 5-9
LOG3SID.ORA, 5-9
LOG4SID.ORA, 5-9
starter database, 5-9

REGEDT32 command, 9-17
registering, an external procedure, 15-6
registry

A2OWIZ80, C-6
adding parameters, C-16
ALL_HOMES subkey, C-10
API, C-6
API parameter, C-9
COMPANY_NAME, C-6, C-9
configuration parameters, C-1
CORE40, C-6
DEFAULT_HOME, C-10
DisplayName, C-14
EXECUTE_SQL, C-6
HOME_COUNTER, C-10
HOMEID naming convention, C-4
Hostname, 12-4, C-12
ID, C-6, C-9
ImagePath, C-14
impact of multiple Oracle homes, C-3, C-4, C-5
keys, C-2
LAST_HOME, C-10
LOGFILE, C-13
modifying values, C-14
MS_HELP, C-6
MSHELP, C-6
NAME, C-11
NET80, C-6
NLS_LANG, C-6, C-10, C-11
NLSRTL32, C-6
NLSRTL33, C-6
ObjectName, C-14
OI_NLS32, C-6
ORA_EXTPROC_THREADED, C-7
ORA_NLS32, C-7

ORA_NLS33, C-7
ORA_SHUTDOWN, 10-14, C-7
ORA_SHUTDOWN_TIMEOUT, 10-14, C-7
ORA_SID_ SHUTDOWN, C-7
ORA_SID_PWFILE, C-7
ORA_SID_SHUTDOWN, 10-14
ORA_SID_SHUTDOWN_TIMEOUT, 10-14, C-7
Oracle Patch Assistant keys, 10-21
ORACLE_GROUP_NAME, C-7, C-10
ORACLE_HOME, C-8, C-10
ORACLE_HOME_NAME, C-8, C-10
ORACLE_HOME_SERVICE, C-8
ORACLE_SID, C-8
ORACLE80, C-8
OTRACE73, C-8
OTT_DFLT, C-8
OTT80, C-8
OWAST, C-8
parameter values, C-2
Password, C-12
password value, 12-4
PATH, C-11
PERF_FILE_NAME, C-13
PERFORMANCE key, C-11
PLSQL23, C-8
PLSQL80, C-8
PLUS_DFLT, C-8
PLUS80, C-8
PRO18, C-9
PRO80, C-9
RDBMS73, C-9
RDBMS80, C-9
RDBMS80_ARCHIVE, C-9
RDBMS80_CONTROL, C-9
REG_DWORD, C-2, C-17
REG_EXPAND_SZ, C-2, C-17
REG_MULTI_SZ, C-2, C-17
REG_SZ, C-2, C-17
REGEDT32, C-14, C-16
SHARED_ORACLE_HOME, C-9, C-10
SQLPATH, C-9
starting, 3-10
SVRMGR, C-9
update ORACLE_SID, 9-17
Username, 12-4, C-12
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Registry Editor, C-2
REMOTE_LOGIN_PASSWORDFILE 

parameter, 10-17, 10-19, B-5
replication, configuration tasks, 8-51
Report View, 12-6
repository database

Oracle Enterprise Manager, 4-14
overview, 8-4
user account, 8-7

Required Support Files
version 7.3.4, 2-18
version 8.0, 2-18

RMAN80. See Recovery Manager
roles

granting through Windows NT, 11-18
MDSYS user name, 5-5
of DBSNMP user name, 5-5
of DEMO user name, 5-5
of SCOTT user name, 5-5
of SYSTEM user name, 5-5
ORDSYS user name, 5-5
SYS user name, 5-5

ROLLBACK_DATA tablespace, description, 5-7

S
scalability

Job Scheduling System, 4-11
with Job Scheduling System, 4-13

scheduling jobs, Oracle Enterprise Manager, 4-8
Schema Manager

capabilities, 4-17
starting, 3-12

schema, INTERNAL user name, 5-4
SCOTT user name, 5-5

database roles of, 5-5
password of, 5-5

SDO80.LIB, Oracle8 Spatial Cartridge application 
development, 8-19

security
of Oracle Enterprise Manager, 4-15
with Job Scheduling System, 4-11
with Oracle Enterprise Manager, 4-15

Security Manager, 4-16
starting, 3-12

SELECT * FROM ALL_OBJECTS, 8-52
SEQUENCE_CACHE_HASH_BUCKETS, 7-25
SERIALIZABLE, 7-25
Server Manager

operating system compatibility, 3-2
running CATREP8M.SQL script, 8-52
running multiple instances, 10-16
shutting down the database, 10-8
starting, 3-9, 10-8, F-3
starting the database, 10-8
using ORADEBUG, 10-23

service discovery, Oracle Enterprise Manager, 4-8
services, 10-2

auto-starting, 10-7
available with Oracle8 database, 3-19
managing, 10-2
OracleAgent, 10-5
OracleConTextService80, 10-5
OracleExtprocAgent, 10-5, 15-9
OracleServiceSID, 10-4
OracleStartSID, 10-4
OracleTNSListener80, 10-4
OracleWebAssistant, 10-5
shutting down a database by stopping a 

service, 10-14
starting, 9-10, 10-6
stopping, 10-6
viewing in the Control Panel, 3-19

SESSION_CACHED_CURSORS, 7-25
SET INSTANCE command, 11-13, 11-17, 11-23
SET ORACLE_SID=SID, 10-16
SHARED_ORACLE_HOME parameter, C-9, C-10
SHARED_POOL_SIZE parameter, B-5
SHARING_VIOLATION error message, D-3
SHUTDOWN command

options, 10-8
using, 10-8

shutting down
databases, 10-8, 10-9, 10-14

SMS. See Systems Management Server
SNAPSHOT_REFRESH_INTERVAL, 7-26
SNAPSHOT_REFRESH_PROCESSES, 7-26
Software Manager, capabilities, 4-18
SORT_READ_FAC parameter, B-5
SORT_SPACEMAP_SIZES parameter, B-5
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SPOOL command, using, 8-51, 8-52
SQL Worksheet

capabilities, 4-16
starting, 3-12

SQL*Loader
control file conventions, 3-18
direct path option, 3-17
operating system compatibility, 3-2
starting, 3-9
using, 3-17

SQL*Net
appropriate versions, 7-17
products, 2-18

SQL*Net Client, defined, 2-20
SQL*Net Server, defined, 2-18
SQL*Plus

defined, 2-19, 2-20
operating system compatibility, 3-3
starting, 3-14

SQL, external procedures, 15-2
SQLNET.ORA file, operating system 

authentication, 11-3
SQLPATH parameter, C-9
starter database

advanced replication support, 5-2
cartridges and options, 5-2
contents, 5-2, 5-4
control file, 5-9
data dictionary, 5-10
data files, 5-8
database files, 5-3
database name, 5-2
initialization parameter file, 5-8
redo log files, 5-9
system identifier, 5-2
tablespaces, 5-3, 5-7
Typical Configuration, 5-2
user names, 5-3, 5-4

starting
databases, 10-8, 10-9
Oracle Services, 10-6
Oracle8 Performance Monitor, 12-5
performance monitoring applications, 12-18
Server Manager, 10-8, F-3

STARTUP command

use of, F-3
using, 10-8

stopping, Oracle Services, 10-6
Storage Manager, capabilities, 4-16
stored packages, Intercartridge Exchange, 15-14
SVRMGR parameter, C-9
SVRMGR30. See Server Manager
syntax

for backing up files with OCOPY80, 13-5
for recovering files with OCOPY80, 13-6

SYS user name, 5-5
changing the password, 5-6
database roles of, 5-5
password of, 5-5

SYS1SID.ORA
data file, 5-8
tablespace contained in, 5-8

SYSDBA
connecting without a password, 11-10

SYSOPER
connecting without a password, 11-10

System Administration tool, Oracle8 ConText 
Cartridge, 16-13

system identifier
defined, 10-4
for custom database, 5-2
for Oracle8 database, 5-6
for starter database, 5-2
multiple Oracle homes, 5-6

SYSTEM tablespace, description, 5-7
SYSTEM user name, 5-5

changing the password, 5-6
database roles of, 5-5
password of, 5-5

Systems Management Server
capabilities
defined
distributing software, 14-3
Oracle product support, 14-2
package definition files, 14-2
products available for installation, 14-3
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T
tablespaces

Advanced Replication support, 8-50, 8-53
containing RBS1SID.ORA, 5-8
containing SYS1SID.ORA, 5-8
containing TMP1SID.ORA, 5-8
containing USR1SID.ORA, 5-8
expanding for large sorts, 5-7
for custom database, 5-3
for starter database, 5-3
ROLLBACK_DATA, 5-7
starter database, 5-7
SYSTEM, 5-7
TEMPORARY_DATA, 5-7
USER_DATA, 5-7

Tcl
including database commands, 4-10
scripts

TEMPORARY_DATA tablespace, description, 5-7
TEMPORARY_TABLE_ LOCKS parameter, B-5
TextServer3 Dictionary Migration Tool

defined, 2-16
third-party backup and recovery vendors, 13-3
TKPROF

operating system compatibility, 3-2
starting, 3-9

TMP1SID.ORA
data file, 5-8
tablespace contained in, 5-8

TNSNAMES.ORA file, 15-3
external procedures, 15-3

TOO_MANY_OPEN_FILES error message, D-3
Tool Command Language. See Tcl
trace files, 12-14

creating with ORADEBUG, 10-23
for monitoring a database, 12-2
using, 12-14
using BACKGROUND_DUMP_DEST 

parameter, 12-14
using USER_DUMP_DEST, 12-14

transaction processing monitor
additional documentation, 15-12
interacting with Oracle8 database, 15-10
types, 15-10

TRANSACTIONS_PER_ ROLLBACK_ SEGMENT 
parameter, B-5

troubleshooting, F-5
Intercartridge Exchange, 15-19
operating system permission problems, F-4
ORA-12203 error, F-2
ORA-12547 error, F-2
ORA-28575 error, F-2
using Oracle Trace, F-5
with ORADEBUG, 10-23

Typical Configuration
contents, 5-2
database installation type, 5-2

U
UNLIMITED_ROLLBACK_SEGMENTS, 7-25
unsolicited error detection, Job Scheduling 

System, 4-12
upgrading

external filters for Oracle8 ConText 
Cartridge, 16-6

multiple Oracle homes, 7-3
Oracle8 ConText Cartridge, 8-20
overview, 7-3
tools, 7-36
wrappers for Oracle8 ConText Cartridge, 16-6

USE_ASYNC_IO, 7-26
USE_IPQ, 7-25
USE_READV, 7-25
USE_SIGIO, 7-25
User Manager

defined, 3-26
for Oracle Enterprise Manager, 8-9
integration with Oracle8 database, 3-26
starting, 3-10

user names
changing passwords for SYS and SYSTEM, 5-6
DBSNMP, 5-5
DEMO, 5-5
for custom database, 5-3
for starter database, 5-3
INTERNAL, 5-4
MDSYS, 5-5
ORDSYS, 5-5
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SCOTT, 5-5
starter database, 5-4
SYS, 5-5
SYSTEM, 5-5

USER_DATA tablespace, description, 5-7
USER_DUMP_DEST parameter, B-5
USER_DUMP_DEST, using, 12-14
Username parameter, C-12
USR1SID.ORA

data file, 5-8
tablespace contained in, 5-8

UTL_HTTP.REQUEST, Intercartridge 
Exchange, 15-14

UTL_HTTP.REQUEST_PIECES, Intercartridge 
Exchange, 15-15

V
V733PLANS_ENABLED, 7-25
vsa@us.oracle.com, xvii

W
web data, Intercartridge Exchange
Windows NT

directory structure for database, A-2
tools, 3-3
user account, 8-9

Windows NT local groups
with database privileges, 11-10, 11-14, 11-20,  

11-22
Windows NT Native Authentication Adapter, use 

of, 11-2
WordPerfect format, supplied external filters, 16-5
wrappers, creating, 16-7
WRITE_ERROR error message, D-4
WRITE_PROTECTED error message, D-4

X
XA. See Oracle XA Library
Xerox XIF format, supplied external filter, 16-5
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	1. Ensure that you have DBA privileges, which are ...
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	3. Shut down the database. Do not use SHUTDOWN IMM...

	Step 2: Back Up the Release 8.0.3 Database
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	2. Delete the following database files located in ...

	Modify the INITSID.ORA File
	Additional Information

	Create and Start an Oracle8 Service
	1. Go to the \MYDIR directory.
	2. Run ORADIM80 from the MS-DOS command prompt:
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	6. Run the following script to generate the data d...
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